
ADOBE® AUDITION®

Aide et didacticiels

Il se peut que certains liens renvoient vers du contenu en anglais uniquement.



-->

Nouveautés
 
Pour en savoir plus, nous vous recommandons de consulter les ressources suivantes en ligne.

Importer et graver un CD audio
video2brain (7 mai 2012)
vidéo
Produire, en toute simplicité, des CD audio de qualité professionnelle.

Tirer parti des surfaces de contrôle
video2brain (7 mai 2012)
vidéo
Mixage parfait.

Corriger la hauteur de ton
video2brain (7 mai 2012)
vidéo
Commandes visuelles et automatiques intuitives.

Didacticiel sur les modèles de session
Durin Gleaves (7 mai 2012)
vidéo
Créer rapidement des éléments multipistes courants

Améliorations touchant aux effets
video2brain (7 mai 2012)
vidéo
Traiter le contenu audio avec un large éventail d’outils créatifs.

Améliorations en mode Multipiste
video2brain (7 mai 2012)
vidéo
Aligner les effets vocaux, Side-chain et bien plus encore.

Exports et sauvegardes
Video2Brain (7 mai 2012)
vidéo
Optimiser les projets en vue d’une efficacité maximale.

Améliorations en mode Forme d’onde
Video2Brain (7 mai 2012)
vidéo
Les commandes de prévisualisation, de transport et de marque simplifient votre flux de production.

Il se peut qu’une partie du contenu lié depuis cette page apparaisse uniquement en anglais.

http://www.adobe.com/go/CHLvid60804_au_fr
http://www.adobe.com/go/CHLvid60805_au_fr
http://www.adobe.com/go/CHLvid60803_au_fr
http://vimeo.com/40323195
http://www.adobe.com/go/CHLvid60807_au_fr
http://www.adobe.com/go/CHLvid60801_au_fr
http://www.adobe.com/go/CHLvid60806_au_fr
http://www.adobe.com/go/CHLvid60802_au_fr


Nouveautés de la version CS6
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Regroupement de clips multipistes

Raccord de clips multipistes sur des sélections temporelles

Placement de clips multipistes

Aperçu des modifications avec la fonction Ignorer la sélection

Presse-papiers multiples dans l’éditeur de forme d’onde
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Montage audio plus rapide et plus précis
Expansion de clips multipistes
Alignement vocal automatique
Prise en charge des consoles d’étalonnage avec automatisation des paramètres
Puissantes commandes de hauteur de ton
Gestion efficace des fichiers
Formats audio et vidéo étendus
Gravure sur CD
Effets supplémentaires, souplesse de routage et prise en charge du format VST3
Automatisation radio intégrée
Traitement par lot amélioré
Métronome configurable
Raccourcis clavier améliorés

Montage audio plus rapide et plus précis

Sélectionnez plusieurs clips, puis choisissez Clip > Groupes > Associer les clips. Vous pouvez déplacer et
modifier des clips associés, et même les étirer proportionnellement lorsque l’expansion est activée. Des paramètres d’expansion de groupe, de
gain, de couleur, etc., sont disponibles dans le panneau Propriétés (Fenêtre > Propriétés).

Pour modifier temporairement tous les clips associés de manière indépendante, sélectionnez Clip > Groupes > Interrompre les groupes. Pour
réappliquer rapidement des groupes dans une session, désélectionnez la commande Interrompre les groupes.
Pour modifier indépendamment un seul clip d’un groupe, cliquez dessus avec le bouton droit de la souris, puis sélectionnez Supprimer le clip
sélectionné du groupe.

La commande Raccord sur la sélection temporelle supprime les parties
inutilisées de clips, ce qui facilite leur alignement sur les éléments musicaux ou vidéo associés d’une session.

1. Sélectionnez un intervalle de temps et un ou plusieurs clips à l’aide de l’outil Sélection temporelle .
2. Sélectionnez Clip > Raccord sur la sélection temporelle.

Dans la section Infos du panneau Propriétés, entrez les heures de début et de fin spécifiques des clips
sélectionnés, ce qui garantit un positionnement précis.

Dans les commandes de transport au bas du panneau Editeur, cliquez sur le
bouton Ignorer la sélection  pour ignorer le contenu audio sélectionné en cours de lecture, ce qui vous permet d’effectuer un aperçu précis des
modifications.

Positionnez la tête de lecture avant la sélection afin de définir la valeur de preroll et de postroll par défaut. Adobe Audition applique le même
paramètre lors de l’aperçu suivant avec l’option Ignorer la sélection.

Sélectionnez Edition > Définir le Presse-papiers actif pour copier et coller du contenu
audio à partir de cinq Presse-papiers différents (au maximum). Lorsque vous devez coller du contenu spécifique utilisé fréquemment, il est
aisément accessible.

Expansion de clip multipiste
Vous pouvez étirer rapidement des clips à la longueur voulue, tout en prévisualisant les résultats au cours de la lecture. Dans le panneau Editeur,
sélectionnez plusieurs clips à étirer proportionnellement. Dans le panneau Propriétés, choisissez parmi les divers types d’expansion optimisés pour
du contenu audio différent.

Pour plus d’informations, reportez-vous à Expansion de clips multipistes dans CS6.

Alignement vocal automatique
Pour aligner rapidement un dialogue superposé sur du contenu audio de production original, utilisez l’option d’alignement vocal automatique.

http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/fr-fr/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/fr-fr/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/fr-fr/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/fr-fr/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/fr-fr/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
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Audition fait correspondre la durée de chaque mot, même si le son d’origine est bruyant ou si sa longueur globale diffère.

Dans l’éditeur de multipiste, sélectionnez deux clips contenant le même dialogue et de longueur semblable. Choisissez ensuite Clip > Alignement
vocal automatique. 

Dans les menus Canal de référence, sélectionnez les canaux dans lesquels le dialogue est le plus clair. Afin d’améliorer davantage
l’alignement, supprimez le silence au début ou à la fin des clips.

Prise en charge des consoles d’étalonnage avec automatisation des paramètres
Mixez de l’audio de manière interactive avec des surfaces de contrôle répandues à l’aide des protocoles de contrôle EUCON, Mackie MCU ou
Logic (y compris les consoles de la série Avid Artist fabriquées précédemment par Euphonix). Vous pouvez également utiliser des contrôleurs sur
tablette tiers prenant en charge ces protocoles. Vous pouvez même utiliser plusieurs appareils simultanément.

Pour connecter votre contrôleur à Audition, sélectionnez Edition > Préférences > Surface de contrôle. Choisissez un protocole de contrôleur dans
le menu Catégorie de périphérique. Ensuite, cliquez sur Configurer pour spécifier les entrées et sorties MIDI (pour les contrôleurs Mackie et Logic
) ou sur Affectations de bouton (pour les contrôleurs Mackie et Red Rover).

Adobe Audition CS6 prend en charge toute la gamme de modes d’automatisation (Lecture, Verrou, Ecriture et Au toucher) pour l’ensemble des
paramètres d’effet, de panoramique et de niveau de piste. Sélectionnez le mode d’automatisation dans le menu situé au bas des commandes de
piste dans le panneau Editeur ou au-dessus de l’atténuateur dans le Mélangeur.

Pour plus de détails sur chaque mode d’automatisation, reportez-vous à Options du mode d’automatisation de piste.

Contrôles avancés de la hauteur de ton
Corrigez précisément la hauteur de ton avec des commandes manuelles ou automatiques, ou manipulez l’audio de manière créative afin de
réaliser des conceptions sonores novatrices.

Pour obtenir les meilleurs résultats, appliquez une correction de la hauteur de ton aux différentes pistes vocales ou instrumentales.

Effet Correction manuelle de la hauteur de ton (éditeur de forme d’onde uniquement)
L’effet Correction manuelle de la hauteur de ton vous permet de régler visuellement la hauteur de ton avec l’affichage de la hauteur de ton
spectrale. L’affichage de la hauteur de ton spectrale présente la hauteur de ton fondamentale sous la forme d’un trait bleu vif et les partiels dans
des teintes allant du jaune au rouge. La hauteur de ton corrigée s’affiche sous la forme d’un trait vert vif.

Sélectionnez Effets > Temps et hauteur de ton > Correction manuelle de la hauteur de ton. Pour obtenir des instructions détaillées, reportez-vous
à la rubrique Effet Correction manuelle de la hauteur de ton.

Vous pouvez surveiller visuellement la hauteur de ton à tout moment sans utiliser l’effet Correction manuelle de la hauteur de ton. Il vous suffit
de cliquer sur l’icône Afficher la hauteur de ton spectrale dans la barre d’options.

Effet Correction automatique de la hauteur de ton
L’effet Correction automatique de la hauteur de ton est disponible à la fois dans les éditeurs Forme d’onde et Multipiste. Dans le second cas, ses
paramètres peuvent être automatisés au fil du temps à l’aide d’images clés et de consoles d’étalonnage externes.

Sélectionnez Effets > Temps et hauteur de ton > Correction automatique de la hauteur de ton. Pour obtenir des instructions détaillées, voir la
section Effet Correction automatique de la hauteur de ton

Gestion efficace de fichiers

Explorateur de médias
Sélectionnez Fenêtre > Explorateur de médias pour prévisualiser les fichiers sur vos lecteurs locaux et réseau, avec des spécifications et des
métadonnées utiles sur les fichiers. Au bas du panneau, cliquez sur le bouton Lire  pour écouter le contenu audio et sur le bouton Lecture en
boucle  pour capturer les détails. Ensuite, faites glisser les fichiers directement sur les panneaux Fichiers ou Ajuster le volume, des sessions
multipiste ou des dispositions de CD.

Pour créer un signet pour un dossier que vous utilisez souvent, naviguez jusqu’au fichier dans l’Explorateur de médias, puis cliquez sur l’icône
Ajouter un raccourci dans le coin supérieur droit du panneau.

Panneau Fichiers
Dans le panneau Fichiers, trouvez rapidement des fichiers en saisissant des données dans la zone de recherche, telles que le nom, les canaux ou
un type de support. Au bas du panneau, cliquez sur les boutons Lire  et Lecture en boucle .

http://idiom-q-win-1/content/help/fr/audition/using/manual-pitch-correction-effect--.html
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Pour gagner de l’espace dans les panneaux Explorateur de médias et Fichiers, cliquez sur le bouton de menu du panneau dans l’angle
supérieur droit et désélectionnez Afficher prévisualisation transfert. Un plus petit bouton de lecture s’affiche dans la partie supérieure et les
commandes Lecture automatique et Aperçu en boucle restent disponibles dans le menu du panneau.

Panneau Marques
Le panneau Marques s’enrichit d’une zone de recherche semblable et des fonctionnalités suivantes :

Dans le coin supérieur droit du panneau, cliquez sur l’icône Afficher les marques de tous les fichiers  pour afficher les marques de l’ensemble
des fichiers ouverts et des sessions. Insérez les plages de marques sélectionnées dans des sessions multipistes, des dispositions de CD ou des
listes de lecture à l’aide des icônes situées en haut du panneau.

Cliquez sur l’icône Insérer dans multipiste  pour ajouter des plages de marques à une session multipiste existante ou créer une session.

Voici les nouveaux types de marque :

Sous-élément pour les plages d’un fichier que vous voulez afficher dans Adobe Premiere Pro comme des éléments distincts
dans le panneau Projet.
Piste du CD. Voir Gravure sur CD.
Minuteur Cart pour les systèmes d’automatisation radio. Voir Automatisation radio intégrée.

Modèles de session, archives et mixages finaux
Sélectionnez Fichier > Exporter > Session en tant que modèle pour créer des modèles multipistes qui accélèrent les projets récurrents nécessitant
des paramètres, des tâches et des fichiers sources similaires. Pour appliquer un modèle à une nouvelle session, sélectionnez Fichier > Nouveau
> Session multipiste, puis choisissez une option Modèle.

Pour archiver des sessions entières ou les déplacer vers d’autres systèmes avec leurs marques, métadonnées et fichiers sources, choisissez
Fichier > Exporter > Session. Dans la boîte de dialogue Exporter la session, personnalisez les fichiers source exportés en sélectionnant
Enregistrer les copies des fichiers associés et en cliquant ensuite sur Options. Pour modifier le format de fichier, sélectionnez Convertir des
fichiers. Pour exporter des fichiers source complets ou conformés, sélectionnez Options de média.

Sélectionnez Fichier > Exporter > Mixage final, puis passez en revue la section Options de mixage final. Cliquez sur Modifier pour générer des
pistes sous forme de fichiers distincts ou pour générer simultanément des fichiers mono, stéréo et principales 5.1.

Formats audio et vidéo étendus
Importez et lisez du contenu vidéo HD à diverses vitesses d’image, y compris 59,94 et 23,976 pour les images compensées et 59,94 pour les
images non compensées. La règle et les autres affichages de code temporel s’ajustent automatiquement.

Les formats d’importation pris en charge incluent désormais FLV, Shockwave et RED R3D, ainsi que Monkey’s Audio et un éventail de formats
audio fournis par la norme libsndfile.

Autres formats d’exportation pris en charge : Monkey et libsndfile, plus FLAC, OGG et MPEG-1 Audio Layer II (MP2).

Remarque : pour activer certains formats, sélectionnez Activer la prise en charge du format DLMS dans les préférences Cache de média et de
disque.

Pour obtenir la liste complète des formats et paramètres associés, reportez-vous à Formats d’importation pris en charge et Paramètres de format
d’exportation.

Gravure de CD
Sélectionnez Fichier > Nouveau > Disposition du CD pour assembler les fichiers que vous souhaitez graver sur des CD audio conformes à la
norme Red Book. Vous pouvez également ajouter des pistes directement à partir des panneaux Fichiers et Marques : cliquez avec le bouton droit
de la souris, puis sélectionnez Insérer dans la disposition du CD. (Pour que cette option soit disponible pour des plages de marques, sélectionnez
Piste du CD dans la colonne Type.)

Appuyez sur la combinaison de touches Shift + M en cours de lecture pour marquer rapidement les points de début et de fin d’une piste
de CD. Ensuite, sélectionnez des points adjacents dans le panneau Marques, puis cliquez sur l’icône Fusionner les marques sélectionnées afin
de créer des intervalles de temps pour chaque piste.

Vous pouvez assembler plusieurs fichiers de disposition de CD en même temps et les sélectionner dans le panneau Fichiers. Dans le panneau
Propriétés, indiquez des propriétés de disque telles que Référence de catalogue de médias (MCN), Titre et Artiste.

Une fois la disposition du CD terminée, sélectionnez Fichier > Exporter > Graver l’audio sur CD. (Dans la boîte de dialogue Graver l’audio,
sélectionnez Mode d’écriture > Test pour vérifier que le transfert des données sera suffisamment rapide pour éviter les erreurs.)

Pour graver rapidement un fichier unique, notamment les marques de piste, sélectionnez Fichier > Exporter > Graver l’audio sur CD dans
l’éditeur de forme d’onde. (Toutes les marques de piste doit être des intervalles et non des points.)
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Effets supplémentaires, souplesse de routage et prise en charge du format VST3

Effets favoris
Audition CS6 réintroduit plusieurs effets majeurs. Sélectionnez les options suivantes dans le menu Effets :

Générer des tonalités pour sélectionner une forme d’onde, ajouter des harmoniques, créer un balayage et régler la phase afin
de créer des éléments de conception sonore et de tester les tonalités.
Spécial > Déphaseur de doppler (éditeur de forme d’onde uniquement) pour simuler le déplacement d’un son par rapport à
l’auditeur, voire le tourbillonnement du son autour de celui-ci.
Imagerie stéréo > Déphaseur graphique pour contrôler précisément le degré de phase de chaque partie du spectre de
fréquences.
Filtre et égaliseur > Filtre coupe-bande pour peaufiner les fréquences spécifiques relatives à une réduction du bruit, à des
effets d’égaliseur extrêmes ou à une résonance intense.

Routage flexible des effets et Side-Chain
Les améliorations du routage vous permettent d’affecter des entrées et sorties d’effets à des canaux spécifiques ; il s’agit là d’une technique
particulièrement souple pour les mixages 5.1 surround. (Par exemple, vous pouvez appliquer des effets mono ou stéréo à des sources 5.1.) Dans
le coin supérieur droit des fenêtres d’effets, cliquez sur l’icône Editeur de couches colorées .

L’option Side-Chain pour les modules externes compatibles et l’effet Traitement de la dynamique intégré vous permet de régler l’amplitude sur la
base d’un signal externe. La technique la plus répandue coupe automatiquement la musique ou le niveau de bruit de fond lorsqu’un commentateur
parle :

1. Ouvrez une session multipiste.

2. Sur la piste de fond que vous souhaitez compresser, appliquez l’effet Amplitude et compression > Traitement de la
dynamique.

3. Dans le Rack d’effets, double-cliquez sur l’effet pour modifier les paramètres.

4. Dans le coin supérieur droit de la fenêtre Traitement de la dynamique, cliquez sur l’icône Définir l’entrée Side-Chain .
Sélectionnez ensuite la configuration de canaux pour l’audio source : Mono, Stéréo ou 5.1.

5. Naviguez jusqu’à la piste de voix hors champ. Dans la section Envoi  du panneau Editeur, sélectionnez Side-Chain >
Traitement de la dynamique [nom de la piste de destination].

Prise en charge des effets VST3 et stabilité à toute épreuve
La prise en charge de VST3 vous donne accès à un nouvel univers d’effets tiers. De plus, le fait de séparer la numérisation des effets tiers permet
de poursuivre l’exécution d’Adobe Audition même si un plug-in devient instable.

Automatisation radio intégrée
Audition CS6 intègre complètement les systèmes d’automatisation radio.

1. Pour définir visuellement les minuteurs AES CART dans un éditeur de forme d’onde audio, placez la tête de lecture dans le
panneau Editeur, puis appuyez sur la touche C. (Pour un positionnement général rapide des minuteurs, appuyez sur la
touche C en cours de lecture).

2. Dans le panneau Marques, cliquez sur les menus contextuels dans la colonne Nom afin de sélectionner des options parmi les
codes Cart par défaut. (Vous pouvez entrer des codes personnalisés pour votre système (quatre caractères maximum).)

Les systèmes Cart lisent uniquement les huit premiers minuteurs dans un fichier ; les autres sont ignorés.

Sélectionnez Fenêtre > Métadonnées pour accéder à ces options :

Sur l’onglet CART, vous pouvez modifier rapidement les ID, les signaux de sortie, les dates de début et de fin, etc. (Les
mêmes métadonnées s’affichent dans la section AES CART de l’onglet XMP).
Sur l’onglet RIFF, choisissez Afficher en tant que > Industrie de la radio pour afficher un sous-ensemble simplifié de
métadonnées RIFF.

Traitement par lots amélioré

http://idiom-q-win-1/content/help/fr/audition/using/doppler-shifter-effect---waveform.html
http://idiom-q-win-1/content/help/fr/audition/using/doppler-shifter-effect---waveform.html
http://idiom-q-win-1/content/help/fr/audition/using/doppler-shifter-effect---waveform.html
http://idiom-q-win-1/content/help/fr/audition/using/graphic-phase-shifter-effect.html
http://idiom-q-win-1/content/help/fr/audition/using/graphic-phase-shifter-effect.html
http://idiom-q-win-1/content/help/fr/audition/using/graphic-phase-shifter-effect.html
http://idiom-q-win-1/content/help/fr/audition/using/graphic-phase-shifter-effect.html
http://idiom-q-win-1/content/help/fr/audition/using/graphic-phase-shifter-effect.html
http://idiom-q-win-1/content/help/fr/audition/using/notch-filter-effect.html
http://idiom-q-win-1/content/help/fr/audition/using/notch-filter-effect.html
http://idiom-q-win-1/content/help/fr/audition/using/notch-filter-effect.html
http://idiom-q-win-1/content/help/fr/audition/using/notch-filter-effect.html
http://idiom-q-win-1/content/help/fr/audition/using/notch-filter-effect.html
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Dans le panneau Traitement par lots, vous pouvez appliquer, à tout moment, des favoris sur plusieurs fichiers, et pas seulement au moment de
l’exportation. Pour définir rapidement des conventions de dénomination communes lors de l’exportation de données à partir des panneaux
Traitement par lots ou Ajuster le volume, cliquez sur Paramètres d’exportation, puis sélectionnez Modèle.

Choisissez Fichier > Enregistrer tout l’audio en tant que Traitement par lots pour traiter tous les fichiers ouverts. (Pour plus d’informations,
reportez-vous à Traitement de fichiers par lots.

Métronome configurable
Un métronome configurable fournit plusieurs modèles de battement et sons. Sélectionnez Edition > Métronome > Modifier le rythme ou Modifier le
type de son.

Pour activer le métronome, cliquez sur l’icône du métronome  dans les panneaux Propriétés ou Editeur. Réglez le volume et le panoramique
dans la piste Métronome qui s’affiche dans la partie supérieure du panneau Editeur.

Pour modifier le tempo et la mesure de la session en cours, réglez les paramètres dans la section Affichage du temps du panneau Propriétés .

Pour la piste de métronome, vous pouvez appliquer des effets, affecter des envois et sorties matérielles, et automatiser le mixage comme avec
des pistes audio.

Raccourcis clavier étendu
Sélectionnez Edition > Raccourcis clavier et entrez ensuite des commandes dans la zone de recherche pour un accès rapide, ou cliquez sur
Copier dans le Presse-papiers pour imprimer du contenu à partir d’un éditeur de texte.

http://creativecommons.org/licenses/by-nc-sa/3.0/deed.fr
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr


Nouveautés
Remarque : certaines fonctionnalités de la version Windows d’Adobe Audition 3.0 ne sont pas disponibles dans CS5.5, notamment la gravure sur
CD, le format MIDI, le métronome, certains effets et formats de fichier, le groupement de clips et l’extension temporelle, ainsi que la prise en
charge de la surface de contrôle. Pour obtenir une liste complète, voir Fonctionnalités d’Adobe Audition 3.0 remplacées ou non implémentées
dans CS5.5.
Adobe Audition CS5.5 regroupe dans un ensemble multiplateforme unique les meilleures fonctionnalités des produits audio Adobe, avec des outils
haut de gamme de montage et de mixage multipiste, de puissantes options d’adoucissement audio et de robustes performances.

Prise en charge Mac OS Tirez profit du traitement multicœur, des données audio natives et de la puissance DSP des ordinateurs Macintosh
d’Apple.
Moteur audio hautes performances Réalisez efficacement plusieurs tâches grâce à la réactivité considérablement améliorée pour les projets de
toutes tailles. Ouvrez vos fichiers trois fois plus rapidement. Travaillez simultanément sur plusieurs sessions multipistes et fichiers audio. Importez
et traitez par lots les fichiers en arrière-plan tout en continuant à modifier les données audio. Accélérez les effets sur les systèmes
multiprocesseur.
Echange de montages avec des applications vidéo telles qu’Adobe Premiere Pro Utilisez les outils de nettoyage et de traitement audio
directement à partir d’Adobe Premiere Pro grâce aux échanges de montage et de mixage. Echangez des fichiers OMF et XML avec des stations
de travail audio numériques et des éditeurs non linéaires tels qu’Avid Pro Tools et Apple Final Cut Pro. Reportez-vous aux sections Utilisation
d’applications vidéo et Exportation de sessions au format d’échange Final Cut Pro ou OMF.
Montage et mixage surround 5.1 intégré Mixez les données audio surround 5.1 directement dans l’éditeur de multipiste. Le panneau
Panoramique de piste fournit des commandes intuitives et des commentaires visuels qui vous aident à localiser avec précision les sons dans le
champ surround. Ouvrez les fichiers de mixage 5.1 dans l’éditeur de forme d’onde afin de modifier les canaux sélectionnés. Voir la section son
surround 5.1.
Flux de production des effets améliorés Configurez les effets tout en effectuant des sélections, en lisant des séquences audio ou même en
appliquant une réduction complexe du bruit. Appliquez les effets multipistes aux clips individuels. Elargissez les capacités de traitement audio
grâce aux modules externes tiers VST et Audio Units. Voir la section Application d’effets.
Nouveaux effets Adobe Audition CS5.5 est doté de nouveaux effets, de la réverbération surround, optimisée pour les fichiers 5.1, à une suite
d’effet de diagnostics qui corrigent les problèmes audio les plus fréquents. Pour plus d’informations, reportez-vous aux sections suivantes :

Effet Réverbération surround

Effet Exhausteur vocal

Effet Aplanisseur du volume de discours

Effet Compresseur monobande

Effets de diagnostic (éditeur de forme d’onde uniquement)

Effet DeHummer

Effet Déesseur

Effet Chœur/Arrondisseur

Effet Modulateur de phase

Bibliothèque enrichie de musiques de fond et d’effets sonores exempts de droit Commencez votre bande son avec plus de 10 000 fichiers
gratuits disponibles par l’intermédiaire du panneau Resource Central. Parcourez et prévisualisez rapidement les fichiers, puis faites-les simplement
glisser du panneau vers les projets audio afin de produire des bandes son professionnelles avec plusieurs calques.
Flux de production des métadonnées rationalisé avec prise en charge Broadcast Wave Simplifiez la modification et la gestion des
métadonnées grâce au panneau de métadonnées XMP. La prise en charge du format XMP s’étend au format Broadcast WAV (BWF), ce qui
permet l’automatisation des flux de production pour les systèmes de production radio et télévisée. Voir la section Affichage et modification des
métadonnées XMP.
Format de session XML natif Enregistrez des sessions multipistes au format flexible XML, norme lisible à l’œil qui facilite la conversion vers des
formats propriétaires de différents fabricants. Les sessions XML Adobe Audition peuvent être ouvertes et modifiées dans des éditeurs de texte, ou
créées au moyen de programmes à partir de scripts et autres outils. Voir la section Enregistrement de sessions multipistes.
Ajustement du volume du clip multipiste Mélange facile d'audio de diverses sources. Voir Ajustement du volume du clip multipiste.
Analyse audio multipiste Analysez les relations entre les phases et la réponse de fréquence en temps réel grâce au Phasemètre et au panneau
Analyse des fréquences. Voir les sections Analyse des phases et Analyse de la plage de fréquences.
Affichages simultanés de la forme d’onde et du spectre Evaluez de manière précise l’amplitude et la fréquence audio. Voir la section Affichage
de formes d’onde et de spectres audio.
Favoris enregistrables Stockez des combinaisons d’effets, de fondus et de réglages d’amplitude, puis réappliquez-les rapidement à un fichier ou
une sélection dans l’éditeur de forme d’onde. Voir la section Favoris.
Panneau Historique Rétablissez facilement l’état antérieur de montages et de mixages, en comparant différents traitements d’effets, réductions
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du bruit, flux de signaux, etc. Restaurez les paramètres d’origine d’un simple clic. Voir la section Annulation, rétablissement et historique.

  |  
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Mode

Type

Durée, expansion et hauteur de ton

Réglages avancés

1. Sélectionnez Clip > Expansion > Activer l’expansion globale du clip.

2. Dans le panneau Editeur, faites glisser les triangles blancs dans le coin supérieur droit ou gauche des clips.

Sélectionnez plusieurs éléments pour les étirer de manière proportionnelle.

Pour personnaliser les paramètres d’expansion des clips sélectionnés, réglez les options Expansion suivantes dans le panneau Propriétés :

Sélectionnez l’une des options suivantes :
Désactivé désactive l’expansion, rétablissant ainsi la longueur d’origine du clip.
Temps réel permet d’entendre les résultats de l’expansion à mesure que vous faites glisser les clips. Ce mode est un excellent
choix lors de l’édition.
Rendu (haute qualité) requiert davantage de traitement, mais permet d’éviter les artefacts audibles. Choisissez ce mode si la
lecture ralentit ou que les performances diminuent en mode Temps réel.

Sélectionnez l’une des options suivantes :
Monophonique constitue la meilleure option pour les instruments de musique en solo ou les dialogues.
Polyphonique constitue la meilleure option pour de la musique avec plusieurs instruments ou des sons ambiants complexes.
Vit. variable modifie la hauteur de ton en plus de la durée, à l’instar du ralentissement ou de l’accélération de magnétophones
à bobines analogiques.

Pour appliquer rapidement le même mode à tous les clips, sélectionnez Clip > Expansion > Tous les clips étirés en temps réel ou Rendu de
tous les clips tirés.

Ces options fournissent des entrées numériques permettant d’opérer des réglages plus précis que ceux
autorisés par le déplacement de clips dans le panneau Editeur.

Définissez les options suivantes :
Sensibilité aux transitoires (disponible en mode Polyphonique) Définit la sensibilité à des transitoires, comme des sons de
batterie et des débuts de note, utilisées comme points d’ancrage pour l’expansion. Augmente si les transitoires semblent
artificielles.
Taille de la fenêtre Définit la taille, en millisecondes, de chaque bloc de données audio traitées. A régler uniquement si un écho
ou des artefacts se produisent.
Les paramètres Précision (disponibles en mode Rendu) déterminent le compromis entre qualité et vitesse de traitement.
L’option Conserver les formants (disponible lorsque Rendu et Monophonique sont sélectionnés) ajuste le timbre des
instruments et des voix, en conservant un effet réaliste au cours des transpositions.

Pour féminiser une voix masculine ou vice-versa, sélectionnez l’option Conserver les formants et changez la hauteur de ton au maximum.
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Comparaison des données audio analogiques et numériques
La transmission et le stockage du son s’effectuent différemment pour les données audio analogiques et numériques.

Données audio analogiques : tension positive et négative
Un micro convertit les ondes de pression en variations de tension sur un fil électrique : la haute pression est convertie en tension positive et la
basse pression en tension négative. Lorsque ces variations de tension se déplacent sur un fil électrique, elles peuvent être enregistrées sur bande
sous la forme de variations d’intensité magnétique ou sur un disque vinyle sous la forme de variations de la taille du sillon. Un haut-parleur
fonctionne de la même manière qu’un micro, mais dans le sens inverse : il capte les signaux de tension émis par un enregistrement audio et vibre
pour recréer l’onde de pression.

Données audio numériques : zéro et un
Contrairement aux supports de stockage analogiques tels que les cassettes ou les disques vinyle, les ordinateurs stockent les informations audio
dans un format numérique, sous la forme d’une série de 0 et de 1. Dans un enregistrement numérique, la forme d’onde d’origine est divisée en
instantanés individuels appelés échantillons. Ce processus est généralement appelé « numérisation » ou « échantillonnage » des données audio.
Il correspond à une « conversion analogique-numérique ».

Lorsque vous enregistrez à partir d’un micro dans un ordinateur, par exemple, des convertisseurs analogiques-numériques transforment le signal
analogique en échantillons numériques que les ordinateurs sont capables de stocker et de traiter.

Compréhension du taux d’échantillonnage
Le taux d’échantillonnage correspond au nombre d’instantanés numériques d’un signal audio pris par seconde. Il détermine la plage de fréquences
d’un fichier audio. Plus il est élevé, plus le profil de la forme d’onde numérique sera proche de celui de la forme d’onde analogique d’origine. Des
taux d’échantillonnage bas limitent la plage des fréquences qui peuvent être enregistrées, de sorte que le son enregistré peut être très éloigné du
son d’origine.

Deux taux d’échantillonnage
A.  Taux d’échantillonnage bas qui altère l’onde sonore d’origine. B.  Taux d’échantillonnage élevé qui reproduit parfaitement l’onde sonore
d’origine.

Pour reproduire une fréquence donnée, le taux d’échantillonnage doit être au moins deux fois supérieur à cette fréquence. Par exemple, les CD
utilisent un taux d’échantillonnage de 44 100 échantillons par seconde afin de pouvoir reproduire les fréquences jusqu’à 22 050 Hz, un niveau
légèrement supérieur à la limite de fréquence perceptible à l’oreille humaine (20 000 Hz).

Vous trouverez ci-dessous les taux d’échantillonnage les plus courants applicables au son numérique :
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Taux d’échantillonnage Niveau de qualité Plage de fréquences

11 025 Hz Faible qualité radio AM (multimédia bas
de gamme)

0-5 512 Hz

22 050 Hz Comparable à la qualité radio FM
(multimédia haut de gamme)

0-11 025 Hz

32 000 Hz Meilleur que la qualité radio FM (taux de
diffusion standard)

0-16 000 Hz

44 100 Hz CD 0-22 050 Hz

48 000 Hz DVD standard 0-24 000 Hz

96 000 Hz DVD Blu-ray 0-48 000 Hz

Compréhension de la résolution
La résolution détermine la gamme dynamique. Lorsqu’une onde sonore est échantillonnée, chaque échantillon se voit attribuer la valeur
d’amplitude la plus proche de l’amplitude de l’onde d’origine. Plus la résolution est élevée, plus le nombre de valeurs d’amplitude possibles est
important, ce qui augmente la plage dynamique et la fidélité tout en réduisant le bruit de fond.

Pour obtenir une qualité audio optimale, Audition transforme tous les fichiers audio en mode 32 bits et les convertit ensuite en une profondeur
de bits spécifique lors de l’enregistrement de fichiers.

Résolution Niveau de qualité Valeurs d’amplitude Plage dynamique

8 bits Téléphonie 256 48 dB

16 bits CD audio 65 536 96 dB

24 bits DVD audio 16 777 216 144 dB

32 bits Optimale 4 294 967 296 192 dB

Plus la résolution en bits est élevée, plus la plage dynamique est grande.

Mesure de l’amplitude en dBFS
Dans les fichiers audio numériques, l’amplitude est mesurée en décibels au-dessous d’une échelle intégrale ou dBFS (decibels below full scale).
L’amplitude maximale possible est égale à 0 dBFS, toutes les amplitudes inférieures à ce niveau étant exprimées par des nombres négatifs.

Remarque : une valeur dBFS donnée ne correspond pas directement au niveau de pression du son d’origine mesuré en dB acoustiques.

Contenu et taille des fichiers audio
Un fichier audio sur disque dur, tel un fichier WAV, est constitué d’un petit en-tête indiquant le taux d’échantillonnage et la résolution en bits, puis
d’une longue série de nombres, un pour chaque échantillon. Ces fichiers peuvent être très volumineux. Par exemple, à raison de 44 100
échantillons par seconde et de 16 bits par échantillon, un fichier mono nécessite un espace de 86 Ko par seconde, soit environ 5 Mo par minute.
Ce chiffre double à 10 Mo par minute pour un fichier stéréo, qui contient deux canaux.



 

Haut de la pageNumérisation du son par Adobe Audition
Lorsque vous enregistrez des données audio dans Adobe Audition, la carte son commence le processus d’enregistrement et spécifie le taux
d’échantillonnage et la profondeur de bit (résolution). Via les ports d’entrée de ligne ou de microphone, la carte son reçoit des données audio
analogiques qu’elle convertit en données numériques à un taux d’échantillonnage donné. Adobe Audition stocke les échantillons dans l’ordre
jusqu’à ce que vous interrompiez l’enregistrement.

Lorsque vous lisez un fichier dans Adobe Audition, ce processus se déroule en sens inverse. Adobe Audition envoie une série d’échantillons
numériques à la carte son. La carte reconstitue alors la forme d’onde d’origine pour l’envoyer vers les haut-parleurs en tant que signal analogique
via les ports de sortie de ligne.

En résumé, le processus de numérisation de données audio commence par une onde de pression dans l’air. Un micro convertit cette onde en
variations de tension. Ensuite, une carte son convertit ces variations de tension en échantillons numériques. Adobe Audition peut alors enregistrer,
modifier et mélanger ces données audio numériques. Les possibilités sont illimitées. Il vous suffit de donner libre cours à votre imagination.

  |  
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Ondes sonores
Le son commence par des vibrations dans l’air, telles celles produites par les cordes d’une guitare, les cordes vocales ou les haut-parleurs. Ces
vibrations font s’entrechoquer les molécules d’air voisines, ce qui augmente légèrement la pression de l’air. Les molécules d’air sous pression
repoussent alors les molécules d’air avoisinantes, qui repoussent à leur tour l’ensemble de molécules suivant, et ainsi de suite. Lorsqu’elles se
déplacent dans l’air, les zones de haute pression laissent derrière elles des zones de basse pression. Lorsque les ondes créées par ces variations
de pression nous parviennent finalement, elles font vibrer les récepteurs de nos oreilles et ces vibrations prennent la forme d’un son.

Une forme d’onde visuelle représentant un son illustre ces ondes de pression d’air. La ligne zéro de la forme d’onde est la pression de l’air au
repos. Lorsque la ligne oscille à un niveau maximum, elle représente une pression supérieure ; lorsqu’elle oscille dans un creux, elle représente
une pression plus basse.

Onde sonore représentée par une forme d’onde visuelle :
A.  Ligne zéro B.  Zone de basse pression C.  Zone de haute pression

Mesures de forme d’onde
Plusieurs mesures décrivent les formes d’onde :

Amplitude Reflète le changement de pression entre le pic (crête) et le creux de la forme d’onde. Les formes d’onde de grande amplitude
correspondent à un son fort ; les formes d’onde de petite amplitude correspondent à un son faible.
Cycle Décrit une séquence répétée de variations de pression, de la pression zéro à une haute pression, puis à une basse pression et enfin à la
pression zéro.
Fréquence Mesurée en hertz (Hz), elle indique le nombre de cycles par seconde. (Par exemple, une forme d’onde de 1 000 Hz présente 1 000
cycles par seconde.) Plus la fréquence est élevée, plus la hauteur musicale est élevée.
Phase Mesurée en 360 degrés, elle indique la position d’une forme d’onde dans un cycle. Le degré zéro correspond au point de départ, suivi de
90° (haute pression), 180° (milieu), 270° (basse pression) et 360° (point final).
Longueur d’onde Mesurée en centimètres ou en pouces, elle indique la distance entre deux points présentant le même degré de phase. Plus la
fréquence augmente, plus la longueur diminue.

Un cycle unique à gauche ; une forme d’onde de 20 Hz complète à droite
A.  Longueur d’onde B.  Degré de phase C.  Amplitude D.  Une seconde

Méthodes d’interaction des ondes sonores



 

Lorsque plusieurs ondes sonores se rencontrent, elles s’additionnent et se soustraient les unes aux autres. Si leurs pics et leurs creux sont
parfaitement en phase, elles se renforcent pour générer une forme d’onde de plus grande amplitude.

Les ondes en phase se renforcent.

Si les pics et les creux de deux formes d’onde sont parfaitement hors phase (ou déphasés), elles s’annulent et elles disparaissent.

Les ondes hors phase s’annulent.

Toutefois, dans la plupart des cas, les ondes sont déphasées dans des degrés divers, ce qui entraîne une forme d’onde combinée plus complexe
que chaque forme d’onde individuelle. Une forme d’onde complexe qui représente de la musique, une voix, un bruit ou un autre son, par exemple,
regroupe les formes d’onde de chaque son.

En raison de sa structure physique unique, un même instrument peut créer des ondes extrêmement complexes. C’est la raison pour laquelle un
violon et une trompette émettent un son différent pour une même note.

Il est possible de combiner deux ondes simples pour créer une onde complexe.

  |  
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Viewing, zooming, and navigating audio
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Comparing the Waveform and Multitrack editors
Zoom audio in the Editor panel
Navigate through time

Comparing the Waveform and Multitrack editors
Adobe Audition provides different views for editing audio files and creating multitrack mixes. To edit individual files, use the Waveform Editor. To
mix multiple files and integrate them with video, use the Multitrack Editor.

The Waveform and Multitrack editors use different editing methods, and each has unique advantages. The Waveform Editor uses a destructive
method, which changes audio data, permanently altering saved files. Such permanent changes are preferable when converting sample rate and bit
depth, mastering, or batch processing. The Multitrack Editor uses a nondestructive method, which is impermanent and instantaneous, requiring
more processing power, but increasing flexibility. This flexibility is preferable when gradually building and reevaluating a multilayered musical
composition or video soundtrack.

You can combine destructive and nondestructive editing to suit the needs of a project. If a multitrack clip requires destructive editing, for example,
simply double-click it to enter the Waveform Editor. Likewise, if an edited waveform contains recent changes that you dislike, use the Undo
command to revert to previous states—destructive edits aren’t applied until you save a file.

For more information about the Waveform Editor, see Editing audio files; for more information about the Multitrack Editor, see Mixing multitrack
sessions.

Basic components of the editors
Though available options differ in the Waveform and Multitrack editors, both views share basic components, such as the tool and status bars, and
the Editor panel.

Basic components of Waveform and Multitrack editors (Waveform shown) 
A. View buttons and toolbar B. Editor panel with zoom navigator at top C. Various other panels D. Status bar 

Switch editors
Do one of the following:

From the View menu, choose Waveform or Multitrack Editor.

In the toolbar, click the Waveform  or Multitrack Editor  button.

In the Multitrack Editor, double-click an audio clip to open it in the Waveform Editor. Alternatively, double-click a file in the
Files panel.

In the Waveform Editor, choose Edit > Edit Original to open the multitrack session that created a mixdown file. (This
command requires embedded metadata in the file. See Embed edit-original data in exported mixdown files.)
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Zoom audio in the Editor panel

To zoom into a specific time range, right-click and drag. 
A. Zoom navigator B. Timeline ruler 

Zoom into a specific time range

In either the zoom navigator or the timeline ruler, right-click and drag. The magnifying glass icon  creates a selection showing the range that will
fill the Editor panel.

Zoom into a specific frequency range

In the vertical ruler for the spectral display, right-click and drag. (See View audio waveforms and spectrums.)

Extend or shorten the displayed range

Place the pointer over the left or right edge of the highlighted area in the zoom navigator, and then drag the magnifying glass icon .

Gradually zoom in or out

In the lower right of the Editor panel, click the Zoom In  or Zoom Out  button.

You can set the Zoom Factor in the General section of the Preferences dialog box. (See Customize preferences.)

Zoom with the mouse wheel or Mac trackpad

Place the pointer over the zoom navigator or ruler, and either roll the wheel or drag up or down with two fingers. (In the Waveform Editor, this
zoom method also works when the pointer is over the waveform.)

Roll or drag over the spectral display, and press Shift to switch between logarithmic and linear frequency scales. (Logarithmic better reflects
human hearing; linear makes individual frequencies more visually distinct.)

Magnify selected audio

In the lower right of the Editor panel, click the Zoom In At In Point , Zoom In At Out Point , or Zoom To Selection  buttons.

Display the entire audio file or multitrack session

In the lower right of the Editor panel, click the Zoom Out Full button .

To display zoom buttons in a separate panel, choose Window > Zoom.

Navigate through time
At higher zoom levels, you can navigate to different audio content in the Editor panel.

Navigate by scrolling

Scrolling with the zoom navigator

In the zoom navigator, drag left or right.

To scroll through audio frequencies in the spectral display, drag up or down in the vertical ruler. (See View audio waveforms
and spectrums.)

Navigate with the Selection/View panel
The Selection/View panel shows the start and end of the current selection and view in the Editor panel. The panel displays this information in the
current time format, such as Decimal or Bars And Beats. (See Change the time display format.)

1. To display the Selection/View panel, choose Window > Selection/View Controls.
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2. (Optional) Enter new values into the Begin, End, or Duration boxes to change the selection or view.

Dock, group, or float panels
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Configuration des entrées et sorties audio
Application de paramètres matériels spécifiques pour les utilisateurs du réseau (Audition CS6)
Attribution de canaux de fichier aux entrées et aux sorties

Adobe Audition vous permet d’utiliser un large éventail d’entrées et de sorties matérielles. Les entrées d’une carte son vous permettent de faire
entrer des données audio de sources telles que des microphones, des magnétophones et des appareils à effets numériques, tandis que les
sorties permettent de contrôler les données audio par l’intermédiaire de sources telles que des haut-parleurs et un casque.

A.  Les entrées d’une carte son sont reliées à des sources telles qu’un
microphone ou un magnétophone. B.  Les sorties d’une carte son sont reliées à des haut-parleurs ou à un casque.

Configuration des entrées et sorties audio
Lorsque vous configurez les entrées et les sorties pour l’enregistrement et la lecture, Adobe Audition peut utiliser les types de pilotes de carte son
suivants :

Sous Windows, les pilotes ASIO prennent en charge les cartes professionnelles, tandis que les pilotes MME prennent
généralement en charge les cartes standard.

Sur Mac OS, les pilotes CoreAudio prennent en charge les cartes professionnelles et standard.

Les pilotes ASIO et CoreAudio sont recommandés car ils permettent d’obtenir de meilleures performances et une latence inférieure. Ils vous
permettent également de contrôler les données audio lors de leur enregistrement et d’entendre directement les modifications apportées au volume,
au panoramique et aux effets lors de la lecture.

1. Sélectionnez la commande Edition > Préférences > Matériel audio (Windows) ou Audition > Préférences > Matériel audio
(Mac OS).

2. Dans le menu Catégorie de périphérique, sélectionnez le pilote pour la carte son à utiliser.
3. Sélectionnez une entrée et une sortie par défaut pour la carte.

Dans l’éditeur de multipiste, vous pouvez remplacer les valeurs par défaut de pistes spécifiques (voir la section Affectation
d’entrées et de sorties audio aux pistes).

4. (MME et CoreAudio) Pour Horloge principale, sélectionnez l’entrée ou la sortie avec laquelle synchroniser un autre matériel
audio numérique (en s’assurant de l’alignement correct des échantillons).

5. Pour les options Taille du tampon d’E/S (ASIO et CoreAudio) ou Latence (MME), spécifiez le paramètre le plus bas possible
sans perte de données audio. Le paramètre idéal dépend de la vitesse de votre système. Quelques essais peuvent s’avérer
nécessaires.

6. Sélectionnez un taux d’échantillonnage pour le matériel audio (pour connaître les taux couramment utilisés pour différents
supports de sortie, voir la section Compréhension du taux d’échantillonnage).

7. (Facultatif) Pour optimiser les performances des cartes ASIO et CoreAudio, cliquez sur Réglages. Pour plus de détails,
consultez la documentation accompagnant la carte son.

Remarque : par défaut, Adobe Audition commande les cartes son ASIO lors de la lecture ou du contrôle de données audio. Si vous souhaitez
accéder à la carte à partir d’une autre application, sélectionnez l’option Libérer le pilote ASIO en arrière-plan (Audition contrôle toujours la carte
pendant l’enregistrement afin d’éviter que les enregistrements ne s’arrêtent soudainement).

Application de paramètres matériels spécifiques pour les utilisateurs du réseau
(Audition CS6)
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Dans des environnements de réseau, les préférences d’Audition sont stockées avec chaque compte d’utilisateur. De cette façon, chaque utilisateur
bénéficie d’une expérience personnalisée pour le montage, l’interface et autres préférences. Toutefois, les préférences du matériel audio doivent
normalement rester cohérentes sur un même périphérique, afin que les entrées et les sorties sur l’interface audio installée soient disponibles dans
Audition.

1. Sélectionnez la commande Edition > Préférences > Matériel audio (Windows) ou Audition > Préférences > Matériel audio
(Mac OS).

2. Au bas des Réglages du matériel audio, sélectionnez l’option Utiliser les valeurs par défaut du périphérique (désélectionnez
cette option uniquement si les utilisateurs déplacent une interface audio affectée d’un périphérique à un autre).

Si vous souhaitez plutôt copier les réglages matériels d’une machine sur une autre, recherchez et copiez le fichier MachineSpecificSettings.xml.

Attribution de canaux de fichier aux entrées et aux sorties
1. Sélectionnez Edition > Préférences > Mappage du canal audio (Windows) ou Audition > Préférences > Mappage du canal

audio (Mac OS).

2. A l’extrémité droite des éléments dans les listes Entrée et Sortie, cliquez sur les triangles pour sélectionner un port matériel
pour chaque canal de fichier.

Cette procédure définit également les sorties par défaut pour la piste principale dans l’éditeur de multipiste. Pour remplacer les valeurs par
défaut, consultez la section Affectation d’entrées et de sorties audio aux pistes.

Voir aussi

  |  
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Personnalisation des préférences
Restaurez les préférences aux valeurs de paramètre par défaut.
Exportation et importation de paramètres d’application personnalisés

Personnalisation des préférences
Dans la boîte de dialogue Préférences, vous pouvez personnaliser l’affichage d’Adobe Audition, le comportement de montage, l’utilisation de
l’espace disque, ainsi que d’autres paramètres.

 Sélectionnez Edition > Préférences (Windows) ou Audition > Préférences (Mac OS). Sélectionnez ensuite la section à personnaliser.

Pour plus d’informations sur une option donnée, passez la souris au-dessus jusqu’à ce qu’une info-bulle s’affiche.

Dans les préférences Cache de média et de disque, sélectionnez le lecteur le plus rapide pour le dossier Temporaire principal, puis un autre
lecteur pour le dossier Temporaire secondaire. Sélectionnez Enregistrer les fichiers .pk pour stocker les informations sur la manière d’afficher
les fichiers WAV (sans fichiers .pk, les fichiers WAV plus volumineux se rouvrent plus lentement).

Restaurez les préférences aux valeurs de paramètre par défaut.
Un comportement inattendu peut indiquer des fichiers de préférences altérés. Pour recréer des fichiers de préférences, procédez comme suit.

 Maintenez la touche Maj enfoncée, puis démarrez Adobe Audition.

Exportation et importation de paramètres d’application personnalisés
Les fichiers des paramètres d’application stockent tous les paramètres d’effet, les espaces de travail et les préférences en cours. Exportez et
importez ces fichiers pour stocker des groupes de paramètres personnalisés pour des flux de production spécifiques, ou transférez les paramètres
favoris vers un autre ordinateur.

1. Sélectionnez Fichier > Exporter > Paramètres de l’application. Définissez ensuite un nom de fichier et un emplacement.

2. Pour réappliquer les paramètres ultérieurement, sélectionnez Fichier > Importer > Paramètres de l’application.

Pour importer les préférences à partir d’Audition 2.0 ou 3.0, recherchez sur le système le fichier audition_settings.xml. Vous pouvez importer ce
fichier pour les versions Mac et Windows d’Audition CS.

Voir aussi
Utilisation des marqueurs

Personnalisation de l’affichage spectral

Modification du format d’affichage du temps

Navigation temporelle et lecture audio
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A propos des espaces de travail
Sélection d'un espace de travail
Ancrage, regroupement ou déplacement de panneaux
Redimensionnement des groupes de panneaux
Ouverture, fermeture et défilement des panneaux
Utilisation de plusieurs moniteurs
Affichage de la barre d’outils
Affichage de la barre d’état
Modification des couleurs, de la luminosité et des performances de l’interface
Enregistrement, réinitialisation ou suppression d’un espace de travail

A propos des espaces de travail
Les applications audio et vidéo Adobe offrent un espace de travail cohérent et personnalisable. Bien que chaque application possède son propre
ensemble de panneaux (Projet, Métadonnées et Montage par exemple), la façon de déplacer et de regrouper les panneaux est la même pour tous
les produits.

La fenêtre principale d’un programme est appelée fenêtre d’application. Les panneaux de cette fenêtre sont organisés dans ce que l’on appelle
l’espace de travail. L’espace de travail par défaut comprend des groupes de panneaux de même que des panneaux isolés.

Personnaliser un espace de travail signifie disposer les panneaux de la manière la mieux adaptée à votre style de travail. Lorsque vous
réorganisez des panneaux, les autres panneaux sont automatiquement redimensionnés pour correspondre à la fenêtre. Vous pouvez créer et
enregistrer plusieurs espaces de travail personnalisés pour différentes tâches. Par exemple, un pour les modifications et un pour les aperçus.

Vous pouvez utiliser des fenêtres flottantes pour créer un espace de travail proche de ceux des versions précédentes des applications Adobe
ou pour placer des panneaux sur plusieurs moniteurs.

Exemple d’espace de travail
A.  Fenêtre d’application B.  Panneaux groupés C.  Panneau individuel

Sélection d'un espace de travail
Chaque application vidéo et audio Adobe inclut des espaces de travail prédéfinis qui optimisent la présentation de panneaux pour des tâches
spécifiques. Lorsque vous choisissez l’un de ces espaces de travail ou tout espace de travail personnalisé que vous avez enregistré, l’espace de
travail actuel est redéfini en conséquence.

 Ouvrez le projet sur lequel vous souhaitez travailler, choisissez la commande Fenêtre > Espace de travail, puis sélectionnez l’espace de travail
de votre choix.
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Vous pouvez ancrer un panneau à d’autres panneaux, ajouter un panneau à un groupe ou retirer un panneau d’un groupe et annuler l’ancrage
d’un panneau pour pouvoir le déplacer librement dans la fenêtre de l’application. Lorsque vous faites glisser un panneau, les zones de largage sur
lesquelles vous pouvez le déplacer sont mises en surbrillance. La zone de largage que vous choisissez détermine l’endroit où le panneau sera
inséré et s’il sera ancré ou regroupé avec d’autres panneaux.

Zones d’ancrage
Les zones d’ancrage se trouvent le long d’un panneau, d’un groupe ou d’une fenêtre. Si vous ancrez un panneau, il devient adjacent au groupe
existant et tous les groupes sont redimensionnés pour recevoir le nouveau panneau.

Déplacement d’un panneau (A) vers une zone d’ancrage (B) pour l’ancrer (C)

Zones de regroupement
Les zones de regroupement se trouvent au milieu d’un panneau ou d’un groupe et le long de l’onglet des panneaux. La dépose d'un panneau sur
une zone de regroupement permet de l'empiler avec d'autres.

Déplacement d’un panneau (A) vers une zone de regroupement (B) pour le regrouper avec les panneaux existants (C)

Ancrage ou regroupement de panneaux

1. Si le panneau que vous souhaitez ancrer ou regrouper avec d’autres n’est pas visible, sélectionnez-le dans le menu Fenêtre.

2. Effectuez l’une des opérations suivantes :

Pour déplacer un panneau individuel, faites glisser la zone de prise dans le coin supérieur gauche de l’onglet d’un
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panneau vers la zone de largage souhaitée.

Utilisation de la prise d’un panneau pour déplacer un panneau

Pour déplacer tout un groupe, faites glisser la prise du groupe dans le coin supérieur gauche sur la zone de largage
désirée.

Utilisation de la prise de groupe pour déplacer tout le groupe

L’application ancre ou regroupe le panneau selon le type de zone de largage.

Annulation de l’ancrage d’un panneau dans une fenêtre flottante
Lorsque vous annulez l’ancrage d’un panneau dans une fenêtre flottante, vous pouvez ajouter des panneaux à la fenêtre et la modifier en
procédant comme pour la fenêtre d’application. Vous pouvez utiliser des fenêtres flottantes afin de vous servir d'un second moniteur ou de créer
des espaces de travail semblables à ceux que proposaient les versions précédentes des applications Adobe.

 Sélectionnez le panneau dont vous souhaitez annuler l’ancrage (s’il n’est pas visible, choisissez-le dans le menu Fenêtre), puis effectuez l’une
des opérations suivantes :

Choisissez l’option Désancrer le panneau ou Désancrer l’image dans le menu du panneau. L’option Sortir cadre annule
l’ancrage du groupe de panneaux.

Cliquez sur le panneau ou le groupe en maintenant la touche Ctrl (Windows®) ou Commande (Mac OS®) enfoncée et faites-le
glisser à partir de son emplacement actuel. Lorsque vous relâchez le bouton de la souris, le panneau ou le groupe apparaît
dans une nouvelle fenêtre flottante.

Faites glisser le panneau ou le groupe hors de la fenêtre d’application. (Si la fenêtre d’application occupe toute la surface de
l’écran, faites glisser le panneau vers la barre des tâches Windows.)

Redimensionnement des groupes de panneaux
Lorsque vous positionnez le pointeur sur des diviseurs entre des groupes de panneaux, des icônes de redimensionnement apparaissent. Lorsque
vous faites glisser ces icônes, tous les groupes qui partagent le diviseur sont redimensionnés. Par exemple, votre espace de travail contient trois
groupes de panneaux empilés verticalement. Si vous faites glisser la séparation entre les deux derniers groupes, ils sont redimensionnés mais le
groupe le plus haut ne change pas.

Pour agrandir un panneau sous le pointeur, appuyez sur la touche accent. (N’appuyez pas sur la touche Maj.) Appuyez de nouveau sur la
touche accent pour que le panneau retrouve sa taille d’origine.

1. Effectuez l’une des opérations suivantes :
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Pour effectuer un redimensionnement horizontal ou vertical, positionnez le pointeur entre deux groupes de panneaux. Le
pointeur prend la forme d’une double flèche .

Pour commander simultanément un redimensionnement dans les deux directions, positionnez le pointeur sur l’intersection

entre trois groupes de panneaux ou plus. Le pointeur prend la forme d'une quadruple flèche .

2. Maintenez le bouton de la souris enfoncé et faites glisser la quadruple flèche pour redimensionner les groupes de panneaux.

Déplacement de la séparation entre des groupes de panneaux pour un redimensionnement horizontal
A.  Groupe original avec icône de redimensionnement B.  Groupes redimensionnés

Ouverture, fermeture et défilement des panneaux
Lorsque vous fermez un groupe de panneaux dans la fenêtre d'application, les autres groupes sont redimensionnés afin d'utiliser le nouvel espace
disponible. Lorsque vous fermez une fenêtre flottante, les panneaux qu’elle comprend se ferment également.

Pour ouvrir ou fermer un panneau, choisissez-le dans le menu Fenêtre.
Pour fermer un panneau ou une fenêtre, cliquez sur son bouton de fermeture .
Pour afficher tous les onglets de panneaux inclus dans un groupe de panneaux étroit, faites glisser la barre de défilement.
Pour mettre un panneau au premier plan d'un groupe de panneaux, procédez de l'une des manières suivantes :

Cliquez sur l’onglet du panneau que vous souhaitez afficher au premier plan.

Déplacez le curseur sur la zone de l’onglet, puis actionnez la molette de la souris. La molette de la souris permet d’afficher
au premier plan les différents panneaux, l’un après l’autre.

Faites glisser les onglets pour changer leur ordre.

Pour afficher les panneaux cachés dans un groupe de panneaux étroit, faites glisser la barre de défilement sur le groupe de
panneaux.

Faites glisser la barre de défilement horizontale pour afficher tous les panneaux d'un groupe étroit.

Utilisation de plusieurs moniteurs
Vous pouvez utiliser plusieurs moniteurs afin d’augmenter la surface d’écran disponible. Lorsque vous utilisez plusieurs moniteurs, la fenêtre
d’application s’affiche sur l’un de ces moniteurs et vous pouvez placer les fenêtres flottantes sur le second moniteur. Les configurations des
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moniteurs sont stockées dans l’espace de travail.

Affichage de la barre d’outils
La barre d’outils vous permet d’accéder rapidement aux outils, au menu Espace de travail et aux boutons de basculement entre les éditeurs de
forme d’onde et de multipiste. Certains outils sont spécifiques à chaque vue. De même, certains outils de l’éditeur de forme d’onde sont
uniquement disponibles dans l’affichage spectral.

Par défaut, la barre d’outils est ancrée directement sous la barre de menus. Vous pouvez toutefois désancrer la barre d’outils et la convertir en
panneau Outils, que vous pourrez alors utiliser comme tout autre panneau.

Pour afficher ou masquer la barre d’outils, choisissez Fenêtre > Outils. Une coche située en regard de la commande Outils
signifie qu’elle est affichée.
Pour désancrer la barre d’outils de son emplacement par défaut, faites glisser sa poignée (extrême gauche) vers un autre
emplacement de l’espace de travail.
Pour réancrer le panneau Outils à son emplacement par défaut, faites glisser l’onglet du panneau vers la zone de dépose qui
s’étend sur toute la largeur de la fenêtre Adobe Audition, juste en dessous de la barre de menus.

Les outils disponibles varient en fonction de chaque vue.
A.  Outils de l’éditeur de forme d’onde pour l’affichage spectral B.  Outils de l’éditeur de multipiste

Affichage de la barre d’état
La barre d’état est située dans le bas de l’espace de travail Adobe Audition. L’extrémité gauche de la barre d’état indique le temps requis pour
ouvrir, enregistrer ou traiter un fichier, ainsi que l’état du transfert en cours (lecture, enregistrement ou arrêté). L’extrémité droite de la barre affiche
diverses informations que vous pouvez personnaliser.

Barre d’état
A.  Temps requis pour ouvrir, enregistrer ou traiter un fichier B.  Fréquence d’images vidéo C.  Etat du fichier D.  Type d’échantillonnage E.
Taille non compressée de l’audio F.  Durée G.  Espace libre H.  Détecter les échantillons perdus

Pour afficher ou masquer la barre d’état, choisissez Affichage > Barre d’état > Afficher. Une coche indique que la barre d’état
est visible.
Pour modifier les informations affichées à l’extrémité droite de la barre, sélectionnez Affichage > Barre d’état, puis cliquez avec
le bouton droit sur la barre. Sélectionnez ensuite l’une des options suivantes :
Fréquence d’images vidéo Affiche la fréquence d’images cible et actuelle des fichiers vidéo ouverts dans l’éditeur de
multipiste.

Etat du fichier Indique quand survient le traitement pour les effets et les réglages d’amplitude.

Type d’échantillonnage Affiche des informations d’échantillon sur la forme d’onde (éditeur de forme d’onde) ou la session
(éditeur de multipiste) ouverte. Par exemple, un fichier stéréo de 16 bits à 44 100 kHz est présenté sous la forme 44100 Hz •
16 bits • Stéréo.

Taille non compressée de l’audio Indique quelle serait la taille du fichier audio actif s’il était enregistré dans un format non
compressé (WAV ou AIFF, par exemple) ou bien la taille totale d’une session multipiste.

Durée Affiche la longueur de la forme d’onde ou de la session en cours. Par exemple, 0:01:247 signifie que la forme d’onde ou
la session a une longueur de 1,247 seconde.

Espace libre Affiche l’espace disponible sur le disque dur.

Espace disponible (temps) Affiche le temps restant pour l’enregistrement, d’après le taux d’échantillonnage actuellement
sélectionné. Cette valeur est affichée en minutes, secondes et millièmes de secondes. Par exemple, si vous paramétrez
Adobe Audition pour enregistrer un fichier audio mono de 8 bits à 11 025 kHz, le temps restant sera affiché sous la forme
suivante : 4399:15.527 libre. Si vous définissez les options d’enregistrement sur stéréo 16 bits à 44 100 kHz, le temps restant
passe à 680:44.736 libre.

Par défaut, les informations d'Espace disponible (temps) sont masquées. Pour les afficher, cliquez avec le bouton droit sur
la barre d'état, puis sélectionnez Espace disponible (temps) dans le menu contextuel.
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Détecter les échantillons perdus Indique qu’il manquait des échantillons durant l’enregistrement ou la lecture. Si cet
indicateur s’affiche, envisagez de réenregistrer le fichier afin d’éviter des pertes audibles.

Modification des couleurs, de la luminosité et des performances de l’interface
1. Sélectionnez Edition > Préférences > Aspect (Windows) ou Audition > Préférences > Aspect (Mac OS).

2. Ajustez les options suivantes selon les besoins, puis cliquez sur OK :
Paramètres prédéfinis Applique, enregistre ou supprime une combinaison de paramètres de couleur et de luminosité.

Couleurs Cliquez sur un nuancier pour modifier la couleur des formes d’onde, des sélections ou de l’indicateur d’instant
présent.

Luminosité Eclaircit ou assombrit les panneaux, fenêtres et boîtes de dialogue.

Utiliser des dégradés Si cette option est désélectionnée, les tons foncés et tons clairs sont supprimés des panneaux, des
boutons et des indicateurs.

Enregistrement, réinitialisation ou suppression d’un espace de travail

Enregistrement d’un espace de travail personnalisé
Lorsque vous personnalisez un espace de travail, l’application effectue un suivi de vos modifications et stocke la mise en page la plus récente.
Pour stocker une présentation spécifique de manière permanente, vous devez enregistrer un espace de travail personnalisé. Les espaces de
travail personnalisés enregistrés apparaissent dans le menu Espace de travail où vous pouvez les sélectionner et les réinitialiser.

 Organisez les images et les panneaux comme vous le souhaitez, puis choisissez la commande Fenêtre > Espace de travail > Nouvel espace de
travail. Saisissez le nom de l’espace de travail, puis cliquez sur le bouton OK.

Remarque : (After Effects, Premiere Pro, Encore) si un projet enregistré avec un espace de travail personnalisé est ouvert sur un autre système,
l’application recherche un espace de travail portant un nom correspondant. Si elle n’en trouve pas (ou si la configuration du moniteur ne
correspond pas), elle utilise l’espace de travail local actuel.

Réinitialisation d’un espace de travail
Réinitialiser l’espace de travail courant permet de revenir à la présentation de panneaux initiale qui a été enregistrée.

 Choisissez la commande Fenêtre > Espace de travail > Réinitialiser nom de l’espace de travail.

Suppression d’un espace de travail

1. Choisissez la commande Fenêtre > Espace de travail > Supprimer l’espace de travail.

2. Sélectionnez l’espace de travail à supprimer et cliquez sur le bouton OK.

Remarque : vous ne pouvez pas supprimer l’espace de travail actif.

Voir aussi
Comparaison des éditeurs de forme d’onde et de multipiste
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Importation, enregistrement et lecture de données

Il se peut qu’une partie du contenu lié depuis cette page apparaisse uniquement en anglais.
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Formats d’importation pris en charge

En haut

Remarque :

Formats d’importation de données audio
Formats d’importation de données vidéo

Autres formats d’importation vidéo dans Audition CS6

Formats d’importation des fichiers audio
Adobe Audition peut ouvrir les fichiers audio aux formats suivants :

AAC (y compris HE-AAC dans Audition CS6)
AIF, AIFF, AIFC (y compris les fichiers jusqu’à 32 canaux)

Le format AIFF se décline en plusieurs variations. Audition peut ouvrir tous les fichiers AIFF non compressés et les versions compressées les plus
courantes.

Pour afficher les métadonnées Auteur d’un fichier AIFF, utilisez le champ Dublin Core : Créateur de l’onglet XMP du panneau
Métadonnées (Voir Affichage et modification de métadonnées XMP.)

APE (Audition CS6)
AU
AVR
BWF
CAF (toutes les versions non compressées et la plupart des versions compressées)
FLAC
HTK
IFF
M4A
MAT
MPC
MP2
MP3 (y compris les fichiers surround MP3)
OGA, OGG
PAF
PCM
PVF
RAW
RF64
SD2
SDS
SF
SND
VOC
VOX
W64
WAV (y compris les fichiers comprenant jusqu’à 32 canaux)

Le format WAV se décline en plusieurs variations. Adobe Audition peut ouvrir tous les fichiers WAV non compressés et les versions compressées
les plus courantes.

WMA (activé avec la prise en charge du format DLMS dans les préférences Cache de média et de disque)
WVE
XI
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En hautFormats d’importation des fichiers vidéo
L’éditeur de forme d’onde vous permet d’ouvrir la portion audio des fichiers vidéo aux formats ci-dessous. L’éditeur de multipiste vous permet
d’insérer les mêmes types de fichier et fournit un aperçu dans le panneau Vidéo.

QuickTime doit être installé pour pouvoir accéder à ces formats vidéo. Pour importer d’autres formats, étendez la prise en charge QuickTime.
Pour plus d’informations : consultez cet article sur le site Web d’Apple.

AVI
DV
MOV (y compris les fichiers comprenant jusqu’à 32 canaux audio)
MPEG-1
MPEG-4
3GPP et 3GPP2

Autres formats d’importation vidéo dans Audition CS6
MPEG-2 (si CS6 Production Premium ou Master Collection est installé)

Pour activer les formats suivants, sélectionnez Activer la prise en charge du format DLMS dans les préférences Cache de média et de disque.
(Cette option est désactivée par défaut pour de meilleures performances.)

AVI (Windows uniquement)
FLV
R3D
SWF
WMV

Insertion d’un fichier vidéo dans une session multipiste

Exportation d’un mixage multipiste vers Adobe Premiere Pro CS5.5

http://creativecommons.org/licenses/by-nc-sa/3.0/deed.fr
http://help.adobe.com/fr_FR/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy_fr
http://www.adobe.com/go/learn_audition_qtformats_fr


Navigating time and playing audio

Note:

To the top

To the top

Pause

Monitoring time
Position the current-time indicator
Preview audio by scrubbing
Play audio linearly or in a loop
Synchronize the current-time indicator across files or views
Change the time display format

Some features in the Windows version of Adobe Audition 3.0 are not available in CS5.5. Examples include CD burning, MIDI, the
metronome, some file formats and effects, clip grouping and time stretching, and control surface support. For a complete list, see Adobe Audition
3.0 features replaced or not implemented in CS5.5.

Monitoring time
In the Editor panel, the following features help you monitor time:

In the timeline near the top of the panel, the current-time indicator  lets you start playback or recording at a specific point.

In the lower left of the panel, the time display shows the current time in numerical format. The default time format is Decimal,
but you can easily change it. (See Change the time display format.) The same format is used by the timeline.

To show the time display in separate panel, choose Window > Time.

Features that help you monitor time 
A. Current-time indicator  B. Timeline  C. Time display 

Position the current-time indicator

In the Editor panel, do any of the following:

In the timeline, drag the indicator  or click a specific time point.

In the time display at lower left, drag across the numbers, or click to enter a specific time.

At the bottom of the panel, click one of the following buttons:

To display these buttons in a separate panel, choose Window > Transport.

 Temporarily stops the current-time indicator. Click the Pause button again to resume playback or recording.
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Move CTI to Previous

Rewind

Fast Forward

Move CTI to Next

To the top

To the top

Return CTI to Start Position on Stop

Play Spectral Selection Only

Note:

To the top

 Places the current-time indicator at the beginning of the next marker. If there are no markers,
the current-time indicator moves to the beginning of the waveform or session.

 Shuttles the current-time indicator backward in time.

Right-click the Rewind button to set the rate at which the cursor moves.

 Shuttles the current-time indicator forward in time.

Right-click the Fast Forward button to set the rate at which the cursor moves.

 Moves the current-time indicator to the next marker. If there are no markers, the current-time
indicator moves to the end of the waveform or session.

Preview audio by scrubbing
To scrub audio (producing an audible preview as you shuttle across a file), do any of the following:

Drag the current-time indicator .

Press the Rewind  or Fast Forward  buttons.

Press the J, K, and L keys to shuttle backward, stop, or shuttle forward. Repeatedly pressing the J or L key gradually increases
shuttle speed. (To change the default, set JKL Shuttle Speed in the Playback preferences.)

Play audio linearly or in a loop
To quickly start and stop playback, press the spacebar.

1. In the Editor panel, position the current-time indicator, or select a range.

2. (Optional) At the bottom of the panel, right-click the Play button , and select one of the following:

Reflects the behavior of Audition 3.0 and earlier. (Press Shift+X to toggle this option
on and off.)

Plays only frequencies you’ve selected with the Marquee , Lasso , or Paintbrush

Selection  tool.

3. (Optional) Click the Loop Playback button  if you want to fine-tune a selected range or experiment with different effects
processing.

4. To start playback, click the Play button.

By default, the Editor panel scrolls when playback extends beyond the visible section of a waveform. In the Playback area of the
Preferences dialog box, you can disable auto-scrolling.

Synchronize the current-time indicator across files or views

In the Waveform Editor, you can maintain the position of the current-time indicator when you switch between files—a useful technique when editing
different versions of the same waveform. In the Multitrack Editor, you can maintain the position of the current-time indicator when you switch to the
Waveform Editor—a useful technique when applying edits and effects in both views.

Synchronize the current-time indicator between files in the Waveform Editor

1. Choose Edit > Preferences > General (Windows) or Adobe Audition Preferences > General (Mac OS).
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Decimal (mm:ss.ddd)

Compact Disc 75 fps

SMPTE 30 fps

SMPTE Drop (29.97 fps)

SMPTE 29.97 fps

SMPTE 25 fps (EBU)

SMPTE 24 fps (Film)

Samples

Bars and Beats

Custom (X frames per second)

2. Select Synchronize Selection, Zoom Level, and CTI Across Files In The Waveform Editor.

Synchronize the current-time indicator between the Multitrack and Waveform Editors

1. Choose Edit > Preferences > Multitrack (Windows) or Adobe Audition Preferences > Multitrack (Mac OS).

2. Select Synchronize Clips With Waveform Editor.

Change the time display format
By default, all audio files and multitrack sessions use the same time display format. To customize the format for an open file or session, choose
Window > Properties, expand the Advanced settings, and deselect Synchronize With Time Display Preferences.

Choose View > Display Time Format, and choose the desired option:

Displays time in minutes, seconds, and thousandths of a second.

Displays time in the same format used by audio compact discs, where each second equals 75 frames.

Displays time in the SMPTE format, where each second equals 30 frames.

Displays time in the SMPTE drop-frame format, where each second equals 29.97 frames.

Displays time in the SMPTE non-drop-frame format, where each second equals 29.97 frames.

Displays time using the European PAL television frame rate, where each second equals 25 frames.

Displays time in a format where each second equals 24 frames, suitable for film.

Displays time numerically, using as a reference the actual number of samples that have passed since the beginning
of the edited file.

Displays time in a musical measures format of bars:beats:subdivisions. To customize settings, choose Edit
Tempo, and set the following options in the Properties panel:

Tempo

Specifies beats per minute.

Time Signature

Specifies the number of beats per measure, and the note that represents full beats. For example, with a signature of 3/8, there
are three notes per measure, and eighth-notes represent full beats.

Subdivisions

Specifies the number of sections each beat is divided into, or the value after the decimal point. For example, if you enter 32
subdivisions per beat, a time setting of 4:2:16 represents an eighth note halfway between beats 2 and 3 in 4/4 time.

Displays time in a custom format. To modify a custom format, choose Edit Custom Frame
Rate, and enter a number of frames per second. Valid values are whole numbers from 2 to 1000.

Customize start offset and time display for multitrack sessions
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Importing with the Files panel
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Import files into the Files panel
Insert from the Files panel into a multitrack session
Change displayed metadata in the Files panel

The Files panel displays a list of open audio and video files for easy access.

Double-click an empty area of the file list to quickly access the Open File dialog box.

Import files into the Files panel
Import files into the Files panel if you want to retain the currently open file in the Editor panel. This technique is particularly helpful when
assembling files for a multitrack session.

1. Do either of the following:

In the Files panel, click the Import File button .

Choose File > Import > File.

2. Select an audio or video file. (See Supported import formats.)

Insert from the Files panel into a multitrack session
1. In the Files panel, select the files you want to insert.

To select multiple adjacent files, click the first file in the desired range, and then Shift-click the last. To select nonadjacent
files, Ctrl-click (Windows) or Command-click (Mac OS).

2. At the top of the Files panel, click the Insert Into Multitrack button . Then choose either New Multitrack Session (see
Create a new multitrack session) or an open session.

The files are inserted on separate tracks at the current time position.

Change displayed metadata in the Files panel
1. In the upper right of the Files panel, click the menu icon , and choose Metadata Display.
2. Select the metadata you want to display, and click OK
3. To move metadata columns left or right, drag column headers such as Name or Duration.

To change the sort order of files, click column headers.
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Remarque :

Extraction des pistes de CD à l’aide de la commande Extraire audio du CD
Configuration des informations de piste et des bases de données de CD (Audition CS6)

Extraction de pistes de CD à l’aide de la commande Ouvrir (Mac OS)

Extraction des pistes de CD à l’aide de la commande Extraire audio du CD
La commande Extraire audio du CD est plus rapide et permet un plus grand contrôle, et offre notamment la capacité d’optimiser la vitesse du
lecteur et de renommer les pistes.

1. Insérez un CD audio dans le lecteur de CD-ROM de l’ordinateur.
2. Sélectionnez Fichier > Extraire audio du CD.
3. Dans la liste déroulante Lecteur, sélectionnez le lecteur qui contient le CD audio.
4. Dans la liste déroulante Vitesse, sélectionnez l’une des vitesses d’extraction prises en charge par le lecteur. L’option Débit

maximal donne généralement des résultats satisfaisants ; si des erreurs se produisent, toutefois, choisissez une vitesse plus
lente.

5. Effectuez l’une des opérations suivantes :
Pour prévisualiser une piste, cliquez sur son bouton Lecture.

Pour inclure ou exclure des pistes, cochez les cases à gauche des numéros de piste ou cliquez sur Activer/désactiver
tout.

Pour renommer une piste, double-cliquez dessus.

Configuration des informations de piste et des bases de données de CD (Audition CS6)
Au centre de la boîte de dialogue Extraire audio du CD, les informations Artiste, Album, Genre et Année sont extraites de la base de données de
CD spécifiée par défaut. Pour modifier ces entrées, effectuez l’une des opérations suivantes :

Pour personnaliser les informations, écrasez les entrées en cours.
Pour insérer des informations d’origine de la base de données, cliquez sur l’icône Récupérer les titres .
Si un message indique plusieurs enregistrements correspondants, cliquez sur les flèches pour insérer les différents
enregistrements de base de données.
Pour spécifier une autre base de données et une autre convention de dénomination des fichiers, cliquez sur l’icône Paramètres
des titres . Pour en savoir plus sur chacune des options Paramètres des titres, placez le curseur de la souris au-dessus
jusqu’à ce qu’une info-bulle s’affiche.

Remarque : si plusieurs entrées Artiste sont détectées, Audition sélectionne automatiquement l’option Compilation. Dans la boîte de dialogue
Paramètres des titres, entrez un caractère Séparateur pour les compilations afin de séparer Artiste et Titre de la piste pour chaque piste.

Extraction de pistes de CD à l’aide de la commande Ouvrir (Mac OS)
cette méthode d’extraction peut considérablement diminuer les performances d’Adobe Audition. La commande Extraire audio du CD

est généralement la meilleure méthode.

La commande Ouvrir vous permet d’extraire les pistes au format AIFF. Audition doit toutefois poursuivre la lecture des données audio issues de
CD, ce qui ralentit l’importation et le montage.

1. Insérez un CD audio dans le lecteur de CD-ROM de l’ordinateur.
2. Choisissez Fichier > Ouvrir.
3. Sélectionnez QuickTime comme type de fichier, puis naviguez jusqu’au lecteur de CD-ROM.
4. Sélectionnez les pistes à extraire et cliquez sur Ouvrir.
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Contrôle des niveaux d’enregistrement et de lecture
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Présentation des règles de niveau
Personnaliser les règles de niveau
Réglage des niveaux d’enregistrement pour les cartes son standard

Présentation des règles de niveau
Vous utilisez les règles de niveau pour contrôler l’amplitude des signaux entrants et sortants lors de l’enregistrement et de la lecture. L’éditeur de
forme d’onde fournit ces mesures uniquement dans le panneau Niveaux. Dans l’éditeur de multipiste, ces mesures sont situées dans le panneau
Niveaux, qui affiche l’amplitude de la sortie de la piste principale, ainsi que dans les règles de piste, qui affichent l’amplitude de pistes individuelles.

Vous pouvez ancrer le panneau Niveaux horizontalement ou verticalement. Lorsqu’un panneau est ancré à l’horizontale, la règle supérieure
représente le canal gauche et la règle inférieure le canal droit.

Pour afficher ou masquer le panneau , choisissez Fenêtre > Règles de niveau.

Panneau Niveaux ancré à l’horizontale
A.  Canal gauche B.  Canal droit C.  Indicateurs de crête D.  Indicateurs de clip

Les règles indiquent les niveaux de signal en dBFS (decibels Full Scale), un niveau de 0 dB correspondant à l’amplitude maximale possible avant
l’écrêtage. Les indicateurs de crête jaunes restent affichés pendant 1,5 seconde pour vous permettre de déterminer facilement l’amplitude de
crête.

Si l’amplitude est trop basse, la qualité du son est réduite. Si elle est trop élevée, il y a écrêtage et distorsion. L’indicateur d’écrêtage rouge, situé à
droite des règles, s’illumine lorsque les niveaux dépassent le plafond maximal de 0 dB.

Pour effacer les indicateurs de clip, cliquez dessus individuellement ou cliquez avec le bouton droit sur les règles, puis sélectionnez Réinitialiser
les indicateurs.

Personnaliser les règles de niveau
Cliquez avec le bouton droit sur les règles, puis sélectionnez l’une des options suivantes :

Signal de niveau d’entrée Dans l’éditeur de forme d’onde, affiche le niveau de l’entrée matérielle par défaut (voir la section Configuration des
entrées et sorties audio). Pour activer ou désactiver rapidement cette option, double-cliquez sur les règles.
Options Plage Modifie la plage de décibels affichée.
Afficher creux Affiche les indicateurs de creux aux points de faible amplitude.

Si les indicateurs de creux sont proches des indicateurs de crête, la plage dynamique (la différence entre les sons les plus légers et les plus
forts) est faible. Si les indicateurs sont très éloignés les uns des autres, la plage dynamique est élevée.

Afficher le dégradé de couleur Les règles passent graduellement du vert au jaune puis au rouge. Désélectionnez cette option pour changer
abruptement de couleur, du vert au jaune à -18 dBFS et au rouge à -6.
Afficher les indicateurs LED Affiche une barre individuelle pour chaque niveau de décibels complet.
Crêtes dynamiques ou Crêtes statiques Modifient le mode des indicateurs de crête. L’option Crêtes dynamiques réinitialise les indicateurs de
niveau de crête jaunes sur un nouveau niveau de crête au bout de 1,5 seconde, ce qui vous permet de voir directement l’amplitude de crête
récente. Plus le son devient calme, plus les indicateurs de crête sont bas. L’option Crêtes statiques conserve les indicateurs de crête, ce qui vous
permet de déterminer l’amplitude maximale du signal depuis le début du contrôle, de la lecture ou de l’enregistrement. Il est toutefois possible de
réinitialiser manuellement les indicateurs de crête en cliquant sur les indicateurs de clip.

Pour connaître le niveau sonore maximal de données audio avant de les enregistrer, sélectionnez l’option Crêtes statiques, Surveillez ensuite
les niveaux d’entrée ; les indicateurs de crête affichent le niveau de la partie la plus forte.

Réglage des niveaux d’enregistrement pour les cartes son standard
Règle les niveaux si les enregistrements sont trop silencieux (ce qui provoque du bruit indésirable) ou trop forts (ce qui provoque de la distorsion).
Pour optimiser les résultats sonores, il est conseillé d’enregistrer les données audio le plus fort possible sans produire d’écrêtage. Lors de la
définition des niveaux d’enregistrement, observez les règles et efforcez-vous de maintenir les pics d’intensité sonore la plus forte dans la plage
jaune (moins de -3 dB).



 

Adobe Audition ne contrôle pas directement les niveaux d’enregistrement d’une carte son. Pour une carte son professionnelle, vous pouvez régler
ces niveaux à l’aide de l’application de mixage fournie avec la carte (voir la documentation de la carte pour des instructions). Pour une carte
standard, vous pouvez utiliser l’application de mixage fournie par Windows ou Mac OS.

Réglage des niveaux de la carte son sous Windows 7 et Windows Vista

1. Cliquez avec le bouton droit de la souris sur l’icône de haut-parleur dans la barre des tâches et sélectionnez Périphériques
d’enregistrement.

2. Double-cliquez sur la source d’entrée que vous souhaitez utiliser.

3. Cliquez sur l’onglet Niveaux et ajustez le curseur si nécessaire.

Réglage des niveaux de la carte son sous Windows XP

1. Double-cliquez sur l’icône de haut-parleur dans la barre des tâches.

2. Choisissez Options > Propriétés.

3. Sélectionnez Enregistrement et cliquez sur OK.

4. Sélectionnez la source d’entrée à utiliser, puis réglez le curseur de volume à votre convenance.

Réglage des niveaux de la carte son sous MAC OS

1. Choisissez Préférences Système dans le menu Pomme.

2. Cliquez sur Son, puis sur l’onglet Entrée.

3. Sélectionnez le périphérique à utiliser, puis réglez le curseur du volume d’entrée à votre convenance.

  |  
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Enregistrement de données audio
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Enregistrement de l’audio dans l’éditeur de forme d’onde
Correction du décalage DC
Enregistrement direct dans un fichier dans l’éditeur de multipiste
Enregistrement de clips audio dans l’éditeur de multipiste
Introduction dans une plage sélectionnée dans l’éditeur de multipiste
Introduction lors de la lecture dans l’éditeur de multipiste
Choix des prises par introduction

Remarque : certaines fonctionnalités de la version Windows d’Adobe Audition 3.0 ne sont pas disponibles dans CS5.5, notamment
l’enregistrement chronométré, la gravure sur CD, le format MIDI, le métronome, certains effets et formats de fichier, ainsi que la prise en charge de
la surface de contrôle. Pour obtenir une liste complète, voir Fonctionnalités d’Adobe Audition 3.0 remplacées ou non implémentées dans CS5.5.

Enregistrement de l’audio dans l’éditeur de forme d’onde
Vous pouvez enregistrer des données audio à partir d’un microphone ou de n’importe quel périphérique que vous pouvez brancher dans le port
Entrée de ligne d’une carte son. Avant d’effectuer un enregistrement, vous pouvez régler le signal d’entrée afin d’optimiser les niveaux signal/bruit.
(Voir la section Réglage des niveaux d’enregistrement pour les cartes son standard ou la documentation relative à une carte professionnelle.)

1. Définissez les entrées audio (voir la section Configuration des entrées et sorties audio).
2. Effectuez l’une des opérations suivantes :

Créez un fichier.

Ouvrez un fichier existant pour remplacer ou ajouter des données audio, puis placez l’indicateur d’instant présent  là où
vous souhaitez commencer l’enregistrement.

3. Au bas du panneau Editeur, cliquez sur le bouton Enregistrer  pour lancer et arrêter l’enregistrement.

Correction du décalage DC
Certaines cartes son enregistrent avec un léger décalage de courant continu (direct current, DC). Le courant continu est introduit dans le signal,
provoquant un décalage du centre de la forme d’onde à partir du point zéro (la ligne médiane sur la représentation de la forme d’onde). Le
décalage DC peut provoquer un clic ou un pop (parasites) au début et à la fin du fichier.

 Dans l’éditeur de forme d’onde, sélectionnez Favoris > Réparer le décalage DC.
Pour mesurer le décalage DC, voir la section Analyse de l’amplitude.

Enregistrement direct dans un fichier dans l’éditeur de multipiste
Dans l’éditeur de multipiste, Adobe Audition enregistre automatiquement chaque clip enregistré directement dans un fichier WAV. Grâce à
l’enregistrement direct dans un fichier, vous pouvez enregistrer et sauvegarder plusieurs clips tout en bénéficiant d’une flexibilité exceptionnelle.

Ce dossier de session contient chaque clip enregistré dans le dossier [nom de session]_Enregistré. Le nom d’un fichier de clip commence par le
nom de la piste, suivi du numéro de prise (par exemple, Piste 1_003.wav).

Après l’enregistrement, vous pouvez modifier les prises afin de générer un mixage final impeccable. Par exemple, si vous effectuez plusieurs
prises d’un solo guitare, vous pouvez combiner les meilleurs passages de chaque solo. (Voir la section Raccord et extension de clips.) Vous
pouvez également utiliser une version du solo pour une piste sonore vidéo et une autre version pour un CD audio.

Enregistrement de clips audio dans l’éditeur de multipiste
Dans l’éditeur de multipiste, vous pouvez enregistrer des données audio sur plusieurs pistes par superposition. Lorsque vous superposez des
pistes, vous pouvez écouter les pistes déjà enregistrées et jouer dessus pour créer des compositions en couche avancées. Chaque
enregistrement devient un nouveau clip audio sur une piste.

1. Dans la section Entrées/Sorties du panneau Editeur, sélectionnez une source dans la liste d’entrées d’une piste.
Remarque : pour modifier les entrées disponibles, sélectionnez Matériel audio, puis cliquez sur Réglages.

2. Cliquez sur le bouton Préparer pour l’enregistrement  de la piste.

http://kb2.adobe.com/cps/895/cpsid_89588.html
http://helpx.adobe.com/en/audition/using/arranging-editing-multitrack-clips.html#trimming_and_extending_clips


Haut de la page

Haut de la page

Haut de la page

Les règles de la piste affichent l’entrée, afin que vous puissiez plus facilement optimiser les niveaux (pour désactiver cette
valeur par défaut et afficher les niveaux uniquement lors de l’enregistrement, désélectionnez l’option Activer le réglage en
entrée lors de la préparation des pistes dans les préférences de multipiste).

3. Pour entendre les entrées matérielles acheminées par l’intermédiaire d’émissions et d’effets de piste, cliquez sur le bouton
Surveiller l’entrée .
Remarque : le routage des entrées par l’intermédiaire des effets et émissions nécessite un traitement considérable. Pour
réduire la latence (délai audible) qui perturbe le minutage des exécutants, voir la section Configuration des entrées et sorties
audio.

4. Pour enregistrer simultanément sur plusieurs pistes, répétez les étapes 1 à 3.

5. Dans le panneau Editeur, positionnez l’indicateur d’instant présent  au point de départ souhaité ou sélectionnez une plage
pour le nouveau clip.

6. Au bas du panneau, cliquez sur le bouton Enregistrer  pour lancer et arrêter l’enregistrement.

Introduction dans une plage sélectionnée dans l’éditeur de multipiste
Si une plage temporelle d’un clip enregistré ne vous convient pas, vous pouvez sélectionner cette plage et y introduire un nouvel enregistrement,
tout en préservant le clip d’origine. Vous pouvez procéder à l’enregistrement dans une plage donnée sans effectuer d’introduction. Toutefois,
l’introduction vous permet d’entendre les données audio situées immédiatement avant et après la plage. Vous disposez ainsi d’un contexte
essentiel pour créer des transitions naturelles.

En ce qui concerne les sections particulièrement importantes ou difficiles, vous pouvez introduire plusieurs prises, puis sélectionner ou modifier
certaines prises afin d’optimiser les performances.

Prise créée par introduction

1. Dans le panneau Editeur, faites glisser l’outil de sélection temporelle  sur la piste appropriée afin de sélectionner une plage
temporelle du clip.

2. Sélectionnez l’entrée de piste appropriée (voir la section Affectation d’entrées et de sorties audio aux pistes).

3. Cliquez sur le bouton Préparer pour l’enregistrement  de la piste.

4. Positionnez l’indicateur d’instant présent  quelques secondes avant la plage sélectionnée.

5. Au bas du panneau Editeur, cliquez sur le bouton Enregistrer .

Audition lit les données audio qui précèdent la sélection, enregistre pour la durée de la plage sélectionnée, puis reprend la lecture.

Introduction lors de la lecture dans l’éditeur de multipiste
Si vous ne devez pas effectuer d’introduction dans une plage donnée, vous pouvez effectuer une introduction rapide dans une zone générale lors
de la lecture.

1. Activez une ou plusieurs pistes pour l’enregistrement. (Voir la section Enregistrement de clips audio dans l’éditeur de
multipiste.)

2. Au bas du panneau Editeur, cliquez sur le bouton Lecture .

3. Lorsque vous atteignez la zone où l’enregistrement doit commencer, cliquez sur le bouton Enregistrer . Une fois
l’enregistrement terminé, cliquez à nouveau sur ce bouton.

Choix des prises par introduction



 

Si vous introduisez plusieurs prises, Audition les superpose les unes au-dessus des autres dans le panneau Editeur. Pour choisir des prises,
procédez comme suit :

1. A l’aide de l’outil Sélection temporelle , sélectionnez une plage qui s’accroche au début et à la fin des prises par
introduction. (Voir la section Accrochage du curseur aux extrémités des clips).

2. Dans la piste, placez le pointeur de la souris sur l’en-tête du clip (l’en-tête indique le nom de la piste, suivi du numéro de
prise).

3. Faites glisser la prise la plus haute vers un autre emplacement (généralement la fin de la session afin d’éviter une lecture
indésirable).

4. Lisez la session. Si vous préférez choisir une prise déjà déplacée, refaites-la glisser vers la plage sélectionnée.

Pour couper le son du clip d’origine pour la durée de la plage par introduction, réglez l’enveloppe de volume (Voir la section Automatisation des
paramètres de clip).

Voir aussi
Création d’un fichier audio vierge

Positionnement de l’indicateur d’instant présent

  |  
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Copying, cutting, pasting, and deleting audio

Note:

To the top

To the top

To the top

Copied and Existing Audio

Invert Copied Audio

Modulate

Crossfade

To the top

Copy or cut audio data
Paste audio data
Mix audio data when pasting
Delete or crop audio

Some features in the Windows version of Adobe Audition 3.0 are not available in CS5.5. Examples include Audition-specific clipboards, CD
burning, MIDI, the metronome, some file formats and effects, and control surface support. For a complete list, see Adobe Audition 3.0 features
replaced or not implemented in CS5.5.

Copy or cut audio data
1. In the Waveform Editor, select the audio data you want to copy or cut. Or, to copy or cut the entire waveform, deselect all

audio data.
2. Choose one of the following:

Edit > Copy to copy audio data to the clipboard.

Edit > Copy To New to copy and paste the audio data into a newly created file.

Edit > Cut to remove audio data from the current waveform and copy it to the clipboard.

Paste audio data
Do either of the following:

To paste audio into the current file, place the current-time indicator  where you want to insert the audio or select existing
audio you want to replace. Then choose Edit > Paste.

To paste audio data into a new file, choose Edit > Paste To New. The new file automatically inherits the sample type (rate
and bit depth) from the original clipboard material.

Mix audio data when pasting
The Mix Paste command mixes audio data from the clipboard with the current waveform.

1. In the Editor panel, place the current-time indicator  where you want to start mixing the audio data. Alternately, select the
audio data you want to replace.

2. Choose Edit > Mix Paste.
3. Set the following options:

Adjust the percentage of each.

Reverses the phase of copied audio, either exaggerating or reducing phase cancellation if the existing
audio contains similar content. (To understand phase cancellation, see How sound waves interact.)

Modulates the amount of copied and existing audio, producing more audible variation.

Applies a crossfade to the beginning and end of the pasted audio, producing smoother transitions. Specify the
fade length in milliseconds.

Delete or crop audio
Do one of the following:

Select audio you want to delete, and choose Edit > Delete.

Select audio you want to keep, and choose Edit > Crop. (Unwanted audio at the beginning and end of the file is removed.)

Convert a waveform between surround, stereo, and mono

Channel Mixer effect
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Displaying audio in the Waveform Editor

To the top

To the top

View audio waveforms and spectrums
About the waveform display
About the spectral display
View layered or uniquely colored waveform channels
Customize the spectral display
Change the vertical scale

View audio waveforms and spectrums
In the Waveform Editor, the Editor panel provides a visual representation of sound waves. Below the panel’s default waveform display, which is
ideal for evaluating audio amplitude, you can view audio in the spectral display, which reveals audio frequency (low bass to high treble).

To view the spectral display, do either of the following:.
In the toolbar, click the Spectral Display  button.

In the Editor panel, drag the divider between the waveform and spectral displays to change the proportion of each. To
instantly show or hide the spectral display, double-click the handle or click the triangle to its right.

Viewing the waveform and spectral displays 
A. Drag the divider to change the proportion of each. B. Click the triangle to show or hide the spectral display. 

To identify specific channels in stereo and 5.1 surround files, note the indicators in the vertical ruler.

About the waveform display
The waveform display shows a waveform as a series of positive and negative peaks. The x-axis (horizontal ruler) measures time, and the y-axis
(vertical ruler) measures amplitude—the loudness of the audio signal. Quiet audio has both lower peaks and lower valleys (near the center line)
than loud audio. You can customize the waveform display by changing the vertical scale and colors.

With its clear indication of amplitude changes, the waveform display is perfect for identifying percussive changes in vocals, drums, and more. To
find a particular spoken word, for example, simply look for the peak at the first syllable and the valley after the last.

Stereo file in waveform display



To the top

To the top

To the top

Windowing Function

Spectral Resolution

About the spectral display
The spectral display shows a waveform by its frequency components, where the x-axis (horizontal ruler) measures time and the y-axis (vertical
ruler) measures frequency. This view lets you analyze audio data to see which frequencies are most prevalent. Brighter colors represent greater
amplitude components. Colors range from dark blue (low-amplitude frequencies) to bright yellow (high-amplitude frequencies).

The spectral display is perfect for removing unwanted sounds, such as coughs and other artifacts.

Spectral display, with high frequencies selected

View layered or uniquely colored waveform channels
For stereo and 5.1 surround files, you can view layered or uniquely colored channels. Layered channels better reveal overall volume changes.
Uniquely colored channels help you visually distinguish them.

Choose View > Waveform Channels, and then select Layered or Uniquely Colored.

Channel View options 
A. Uniquely Colored B. Layered (with Uniquely Colored still selected) 

Customize the spectral display
The Spectral Display preferences help you enhance different details and better isolate artifacts.

1. Choose Edit > Preferences > Spectral Display (Windows) or Audition > Preferences > Spectral Display (Mac OS).

2. Set the following options

Determines the Fast Fourier transform shape. These functions are listed in order from narrowest to
widest. Narrower functions include fewer surrounding frequencies but less precisely reflect center frequencies. Wider functions
include more surrounding frequencies but more precisely reflect center frequencies. The Hamming and Blackman options
provide excellent overall results.

Specifies the number of vertical bands used to draw frequencies. As you increase resolution, frequency
accuracy increases, but time accuracy decreases. Experiment to find the right balance for your audio content. Highly
percussive audio, for example, may be better reflected by low resolution.

To adjust resolution directly in the Editor panel, right-click the vertical ruler next to the spectral display, and choose
Increase or Decrease Spectral Resolution.
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Decibel Range

Play Only Selected Frequencies When A Spectral Selection Exists

To the top

Decibels

Percentage

Sample Values

Normalized Values

More Logarithmic or Linear

Full Logarithmic or Linear

Changes the amplitude range over which frequencies are displayed. Increasing the range intensifies colors,
helping you see more detail in quieter audio. This value simply adjusts the spectral display; it does not change audio
amplitude.

Deselect this option to hear all frequencies in the
same time range as a selection.

Change the vertical scale
In the Waveform Editor, you can change the amplitude or frequency scale of the vertical ruler.

Change the amplitude scale of the waveform display

In the waveform display, right-click the vertical ruler and select one of the following:

Indicates amplitude on a decibel scale that ranges from –Infinity to zero dBFS.

Indicates amplitude on a percentage scale that ranges from –100% to 100%.

Indicates amplitude on a scale that shows the range of data values supported by the current bit depth. (See
Understanding bit depth.) 32-bit float values reflect the normalized scale below.

Indicates amplitude on a normalized scale that ranges from –1 to 1.

Change the frequency scale of the spectral display

In the spectral display, right-click the vertical ruler and select one of the following:

Gradually displays frequencies in a more logarithmic scale (reflecting human hearing) or a more
linear scale (making high frequencies more visually distinct).

Hold down Shift and roll the mouse wheel over the spectral display to show frequencies more logarithmically (up) or linearly
(down).

Displays frequencies completely logarithmically or linearly.

Sound waves

Change interface colors, brightness, and performance

Select spectral ranges

Techniques for restoring audio
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Création et ouverture de fichiers

En haut

Taux d’échantillonnage

Canaux

Résolution

En haut

Modèle (CS6)

Taux d’échantillonnage

Remarque :

Création d’un fichier audio vierge
Création d’une session multipiste
Ouverture des fichiers audio et des mixages multipistes existants
Ajout de fichiers audio à un autre (Audition CS6)
Importation d’un fichier sous forme de données brutes
Insertion d’un fichier audio dans une session multipiste
Insertion localisée d’un fichier Broadcast Wave dans une session

Création d’un fichier audio vierge
Les nouveaux fichiers audio vierges s’avèrent parfaits pour enregistrer de nouvelles données audio ou pour combiner des données audio collées.

1. Sélectionnez Fichier > Nouveau > Fichier audio.

Pour créer rapidement un fichier à partir de données audio sélectionnées dans un fichier ouvert, sélectionnez Edition >
Copier vers nouveau (Voir Copie ou suppression de données audio.)

2. Nommez le fichier, puis définissez les options suivantes :

Détermine la plage de fréquences du fichier. Pour reproduire une fréquence donnée, le taux
d’échantillonnage doit être au moins deux fois supérieur à cette fréquence. (voir la section Compréhension du taux
d’échantillonnage).

Détermine si la forme d’onde est en mode mono, stéréo ou surround 5.1.

L’option mono s’avère particulièrement adaptée aux enregistrements vocaux uniquement ; le traitement est plus rapide et
les fichiers plus petits.

Détermine la plage d’amplitudes du fichier. Le niveau 32 bits apporte une souplesse de traitement maximale
dans Adobe Audition. Pour une plus grande compatibilité avec les applications courantes, toutefois, convertissez le fichier à
une résolution inférieure une fois le montage terminé (voir les sections Compréhension de la résolution et Modification de la
résolution en bits d’un fichier).

Création d’une session multipiste
Les fichiers de session (*.sesx) ne contiennent pas de données audio. Il s’agit en fait de petits fichiers XML qui renvoient vers d’autres fichiers
audio présents sur le disque dur. Ils gardent la trace des fichiers qui constituent la session, de leur point d’insertion, des enveloppes et des effets
appliqués, etc.

Pour examiner les paramètres en détail, il est possible d’ouvrir les fichiers SESX dans des éditeurs de texte ou de les stocker dans des
systèmes de contrôle de version (Perforce, par exemple, réputé dans l’industrie du jeu).

1. Sélectionnez Fichier > Nouveau > Session multipiste.
2. Entrez le nom et l’emplacement du fichier, puis définissez les options suivantes :

Indique un modèle par défaut ou un modèle que vous avez créé. Les modèles de session définissent des
fichiers sources et des paramètres, par exemple, le taux d’échantillonnage et la résolution.

Détermine la plage de fréquences de la session. Pour reproduire une fréquence donnée, le taux
d’échantillonnage doit être au moins deux fois supérieur à cette fréquence. (voir la section Compréhension du taux
d’échantillonnage).

tous les fichiers ajoutés à une session doivent avoir un taux d’échantillonnage identique. Si vous tentez
d’importer des fichiers dont les taux d’échantillonnage varient, Adobe Audition vous demande de les rééchantillonner, ce qui
risque de réduire la qualité audio. Pour modifier la qualité de rééchantillonnage, réglez les paramètres Conversion du taux
d’échantillonnage dans les préférences Données.
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Résolution

Remarque :

Principal

En haut

Remarque :

En haut

Remarque :

En haut

Taux d’échantillonnage

Canaux

Détermine la plage d’amplitudes de la session, y compris les enregistrements et les fichiers créés à l’aide de la
commande Multipiste > Mixage dans un nouveau fichier. (Voir la section Compréhension de la résolution.)

choisissez la résolution avec soin, car il n’est plus possible de la modifier une fois la session créée. Idéalement,
vous devriez travailler à un niveau de 32 bits avec des systèmes rapides. Si votre système est lent, définissez une résolution
inférieure.

Détermine si les pistes sont mixées en pistes mono, stéréo ou 5.1 (voir la section Acheminement de données audio
vers des bus, des émissions et la piste principale).

Ouverture des fichiers audio et des mixages multipistes existants
Les types de fichiers suivants s’ouvrent dans l’éditeur de multipiste : session Audition, séquence Adobe Premiere Pro XML, fichier d’échange XML
Final Cut Pro et OMF.

Tous les autres types de fichiers pris en charge s’ouvrent dans l’éditeur de forme d’onde, y compris la portion audio des fichiers vidéo.

les fichiers de session SES d’Audition 3.0 et versions antérieures ne sont pas pris en charge. Si vous disposez d’Audition 3.0 ,
enregistrez les sessions au format XML pour pouvoir les ouvrir dans des versions CS. Toutefois, notez que les effets plus anciens sont exclus
dans CS6 ; les effets et l’expansion temporelle sont exclus dans CS5.5.

Si vous ouvrez plusieurs fichiers, le menu du panneau Editeur vous permet de choisir quel fichier afficher.

1. Choisissez Fichier > Ouvrir.
2. Sélectionnez un fichier audio ou vidéo (voir la section Formats d’importation pris en charge).

Si le fichier de votre choix ne s’affiche pas, sélectionnez Tous les médias pris en charge dans le menu au bas de la boîte
de dialogue.

Ajout de fichiers audio à un autre (Audition CS6)
Ajoutez des fichiers avec des marques Piste du CD pour assembler rapidement vos données audio et leur appliquer un traitement homogène.

1. Dans l’éditeur de forme d’onde, effectuez l’une des opérations suivantes :

Pour ajouter le fichier actif, choisissez Fichier > Ouvrir et ajouter > A l’actif.
Pour ajouter un nouveau fichier, choisissez Fichier > Ouvrir et ajouter > Au nouveau.

2. Dans la boîte de dialogue Ouvrir et ajouter, sélectionnez un ou plusieurs fichiers. 

si le taux d’échantillonnage, la résolution ou le type de canal des fichiers sélectionnés diffère de celui du fichier
ouvert, Audition convertit les fichiers sélectionnés en fonction du fichier ouvert. Pour obtenir des résultats optimaux, ajoutez
des fichiers dont le type d'échantillon est identique à celui du fichier d'origine.

3. Cliquez sur Ouvrir.

Importation d’un fichier sous forme de données brutes
Si vous ne parvenez pas à ouvrir un fichier particulier, il est possible qu’il lui manque les informations d’en-tête nécessaires sur le type
d’échantillon. Pour préciser manuellement ces informations, importez le fichier sous forme de données brutes.

1. Sélectionnez Fichier > Importer > Données brutes.
2. Sélectionnez le fichier et cliquez sur Ouvrir.
3. Définissez les options suivantes :

Doit correspondre au taux connu du fichier, si possible. Pour consulter des exemples de paramètres
courants, voir la section Compréhension du taux d’échantillonnage. Adobe Audition peut importer des données brutes avec
des taux compris entre 1 et 10 000 000 Hz ; la lecture et l’enregistrement, toutefois, sont uniquement pris en charge entre
6 000 et 192 000 Hz.

Entrez un nombre compris entre 1 et 32.
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Codage

Ordre des octets

Décalage d’octets de début (CS6)

En haut

En haut

Détermine le schéma de stockage des données pour le fichier. Si vous ne connaissez pas le codage utilisé par le
fichier, consultez la personne qui vous a fourni le fichier ou la documentation de l’application dans laquelle il a été créé.
Plusieurs tentatives et erreurs s’avèrent souvent nécessaires.

Définit la séquence numérique pour les octets des données. La méthode Little-Endian est généralement
utilisée pour les fichiers WAV, la méthode Big-Endian pour les fichiers AIFF. L’option Ordre des octets par défaut applique
automatiquement la valeur par défaut correspondant au processeur du système. Il s’agit généralement de la meilleure option.

Spécifie le point de données dans le fichier à partir duquel le processus d’importation doit
commencer.

Insertion d’un fichier audio dans une session multipiste
Lorsque vous insérez un fichier audio dans l’éditeur de multipiste, il devient un clip audio de la piste sélectionnée. Si vous insérez plusieurs
fichiers simultanément ou un seul fichier dont la longueur est supérieure à l’espace disponible dans la piste sélectionnée, Adobe Audition insère
de nouveaux clips dans les pistes vides les plus proches.

1. Dans l’éditeur de multipiste, sélectionnez une piste, puis placez la tête de lecture  au point d’insertion souhaité.

2. Sélectionnez Multipiste > Insérer un fichier.
3. Sélectionnez un fichier audio ou vidéo (voir la section Formats d’importation pris en charge).

Dans CS6, faites glisser les plages à partir du panneau Marques de l’éditeur de multipiste pour convertir automatiquement les clips.

Insertion localisée d’un fichier Broadcast Wave dans une session
Lors de l’insertion d’un fichier Broadcast Wave (BWF) dans une session multipiste, Adobe Audition peut utiliser l’estampille intégrée afin de placer
le fichier à un point donné. On parle généralement d’insertion localisée.

1. Sélectionnez Edition > Préférences > Multipiste (Windows) ou Audition > Préférences > Multipiste (Mac OS).
2. Sélectionnez·Utiliser le code temporel incorporé lors de l’insertion de clips dans la multipiste.
3. Dans l’éditeur de multipiste, sélectionnez une piste.
4. Sélectionnez Multipiste > Insérer un fichier, puis sélectionnez un fichier BWF.

Adobe Audition insère un clip audio au point de début désigné.

Pour afficher ou modifier l’estampille d’un clip BWF, ouvrez le clip dans l’éditeur de forme d’onde, puis sélectionnez Fenêtre > Métadonnées.
Sur l’onglet BWF, la valeur de l’estampille s’affiche sous la forme d’une référence temporelle.

Sessions multipistes

Insertion d’un fichier vidéo dans une session multipiste
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Automatisation des tâches courantes (CS6)

En haut

En haut

Remarque :

Favoris
Ajustement du volume dans plusieurs fichiers
Traitement de fichiers par lots

Favoris
Les favoris sont des combinaisons d’effets, de fondus et de réglages d’amplitude que vous pouvez enregistrer afin de les réappliquer rapidement à
un fichier ou à une sélection dans l’éditeur de forme d’onde. Le menu Favoris contient quelques favoris par défaut, ainsi que tous les favoris que
vous créez.

Pour attribuer des favoris à des raccourcis clavier, reportez-vous à Personnalisation des raccourcis.

Création d’un favori à partir d’une combinaison de réglages

1. Dans l’éditeur de forme d’onde, sélectionnez Favoris > Commencer l’enregistrement du favori.

2. Appliquez les effets, les fondus et les réglages d’amplitude à enregistrer.

3. Sélectionnez Favoris > Arrêter d’enregistrer le favori, puis nommez le favori.

Création d’un favori à partir d’un effet spécifique

1. Définissez les paramètres d’effet nécessaires.

2. En haut à droite de la boîte de dialogue des effets, cliquez sur l’icône Favori . Nommez ensuite le favori.

Création d’un favori à partir du rack d’effets (CS6)

1. Dans le rack d’effets, réglez les paramètres et l’ordre des effets.

2. En haut à droite du rack d’effets, cliquez sur l’icône Favori . Nommez ensuite le favori.

Suppression d’un favori

1. Sélectionnez Favoris > Supprimer un favori.

2. Sélectionnez le nom du favori, puis cliquez sur OK.

Ajustement du volume dans plusieurs fichiers
Si vous prévoyez de présenter un ensemble de fichiers audio sur CD, sur Internet ou ailleurs, homogénéisez les niveaux à l’aide du panneau
Ajuster le volume.

Pour faire correspondre les clips multipistes sans modifier les fichiers source, consultez la section Ajustement du volume du clip

1. Dans l’éditeur de forme d’onde, sélectionnez Fenêtre > Ajuster le volume.

2. Faites glisser les fichiers du panneau Fichiers vers le panneau Ajuster le volume. Vous pouvez également cliquer sur le
bouton Ajouter des fichiers  du panneau afin de parcourir les fichiers sur votre système.

par défaut, pour des performances optimales, l’ajustement du volume traite quelques fichiers seulement à la fois.
Pour traiter plusieurs fichiers, modifiez la valeur Nombre maximal de traitements de fichiers simultanés dans les préférences
de données.

3. (Facultatif) Pour afficher les statistiques d’amplitude telles que perçues et le volume maximal de chaque fichier, cliquez sur
l’icône Calculer . Cliquez ensuite sur Paramètres afin de préciser les valeurs cibles en fonction de ces statistiques.



Intensité sonore

Perçu

RMS total

Crête

Crête authentique

% clip

Ajuster sur

RMS total

Fichier

Intensité sonore

Intensité sonore perçue

Volume maximal

Utiliser limites

Temps d’anticipation

Remarque :

Temps de relâchement

Remarque :

4. Effectuez l’une des opérations suivantes :

Pour traiter les fichiers existants, mais les enregistrer ultérieurement, désélectionnez l’option Exporter située au bas du
panneau. 
Pour traiter les nouveaux fichiers, sélectionnez Exporter. (Pour personnaliser les paramètres d’exportation, reportez-vous à
Traitement de fichiers par lots.) 

5. Cliquez sur Exécuter.

Compréhension des statistiques d’ajustement du volume

Valeur d’amplitude moyenne. (Pour Audition CS6, cela correspond à la norme ITU-R BS.1770-2, permettant de garantir des
niveaux de diffusion constants compatibles avec EBU R 128.)

Valeur d’amplitude moyenne ajustée sur les fréquences moyennes pour la sensibilité maximale de l’oreille humaine.

Amplitude quadratique moyenne la plus courante dans tout le fichier. Si, par exemple, la majorité des deux fichiers est de -50 dBFS, la
RMS totale en tient compte, même si l’un des fichiers contient davantage de passages forts.

L’amplitude quadratique moyenne reflète souvent mieux l’amplitude perçue que la moyenne de l’intensité sonore absolue.

Amplitude maximale.

Désigne l’amplitude maximale telle qu’elle est définie par la norme ITU-R BS.1770-2.

Pourcentage de la forme d’onde qui doit être écrêté à la suite de la normalisation. Il n’y a aucun écrêtage en cas d’utilisation de la
limitation. Il est toutefois préférable d’éviter l’écrêtage avant une limitation. Si des fichiers ajustés ont un écrêtage supérieur à 0 %, cliquez sur
Annuler, puis définissez une amplitude légèrement inférieure.

Paramètres d’ajustement du volume

Dans le panneau Ajuster le volume, cliquez sur Paramètres afin de définir les options suivantes :

Détermine de quelle manière est mathématiquement comparée l’amplitude :

Ajuste le volume selon une intensité sonore générale que vous précisez.

Ajuste le volume selon l’intensité sonore générale d’un fichier sélectionné. Sélectionnez cette option si un
fichier reflète le volume que vous voulez atteindre.

Ajuste le volume selon une intensité sonore moyenne que vous précisez.

Ajuste le volume selon le niveau d’intensité sonore perçu, en prenant en compte les
fréquences intermédiaires auxquelles l’oreille est la plus sensible. Cette option fonctionne bien, sauf si la perception
des fréquences varie de manière importante dans un fichier (par exemple, si les fréquences moyennes sont marquées
dans un court passage alors que tout le fichier est en fréquences basses).

Ajuste le volume selon une amplitude maximale que vous précisez, en normalisant les fichiers.
Comme cette option conserve la plage dynamique, son choix est judicieux pour les fichiers que vous envisagez de
traiter ultérieurement ou pour les données audio très dynamiques, telles que la musique classique.

Applique une limitation fixe afin d’éviter que les crêtes ne soient écrêtées. Lorsque vous amplifiez des
données audio, il arrive que certains échantillons s’étendent au-delà du point d’écrêtage.

Précise le délai en millisecondes nécessaire pour atténuer les données audio avant d’atteindre
la crête la plus forte.

si cette valeur est trop faible, une distorsion audible risque de se produire. veillez à ce que cette valeur ne soit
pas inférieure à 5 millisecondes.

Spécifie le délai en millisecondes nécessaire à l’atténuation pour remonter à 12 dB (soit le
temps nécessaire pour reprendre le volume normal après une crête très forte).

un délai de 200 millisecondes permet de préserver les fréquences basses. Si ce paramètre est trop élevé, les
données audio risquent de ne pas reprendre leur niveau normal avant un moment.
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En haut

Remarque :

Préfixe et suffixe de nom de fichier

Modèle

Emplacement

Identique à l’emplacement du fichier source

Ecraser les fichiers existants

Format

Type d’échantillonnage

Nouveau type d’échantillonnage

Supprimer les fichiers du panneau à la fin de l’opération

Inclure des marques et d’autres métadonnées

Traitement de fichiers par lots
Le traitement par lots regroupe les fichiers afin d’appliquer rapidement le traitement des favoris, le rééchantillonnage ou l’enregistrement dans un
nouveau format. Permet d’automatiser rapidement les tâches courantes, telles que l’exportation au format mp3 ou l’application d’effets identiques
sur des fichiers connexes.

1. Dans l’éditeur de forme d’onde, sélectionnez Fenêtre > Traitement par lots.

2. Dans le panneau Traitement par lots, cliquez sur le bouton Ajouter des fichiers  afin de parcourir les fichiers sur votre
système. (Pour ajouter rapidement tous les fichiers ouverts, choisissez Fichier > Enregistrer tout l’audio sous Traitement par
lots.)

par défaut, pour des performances optimales, le traitement par lots est limité à trois fichiers à la fois. Pour traiter
plusieurs fichiers, modifiez la valeur Nombre maximal de traitements de fichiers simultanés dans les préférences de données.

3. Sélectionnez une option de traitement dans le menu Favoris. Ensuite, effectuez l’une des opérations suivantes :

Pour traiter les fichiers existants, désactivez l’option Exporter au bas du panneau, puis cliquez sur Exécuter.
Pour traiter les nouveaux fichiers, sélectionnez Exporter, puis cliquez sur Exécuter. (Pour personnaliser les paramètres
d’exportation, reportez-vous à l’étape suivante.)

4. Cliquez sur Paramètres d’exportation, puis définissez les options suivantes :

Permettent d’identifier les fichiers traités par lots.

Définit une convention de dénomination pour les fichiers traités, par exemple, l’artiste, la date, le morceau
(%a/%d/%s/).

Précise le dossier de destination pour les fichiers traités.

Enregistre les fichiers modifiés dans le même dossier que le fichier
source.

Remplace automatiquement les fichiers existants du même nom.

Indique le format du fichier. La section Paramètres de format ci-dessous indique les modes de compression et de
stockage des données. Cliquez sur Modifier pour les ajuster (Voir Paramètres du format audio).

Indique le taux d’échantillonnage et la résolution. Pour personnaliser ces options, cliquez sur
Modifier. (voir la section Conversion du taux d’échantillonnage d’un fichier).

Indique le taux d’échantillonnage et la résolution après l’exportation. Si les fichiers sources
possèdent différents types d’échantillonnage, cliquez sur le menu contextuel pour voir comment chaque fichier sera converti.
(Le menu ne s’applique pas aux options de conversion ; pour les ajuster, cliquez sur Modifier pour Type d’échantillonnage.)

Supprime les noms de fichier du panneau Traitement par lots
après l’exportation.

Inclut dans les fichiers traités les informations et les marques audio issues
du panneau Métadonnées (VoirUtilisation des marqueurs et Affichage et modification de métadonnées XMP.)

Sélection de données audio

Effet Normaliser (éditeur de forme d’onde uniquement)

Analyse de l’amplitude
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Automating common tasks (CS5.5)

To the top

To the top

Note:

Loudness

Perceived

Favorites
Match volume across multiple files
Batch process files

Favorites
Favorites are combinations of effects, fades, and amplitude adjustments that you can save and quickly reapply to any file or selection in the
Waveform Editor. The Favorites menu lists some defaults to get you started, plus any additional favorites you create.

To assign favorites to keyboard shortcuts, see Customize shortcuts.

Create a favorite from a combination of adjustments

1. In the Waveform Editor, choose Favorites > Start Recording Favorite.

2. Apply the effects, fades, and amplitude adjustments you want to save.

3. Choose Favorite > Stop Recording Favorite, and name the favorite.

Create a favorite from a specific effect

1. Adjust effect settings as desired.

2. In the upper right of the effect dialog box, click the Favorite icon . Then name the favorite.

Delete a favorite

1. Choose Favorites > Delete Favorite.

2. Select the favorite name, and click OK.

Match volume across multiple files
If you plan to present a group of audio files on CD, the web, or elsewhere, use the Match Volume panel to make them sound consistent.

To match multitrack clips without changing source files, see Match clip volume

1. In the Waveform Editor, choose Window > Match Volume.

2. Drag files from the Files panel to the Match Volume panel. Or click the Add Files button  in the panel to browse to files on
your system.

By default, Match Volume processes at most three files at a time for optimal performance. To process more files,
change the value for Maximum Number Of Concurrent File Processes in the Data preferences.

3. (Optional) To display amplitude statistics such as perceived and peak volume for each file, click the Compute icon . Then
click Settings to specify target values based on these statistics.

4. Click Match Volume to apply the necessary amplitude changes. Or click Batch Process to apply those changes and export to
the same file format and sample type. (See Batch process files.)

Understanding Match Volume statistics

Is the average amplitude value.

Is the average amplitude value adjusted for the human ear’s greater sensitivity to midrange frequencies.
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Total RMS

Peak

% Clip

Match To

Total RMS

File

Loudness

Perceived Loudness

Peak Volume

Use Limiting

Lookahead Time

Note:

Release Time

Note:

To the top

Note:

Apply Favorite

Filename Prefix and Postfix

Location

Is the most common root-mean-square amplitude across the entire file. For example, if the majority of two files is -50 dBFS, the total
RMS values would reflect that, even if one file contains more loud passages.

RMS amplitude often better reflects perceived amplitude than the absolute Loudness average.

Is the maximum amplitude.

Is the percentage of the waveform that would be clipped as a result of normalization. Clipping won’t occur if limiting is used. However,
clipping should ideally be avoided prior to limiting. If any matched files show more than 0% clipping, click Undo, and match to a slightly lower
amplitude.

Adjust Match Volume settings

In the Match Volume panel, click Settings to adjust the following options:

Determines how amplitude is mathematically compared:

Matches an overall loudness you specify.

Matches the overall loudness of a selected file. Choose this option if one file reflects the target volume you want
to achieve.

Matches an average loudness you specify.

Matches the perceived loudness level, accounting for middle frequencies that the ear is most
sensitive to. This option works well unless frequency emphasis varies greatly in a file (for example, midrange
frequencies are pronounced in a short passage, but bass frequencies are elsewhere).

Matches a maximum amplitude you specify, normalizing the files. Because this option retains dynamic
range, it’s a good choice for files you plan to process further, or for highly dynamic audio like classical music.

Applies hard limiting to keep peaks from being clipped. (When you amplify audio, some samples may extend
beyond the clipping point.)

Specifies the number of milliseconds to attenuate audio before reaching the loudest peak.

If this value is too small, audible distortion might occur. Make sure that the value is at least 5 milliseconds.

Specifies the number of milliseconds for attenuation to rebound 12 dB (roughly the amount needed to
resume normal volume after an extremely loud peak is encountered).

A setting of 200 milliseconds works well to preserve low bass frequencies. If the setting is too high, audio may stay
below normal levels for a while.

Batch process files
Batch process groups of files to quickly apply favorite processing, resample, or save to a new format. Quickly automate common tasks like
exporting to mp3 format or applying identical effects to related files.

1. In the Waveform Editor, choose Window > Batch Process.

2. In the Batch Process panel, click the Add Files button  to browse to files on your system.

By default, batch processing is limited to three files at a time for optimal performance. To process more files, change
the value for Maximum Number Of Concurrent File Processes in the Data preferences.

3. Click Batch Process, and set the following options:

Applies a combination of effects, fades, and amplitude adjustments. (See Favorites.)

Help you identify batched files.

Specifies the destination folder for processed files.
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Same As Source File Location

Overwrite Existing Files

Format

Sample Type

Clear Batch Process Panel Upon Completion

Include Markers and Other Metadata

Saves modified files in the same folder as the file’s source file.

Automatically replaces existing files with the same name.

Specifies the file format. The Format Settings area below indicates data compression and storage modes; to adjust
these, click Change. (See Audio format settings.)

Indicates the sample rate and bit depth. To adjust these options, click Change. (See Convert the sample rate
of a file.)

Removes filenames from the source list after the files are converted
successfully.

Includes audio markers and information from the Metadata panel in processed files.
(See Working with markers and Viewing and editing XMP metadata.)

Selecting audio

Normalize effect (Waveform Editor only)

Analyze amplitude
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Working with markers

Note:

To the top

Add, select, and rename markers
Adjust, merge, convert, or delete markers
Save audio between markers to new files
Creating playlists

Markers (sometimes called cues) are locations that you define in a waveform. Markers make it easy to navigate within a waveform to make a
selection, perform edits, or play back audio.

In Adobe Audition, a marker can be either a point or a range. A point refers to a specific time position within a waveform (for instance, 1:08.566
from the start of the file). A range has both a start time and an end time (for example, all of the waveform from 1:08.566 to 3:07.379). You can
drag start and end markers for a range to different times.

In the timeline at the top of the Editor panel, markers have white handles you can select, drag, or right-click to access additional commands.

Examples of markers 
A. Marker point B. Marker range 

To preserve markers when you save a file, select Include Markers and Other Metadata.

Add, select, and rename markers
Though you can add markers directly in the Editor panel, you use the Markers panel (Windows > Markers) to define and select markers.

To hide or show information such as Duration and Type, choose Markers Display from the panel menu .

Add a marker

1. Do one of the following:

Play audio.

Place the current-time indicator  where you want a marker point to be.

Select the audio data you want to define as a marker range.

2. Either press the M key, or click the Add Marker button  in the Markers panel.

To automatically create markers where silence occurs, see Delete Silence and Mark Audio options.

Select markers

Click a marker in the Editor or Markers panel. Or double-click to move the current-time indicator  to that location and select
the area for range markers.

To select adjacent markers, click the first marker you want to select in the Markers panel, and then Shift-click the last.

To select nonadjacent markers, Ctrl-click (Windows) or Command-click (Mac OS) them in the Markers panel.

To move the current-time indicator to the nearest marker, choose Edit > Marker > Move CTI to Next or Previous.

Rename a marker

1. In the Markers panel, select the marker.

2. Click the marker name, and enter a new name.
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Use Marker Names In Filename

Prefix

Postfix Starting #

Location

Format

Sample Type

Include Markers and Other Metadata
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Adjust, merge, convert, or delete markers
After creating markers, you can fine-tune them to best address the needs of an audio project.

Reposition markers

In the Editor panel, drag marker handles to a new location.

In the Markers panel, select the marker, and enter new Start values for point markers, or Start, End, and Duration values for
range markers.

Merge individual markers

In the Markers panel, select the markers you want to merge, and click the Merge button .

The new merged marker inherits its name from the first marker. Merged point markers become range markers.

Convert a point marker to a range marker

Right-click the marker handle, and choose Convert to Range.

The marker handle splits into two handles.

Convert a range marker to a point marker

Right-click a marker handle, and choose Convert to Point.

The two parts of the range marker handle merge into a single handle, with the start time of the range becoming the time for the
point marker.

Delete markers

Select one or more markers, and click the Delete button  in the Markers panel.

Right-click the marker handle in the Editor panel, and choose Delete Marker.

Save audio between markers to new files

1. In the Waveform Editor, choose Window > Markers.

2. Select one or more marker ranges. (See Working with markers .)

3. Click the Export Audio button  in the Markers panel.

4. Set the following options:

Uses the marker name as the prefix for the filename.

Specifies a filename prefix for the new files.

Specifies the number to begin with when adding numbers to the filename prefix. Adobe Audition
automatically adds numbers after the prefix (for example, prefix02, prefix03) to distinguish saved files.

Specifies the destination folder for saved files. Click Browse to specify a different folder.

Specifies the file format. The Format Settings area below indicates and data compression and storage modes; to
adjust these, click Change. (See Audio format settings.)

Indicates the sample rate and bit depth. To adjust these options, click Change. (See Convert the sample rate
of a file.)

Includes audio markers and information from the Metadata panel in processed files.
(See Viewing and editing XMP metadata.)

Creating playlists
A playlist is an arrangement of marker ranges that you can play back in any order and loop a specified number of times. A playlist lets you try
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Note:

different versions of an arrangement before you commit to edits. You create playlists in the Playlist panel (Window > Playlist).

To store a playlist with a file, you must save in WAV format. (See Save audio files.)

Create a playlist

1. In the Playlist panel, click the Open Markers Panel button .

2. In the Markers panel, select marker ranges you want to add to the playlist. Then click the Insert Selected Range Markers Into
Playlist button , or drag the range markers to the Playlist panel.

Change the order of items in a playlist

Drag the item up or down.

Play items in a playlist

To play all or part of the list, select the first item you want to play. Then click the Play button  at the top of the panel.

To play a specific item, click the Play button to the left of the item name.

Loop an item in a playlist

Select an item, and enter a number in the Loops column. Each item can loop a different number of times.

Delete items from a playlist

Select the items, and click the Remove button .

Delete Silence and Mark Audio options

Batch process files
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Analyse de la phase, de la fréquence et de l’amplitude
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Analyse des phases
Analyse de la plage de fréquences
Analyse de l’amplitude

Dans Adobe Audition, il existe plusieurs manières d’analyser les données audio. Utilisez le panneau Phasemètre pour comparer les relations de
phase entre deux canaux. Pour analyser la plage tonale et dynamique, utilisez les panneaux Analyse des fréquences et Statistiques sur
l’amplitude.

L’éditeur de forme d’onde fournit également un affichage spectral de la fréquence, que vous pouvez utiliser conjointement avec les méthodes
d’analyse ci-dessus (Voir la section Affichage des données audio dans l’éditeur de forme d’onde).

Analyse des phases
Le panneau Phasemètre révèle les canaux déphasés pour les formes d’onde stéréo et surround, que vous pouvez corriger à l’aide de la
commande Effets > Inverser (voir la section Inversion d’une forme d’onde). Ce panneau vous permet également d’identifier les canaux bien en
phase qui produiraient le même son s’ils étaient compilés en mono (voir la section Conversion d’une forme d’onde en surround, en stéréo ou en
mono).

Pour comprendre la phase audio, voir la section Méthodes d’interaction des ondes sonores.

1. Sélectionnez Fenêtre > Phasemètre.
2. Cliquez avec le bouton droit sur le panneau Phasemètre, puis sélectionnez des canaux dans les menus Canal et Comparer à.
3. Dans le panneau Editeur, sélectionnez une plage, le cas échéant, puis lancez la lecture.

Dans le panneau Phasemètre, l’audio à gauche est plus déphasé, tandis que l’audio à droit est plus en phase. -1,0 correspond à une annulation
totale de la phase, tandis que 1,0 reflète un contenu audio identique dans chaque canal.

Pour personnaliser l’aspect du phasemètre, cliquez dessus avec le bouton droit, puis sélectionnez Afficher le dégradé de couleur ou Afficher les
indicateurs LED.

Analyse de la plage de fréquences
Utilisez le panneau Analyse des fréquences pour identifier les bandes de fréquences problématiques, que vous pouvez dès lors corriger à l’aide
d’un effet de filtre.

1. Sélectionnez Fenêtre > Analyse des fréquences.
2. Dans le panneau Editeur, cliquez sur un point temporel, sélectionnez une plage ou lancez la lecture.
3. Le panneau Analyse des fréquences affiche la fréquence le long de l’axe horizontal et l’amplitude le long de l’axe vertical.

Si vous avez sélectionné une plage, Adobe Audition analyse uniquement le point central. Pour analyser toute la fréquence
de la plage, cliquez sur Analyser la sélection.

Options du panneau Analyse des fréquences
Echelle Affiche l’échelle des fréquences de manière logarithmique (reproduit l’audition humaine) ou linéaire (fréquences supérieures plus
détaillées).

Copier toutes les données du graphique Copie dans le Presse-papiers du système un rapport textuel sur les données de fréquence.
Boutons Maintenir Permettent de réaliser jusqu’à huit instantanés des fréquences pendant la lecture d’une forme d’onde. Le contour des
fréquences (représenté dans la même couleur que le bouton actionné) se fige sur le graphique et est recouvert par les autres contours de
fréquences. Pour effacer un contour de fréquence figé, cliquez une nouvelle fois sur le bouton Maintenir correspondant.
Afficher Permet de modifier l’affichage graphique. Choisissez l’un des styles suivants :

Lignes  Affiche l’amplitude de chaque fréquence à l’aide de lignes simples. Par défaut, le canal gauche est vert, celui de droite est bleu.
Zone  Affiche également les lignes d’amplitude, mais comble la zone située sous les lignes d’une couleur unie et lisse les différences
d’amplitude d’une même zone.
Mesures  Affiche l’effet de la résolution d’analyse en fractionnant l’affichage en segments rectangulaires. Plus la taille de la TFR est
grande, plus la résolution de l’analyse est élevée et plus les mesures sont étroites.

Canal supérieur Détermine quel canal d’un fichier stéréo ou surround s’affiche au-dessus des autres dans le graphique. Pour combiner les
canaux affichés, sélectionnez Moyenne.
Analyser ou Analyser la sélection Analyse l’ensemble du fichier ou de la sélection, et affiche les données de fréquence moyennes dans le
graphique (par défaut, le graphique affiche les données du point central des fichiers ou sélections).

http://helpx.adobe.com/en/audition/using/displaying-audio-waveform-editor.html
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Options avancées
Taille de la TFR Spécifie la taille de la TFR (Transformation de Fourier rapide). Les tailles de TFR plus élevées révèlent plus précisément les
données de fréquence, mais nécessitent un temps de traitement plus long.
Fenêtre Détermine la forme de la transformation de Fourier rapide. Ces fonctions sont répertoriées dans l’ordre, de la plus étroite à la plus large :
Les fonctions plus étroites comprennent moins de fréquences environnantes mais reproduisent moins précisément les fréquences centrales. Les
fonctions plus larges comprennent davantage de fréquences environnantes mais reproduisent plus précisément les fréquences centrales. Les
options Hamming et Blackmann fournissent d’excellents résultats généraux.
Référence 0 dB Détermine l’amplitude à laquelle les données audio de 0 dBFS de pleine ampleur sont affichées. Par exemple, une valeur de zéro
affiche un son de 0 dBFS à 0 dB. Une valeur de 30 affiche un son de 0 dBFS à -30 dB. Cette valeur déplace simplement le graphe vers le haut
ou vers le bas ; elle ne modifie en rien l’amplitude des données audio.

Réglez la Référence 0 dB afin d’étalonner cet affichage pour une autre référence de décibels, tel le niveau de pression du son.

Valeur à [x] Hz Révèle l’amplitude exacte de fréquences spécifiques lorsque vous survolez le graphe avec la souris.
Fréquence globale Pour le point de départ d’une plage sélectionnée, indique la fréquence moyenne.
Note musicale globale Pour le point de départ d’une plage sélectionnée, indique la position du clavier et la variance par rapport au réglage
standard (La 440). Par exemple, A2 +7 signifie le deuxième La le plus grave sur un clavier réglé 7 % plus haut que la normale.

Zoom sur les graphiques de fréquence
Dans le panneau Analyse des fréquences, vous pouvez agrandir les graphiques afin de mieux analyser les fréquences.

 Effectuez l’une des opérations suivantes :

Pour effectuer un zoom avant, cliquez avec le bouton droit de la souris sur la règle verticale ou horizontale, puis faites glisser
l’icône de loupe le long de la règle.

Pour déplacer un graphique agrandi, cliquez avec le bouton gauche sur la règle verticale ou horizontale, puis faites glisser
l’icône main  le long de la règle.

Pour effectuer un zoom arrière sur un graphique agrandi, cliquez avec le bouton droit sur la règle verticale ou horizontale, puis
sélectionnez Zoom arrière pour revenir à l’échelle d’agrandissement antérieure ou Zoom arrière sur l’ensemble pour annuler
totalement l’agrandissement.

Zoom et navigation dans un graphique Analyse des fréquences

Analyse de l’amplitude
1. Dans l’éditeur de forme d’onde, sélectionnez Fenêtre > Statistiques sur l’amplitude.
2. Pour calculer les statistiques pour l’ensemble d’un fichier ou d’une sélection, cliquez sur Analyser ou Analyser la sélection (par

défaut, les statistiques sont calculées à partir du point central des fichiers et sélections).
Vous pouvez régler une sélection dans le panneau Editeur. Cliquez de nouveau sur Analyser la sélection pour recalculer
les statistiques.

3. Evaluez l’amplitude sur les onglets suivants :

L’onglet Général affiche des statistiques numériques indiquant la plage dynamique, identifiant les échantillons écrêtés et
notant les décalages DC.

L’onglet Histogramme RMS affiche un graphique qui illustre la prévalence relative de chaque amplitude. La règle
horizontale mesure l’amplitude en décibels, tandis que la règle verticale mesure la prévalence selon la formule RMS.
Sélectionnez un canal à afficher dans le menu Afficher le canal.

L’onglet Histogramme permet d’identifier des amplitudes qui prévalent, puis de les compresser, de les limiter ou de les
normaliser avec un effet d’amplitude.

Options générales



 

Cliquez sur les icônes à droite des valeurs pour naviguer jusqu’à l’emplacement correspondant dans le fichier.

Amplitude pic Affiche l’échantillon avec l’amplitude la plus forte sous la forme de décibels.
Valeur d’échantillon max. Affiche l’échantillon avec l’amplitude la plus forte.
Valeur d’échantillon min. Affiche l’échantillon avec l’amplitude la plus faible.
Echantillons écrêtés possibles Affiche le nombre d’échantillons susceptibles d’avoir excédé 0 dBFS. Cliquez sur l’icône  à droite de cette
valeur pour naviguer jusqu’au premier échantillon écrêté dans le fichier audio (si nécessaire, recliquez sur l’icône pour afficher les échantillons
écrêtés suivants).
Amplitude RMS totale, maximale, minimale et moyenne Affiche les moyennes quadratiques de la sélection. Ces valeurs dépendent de la
prévalence des amplitudes spécifiques, qui reflètent souvent mieux l’intensité sonore perçue que des amplitudes absolues ou moyennes.
Décalage DC Affiche le décalage actuel direct appliqué à la forme d’onde au cours de l’enregistrement. Les valeurs positives se situent au-dessus
de la ligne centrale, les valeurs négatives en dessous. (Voir la section Correction du décalage DC.)
Résolution mesurée Indique la résolution de la forme d’onde (32 indique que la forme d’onde utilise l’intégralité de la plage flottante de 32 bits).
Plage dynamique Reproduit la différence entre l’amplitude RMS maximale et minimale.
Plage dynamique utilisée Affiche la plage dynamique moins les périodes anormalement longues d’amplitude RMS faible (les passages
silencieux, par exemple).
Intensité sonore Affiche l’amplitude moyenne.
Intensité sonore perçue Compense pour l’emphase de l’oreille humaine sur les fréquences intermédiaires.
Copier Copie toutes les statistiques de l’onglet Général dans le Presse-papiers du système.

Options des Paramètres RMS
Pour définir la manière dont sont calculées les statistiques RMS, définissez les options suivantes :

0 dB = Onde sinusoïdale FS Fait correspondre le niveau de décibels à une forme sinusoïdale à pleine échelle, où l’amplitude de crête est
d’environ 3,01 dB plus silencieuse qu’une forme carrée à pleine échelle.
0 dB = Onde carrée FS Fait correspondre le niveau de décibels à une forme carrée à pleine échelle, où l’amplitude de crête est d’environ 3,01 dB
plus bruyante qu’une forme sinusoïdale à pleine échelle.
Rendre compte DC Ignore les décalages DC des mesures.
Largeur de la fenêtre Spécifie le nombre de millisecondes dans chaque fenêtre RMS. Une plage sélectionnée contient plusieurs fenêtres de ce
type, dont Adobe Audition calcule les moyennes afin de déterminer les valeurs RMS minimale et maximale. Pour obtenir les valeurs RMS les plus
précises, utilisez de larges fenêtres pour les sons présentant une vaste plage dynamique et des fenêtres étroites pour les sons dont la plage
dynamique est étroite.

  |  
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Ecoute d’un fichier à un autre taux d’échantillonnage
Conversion du taux d’échantillonnage d’un fichier
Conversion d’une forme d’onde en surround, en stéréo ou en mono
Modification de la résolution en bits d’un fichier
Utilisation des préconfigurations de conversion de taux d’échantillonnage

Ecoute d’un fichier à un autre taux d’échantillonnage
La commande Interpréter le taux d’échantillonnage permet d’écouter le résultat de l’application d’un autre taux d’échantillonnage sur un fichier
audio (voir la section Compréhension du taux d’échantillonnage). Cette commande vous permet d’identifier les fichiers qui indiquent un taux
incorrect dans l’en-tête du fichier. Pour convertir ensuite définitivement le taux d’échantillonnage, sélectionnez Edition > Convertir le type
d’échantillons.

1. Dans l’éditeur de forme d’onde, sélectionnez Edition > Interpréter le taux d’échantillonnage.
2. Entrez un taux d’échantillonnage dans la zone de texte ou sélectionnez un taux usuel dans la liste.

Remarque : dans Adobe Audition, vous pouvez utiliser n’importe quel taux d’échantillonnage compris entre 6 000 et 192 000 Hz. Il est possible,
cependant, que votre carte son ne puisse pas le lire correctement. Pour connaître les taux d’échantillonnage pris en charge, consultez la
documentation accompagnant votre carte son.

Conversion du taux d’échantillonnage d’un fichier
Le taux d’échantillonnage d’un fichier détermine la plage de fréquences de la forme d’onde. Lorsque vous convertissez ce taux, n’oubliez pas que
la plupart des cartes son prennent en charge uniquement certains taux d’échantillonnage.

1. Dans l’éditeur de forme d’onde, sélectionnez Edition > Convertir le type d’échantillon.
Pour accéder rapidement à la boîte de dialogue Convertir le type d’échantillons, double-cliquez sur la section Type
d’échantillonnage de la barre d’état (voir la section Affichage de la barre d’état).

2. Sélectionnez un taux dans la liste Taux d’échantillonnage ou saisissez une valeur personnalisée dans la zone de texte.
3. Dans la section Avancé, faites glisser le curseur de qualité pour régler la qualité de conversion de l’échantillonnage.

Des valeurs élevées préservent les hautes fréquences, mais la conversion est plus longue. Avec des valeurs inférieures, la
durée de traitement est moins longue, mais les hautes fréquences sont réduites.

Utilisez des valeurs de qualité supérieures pour le sous-échantillonnage d’un taux élevé vers un taux faible. Lors du sur-
échantillonnage, des valeurs plus élevées ont peu d’effet.

4. Pour obtenir de meilleurs résultats, sélectionnez Filtre pré/post afin d’éviter le crénelage des bruits.

Conversion d’une forme d’onde en surround, en stéréo ou en mono
La commande Convertir le type d’échantillon constitue la manière la plus rapide de convertir une forme d’onde en un nombre différent de canaux.

1. Dans l’éditeur de forme d’onde, sélectionnez Edition > Convertir le type d’échantillon.
2. Dans le menu Canaux, sélectionnez Mono, Stéréo ou 5.1.
3. Dans la section Avancé, entrez les pourcentages des mixages gauche et droit :

Si vous convertissez le type mono en stéréo, les options Mixage gauche et Mixage droit permettent de spécifier
l’amplitude relative selon laquelle le signal mono d’origine est placé de chaque côté du nouveau signal stéréo. Par
exemple, vous pouvez placer la source mono sur le canal gauche uniquement, le canal droit uniquement ou à tout autre
point entre les deux.

Lorsque vous convertissez un type stéréo en mono, les options Mixage gauche et Mixage droit définissent le pourcentage
du signal du canal correspondant qui sera mixé dans la forme d’onde mono finale. La méthode de mixage la plus courante
utilise 50 % des deux canaux.

Pour connaître d’autres techniques de conversion de canaux, consultez les rubriques suivantes :

Extraction de canaux audio vers des fichiers mono

Mixage de données audio lors du collage

http://helpx.adobe.com/en/audition/using/saving-exporting-files.html#extract_audio_channels_to_mono_files
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Effet Mélangeur de canaux

Modification de la résolution en bits d’un fichier
La résolution (en bits) d’un fichier détermine la plage dynamique du son. (Voir la section Compréhension de la résolution.) Adobe Audition prend
en charge des résolutions allant jusqu’à 32 bits. Vous pouvez augmenter la résolution du fichier pour obtenir une plus grande plage dynamique, ou
réduire cette résolution pour diminuer la taille du fichier.

Remarque : certains lecteurs multimédias et applications courants nécessitent des données audio de 16 bits ou moins.
1. Dans l’éditeur de forme d’onde, sélectionnez Edition > Convertir le type d’échantillon.
2. Sélectionnez un nombre de bits dans le menu ou saisissez une valeur personnalisée dans la zone de texte.
3. Dans la section Avancé, définissez les options suivantes :

Interpolation Active ou désactive l’interpolation lors de la conversion en une résolution plus faible. Si l’interpolation est
désactivée, la résolution est abruptement tronquée, ce qui produit sur les passages à faible volume des craquements causés
par la distorsion de quantification

L’interpolation introduit une petite quantité de bruit. Néanmoins, le résultat est de loin préférable à l’importante distorsion que
vous risquez d’entendre avec de faibles niveaux de signal. L’interpolation permet également d’entendre des sons qui seraient
masqués par les limites de bruit et de distorsion des données audio à une résolution inférieure.

Type d’interpolation Contrôle la manière dont le bruit de l’interpolation est distribué par rapport à la valeur d’amplitude
d’origine. En général, un type triangulaire constitue le meilleur compromis entre le rapport signal/bruit, la distorsion et la
modulation de bruit.

Type d’interpolation Réduit le rapport signal/bruit Modulation du bruit

Triangulaire 4,8 dB Non

Gaussien 6,0 dB Négligeable

Remarque : l’interpolation triangulaire (formée) et gaussienne (formée) déplace légèrement plus de bruit à hautes
fréquences. Pour un plus grand contrôle, définissez les options de mise en forme du bruit.

Mise en forme du bruit Détermine quelles fréquences contiennent du bruit d’interpolation. En mettant le bruit en forme, vous
pouvez utiliser des profondeurs d’interpolation plus faibles sans pour autant introduire d’artefacts audibles. La meilleure mise
en forme dépend des données audio d’origine, du taux d’échantillonnage final et de la résolution en bits.
Remarque : la mise en forme du bruit est désactivée pour les taux d’échantillonnage inférieurs à 32 kHz ; sinon, tous les
bruits resteraient à des fréquences audibles.

Passe-haut  Si le répartiteur est défini sur 7,3 kHz, le bruit d’interpolation chute à -180 dB à 0 Hz et à -162 dB à
100 Hz.

Légère pente  Si le répartiteur est défini sur 11 kHz, le bruit chute à -3 dB à 0 Hz et à -10 dB à 5 Hz.

Neutre Une mise en forme neutre légère est réduite jusqu’à 14 kHz, dégrade le bruit jusqu’à 17 kHz au maximum,
avant d’être réduite de nouveau jusqu’aux fréquences les plus élevées. Le bruit de fond semble identique à celui qui
est audible sans mise en forme du bruit, mais il est d’environ 11 dB plus silencieux.

Une mise en forme neutre lourde est réduite jusqu’à 15,5 kHz, plaçant tous les bruits d’interpolation au-dessus de
16 kHz (où là où vous définissez le répartiteur). Des oreilles sensibles peuvent entendre une sonnerie aiguë si le
répartiteur est trop faible. Si vous convertissez des données audio de 48 ou 96 kHz, en revanche, le répartiteur peut
être placé bien au-dessus de 20 kHz.

Sélectionnez une forme neutre afin d’éviter de colorer soniquement le souffle de fond. Ce souffle est toutefois plus
intense que les autres formes.

En forme de U  Avec la valeur Peu profond, le bruit est principalement réduit de 2 kHz à 14 kHz, mais il devient plus
intense quand l’audio approche de 0 Hz, car les basses fréquences sont beaucoup moins audibles. La valeur Moyen
place un peu plus de bruit dans les fréquences supérieures à 9 kHz, mais réduit le bruit en dessous de cette
fréquence. La valeur Profond augmente davantage le bruit au-dessus de 9 kHz, mais le réduit également davantage
dans la plage 2-6 kHz.

Pondéré  La valeur Léger tente de reproduire la manière dont l’oreille perçoit les sons de faible niveau en réduisant
davantage le bruit dans la plage 2-6 kHz et en l’augmentant dans la plage 10-14 kHz. A des volumes plus élevés, le
souffle peut être plus significatif. La valeur Lourd réduit uniformément la plage 2-6 KHz la plus sensible, aux dépens
d’un bruit supérieur au-dessus de 8 kHz.

Répartiteur Détermine la fréquence au-dessus de laquelle survient la mise en forme du bruit.
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Intensité Définissez l’amplitude maximale du bruit ajouté à une fréquence.

Mode adaptatif Varie la distribution du bruit sur les fréquences.

Utilisation des préconfigurations de conversion de taux d’échantillonnage
Si vous devez appliquer le même type de conversion à plusieurs fichiers, l’utilisation d’une préconfiguration de conversion de taux
d’échantillonnage peut vous permettre de gagner du temps.

1. Choisissez Edition > Convertir le type d’échantillon.
2. Ajustez les paramètres nécessaires.

3. Cliquez sur le bouton Nouvelle préconfiguration .

Une fois créée, la préconfiguration apparaît dans la liste des préconfigurations située dans la partie supérieure de la boîte de
dialogue. Pour supprimer une préconfiguration, sélectionnez-la dans la liste, puis cliquez sur le bouton Supprimer .
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Inversion, retournement et silence audio
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Inversion d’une forme d’onde
Retournement d’une forme d’onde
Création de silence

Inversion d’une forme d’onde
L’effet Inverser permet d’inverser une phase audio de 180 degrés. (Pour comprendre les degrés de phase, voir la section Mesures de forme
d’onde.)

L’inversion n’entraîne pas de modification audible d’une forme d’onde. Toutefois, vous entendrez la différence lors de la combinaison de plusieurs
formes d’onde. Par exemple, inversez des données audio collées pour améliorer leur alignement avec les données audio existantes. Vous pouvez
aussi inverser un canal d’un fichier stéréo afin de corriger un enregistrement déphasé.

1. Si vous voulez inverser une partie de la forme d’onde, sélectionnez la plage correspondante. Pour inverser la totalité de la
forme d’onde, désélectionnez toutes les données audio.

2. Choisissez Effets > Inverser.

Retournement d’une forme d’onde
L’effet Retourner génère le retournement d’une forme d’onde de la droite vers la gauche ; la lecture se fait en sens inverse. Il permet de créer des
effets spéciaux.

1. Si vous voulez retourner une partie de la forme d’onde, sélectionnez la plage correspondante. Pour retourner la totalité de la
forme d’onde, désélectionnez toutes les données audio.

2. Choisissez Effets > Retourner.

Création de silence
La création de silence s’avère utile pour insérer des pauses et supprimer le bruit superflu d’un fichier audio. Dans Adobe Audition, il existe deux
manières de créer le silence :

Pour désactiver le son existant dans l’éditeur de forme d’onde, sélectionnez le contenu, puis choisissez Effets > Silence.
Contrairement à la suppression ou à la découpe d’une sélection, qui divise le matériel environnant, la désactivation du son ne
change pas la durée de la sélection.

Pour ajouter du silence dans l’éditeur de forme d’onde ou de multipiste, positionnez l’indicateur d’instant présent  ou
sélectionnez le son existant. Choisissez ensuite Edition > Insérer > Silence, puis précisez le nombre de secondes. Le son
placé à droite est repoussé dans le temps, augmentant ainsi la durée. Les clips multipistes sont fractionnés si nécessaire.

Voir aussi
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Haut de la page

Haut de la page

Sélectionner des plages temporelles
Sélection de plages spectrales
Sélection et correction automatique d’artefacts
Sélection de la totalité d’une forme d’onde
Spécification des canaux à modifier
Réglage d’une sélection sur des points de passage à zéro
Accrochage du curseur à des marqueurs, des règles, des trames et des passages à zéro

Sélectionner des plages temporelles

1. Dans la barre d’outils, sélectionnez l’outil de sélection temporelle .
2. Effectuez l’une des opérations suivantes :

Pour sélectionner une plage, faites glisser le curseur dans le panneau Editeur.

Glissement pour sélectionner des plages temporelles

Pour étendre ou réduire une sélection, faites-en glisser les bords (cliquez en appuyant sur la touche Maj sur les bords afin
d’étendre rapidement une sélection jusqu’à un emplacement spécifique).

Remarque : il est également possible d’étendre ou de raccourcir une sélection en cliquant à l’aide du bouton droit de la
souris. Pour utiliser cette fonctionnalité, activez l’option Étendre la sélection dans la section Général de la boîte de
dialogue Préférences.

Sélection de plages spectrales
Lorsque vous travaillez sur un affichage spectral, vous pouvez utiliser le Rectangle de sélection, le Lasso ou le Pinceau pour sélectionner les
données audio au sein de plages spectrales spécifiques. L’outil Rectangle de sélection vous permet de sélectionner une zone rectangulaire. Les
outils Lasso et Pinceau permettent d’effectuer des sélections de forme irrégulière. Les trois outils permettent une édition et un traitement détaillés
et offrent également une remarquable souplesse dans le travail de restauration des données audio. Par exemple, si vous décelez des artefacts
audio, vous pouvez sélectionner et modifier uniquement les fréquences concernées, ce qui donne des résultats supérieurs avec un traitement plus
rapide.

L’outil Pinceau crée des sélections uniques qui déterminent l’intensité des effets appliqués. Pour régler l’intensité, étalez les coups de pinceaux en
couche ou modifiez le paramètre Opacité dans la barre d’outils. Plus la zone blanche sélectionnée est opaque, plus les effets appliqués sont
intenses.
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Types de sélections spectrales
A.  Rectangle de sélection B.  Lasso C.  Pinceau

1. Dans la barre d’outils, sélectionnez l’outil Rectangle de sélection , Lasso  ou Pinceau .
2. Dans le panneau Editeur, faites glisser l’outil dans l’affichage spectral afin de sélectionner les données audio de votre choix.

Remarque : lorsque vous effectuez une sélection dans une forme d’onde stéréo, elle s’applique par défaut à tous les
canaux. Pour sélectionner les données audio de canaux spécifiques, sélectionnez-les dans le menu Edition > Activer les
canaux.

3. Pour affiner la sélection, effectuez l’une des opérations suivantes :

Pour déplacer la sélection, placez le pointeur dans la sélection, puis faites-le glisser jusqu’à l’emplacement voulu.

Pour redimensionner la sélection, placez le pointeur sur le coin ou le bord de la sélection, puis faites-le glisser pour obtenir
la taille souhaitée. (Pour les sélections au pinceau, vous pouvez également ajuster le paramètre Epaisseur du pinceau
dans la barre d'outils.)

Pour ajouter un élément au Lasso de sélection ou au Pinceau d’effets, déplacez celui-ci tout en maintenant la touche Maj
enfoncée. Pour retirer un élément de la sélection, il faut le faire glisser tout en maintenant la touche Alt enfoncée.

Pour déterminer l’intensité des effets appliqués aux sélections au pinceau, réglez le paramètre Opacité dans la barre
d’outils.

Par défaut, Adobe Audition lit uniquement les données audio de la sélection spectrale. Pour entendre toutes les données audio d’une même
plage temporelle, cliquez avec le bouton droit sur le bouton Lecture , puis désélectionnez l’option Lire la sélection spectrale uniquement.

Sélection et correction automatique d’artefacts
Pour la réparation la plus rapide de petits artefacts individuels, tels que les clics ou les pops isolés, servez-vous du Correcteur de tons directs.
Lorsque vous sélectionnez des données audio à l’aide de cet outil, celui-ci applique automatiquement la commande Favoris > Correction
automatique.

Remarque : La correction automatique est optimisée pour les petits artefacts audio et se limite par conséquent aux sélections de quatre
secondes ou moins.

1. Dans la barre d’outils, sélectionnez l’outil Correcteur de tons directs .
2. Réglez le paramètre Epaisseur pour modifier le diamètre des pixels. ou appuyez sur les touches de crochets.
3. Dans le panneau Editeur, cliquez en maintenant le bouton de la souris enfoncé sur un artefact audio dans l’affichage spectral

ou faites glisser l’outil dessus.
Remarque : si vous cliquez sans maintenir le bouton de la souris enfoncé, Audition déplace l’indicateur d’instant présent afin
que vous puissiez prévisualiser l’audio, mais sans le réparer. Pour réparer l’audio en cliquant, sélectionnez l’option Créer une
sélection circulaire lorsque le bouton de la souris est enfoncé dans la section Général des préférences.
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Suppression instantanée d’un artefact à l’aide du Correcteur de tons directs
A.  Avant B.  Après

Sélection de la totalité d’une forme d’onde
 Effectuez l’une des opérations suivantes :

Pour sélectionner la plage visible d’une forme d’onde, cliquez deux fois dans le panneau Editeur.

Pour sélectionner l’ensemble d’une forme d’onde, cliquez trois fois dans le panneau Editeur.

Spécification des canaux à modifier
Par défaut, Adobe Audition applique les sélections et les modifications à tous les canaux d’une forme d’onde stéréo ou surround. Vous pouvez
toutefois facilement sélectionner et modifier des canaux spécifiques.

 A droite du panneau Editeur, cliquez sur les boutons de canal dans la règle d’amplitude. Pour un fichier stéréo, par exemple, cliquez sur le
bouton du canal de gauche  ou du canal de droite .

Pour sélectionner un canal stéréo simplement en faisant glisser le curseur tout en haut ou tout en bas du panneau Editeur, sélectionnez
Autoriser l’édition de canaux contextuelle dans la section Général de la boîte de dialogue Préférences.

Sélection de canaux spécifiques d’un fichier surround 5.1

Réglage d’une sélection sur des points de passage à zéro
Pour bon nombre de tâches d’édition, telles que la suppression ou l’insertion de son, il est conseillé de commencer et de terminer les sélections
aux passages à zéro (points où l’amplitude est nulle). Ceci permet d’éviter la création de pops ou de clics audibles.

 Pour régler une sélection aux points de passage à zéro les plus proches, sélectionnez Edition > Passages à zéro. Sélectionnez ensuite une
option telle que Régler la sélection vers l’intérieur (qui déplace les deux bords vers l’intérieur jusqu’au prochain passage à zéro).

Toutes les modifications font l’objet d’un fondu croisé, afin de réduire davantage les risques de pops ou de clics. Vous pouvez modifier la durée
des fondus croisés dans la section Données de la boîte de dialogue Préférences.

Accrochage du curseur à des marqueurs, des règles, des trames et des passages à zéro
L’accrochage entraîne le déplacement des bords de la sélection, ainsi que de l’indicateur d’instant présent, vers des éléments tels que des
marques, des graduations de la règle, des points de passage à zéro et des trames. L’activation de cette fonction permet une sélection précise,
mais vous pouvez la désactiver pour des éléments spécifiques, si vous préférez.

1. Pour activer l’accrochage des éléments sélectionnés, cliquez sur l’icône Activer/désactiver l’accrochage  située en haut du
panneau Editeur.

2. Pour préciser à quels éléments les accrocher, sélectionnez Edition > Accrochage, puis sélectionnez l’une des options
suivantes :
Accrocher aux marqueurs Permet d’accrocher le curseur à un point de marqueur. Pour plus d’informations sur la définition



 

des marques, voir la section Utilisation des marqueurs.

Accrocher à la règle (Brut) S’accroche uniquement aux principales divisions numériques (minutes et secondes, par
exemple) de la ligne temporelle.
Remarque : vous ne pouvez activer qu’une seule commande d’accrochage à la règle à la fois.

Accrocher à la règle (fin) S’accroche aux subdivisions (millisecondes, par exemple) de la ligne temporelle. Effectuez un
zoom avant (cliquez avec le bouton droit sur la ligne temporelle et faites-la glisser) afin d’afficher des subdivisions plus
précises et de mieux placer le curseur.

Accrocher aux passages à Zéro Permet d’accrocher le curseur au point d’intersection le plus proche entre les données
audio et la ligne médiane (point d’amplitude zéro).

Accrocher aux trames Permet d’accrocher le curseur au bord d’une trame si le format temporel est mesuré en trames (CD et
SMPTE, notamment).

Vous pouvez accéder aux options d’accrochage en cliquant à l’aide du bouton droit de la souris sur la ligne temporelle.

Voir aussi
A propos de l’affichage spectral

Personnalisation de l’affichage spectral

Accrochage du curseur aux extrémités des clips
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Annulation ou rétablissement de modifications
Comparaison des états de l’historique

Annulation ou rétablissement de modifications
À chaque démarrage, Adobe Audition effectue le suivi des modifications que vous apportez. Les modifications ne s’appliquent pas de manière
permanente tant que vous n’avez pas enregistré et fermé un fichier. Vous pouvez donc les annuler et les rétablir à votre guise.

 Pour annuler ou rétablir des modifications, effectuez l’une des opérations suivantes :

Pour annuler une modification, choisissez Edition > Annuler [nom de la modification]

Pour rétablir une modification, choisissez Edition > Rétablir [nom de la modification].

Pour répéter la dernière commande exécutée dans l’éditeur de forme d’onde, sélectionnez Edition > Répéter la dernière
commande. Vous pouvez répéter toutes les commandes, à quelques exceptions près (Supprimer, par exemple).

Pour répéter la dernière commande sans ouvrir sa boîte de dialogue, appuyez sur Ctrl + R (Windows) ou Commande + R
(Mac OS).

Comparaison des états de l’historique
Alors que les commandes Annuler et Rétablir vous limitent à une suite de changements incrémentiels, le panneau Historique vous permet de
revenir instantanément à n’importe quel changement préalable. Utilisez le panneau pour comparer rapidement les données audio traitées et
d’origine ou éliminer une suite de changements qui donnent des résultats indésirables.

Remarque : les états de l’historique disparaissent lorsque vous fermez le fichier.

Retour aux états

Pour revenir à un état de l’historique, cliquez dessus.

Pour se déplacer graduellement d’un état à l’autre, appuyez sur les flèches Haut et Bas sur le clavier.

Suppression d’états
Lorsque vous utilisez des fichiers audio volumineux, supprimez les états de l’historique inutiles afin de libérer de l’espace disque et d’améliorer les
performances.

Pour supprimer tous les états, choisissez Effacer l’historique dans le menu du panneau .

Pour supprimer un état spécifique, sélectionnez-le, puis cliquez sur l’icône de corbeille .

Remarque : la suppression d’états de l’historique entraîne également la suppression des commandes Annuler correspondantes.

  |  

http://creativecommons.org/licenses/by-nc-sa/3.0/


Fondu et modification de l’amplitude de manière visuelle

Haut de la page

Fondu visuel en entrée ou en sortie
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Accrochage ou masquage de la commande d’amplitude visuelle

Différents effets peuvent modifier l’amplitude ou produire des fondus ; toutefois, les commandes visuelles de fondu et de gain permettent
d’effectuer cette tâche avec rapidité et intuitivité. Au fur et à mesure que vous faites glisser ces commandes dans le panneau Editeur, un aperçu
vous aide à ajuster les données audio de manière précise.

Commandes visuelles dans le panneau Editeur
A.  Commandes de fondu B.  Commande de gain (affichage tête haute)

Pour un fondu rapide de l’audio sélectionné, choisissez Favoris > Fondu d’entrée ou Fondu de sortie.

Fondu visuel en entrée ou en sortie
Adobe Audition propose trois types de fondu visuel :

Les fondus linéaires produisent une modification de volume uniforme qui fonctionne bien sur un grand nombre de matériaux.
Cependant, lorsque le fondu est trop brutal, essayez l’une des autres options.

Les fondus logarithmiques changent progressivement de volume, d’abord lentement puis rapidement ou vice versa.

Les fondus cosinus ont la forme d’une courbe en S et changent de volume lentement au début, puis rapidement au niveau du
corps du fondu et lentement à la fin.

Remarque : dans l’éditeur de forme d’onde, les fondus modifient définitivement les données audio. Pour appliquer des fondus que vous pourrez
réajuster dans l’éditeur de multipiste, consultez la rubrique Fondu ou fondu croisé de clips multipistes.

Types de fondus
A.  Linéaire B.  Logarithmique C.  Cosinus

 Dans la partie supérieure gauche ou droite de la forme d’onde, faites glisser la poignée Fondu en entrée  ou Fondu en sortie  vers l’intérieur,
puis effectuez l’une des tâches suivantes :

Pour obtenir un fondu linéaire, il faut faire glisser l’élément parfaitement à l’horizontale.

Pour effectuer un fondu logarithmique, faites glisser vers le haut ou le bas.

Pour un fondu cosinus (courbe S), maintenez enfoncée la touche Ctrl (Windows) ou Commande (Mac OS).

Pour créer des fondus cosinus par défaut et maintenir enfoncées les touches ci-dessus afin de créer des fondus linéaires ou logarithmiques,
modifiez le paramètre Fondu par défaut dans la section Général des préférences.
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Augmentation ou diminution visuelle de l’amplitude
1. Dans le panneau Editeur, sélectionnez des données audio ou ne sélectionnez rien pour régler l’ensemble du fichier.
2. Dans la commande de gain qui flotte au-dessus du panneau, faites glisser les chiffres ou les boutons.

les chiffres donnent la nouvelle amplitude par rapport à l’amplitude existante. Lorsque vous relâchez le bouton de la souris, les
chiffres reviennent à 0 dB et vous pouvez apporter d’autres modifications.

Modification de volume d’une zone sélectionnée

Accrochage ou masquage de la commande d’amplitude visuelle
Par défaut, la commande d’amplitude visuelle apparaît dans un affichage tête haute qui flotte au-dessus de toutes les formes d’onde. Si cela vous
gêne, procédez de l’une des manières suivantes :

Pour ancrer l’affichage tête haute, cliquez sur le bouton Accrocher .

Pour afficher la commande tête haute uniquement sur les sélections en surbrillance, sélectionnez l’option Affichage tête haute
visible uniquement pour les plages de sélection dans les préférences générales.

Pour masquer totalement l’affichage tête haute, désélectionnez l’option Affichage > Affichage tête haute activé.

Voir aussi
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Effects Rack overview
Use effect presets
Control effect settings with graphs
About spline curves for graphs

Effects Rack overview
The Effects Rack lets you insert, edit, and reorder up to 16 effects, optimize mix levels, and store favorite presets. Most rack controls appear in
both the Waveform and Multitrack editors.

Controls shared by the Waveform and Multitrack editors 
A. Rack Preset controls B. Effect slots C. Level controls D. Main Power button 

Controls unique to the Waveform Editor
In the Waveform Editor, the Effects Rack provides a Process menu that that lets you modify a selection or the entire file, and an Apply button that
permanently applies effects.

Controls unique to the Waveform Editor 
A. Apply button permanently applies effects B. Process menu lets you modify selection or entire file 

Controls unique to the Multitrack Editor
The Effects Rack provides Pre-render Track and FX Pre/Post-Fader buttons that you use to optimize and route effects. Each clip and track has its
own Effects Rack, which is saved with the session.

Buses and the Master track lack a Pre-render option because processing effects from all source tracks would reduce performance.

Controls unique to the Multitrack Editor 
A. FX Pre/Post-Fader B. Pre-render 

Set input, output, and mix levels in racks
To optimize volume, adjust Input and Output levels so their meters peak without clipping.
To change the percentage of processed audio, drag the Mix slider. 100% (Wet) equals fully processed audio; 0% (Dry) equals
original, unprocessed audio.

Insert, bypass, reorder, or remove effects in racks
In the Effects Rack, you manage groups of effects by using individual effect slots.

In the Multitrack Editor, the fx section of the Editor panel or Mixer provides quick access to slots in the Effects Rack.
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Reordering and inserting effects in racks: 
A. Reorder by dragging B. Insert with the slot menu 

To insert an effect, choose it from a slot’s pop-up menu. Then adjust effect settings as desired.

To later reaccess effect settings, double-click the effect name in the rack.

To bypass an effect, click its Power button .

To bypass all effects, click the main Power button in the lower left corner of a rack, or the fx power button in the Editor panel or
Mixer.

To bypass a selected group of effects, choose Toggle Power State of Selected Effects from the panel menu .

Bypass effects to quickly compare processed and unprocessed audio.

To remove a single effect, choose Remove Effect from a slot’s pop-up menu. Or select the slot, and press Delete.

To remove all effects, choose Remove All Effects from the panel menu .

To reorder effects, drag them to different slots.

Reordering effects produces different sonic results. (For an example, place Reverb prior to Phaser, and vice versa.)

Use effect presets
Many effects provide presets that let you store and recall favorite settings. In addition to effect-specific presets, the Effects Rack provides rack
presets that store groups of effects and settings.

To apply a preset, choose it from the Presets menu.

1. To save current settings as a preset, click the New Preset button .

To delete a preset, select it, and click the Delete button .

To modify an existing preset, apply it, adjust settings as desired, and then save a new preset with the same name.

Control effect settings with graphs
Many Adobe Audition effects provide graphs where you can adjust parameters. By adding and moving control points on the graph, you can
precisely tailor effect settings.

Graph control points function together with related numerical settings. If you change or disable a numerical setting, the related graph control
follows suit.
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Moving a control point changes the related settings, and vice versa.

To move a point on a graph, drag it to a new location.

The following techniques don’t apply to the DeHummer, Mastering, Full Reverb, Parametric Equalizer, and Track EQ
graphs.

To add a control point to a graph, click in the grid at the location where you want to place the point.

To enter numeric values for a control point, right-click it, and choose Edit Point

To remove a point from a graph, drag it off the graph.

To return a graph to its default state, click the Reset button .

About spline curves for graphs
By default, graphs display straight lines between control points. However, some graphs provide a Spline Curves option that creates a curve
between control points for smoother transitions.

When you use spline curves, lines don’t travel directly through control points. Instead, the points control the shape of the curve. To move the
curve closer to a control point, click near it to create a cluster of control points.

Graph with straight lines compared to graph with spline curves

Apply groups of effects in the Waveform Editor

Favorites
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Applying effects in the Multitrack Editor
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Apply effects to clips or tracks
Pre-render track effects to improve performance
Insert effects before or after sends and EQ

Apply effects to clips or tracks
In the Multitrack Editor, you can apply up to 16 effects to each clip, track, and bus and adjust them while a mix plays. (Apply clip effects if a track
contains multiple clips that you want to process independently.)

You can insert, reorder, and remove effects in the Editor, Mixer, or Effects Rack panel. Only in the Effects Rack, however, can you save favorite
settings as presets, which you can apply to multiple tracks.

In the Multitrack Editor, effects are nondestructive, so you can change them at any time. To readapt a session for different projects, for example,
simply reopen it and change effects to create new sonic textures.

Revealing effect slots in the Editor panel

1. Do any of the following:
Select a clip, and click Clip Effects at the top of the Effects Rack.

Select a track, and click Track Effects at the top of the Effects Rack.

Display the fx section of the Editor or Mixer. (In the Editor panel, click the button  in the upper-left corner.)

2. Choose effects for up to 16 slots in the list. (See Insert, bypass, reorder, or remove effects in racks.)
3. Press the spacebar to play the session, and then edit, reorder, or remove effects as needed.

To change effect settings over time, use envelopes. (See Automating mixes with envelopes.)

Pre-render track effects to improve performance
In the Multitrack Editor, pre-render track effects to address heavy CPU usage, improving performance for complex mixes or low-latency recording.
(Latency measures the delay between user input and sound output from a computer. If latency is high, it produces an audible echo during
recording, disrupting timing for musicians.)

You can continue to edit track settings normally; pre-rendering processes audio when pauses occur in playback or editing.

In the Editor panel, Effects Rack, or Mixer, click the Pre-Render Track button .

Insert effects before or after sends and EQ
On each track, you can insert effects either pre- or post-fader. Pre-fader effects process audio before sends and EQ. Post-fader effects process
audio after sends and EQ. For most mixes, the default, pre-fader setting works well. The post-fader setting offers signal-routing flexibility for
particularly complex mixes.

In the fx section of the Editor panel or Mixer, click the Pre-Fader/Post-Fader button to insert effects either before sends and
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EQ , or after .

If you’re editing effect settings in the Effects Rack, click the Pre-Fader/Post-Fader button in the lower-left corner.

Pre- and post-fader effect and send routing for each track: 
A. Input B. EQ C. Volume D. Mute E. Send F. Effects Rack 

Routing audio to buses, sends, and the Master track

Set up a send
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Ajout de modules externes tiers

 

Les modules externes tiers vous permettent d’étendre les effets déjà performants proposés par Adobe Audition. L’application prend en charge les
modules externes VST sur les deux plates-formes, ainsi que les modules externes Audio Units sur Mac OS.

L’application d’effets d’un module externe est identique à celle d’effets intégrés. Pour des informations sur les fonctionnalités de modules externes,
reportez-vous à la documentation fournie par le fabricant concerné.

Activation des modules externes VST et Audio Units
Pour accéder dans Adobe Audition aux modules externes tiers, vous devez tout d’abord les activer. Tous les modules externes tiers sont
désactivés par défaut. Pour optimiser les performances, activez uniquement les modules externes que vous comptez utiliser dans Adobe Audition.

Remarque : si les effets sont utilisés dans une session multipiste, fermez celle-ci.

1. Sélectionnez Effets > Gestionnaire de modules externes audio.

2. Dans la section Dossiers des modules externes VST, cliquez sur Ajouter afin de sélectionner les dossiers dans lesquels
rechercher des modules externes. Cliquez sur Par défaut afin de définir le dossier VST standard de votre système
d’exploitation.

3. Dans la section Modules externes disponibles, cliquez sur Rechercher des modules externes.

Si vous avez récemment mis à jour un module externe, sélectionnez Réanalyser les modules externes existants.

4. Sélectionnez les modules externes auxquels vous souhaitez accéder dans Adobe Audition, puis cliquez sur OK.

Remarque : si un effet tiers n’est pas compatible, Adobe Audition l’ajoute dans la liste des effets non pris en charge.

Voir aussi
Application d’effets dans l’éditeur de multipiste

Automatisation des paramètres de piste
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http://helpx.adobe.com/en/audition/using/applying-effects-multitrack-editor.html
http://helpx.adobe.com/en/audition/using/automating-mixes-envelopes1.html#automating_track_settings
http://creativecommons.org/licenses/by-nc-sa/3.0/


Application d’effets dans l’éditeur de forme d’onde
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Application de groupes d’effets dans l’éditeur de forme d’onde
Application d’effets individuels dans l’éditeur de forme d’onde
A propos des effets de processus

Lors de la prévisualisation des effets, vous pouvez ajuster les sélections et l’indicateur d’instant présent dans le panneau Editeur (à l’exception
des effets Normaliser et Expansion et compression).

Application de groupes d’effets dans l’éditeur de forme d’onde
Grâce au rack d’effets de l’éditeur de forme d’onde, vous pouvez appliquer des groupes d’effets (ce rack n’intègre pas d’effets de traitement, telle
la réduction du bruit, qui doivent être appliqués de manière individuelle).

1. Sélectionnez Fenêtre > Rack d’effets.
2. Dans la liste numérotée, sélectionnez des effets pour un maximum de 16 emplacements (Voir la section Insertion,

contournement, réorganisation et suppression d’effets dans les racks).
3. Lancez la lecture pour prévisualiser les modifications, puis modifiez, mélangez et réorganisez les effets à votre guise.

Pour comparer les données audio traitées à celles d’origine, activez et désactivez le bouton Marche/Arrêt principal situé
dans le coin inférieur gauche du rack ou le bouton Marche/Arrêt de chaque effet.

4. Pour appliquer les modifications aux données audio, cliquez sur Appliquer.
Pour enregistrer des paramètres, enregistrez une préconfiguration de rack. (Voir la section Utilisation des préconfigurations
d’effets).

Application d’effets individuels dans l’éditeur de forme d’onde
1. Sélectionnez un effet dans un sous-menu du menu Effets.

2. Cliquez sur le bouton Prévisualiser , puis modifiez les paramètres à votre convenance.
Lors de la modification des paramètres, observez le panneau Niveaux afin d’optimiser l’amplitude.

3. Pour comparer les données audio d’origine à celles traitées, sélectionnez et désélectionnez le bouton Marche/arrêt .
4. Pour appliquer les modifications aux données audio, cliquez sur Appliquer.

A propos des effets de processus
Vous pouvez identifier les effets de processus d’après le mot processus qui s’affiche dans les commandes de menu. Ces effets gourmands en
ressources sont uniquement accessibles hors connexion, dans l’éditeur de forme d’onde. Contrairement aux effets en temps réel, les effets de
processus peuvent uniquement être appliqués individuellement. Ils ne sont donc pas accessibles dans le rack d’effets.

Voir aussi
Présentation du rack d’effets

Utilisation des préconfigurations d’effets

Commande des paramètres d’effets dans des graphiques

  |  
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Référence aux effets

Il se peut qu’une partie du contenu lié depuis cette page apparaisse uniquement en anglais.



Effets d’amplitude et de compression
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Effet Amplification
Effet Mélangeur de canaux
Effet Déesseur
Effet Traitement de la dynamique
Effet Limitateur fixe
Effet Compresseur multibande
Effet Normaliser (éditeur de forme d’onde uniquement)
Effet Compresseur monobande
Effet Aplanisseur du volume de discours
Effet Compresseur à modélisation de tube
Effet Enveloppe de volume (éditeur de forme d’onde CS5.5 uniquement)

Effet Amplification
L’effet Amplitude et compression > Amplification permet de renforcer ou d’atténuer un signal audio. Puisque l’effet agit en temps réel, vous pouvez
le combiner à d’autres effets du rack d’effets.

Curseurs de gain Amplifient ou atténuent les canaux audio individuels.
Curseurs de lien Déplace les curseurs de canaux conjointement.

Effet Mélangeur de canaux
L’effet Amplitude et compression > Mélangeur de canaux modifie l’équilibre des canaux stéréo ou surround, ce qui vous permet de modifier la
position apparente des sons et de corriger les niveaux discordants ou les problèmes de phasage.

Liste de canaux Permet de sélectionner le canal de sortie.
Curseurs du canal d’entrée Déterminent le pourcentage des canaux actifs à mélanger dans le canal de sortie. Pour un fichier stéréo, par
exemple, une valeur G de 50 et une valeur R de 50 génèrent un canal de sortie qui contient autant de données audio des canaux de gauche et de
droite actifs.
Inverser Inverse une phase de canal (pour comprendre ce concept audio essentiel, voir la section Méthodes d’interaction des ondes sonores).
L’inversion de tous les canaux n’entraîne aucune différence sonore perceptible. L’inversion d’un seul canal peut toutefois grandement modifier le
son.

Effet Déesseur
L’effet Amplitude et compression > Déesseur supprime les sifflements (sons « S » audibles dans les discours et les chansons qui risquent de
distordre les hautes fréquences).

Le graphique révèle les fréquences traitées. Cliquez sur le bouton Prévisualiser  pour savoir combien de contenu audio existe dans la plage
traitée.

Mode Sélectionnez Bande large pour compresser uniformément toutes les fréquences ou Multibande pour compresser uniquement la plage de
sifflements. Le réglage Multibande est adapté à la plupart des contenus audio, mais il augmente légèrement le temps de traitement.
Seuil Définit l’amplitude au-dessus de laquelle survient la compression.
Centrer fréquence Définit la fréquence à laquelle les sifflements sont le plus intense. Pour vérifier, réglez ce paramètre pendant la lecture audio.
Bande passante Détermine la plage de fréquences qui déclenche le compresseur.

Pour régler visuellement la fréquence centrale et la bande passante, faites glisser les bords de la sélection dans le graphique.

Sifflements en sortie uniquement Vous permet d’entendre les sifflements détectés. Commencez la lecture, puis ajustez les paramètres ci-
dessus.
Réduction de gain Affiche le niveau de compression des fréquences traitées.

Effet Traitement de la dynamique
L’effet Amplitude et compression > Traitement de la dynamique peut faire office de compresseur, de limiteur ou d’extenseur. En tant que
compresseur et que limiteur, cet effet réduit la plage dynamique, ce qui génère des niveaux de volume cohérents. En tant qu’extenseur, il
augmente la plage dynamique en diminuant le niveau des signaux faibles. (Avec des paramètres d’expanseur extrêmes, vous pouvez créer une



porte de bruit qui élimine totalement le bruit au-dessous d’un seuil d’amplitude défini.)

L’effet Traitement de la dynamique peut produire des modifications subtiles que vous ne remarquez qu’après des écoutes répétées. Lorsque vous
appliquez cet effet dans la l’éditeur de forme d’onde, utilisez une copie du fichier original de manière à pouvoir rétablir le son de base, si
nécessaire.

Utilisez la préconfiguration Limiteur de diffusion afin de simuler le son traité d’une station de radio contemporaine.

Onglet Dynamique
Graphe Représente le niveau d’entrée sur la règle horizontale (axe des x) et le niveau de sortie sur la règle verticale (axe des y). Le graphe par
défaut, qui présente une ligne droite allant du coin inférieur gauche au coin supérieur droit, dépeint un signal resté intact ; chaque valeur d’entrée
possède le même niveau de sortie. L’ajustement du graphe modifie la relation entre les niveaux d’entrée et de sortie, altérant ainsi la plage
dynamique.
Si, par exemple, un élément sonore souhaitable se produit à environ -20 dB, vous pouvez amplifier le signal d’entrée à ce niveau, tout en laissant
tous les autres éléments inchangés. Vous pouvez également tracer une ligne inverse (du coin supérieur gauche au coin inférieur droit) qui va
drastiquement amplifier les sons silencieux et supprimer les sons intenses.

Ajouter un point Ajoute dans le graphe un point de contrôle à l’aide des niveaux d’entrée et de sortie numériques que vous précisez. Cette
méthode est plus précise que de cliquer sur le graphe pour y ajouter des points.

Pour ajuster numériquement un point de contrôle existant, cliquez dessus avec le bouton droit, puis sélectionnez Modifier le point.

Supprimer le point Supprime le point sélectionné du graphe.

Inverser Bascule le graphe, en convertissant la compression en expansion et réciproquement.
Remarque : vous pouvez inverser un graphe uniquement s’il possède des points dans les deux coins par défaut (-100, -100 et 0, 0) et que son
niveau de sortie augmente de gauche à droite (c’est-à-dire que chaque point de contrôle doit être supérieur à celui se trouvant à sa gauche).

Réinitialiser Réinitialise le graphe à son état par défaut.
Courbes splines Crée des transitions plus lisses et courbes entre les points de contrôle, plutôt que des transitions linéaires plus abruptes (Voir la
section A propos des courbes splines des graphiques).
Ajustement du gain Amplifie le signal traité.

Onglet Paramètres
Général Fournit les paramètres généraux.

Temps d’anticipation  Corrige les pics transitoires susceptibles de survenir au début des signaux extrêmement forts qui s’étendent au-
delà des paramètres Temps d’attaque du compresseur. En étendant le temps d’anticipation, la compression attaque avant que l’audio ne
devienne fort, ce qui garantit que l’amplitude n’excède jamais un certain niveau. Inversement, la réduction du temps d’anticipation permet
d’améliorer l’impact de la musique à percussion telle que les battements de tambour.
Porte de bruit  Rend complètement silencieux les signaux étendus au-dessous d’un rapport de 50 contre 1.

Détecteur de niveau Détermine l’amplitude d’entrée d’origine.

Gain d’entrée  Applique un gain au signal avant qu’il ne pénètre dans le détecteur de niveau.
Temps d’attaque  Détermine le délai en millisecondes requis par le signal d’entrée pour enregistrer un niveau d’amplitude modifié. Si, par
exemple, l’audio chute soudainement de 30 dB, le temps d’attaque précisé s’écoule avant que l’entrée n’enregistre une modification de
l’amplitude. Ceci permet d’éviter les lectures d’amplitude erronées dues à des modifications temporaires.
Temps de relâchement  Détermine le délai en millisecondes pendant lequel le niveau d’amplitude actuel est conservé avant qu’une autre
modification d’amplitude ne soit enregistrée.

Utilisez les paramètres d’attaque et de relâchement rapides pour les données audio ayant des transitions rapides, et des paramètres
plus lents pour des données audio avec moins de percussions.

Mode Crête  Détermine les niveaux en fonction des pics d’amplitude. Ce mode est légèrement plus difficile à utiliser que le RMS, car les
pics ne sont pas précisément reproduits dans le graphe Dynamique. Il s’avère toutefois utile lorsque vous souhaitez atténuer certains pics
transitoires forts des données audio.
Mode RMS  Détermine les niveaux en fonction de la moyenne quadratique, qui permet d’établir une moyenne plus proche de la façon
dont les individus perçoivent le volume. Ce mode reproduit précisément les amplitudes du graphe Dynamique. Par exemple, un limitateur
(ligne plane horizontale) à -10 dB reflète une amplitude moyenne quadratique (RMS) de -10 dB.

Processeur de gain Amplifie ou atténue le signal en fonction de l’amplitude détectée.

Gain de sortie  Applique le gain au signal de sortie une fois le traitement de la dynamique terminé.
Temps d’attaque  Détermine le délai en millisecondes requis pour que le signal de sortie atteigne le niveau spécifié. Si, par exemple,
l’audio chute soudainement de 30 dB, le temps d’attaque précisé s’écoule avant que le niveau de sortie ne change.
Temps de relâchement  Détermine le délai en millisecondes requis pour conserver le niveau de sortie actuel.
Remarque : si la somme des temps d’attaque et de relâchement est trop courte (moins de 30 millisecondes environ), des artefacts
peuvent être audibles. Pour connaître les temps d’attaque et de relâchement appropriés en fonction du type de contenu audio,
sélectionnez les diverses options du menu Préconfigurations.
Lier canaux  Traite de manière équivalente tous les canaux, en préservant l’équilibre stéréo ou surround. Par exemple, un battement de
tambour compressé sur le canal de gauche entraîne une réduction équivalente du niveau du canal de droite.
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Limitation des bandes Restreint le traitement de la dynamique à une plage de fréquences spécifique.

Fréquence de coupure basse  Indique la fréquence la plus basse qu’affecte le traitement dynamique.
Fréquence de coupure élevée  Indique la fréquence la plus haute qu’affecte le traitement dynamique.

Effet Limitateur fixe
L’effet Amplitude et compression > Limitateur fixe atténue considérablement les données audio qui dépassent un seuil défini. En général, la
limitation s’applique avec une amplification d’entrée, une technique qui augmente le volume général tout en évitant les distorsions.

Amplitude maximale Définit l’amplitude maximum autorisée pour les échantillons.
Pour éviter un écrêtage lors de l’utilisation de données audio de 16 bits, définissez cette valeur sur -0,3 dB au maximum. Si vous définissez
une valeur encore plus faible (à -3 dB), vous disposez d’un peu plus de liberté pour les modifications ultérieures.

Amplification en entrée Pré-amplifie le son avant la limitation, ce qui vous permet de rendre une sélection plus forte sans écrêtage. Plus vous
augmentez ce niveau, plus la compression augmente. Essayez des paramètres extrêmes afin d’obtenir le son intense et à fort impact audible dans
la musique pop contemporaine.
Temps d’anticipation Définit le délai (en millisecondes) généralement requis pour atténuer le son avant que la crête la plus forte soit atteinte.
Remarque : veillez à ce que cette valeur ne soit pas inférieure à 5 millisecondes. Si cette valeur est trop faible, des effets de distorsion audibles
peuvent se produire.
Temps de relâchement Définit le délai (en millisecondes) requis pour que l’atténuation remonte à 12 dB (ou, globalement, le temps nécessaire
pour que le son retrouve un volume normal après avoir rencontré une crête extrêmement forte). En règle générale, un paramètre d’environ 100
(valeur par défaut) fournit de bons résultats et préserve les fréquences très basses.
Remarque : si cette valeur est trop élevée, le son peut rester très faible et ne pas revenir à des niveaux normaux avant un certain temps.
Lier canaux Lie l’intensité sonore de tous les canaux, en préservant l’équilibre stéréo ou surround.

Effet Compresseur multibande
L’effet Amplitude et compression > Compresseur multibande permet de compresser quatre bandes de fréquences différentes de manière
indépendante. En règle générale, chaque bande est constituée de contenu dynamique unique. Par conséquent, la compression multibande s’avère
un outil particulièrement performant dans le cadre de la mastérisation audio.

Grâce aux commandes de l’effet Compresseur multibande, vous pouvez définir des fréquences de répartition et appliquer des paramètres de
compression spécifiques de la bande. Cliquez sur les boutons Solo pour prévisualiser des bandes isolées ou sur les boutons Ignorer pour ignorer
des bandes sans leur appliquer de traitement. Après avoir réglé des bandes de manière individuelle, ajustez-les de manière globale à l’aide des
commandes de lien de bande, puis optimisez le volume global à l’aide du curseur Gain de sortie et des paramètres du limiteur.

Pour modifier les paramètres de compression au fil du temps, utilisez des pistes d’automatisation dans l’éditeur de multipiste. (Voir la section
Automatisation des paramètres de piste).

Ajustement d’une fréquence de répartition dans l’effet Compresseur multibande
A.  Bandes de fréquences B.  Marqueurs de répartiteur C.  Bande ignorée (aucun traitement appliqué) D.  Échelle d’amplitude E.  Échelle de
fréquence

Répartiteur Définit les fréquences de répartition, qui déterminent la largeur de chaque bande. Spécifiez des fréquences basses, moyennes et
hautes ou faites glisser les marqueurs du répartiteur au-dessus du graphique.
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Commandes spécifiques d’une bande dans l’effet Compresseur multibande
A.  Solo B.  Ignorer C.  Curseur de seuil D.  Règles du niveau d’entrée E.  Règles de réduction du gain

Boutons Solo Permettent d’écouter des bandes de fréquences spécifiques. Activez un seul bouton Solo à la fois pour écouter une bande isolée
ou activez plusieurs boutons pour écouter plusieurs bandes simultanément.
Boutons Ignorer Permettent d’ignorer des bandes afin de ne leur appliquer aucun traitement.

Cliquez en appuyant sur la touche Alt (Windows) ou Option (Mac OS) sur les boutons Solo ou Ignorer afin d’appliquer rapidement à une bande
un paramètre unique.

Curseurs de seuil Permet de définir le niveau d’entrée correspondant au début de la compression. Les valeurs possibles sont comprises entre -
60 et 0 dB. Le paramètre optimal varie en fonction du contenu audio et du type musical. Pour comprimer uniquement les crêtes extrêmes et
conserver une plage plus dynamique, indiquez une valeur de seuil inférieure d’environ 5 dB au niveau d’entrée de crête. Pour comprimer
fortement les données audio et diminuer considérablement la gamme dynamique, utilisez une valeur inférieure d’environ 15 dB au niveau d’entrée
de crête.
Règles du niveau d’entrée Permet de mesurer l’amplitude d’entrée. Double-cliquez sur les règles pour réinitialiser les indicateurs de crêtes et de
clips.
Règles de réduction du gain Permet de mesurer la réduction d’amplitude à l’aide de règles rouges qui s’étendent de haut (réduction minimale)
en bas (réduction maximale).
Gain Amplifie ou coupe l’amplitude après compression. Les valeurs possibles sont comprises entre -18 et +18 dB, 0 correspondant au gain
d’unité.
Taux Définit un taux de compression allant de 1:1 à 30:1. Par exemple, la valeur 3,0 génère une sortie de 1 dB pour chaque augmentation de
3 dB au-dessus du seuil de compression. Les valeurs sont généralement comprises entre 2,0 et 5,0. Toutefois, les valeurs élevées génèrent un
son fortement compressé souvent caractéristique de la musique pop.
Attaque Détermine la vitesse d’application de la compression en cas de dépassement du seuil. Les valeurs possibles sont comprises entre 0 et
500 millisecondes. La valeur par défaut (10 millisecondes) convient à la plupart des données audio. Les valeurs élevées permettent d’obtenir de
meilleurs résultats avec un son à transitoires rapides, mais elles paraissent peu naturelles pour les données audio moins percutantes.
Relâchement Détermine la vitesse d’arrêt de la compression lorsque les données audio deviennent inférieures au seuil. Les valeurs possibles
sont comprises entre 0 et 5000 millisecondes. La valeur par défaut (100 millisecondes) convient à la plupart des données audio. Augmentez la
valeur pour un son à transitoires rapides et diminuez-la pour les données audio moins percutantes.
Gain de sortie Amplifie ou coupe le niveau de sortie global après compression. Les valeurs possibles sont comprises entre -18 et +18 dB, 0
correspondant au gain d’unité. Double-cliquez sur les règles pour réinitialiser les indicateurs de crêtes et de clips.
Limiteur Permet d’appliquer une limitation après le gain de sortie, à la fin de la trajectoire du signal, afin d’optimiser les niveaux généraux.
Déterminez des paramètres de seuil, d’attaque et de relâchement moins agressifs que des paramètres de bande similaires. Indiquez ensuite un
paramètre de marge afin de spécifier le plafond absolu relatif à 0 dBFS.

Pour créer des données audio extrêmement compressées, activez le limiteur, puis testez des paramètres de gain de sortie très élevés.

Spectre sur entrée Affiche le spectre de fréquences du signal d’entrée au lieu du signal de sortie dans le graphique multibande. Pour visualiser
rapidement le taux de compression appliqué à chaque bande, activez et désactivez cette option.
Limiteur pente de coupure raide Applique une limitation fixe immédiate pour le paramètre de marge actuel. (Désactivez cette option pour
appliquer une limitation légère plus lente, qui semble moins compressée, mais risque de dépasser le paramètre de marge.)
Remarque : le temps d’attaque maximal pour la limitation de pente de coupure raide est de 5 ms.
Commandes de lien de bande Permet de modifier les paramètres de compression de manière globale pour toutes les bandes tout en respectant
les différences relatives entre les bandes.

Pour lier temporairement les commandes de lien de bande, maintenez enfoncées les touches Alt + Maj (Windows) ou Option + Maj (Mac OS).
Pour réinitialiser une commande sur toutes les bandes, maintenez enfoncées les touches Ctrl + Alt + Maj (Windows) ou
Commande + Option + Maj (Mac OS), puis cliquez sur la commande.

Effet Normaliser (éditeur de forme d’onde uniquement)
Remarque : cet effet nécessite un traitement hors ligne. Lorsqu’il est activé, vous ne pouvez pas modifier la forme d’onde, ajuster les sélections
ni déplacer l’indicateur d’instant présent.
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L’effet Amplitude et compression > Normaliser permet de définir un niveau de crête pour un fichier ou une sélection. Lorsque vous normalisez le
son à 100 %, vous obtenez l’amplitude maximale autorisée par le son numérique, à savoir 0 dBFS. Si, toutefois, vous envoyez les données audio
à un ingénieur de mastérisation, normalisez le son entre -3 et -6 dBFS afin de créer une atténuation pour un traitement ultérieur.

L’effet Normaliser amplifie la qualité de l’ensemble du fichier ou de la sélection. Par exemple, si le son original atteint une crête de 80 % et un
creux de 20 %, la normalisation à 100 % amplifie la crête à 100 % et le creux à 40 %.

Pour appliquer la normalisation RMS, sélectionnez Effets > Ajuster le volume. Si vous le souhaitez, vous pouvez appliquer cette commande à
un fichier unique (Voir la section Ajustement du volume dans plusieurs fichiers.)

Normaliser à Définit le pourcentage du pic le plus élevé par rapport à l’amplitude maximale possible.
Sélectionnez dB pour définir la valeur Normaliser en décibels plutôt qu’en pourcentage.

Normaliser tous les canaux à l’identique Utilise tous les canaux d’une forme d’onde stéréo ou surround afin de calculer le niveau
d’amplification. Si cette option n’est pas sélectionnée, l’amplification est calculée séparément pour chaque canal, avec le risque d’en amplifier l’un
des deux considérablement plus que les autres.
Ajustement de la correction DC Permet de régler la position de la forme d’onde dans l’affichage. Certains matériels d’enregistrement peuvent
appliquer une polarisation (correction DC) de telle façon que la forme d’onde enregistrée semble se situer au-dessus ou en dessous de la ligne
centrale normale dans l’affichage des ondes. Pour centrer la forme d’onde, définissez un pourcentage de zéro. Pour dévier l’ensemble de la forme
d’onde sélectionnée au-dessus ou en dessous de la ligne centrale, définissez un pourcentage positif ou négatif.

Effet Compresseur monobande
L’effet Amplitude et compression > Compresseur monobande réduit la plage dynamique, produisant ainsi des niveaux de volume constants et
augmentant l’intensité sonore perçue. La compression monobande est particulièrement efficace pour les voix hors champ, car elle permet de faire
ressortir la voix du narrateur par rapport à la bande musicale et au son d’arrière-plan.

Ecoutez de la musique de variété moderne pour obtenir des exemples de données audio très compressées. A l’inverse, la plupart des
enregistrements de jazz sont peu compressés et ceux de musique classique, pas du tout.

Seuil Permet de définir le niveau d’entrée correspondant au début de la compression. Le paramètre optimal varie en fonction du contenu audio et
du style. Pour comprimer uniquement les crêtes extrêmes et conserver une plage plus dynamique, indiquez une valeur de seuil inférieure
d’environ 5 dB au niveau d’entrée de crête. Pour comprimer fortement les données audio et diminuer considérablement la gamme dynamique,
utilisez une valeur inférieure d’environ 15 dB au niveau d’entrée de crête.
Taux Définit un taux de compression allant de 1:1 à 30:1. Par exemple, la valeur 3 génère une sortie de 1 dB pour chaque augmentation de 3 dB
au-dessus du seuil. Les valeurs sont généralement comprises entre 2 et 5. Toutefois, les valeurs élevées génèrent un son fortement compressé
souvent caractéristique de la musique pop.
Attaque Détermine la vitesse de démarrage de la compression lorsque les données audio deviennent supérieures au seuil. La valeur par défaut
(10 millisecondes) convient à la plupart des données source. Utilisez des paramètres plus rapides uniquement pour des données audio comportant
des transitoires rapides, par exemple des enregistrements de percussions.
Relâchement Détermine la vitesse d’arrêt de la compression lorsque les données audio deviennent inférieures au seuil. La valeur par défaut
(100 millisecondes) convient à la plupart des données audio. Augmentez la valeur pour un son à transitoires rapides et diminuez-la pour les
données audio moins percutantes.
Gain de sortie Amplifie ou coupe l’amplitude après compression. Les valeurs possibles sont comprises entre -30 dB et +30 dB, 0 correspondant
au gain d’unité.

Effet Aplanisseur du volume de discours
L’effet Amplitude et compression > Aplanisseur du volume de discours est un effet de compression qui optimise les dialogues, en égalisant les
niveaux et en supprimant le bruit de fond.

Pour obtenir de meilleurs résultats, procédez comme suit :

1. Sélectionnez la séquence audio avec le niveau le plus faible. Définissez le Niveau de volume cible et le Degré de nivellement
à gauche. Commencez la lecture, puis augmentez graduellement le Degré de nivellement jusqu’à ce que le discours devienne
plaisamment audible sans augmenter le bruit de fond.

2. Sélectionnez la séquence audio avec le niveau le plus élevé, puis commencez la lecture. Définissez le Niveau de volume cible
jusqu’à ce que le volume corresponde à l’intensité du passage silencieux que vous venez d’ajuster.

3. Si nécessaire, réajustez le Degré de nivellement afin d’éviter une surcompression du son.

Voici quelques détails supplémentaires sur chaque option :

Niveau de volume cible Définit le niveau de sortie souhaité par rapport à 0 dBFS (voir la section Mesure de l’amplitude en dBFS).
Degré de nivellement A un degré faible, amplifie légèrement le discours sans amplifier le niveau de bruit. A un degré élevé, amplifie davantage
l’intégralité du signal tandis que celui-ci se rapproche du niveau de bruit.
Amplifier les signaux faibles Interprète les passages plus courts à faible volume comme le discours à amplifier. Pour la plupart du contenu
audio, désélectionnez cette option pour générer un son plus lisse.
Avancé Cliquez sur le triangle afin d’accéder aux options suivantes :

http://helpx.adobe.com/en/audition/using/automating-common-tasks-cs6.html#match_volume_across_multiple_files
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Compresseur  Préserve un niveau fort si le signal traité chute en dessous d’un certain seuil par rapport à 0 dBFS.
Porte de bruit  Elimine le bruit de fond en réduisant considérablement le niveau de sortie lorsque le signal chute selon un certain
décalage que vous définissez.

Effet Compresseur à modélisation de tube
L’effet Amplitude et compression > Compresseur à modélisation de tube simule la chaleur des anciens compresseurs matériels. Utilisez cet effet
pour ajouter une distorsion subtile qui donne une coloration plaisante au son.

Curseur de seuil Permet de définir le niveau d’entrée correspondant au début de la compression. Les valeurs possibles sont comprises entre -60
et 0 dB. Le paramètre optimal varie en fonction du contenu audio et du type musical. Pour comprimer uniquement les crêtes extrêmes et
conserver une plage plus dynamique, indiquez une valeur de seuil inférieure d’environ 5 dB au niveau d’entrée de crête. Pour comprimer
fortement les données audio et diminuer considérablement la gamme dynamique, utilisez une valeur inférieure d’environ 15 dB au niveau d’entrée
de crête.
Règles du niveau d’entrée A gauche du curseur, ces règles de niveau mesurent l’amplitude d’entrée. Double-cliquez sur les règles pour
réinitialiser les indicateurs de crêtes et de clips.
Règles de réduction du gain A droite du curseur, ces règles de niveau permettent de mesurer la réduction d’amplitude à l’aide de barres rouges
qui s’étendent de haut (réduction minimale) en bas (réduction maximale).
Gain Amplifie ou coupe l’amplitude après compression. Les valeurs possibles sont comprises entre -18 et +18 dB, 0 correspondant au gain
d’unité.
Taux Définit un taux de compression allant de 1:1 à 30:1. Par exemple, la valeur 3,0 génère une sortie de 1 dB pour chaque augmentation de
3 dB au-dessus du seuil de compression. Les valeurs sont généralement comprises entre 2,0 et 5,0. Toutefois, les valeurs élevées génèrent un
son fortement compressé souvent caractéristique de la musique pop.
Attaque Détermine la vitesse d’application de la compression en cas de dépassement du seuil. Les valeurs possibles sont comprises entre 0 et
500 millisecondes. La valeur par défaut (10 millisecondes) convient à la plupart des données audio. Les valeurs élevées permettent d’obtenir de
meilleurs résultats avec un son à transitoires rapides, mais elles paraissent peu naturelles pour les données audio moins percutantes.
Relâchement Détermine la vitesse d’arrêt de la compression lorsque les données audio deviennent inférieures au seuil. Les valeurs possibles
sont comprises entre 0 et 5000 millisecondes. La valeur par défaut (100 millisecondes) convient à la plupart des données audio. Augmentez la
valeur pour un son à transitoires rapides et diminuez-la pour les données audio moins percutantes.

Effet Enveloppe de volume (éditeur de forme d’onde CS5.5 uniquement)
L’effet Amplitude et compression > Enveloppe de volume vous permet de modifier le volume au cours du temps à l’aide d’amplifications et
d’atténuations. Dans le panneau Editeur, il suffit de faire glisser la ligne jaune. Le haut du panneau représente une amplification de 100 %
(normale) et le bas, une atténuation de 100 % (silence).

Bien que l’effet Enveloppe de volume ne soit pas disponible dans l’éditeur de multipiste, vous pouvez utiliser des pistes d’automatisation pour
accomplir la même tâche (Voir la section Automatisation des paramètres de piste).

Action de faire glisser un point d’ancrage dans le panneau Editeur

Ligne d’enveloppe jaune dans le panneau Editeur Faites glisser pour ajuster le pourcentage d’amplitude et cliquez pour ajouter des images
clés pour des amplifications et des atténuations supplémentaires. Pour sélectionner, repositionner ou supprimer rapidement plusieurs images clés,
consultez la section Réglage de l’automatisation avec les images clés.
Courbes splines Applique des transitions plus lisses et courbes entre chaque image clé, plutôt que des transitions linéaires Voir la section A
propos des courbes splines des graphiques.
Voir aussi
Application d’effets dans l’éditeur de multipiste

Utilisation des préconfigurations d’effets
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Effet Délai analogique
Effet Délai
Effet Echo

Les délais sont des copies séparées d’un signal d’origine qui réapparaissent quelques millisecondes les unes après les autres. Un écho est un son
qui est suffisamment retardé dans le temps pour que vous l’entendiez comme une copie distincte du son original. Les délais et les échos
constituent un excellent moyen pour améliorer l’ambiance d’une piste, alors que la réverbération et le chœur sont susceptibles de brouiller le
mélange.

Pour accéder à des options courantes à partir de délais matériels, utilisez l’effet Écho d’Adobe Audition.

Effet Délai analogique
L’effet Délai et écho > Délai analogique simule la chaleur du son des anciennes unités de délai matériels. Des options uniques appliquent une
distorsion caractéristique et règlent l’étendue stéréo. Spécifiez des temps de délais de 35 millisecondes au minimum afin de créer des échos
discrets, et des temps plus courts pour produire des effets plus subtils.

Mode Spécifie le type d’émulation matérielle, déterminant les caractéristiques d’égalisation et de distorsion. Bande et Tube reflètent le caractère
sonore des anciennes unités de retard, tandis qu’Analogique reflète les lignes de retard électronique ultérieures.
Sortie originale Détermine le niveau des données audio d’origine, non traitées.
Sortie résultat Détermine le niveau des données audio d’origine retardées, traitées.
Délai Spécifie la longueur du retard en millisecondes.
Ré-injection Crée des échos répétés en renvoyant les données audio retardées par la ligne de délai. Par exemple, un réglage de 20 % envoie
des données audio retardées à un cinquième de son volume d’origine, créant des échos à atténuation progressive. Un réglage de 200 % envoie
des données audio retardées au double de son volume d’origine, créant des échos dont l’intensité croît rapidement.
Remarque : lorsque vous expérimentez avec des paramètres de feedback élevés, diminuez le volume de votre système.
Trash Augmente la distorsion et amplifie les basses fréquences, ajoutant de la chaleur.
Diffusion Détermine la largeur stéréo du signal retardé.

Effet Délai
L’effet Délai et écho > Délai permet de créer des échos simples, ainsi que toute une série d’autres effets. Les délais de 35 millisecondes ou plus
génèrent des échos discrets, tandis que ceux durant de 15 à 34 millisecondes produisent un effet imitant le Chœur ou l’Arrondisseur. (Le résultat
n’est pas aussi probant que si vous appliquez directement un effet Chœur ou Arrondisseur dans Adobe Audition puisque les paramètres du délai
ne changent pas au cours du temps.)

Si vous réduisez le délai entre 1 et 14 millisecondes, vous pouvez localiser dans l’espace un son mono afin que le son semble provenir de la
gauche ou de la droite, même si les niveaux de volume réels gauche et droit sont identiques.

Temps de délai Règle le délai des deux canaux gauche et droit entre –500 millisecondes et +500 millisecondes. En saisissant un nombre négatif,
vous pouvez déplacer un canal en avant dans le temps au lieu de le retarder. Par exemple, si vous saisissez 200 millisecondes pour le canal
gauche, la partie concernée par ce délai dans la forme d’onde est entendue avant la partie originale.
Mixer Détermine le rapport entre le signal traité (avec effets) et le signal d’origine (pur) à mixer dans la sortie finale. Choisissez la valeur 50 pour
mixer les deux équitablement.
Inverser Inverse la phase du signal retardé, en créant des effets d’annulation de phase semblables aux filtres de veinage. (pour comprendre
l’annulation de phase, voir la section Méthodes d’interaction des ondes sonores).

Effet Echo
L’effet Délai et écho > Echo permet d’ajouter au son une série d’échos répétés qui s’atténuent. (Pour insérer un seul écho, utilisez plutôt l’effet
Délai.) En variant le pourcentage du délai, vous pouvez créer des effets imitant l’écho renvoyé par une montagne telle que le Grand Canyon ou
des sons métalliques donnant l’impression de provenir de tuyaux de canalisations. En égalisant les délais, vous pouvez transformer le son
caractéristique d’une pièce pour passer d’un effet réfléchissant (créant des échos aux sonorités limpides) à un effet presque entièrement
absorbant (générant des échos sombres).

Remarque : veillez à ce que la longueur du fichier audio soit suffisante pour que l’écho puisse se terminer. Si l’écho est coupé de façon abrupte
avant qu’il ait eu le temps de s’atténuer complètement, annulez l’effet , ajoutez plusieurs secondes de silence en sélectionnant l’option Générer >
Silence, puis appliquez à nouveau l’effet Echo.
Temps de délai Indique le nombre de millisecondes, de temps ou d’échantillons séparant chaque écho. Par exemple, la valeur 100 millisecondes



 

se traduit par un délai d’un dixième de seconde entre les échos successifs.
Ré-injection Détermine le taux de dégradation de l’écho. Chaque écho successif s’estompe un peu plus vite que le précédent, d’un certain
pourcentage. Si vous définissez l’atténuation à 0 %, il n’y a pas d’écho du tout ; si vous lui attribuez la valeur 100 %, l’écho ne s’estompe jamais.
Niveau d’écho Définit le pourcentage du signal en écho (avec effets) qu’il convient de mélanger avec le signal d’origine (pur) dans la sortie
finale.

Vous pouvez créer d’étonnants effets d’écho en stéréo en paramétrant des valeurs gauche et droite différentes pour les commandes Temps de
délai, Ré-injection et Niveau d’écho.

Verrouiller gauche & droite Lie les curseurs de l’atténuation, du délai et du volume initial de l’écho, tout en conservant les mêmes paramètres
pour chaque canal.
Rebond écho Fait rebondir les échos d’avant en arrière entre les canaux gauche et droit. Si vous voulez créer un seul écho rebondissant d’avant
en arrière, choisissez un volume initial de l’écho de 100 % pour un canal et de 0 % pour l’autre. Sinon, les paramètres de chaque canal vont
rebondir vers l’autre, ce qui aura pour conséquence de créer deux séries d’échos sur chaque canal.
Égalisation des échos successifs Transmet chaque écho successif dans un égaliseur à huit bandes, ce qui vous permet de simuler l’absorption
sonore naturelle d’une pièce. Si vous définissez cette option à 0, la bande de fréquences reste inchangée ; si vous la définissez à –15, la
fréquence diminue de 15 dB. Et comme –15 dB correspond à la différence de chaque écho successif, certaines fréquences disparaissent plus
rapidement que d’autres.
Unités du temps de délai Indique l’unité (millisecondes, temps ou échantillons) utilisée pour le paramètre Temps de délai.
Voir aussi
Application d’effets dans l’éditeur de multipiste

Utilisation des préconfigurations d’effets
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Diagnostic et réparation, suppression ou marquage de l’audio
Options DeClicker
Options DeClipper
Options Supprimer le silence et Marquer l’audio

Vous pouvez accéder aux diagnostics par l’intermédiaire du menu Effets ou directement dans le panneau Diagnostics (Fenêtre > Diagnostics).
Grâce à ces outils, vous pouvez rapidement supprimer des bruits de clic, des distorsions ou des silences de l’audio, tout en ajoutant des
marqueurs là où il existe des silences.

Pour mieux contrôler la restauration audio, utilisez les diagnostics conjointement avec les outils Affichage spectral et les effets Réduction du
bruit. Voir la section Techniques de restauration de données audio.

Adobe recommande Vous souhaitez partager un
didacticiel ?

Restauration du son écrêté
des appareils photo reflex
numériques
Jason Levine
Récupération de la plage dynamique perdue avec
l’effet DeClipper.

Diagnostic et réparation, suppression ou marquage de l’audio
Contrairement aux effets conventionnels de réduction du bruit, qui traitent toutes les données audio sélectionnées, les diagnostics recherchent les
zones à problème ou silencieuses et vous laissent choisir lesquelles corriger.

1. Sélectionnez une option dans le menu Effet du panneau Diagnostics.

2. Cliquez sur Analyser.

3. Dans la partie inférieure du panneau, effectuez l’une des opérations suivantes :

Sélectionnez dans la liste un ou plusieurs éléments détectés, puis cliquez sur Réparer, Supprimer ou Repérer (les options
disponibles dépendent de l’effet de diagnostic choisi).

Pour marquer les clics ou écrêtages détectés, cliquez avec le bouton droit sur les éléments sélectionnés dans la liste,
puis choisissez Créer des marques dans le menu contextuel (Voir la section Utilisation des marqueurs).

Cliquez sur Tout réparer, Tout supprimer ou Tout marquer pour corriger tous les éléments détectés.

Cliquez sur la loupe  pour effectuer un zoom avant sur un problème sélectionné dans le panneau Editeur. Recliquez
sur l’icône pour effectuer un zoom arrière.

Cliquez sur Effacer les réparations, Effacer les éléments supprimés ou Effacer les éléments marqués pour supprimer de la
liste les éléments déjà corrigés.

Options DeClicker
L’effet Diagnostics > DeClicker détecte et supprime les bruits de clic et de pop des microphones sans fil, des disques vinyles et d’autres sources.

Les options DeClicker associent ces bruits pour la Suppression automatique des bruits de clic, que vous pouvez combiner avec d’autres effets du
rack d’effets et appliquer dans l’éditeur de multipiste (voir la section Effet Suppression automatique des bruits de clic). En outre, cet effet applique
automatiquement plusieurs passes d’analyse et de réparation. Pour obtenir le même niveau de réduction des bruits de clic avec le DeClicker, vous
devez l’appliquer manuellement à plusieurs reprises. Toutefois, l’effet DeClicker vous permet d’évaluer les clics détectés et de sélectionner ceux à
corriger.

Dans le panneau Diagnostics, cliquez sur Paramètres pour accéder aux options suivantes :

Seuil Détermine la sensibilité au bruit. Des valeurs basses détectent plus de bruits parasites, mais peuvent affecter des sons à conserver. Les
paramétrages possibles sont compris entre 30 et 100, la valeur par défaut étant 1.
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Complexité Indique la complexité du bruit. Des valeurs plus élevées impliquent un traitement plus poussé mais peuvent nuire à la qualité sonore.
Les paramétrages possibles sont compris entre 16 et 100, la valeur par défaut étant 1.

Pour identifier visuellement les clics, effectuez un zoom avant et utilisez un Affichage spectral de la fréquence avec une résolution de
256 bandes (vous pouvez accéder à ce paramètre par le biais de l’onglet Affichage spectral de la boîte de dialogue Préférences). La plupart
des clics apparaissent sous la forme de barres verticales lumineuses s’étirant de haut en bas sur la représentation.

Options DeClipper
L’effet Diagnostics > DeClipper répare les formes d’onde écrêtées en remplissant les portions écrêtées avec de nouvelles données audio.
L’écrêtage survient lorsque l’amplitude audio excède le niveau maximal de la résolution actuelle. Généralement, l’écrêtage est la conséquence de
niveaux d’enregistrement trop élevés. Vous pouvez surveiller ce processus pendant l’enregistrement ou la lecture en observant les règles de
niveau. Lorsqu’un écrêtage a lieu, les cases situées à l’extrême droite des règles deviennent rouges.

Visuellement, les sons écrêtés apparaissent sous la forme de vastes zones plates situées en haut de la forme d'onde. D’un point de vue sonore,
les sons écrêtés ressemblent à une distorsion de texte statique.

Remarque : si vous devez régler le décalage DC d’un son écrêté, commencez par utiliser l’effet DeClipper. Si vous procédez dans l’ordre
inverse, l’effet DeClipper n’identifie pas les zones écrêtées situées sous 0 dBFS.
Dans le panneau Diagnostics, cliquez sur Paramètres pour accéder aux options suivantes :

Gain Spécifie le degré d’atténuation appliqué avant le traitement. Cliquez sur Auto pour que le paramètre de gain repose sur l’amplitude moyenne
en entrée.
Tolérance Spécifie la variation de l’amplitude dans les régions écrêtées. Une valeur de 0 % détecte l’écrêtage uniquement dans les lignes
parfaitement horizontales à une amplitude maximale ; une valeur de 1 % détecte l’écrêtage en commençant à 1 % au-dessous de l’amplitude
maximale ; etc. (une valeur de 1 % détecte davantage d’écrêtage).
Taille min. du clip Spécifie la longueur de l’exécution la plus courte des échantillons écrêtés à réparer. Des valeurs faibles réparent un plus grand
pourcentage d’échantillons écrêtés ; des valeurs élevées réparent des échantillons écrêtés uniquement s’ils sont précédés ou suivis d’autres
échantillons écrêtés.
Interpolation L’option Cubique utilise des courbes splines pour recréer le contenu de fréquence des données audio écrêtées. Dans la plupart des
cas, cette approche est plus rapide, mais elle peut introduire de nouvelles fréquences fallacieuses. L’option TFR recrée les données audio
écrêtées à l’aide de la transformation de Fourier rapide. Cette approche est généralement plus lente, mais produit de meilleurs résultats pour les
écrêtages plus sévères. Dans le menu Taille de la TFR, sélectionnez le nombre de bandes de fréquences à évaluer et à remplacer (davantage de
bandes produisent une plus grande précision, mais le traitement est plus long).

Pour conserver l’amplitude lors de la restauration des données audio écrêtées, appliquez l’effet DeClipper avec un paramètre de gain de zéro,
suivi de l’effet Limitation fixe avec une valeur d’amplification de zéro et une valeur de limite de -0,2 dB.

Options Supprimer le silence et Marquer l’audio
Les effets Diagnostics > Supprimer le silence et Marquer l’audio identifient les passages silencieux des données audio, puis les suppriment ou les
marquent (Voir la section Utilisation des marqueurs). La suppression automatique des silences vous aide à resserrer les pistes sans affecter les
données audio du premier plan. Le marquage automatique du silence vous aide à naviguer rapidement entre les repères audio pour le montage.

Dans le panneau Diagnostics, cliquez sur Paramètres pour accéder aux options suivantes :

Définir le silence en tant que Détermine l’amplitude et la durée identifiées comme silence.
Définir l’audio en tant que Détermine l’amplitude et la durée identifiées comme contenu audio.
Rechercher les niveaux Calcule automatiquement les niveaux de signal du silence et des données audio en fonction du contenu du fichier.
Corriger par (Supprimer le silence uniquement) Sélectionnez Silence raccourcissant pour réduire les passages silencieux à un nombre
spécifique de millisecondes. Sélectionnez Suppression du silence pour couper le son des passages silencieux tout en conservant la longueur du
fichier (la suppression du silence permet de préserver la synchronisation vidéo avec les clips audio dans les applications de montage vidéo).

Pour diviser en plusieurs fichiers les sections sonores ou vocales séparées par un silence, appliquez l’effet Marquer l’audio, puis cliquez sur
Tout marquer. Voir ensuite Enregistrement des données audio entre des marqueurs dans un nouveau fichier.

Voir aussi
Utilisation des préconfigurations d’effets

  |  

http://helpx.adobe.com/en/audition/using/markers.html
http://helpx.adobe.com/en/audition/using/markers.html#save_audio_between_markers_to_new_files
http://helpx.adobe.com/en/audition/using/effects-controls.html#use_effect_presets
http://creativecommons.org/licenses/by-nc-sa/3.0/
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Techniques de restauration de données audio
Effet Réduction du bruit (éditeur de forme d’onde uniquement)
Effet Réduction adaptative du bruit
Effet Suppression automatique des bruits de clic
Effet Correction automatique de phase
Effet DeHummer
Effet Réduction du souffle (éditeur de forme d’onde uniquement)

Adobe recommande Vous souhaitez partager un
didacticiel ?

Présentation de la réduction
du bruit et Réduction du
bruit avancée
Colin Smith
Suppression automatique des clics, restauration du
son écrêté et correction des artefacts individuels. Ou
nettoyage du bruit complexe à l’aide de deux effets
puissants.

Techniques de restauration de données audio
Vous pouvez résoudre un nombre important de problèmes liés au son à l’aide de deux fonctionnalités puissantes. Utilisez tout d’abord l’affichage
spectral afin d’identifier et de sélectionner différentes plages de bruit et autres artefacts dans un graphe (voir les sections Sélection de plages
spectrales et Sélection et correction automatique d’artefacts). Ensuite, à l’aide des effets Diagnostics ou Réduction du bruit, corrigez certains
problèmes, notamment :

Les grésillements induits par des microphones sans fil ou des anciens disques en vinyle. (Voir la section Effet Suppression
automatique des bruits de clic.)

Bruit de fond tel un grondement de vent, un souffle de bande magnétique ou le bourdonnement d'une ligne à haute tension.
(Voir les sections Effet Réduction adaptative du bruit et Effet DeHummer).

Annulation de phase des microphones stéréo mal placés ou des téléscripteurs mal alignés (voir la section Effet Correction
automatique de phase).

Les effets de restauration en temps réel ci-dessus, disponibles dans les éditeurs de forme d’onde et de multipiste, sont à même de résoudre
rapidement les problèmes de son courants. Si un son contient énormément de bruit, toutefois, utilisez plutôt les effets hors ligne propres à
l’éditeur de forme d’onde, tels que Réduction souffle ou Réduction du bruit.

Sélection de divers types de bruit dans l’affichage spectral
A.  Souffle B.  Grésillement C.  Grondement

http://www.adobe.com/community/publishing/download.html
http://www.adobe.com/community/publishing/download.html
http://tv.adobe.com/watch/no-stupid-questions-with-colin-smith/introduction-to-noise-reduction-in-audition-cs55/
http://tv.adobe.com/watch/no-stupid-questions-with-colin-smith/introduction-to-noise-reduction-in-audition-cs55/
http://tv.adobe.com/watch/no-stupid-questions-with-colin-smith/advanced-noise-reduction-in-audition-cs55/
http://tv.adobe.com/watch/no-stupid-questions-with-colin-smith/advanced-noise-reduction-in-audition-cs55/


Effet Réduction du bruit (éditeur de forme d’onde uniquement)
L’effet Réduction / restauration du bruit > Réduction du bruit réduit considérablement le bruit de fond et le bruit de la bande passante, avec une
réduction minimale de la qualité du signal. Cet effet permet de supprimer plusieurs bruits, y compris des souffles de bandes magnétiques, des
bruits de fond de microphones, le bourdonnement d'une ligne à haute tension ou tout autre bruit constant tout le long de la forme d’onde.

La bonne proportion de réduction du bruit dépend du type de bruit de fond et de la perte de qualité acceptable pour le reste du signal. En règle
générale, vous pouvez augmenter le rapport signal/bruit de 5 à 20 dB et conserver une excellente qualité sonore.

Pour optimiser les résultats de l’effet Réduction du bruit, appliquez-le à des sons sans décalage DC. Avec un décalage DC, cet effet peut
introduire des clics dans les passages calmes (pour supprimer un décalage DC, sélectionnez Favoris > Réparer le décalage DC).

Evaluation et réglage des bruits à l’aide du graphique Réduction du bruit :
A.  Faites glisser les points de contrôle afin de varier la réduction dans différentes plages de fréquences. B.  Bruit d’amplitude faible. C.  Bruit
d’amplitude élevé. D.  Seuil au-dessous duquel survient la réduction du bruit.

Application de l’effet Réduction du bruit
1. Dans l’éditeur de forme d’onde, sélectionnez une plage contenant uniquement du bruit et durant au moins une demi-seconde.

Pour sélectionner du bruit dans une plage de fréquences donnée, utilisez l’outil Rectangle de sélection (voir la section
Sélection de plages spectrales).

2. Sélectionnez Effets > Réduction / restauration du bruit > Capturer l’impression du bruit.
3. Dans le panneau Editeur, sélectionnez la plage dans laquelle vous souhaitez supprimer le bruit.
4. Sélectionnez Effets > Réduction / restauration du bruit > Réduction du bruit.
5. Définissez les options de votre choix.

Si l’enregistrement a lieu dans un environnement bruyant, enregistrez quelques secondes de bruit de fond représentatif qui pourront par la suite
être utilisées comme impression du bruit.

Options de l’effet Réduction du bruit
Capturer l’impression du bruit Extrait un profil de bruit d’une plage sélectionnée, en n’indiquant que le bruit de fond. Adobe Audition collecte
des informations statistiques sur le bruit de fond de manière à pouvoir le supprimer du reste de la forme d’onde.

Si la plage sélectionnée est trop courte, l’option Capturer l’impression du bruit est désactivée. Réduisez la taille de la TFR ou sélectionnez une
plage de bruits plus longue. Si vous n’en trouvez pas, copiez et collez la plage sélectionnée pour en créer une. Vous pourrez ensuite supprimer
le bruit collé à l’aide de la commande Modifier > Supprimer.

Enregistrer l’impression de bruit actuelle Enregistre l'impression de bruit dans un fichier .fft, qui contient des informations sur le type
d'échantillon, la taille de la TFR (Transformée de Fourier Rapide) et trois jeux de coefficients TFR : un pour la plus petite quantité de bruit trouvée,
un pour la quantité la plus importante et un pour la puissance moyenne.

Charger une impression de bruit à partir du disque Permet d’ouvrir une impression de bruit enregistrée au format TFR dans
Adobe Audition. Vous ne pouvez toutefois appliquer des impressions de bruit qu'à des types d'échantillons identiques. (Par exemple, vous ne
pouvez pas appliquer un profil mono de 22 kHz sur un échantillon stéréo de 44 kHz.)
Remarque : en raison de cette spécificité, une impression correspondant à un type de bruit ne donnera pas de résultats satisfaisants avec les
autres types. Toutefois, si vous supprimez régulièrement un bruit similaire, un profil enregistré permet d'améliorer considérablement votre
rendement.
Graphe Représente la fréquence sur l’axe des abscisses (horizontal) et le degré de réduction du bruit sur l’axe des ordonnées (vertical).
La courbe de contrôle bleue définit le niveau de réduction du bruit à différentes plages de fréquences. Si, par exemple, vous souhaitez appliquer la
réduction du bruit uniquement aux fréquences les plus élevées, ajustez la courbe de contrôle vers le bas à droite du graphique.

Si vous cliquez sur le bouton Réinitialiser  pour aplatir la courbe de contrôle, le niveau de réduction du bruit dépend entièrement de l'impression
de bruit.
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Pour une plus grande emphase sur le niveau de bruit, cliquez sur le bouton de menu  en haut à droite du graphe, puis désélectionnez les
options Afficher la courbe de contrôle et Afficher l’info-bulle sur le graphique.

Niveau de bruit Un niveau élevé affiche la plus grande amplitude du bruit détecté à chaque fréquence ; un niveau faible affiche la plus faible
amplitude. Le seuil affiche l’amplitude en dessous de laquelle survient la réduction du bruit.

Les trois éléments du niveau de bruit peuvent se chevaucher dans le graphique. Pour mieux les distinguer, cliquez sur le bouton de menu ,
puis sélectionnez des options dans le menu Afficher le niveau de bruit.

Echelle Détermine de quelle manière sont organisées les fréquences le long de l’axe des abscisses horizontal :

Pour un contrôle plus précis des fréquences basses, sélectionnez Logarithmique. Une échelle logarithmique ressemble
davantage à ce qu’entend un humain.

Pour utiliser une haute fréquence détaillée avec des intervalles égaux, sélectionnez Linéaire.

Canal Affiche le canal sélectionné dans le graphique. Le degré de réduction du bruit est toujours identique pour tous les canaux.
Sélectionner le fichier entier Permet d’appliquer l’impression du bruit capturée à l’ensemble du fichier.
Réduction du bruit Contrôle le pourcentage de réduction du bruit dans le signal de sortie. Ajustez ce réglage tout en prévisualisant l’audio afin
d’obtenir une réduction maximale du bruit avec un minimum d’artefacts (avec des niveaux de réduction du bruit excessivement élevés, il arrive que
le son semble modulé ou déphasé).
Réduire de Détermine la réduction d’amplitude du bruit détecté. Des valeurs comprises entre 6 et 30 dB sont recommandées. Pour réduire les
artefacts semblables à des bulles, entrez des valeurs faibles.
Bruit en sortie uniquement Prévisualise uniquement le bruit, afin que vous puissiez déterminer si l’effet supprime des sons qui ne doivent pas
l’être.
Avancé Cliquez sur le triangle afin d’accéder aux options suivantes :

Vitesse d’atténuation spectrale  Spécifie le pourcentage de fréquences traitées lorsque le son se situe sous le bruit de fond. Un réglage
fin de ce pourcentage permet une plus grande réduction du bruit avec moins d’artefacts. Les valeurs comprises entre 40 % et 75 %
produisent les meilleurs résultats. Sous ces valeurs, des artefacts « bruits de bulle » deviennent souvent audibles. Au-dessus de ces
valeurs, des bruits excessifs sont conservés.
Lissage  Prend en compte la variance du signal de bruit dans chaque bande de fréquences. Les bandes qui varient considérablement à
l’analyse (par exemple les bruits blancs) sont lissées d’une autre manière que les bandes constantes (tels les bourdonnements de 60 Hz).
En règle générale, le fait d’augmenter le niveau de lissage (jusqu’à deux points environ) réduit les artefacts d’arrière-plan, en contrepartie
d’une augmentation du niveau du bruit de la bande passante.
Facteur de précision  Contrôle les modifications d’amplitude. Les valeurs comprises entre 5 et 10 fonctionnent mieux ; les chiffres impairs
sont idéaux pour le traitement symétrique. Avec des valeurs de 3 ou moins, la transformation de Fourier rapide s’effectue en blocs
géants ; des chutes ou des pointes de volume peuvent survenir entre ces blocs. Les valeurs au-delà de 10 n’apportent aucun changement
notable de qualité, mais allongent la durée de traitement.
Largeur de transition  Détermine la plage d’amplitudes entre le bruit et l’audio souhaitable. Par exemple, une largeur de zéro applique
une porte de bruit aiguë à chaque bande de fréquences. L’audio juste au-dessus du seuil reste inchangé ; l’audio juste au-dessous est
réduit au silence. Vous pouvez également spécifier une plage pour laquelle le son est progressivement réduit au silence en fonction du
niveau d’entrée. Si, par exemple, la largeur de transition est de 10 dB et si le niveau de bruit pour la bande est de -60 dB, le son à -60 dB
reste inchangé, le son à -62 dB est légèrement réduit et le son à -70 dB est entièrement supprimé.
Taille de la TFR  Détermine combien de bandes de fréquences individuelles sont analysées. Cette option affecte considérablement la
qualité. Le bruit dans chaque bande de fréquences est traité séparément ; s’il y a davantage de bandes, le bruit est supprimé avec une
fréquence plus détaillée. Les meilleurs réglages sont compris entre 4 096 et 8 192.
La taille de la transformation de Fourier rapide détermine le compromis entre la précision de la fréquence et la précision temporelle. Des
tailles de TFR plus élevées peuvent engendrer des artefacts avec des bruissements ou des réverbérations, mais permettent de supprimer
plus précisément les fréquences de bruit. Des tailles de TFR inférieures produisent un meilleur temps de réponse (moins de bruissements
avant un coup de timbale, par exemple), mais peuvent amoindrir la résolution de la fréquence, créant ainsi des sons creux ou étouffés.

Instantanés d’impression du bruit  Détermine combien d’instantanés de bruit inclure dans le profil capturé. Une valeur de 4 000 est
optimale pour garantir la précision des données.
De très petites valeurs nuisent considérablement à la qualité des différents niveaux de réduction du bruit. Avec plus d’instantanés, un
niveau de réduction du bruit de 100 coupera vraisemblablement plus de bruit, mais également plus de signaux d’origine. Toutefois, un
faible niveau de réduction du bruit avec plus d’instantanés supprime également plus de bruit, mais conserve probablement le signal initial.

Effet Réduction adaptative du bruit
L’effet Réduction / restauration du bruit > Réduction adaptative du bruit supprime rapidement le bruit variable de la bande passante, tel que les
bruits de fond, les grondements et le vent. Puisque cet effet agit en temps réel, il peut être combiné à d’autres effets du rack d’effets et appliqué
dans l’éditeur de multipiste. En revanche, l’effet Effet Réduction du bruit standard est uniquement disponible sous forme d’un processus hors ligne
dans l’éditeur de forme d’onde. Il arrive toutefois que cet effet soit plus efficace pour la suppression du bruit constant, tel que le souffle ou le
bourdonnement.

Pour optimiser les résultats, appliquez la Réduction adaptative du bruit aux sélections qui commencent par du bruit suivi par l’audio souhaitable.
L’effet identifie le bruit en fonction des premières secondes de l’audio.

Important : cet effet nécessite un traitement considérable. Si votre système est plus lent, réduisez la taille de la TFR et désactivez le mode
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Qualité supérieure.
Réduire le bruit de Détermine le niveau de réduction du bruit. Des valeurs comprises entre 6 et 30 dB sont recommandées. Pour réduire les
effets semblables à des bulles, entrez des valeurs faibles.
Bruyance Indique le pourcentage des données audio d’origine comportant du bruit.
Réglage fin du niveau de bruit Règle manuellement le niveau de bruit au-dessus ou en dessous de la valeur de bruit automatiquement
calculée.
Seuil du signal Règle manuellement le seuil des données audio au-dessus ou en dessous de la valeur de seuil automatiquement calculée.
Vitesse d’atténuation spectrale Détermine la rapidité à laquelle le traitement du bruit chute de 60 décibels. Un réglage précis de ce paramètre
permet une plus grande réduction du bruit avec moins d’artefacts. Des valeurs trop brèves engendrent des sons de bulles ; des valeurs trop
longues engendrent un effet de réverbération.
Préservation de la bande passante Retient les données audio souhaitées au format des bandes de fréquences spécifiées entre les artefacts
identifiés. Par exemple, un réglage de 100 Hz garantit qu’aucune donnée audio n’est supprimée à hauteur de 100 Hz au-dessus ou en dessous
des artefacts décelés. Des paramètres plus faibles suppriment davantage de bruit, mais peuvent introduire un traitement audible.
Taille de la TFR Détermine combien de bandes de fréquences individuelles sont analysées. Choisissez un réglage élevé pour augmenter la
résolution de fréquence et une valeur faible pour renforcer la résolution temporelle. Les paramètres de valeur élevée conviennent particulièrement
bien aux artefacts de longue durée, tels que les grincements ou les bourdonnements de lignes à haute tension, alors que les valeurs faibles sont à
même de traiter les artefacts transitoires, comme par exemple les clics et les claquements.
Mode haute qualité Exécute le traitement plus lentement mais avec de meilleurs résultats.

Effet Suppression automatique des bruits de clic
Pour supprimer rapidement les crépitements et autres bruits parasites des enregistrements vinyles, utilisez l’effet Réduction / restauration du
bruit > Suppression automatique des bruits de clic. Vous pouvez corriger une plage sonore étendue ou un seul clic ou bruit parasite.

Cet effet fournit les mêmes options que l’effet DeClicker, qui vous permet de sélectionner les clics détectés à corriger (voir la section Options
DeClicker). Toutefois, l’effet Suppression automatique des bruits de clic agissant en temps réel, il peut être combiné à d’autres effets du rack
d’effets et appliqué dans l’éditeur de multipiste. En outre, l’effet Suppression automatique des bruits de clic applique automatiquement plusieurs
passes de balayage et de réparation. Pour obtenir le même niveau de réduction des bruits de clic avec le DeClicker, vous devez l’appliquer
manuellement plusieurs fois.

Seuil Détermine la sensibilité au bruit. Des valeurs basses détectent plus de bruits parasites, mais peuvent affecter des sons à conserver. Les
paramétrages possibles sont compris entre 30 et 100, la valeur par défaut étant 1.
Complexité Indique la complexité du bruit. Des valeurs plus élevées impliquent un traitement plus poussé mais peuvent nuire à la qualité sonore.
Les paramétrages possibles sont compris entre 16 et 100, la valeur par défaut étant 1.

Effet Correction automatique de phase
L’effet Réduction / restauration du bruit > Correction automatique de phase traite les erreurs d’azimut causées par le désalignement des têtes de
bande, le brouillage stéréo provoqué par un mauvais placement de microphone, ainsi qu’un certain nombre d’autres problèmes de phase.

Décalage de temps global Active les curseurs de décalage des canaux gauche et droit, ce qui vous permet d’appliquer un décalage de phase
uniforme à tous les sons sélectionnés.
Alignement automatique de canaux et Panoramisation centrale automatique Alignent la phase et la panoramisation d’une série d’intervalles
temporaires discrets, ce qui permet d’effectuer les spécifications à l’aide des options suivantes :

Résolution temporelle  Spécifie le nombre de millisecondes dans chaque intervalle traité. Les valeurs faibles augmentent la précision et
les valeurs élevées les performances.
Réactivité  Détermine la vitesse de traitement globale. Les réglages lents augmentent la précision et les réglages rapides les
performances.
Canal  Détermine les canaux auxquels sera appliquée la correction de phase.
Taille de l’analyse  Spécifie le nombre d’échantillons dans chaque unité audio analysée.

Pour effectuer les corrections de phase les plus efficaces et les plus précises, optez pour l’option Alignement automatique de canaux. Activez
les curseurs de Décalage de temps global uniquement lorsque vous êtes sûr qu’un ajustement uniforme est absolument nécessaire ou que
vous souhaitez animer manuellement la correction de phase dans l’éditeur de multipiste.

Effet DeHummer
L’effet Réduction / restauration du bruit > DeHummer supprime les bandes de fréquences étroites et leurs harmoniques. L’application la plus
courante résout les bourdonnements des lignes de transmission issus de la foudre et des appareils électroniques. Toutefois, le DeHummer peut
également appliquer un filtre coupe-bande qui supprime une fréquence extrêmement résonante de l’audio source.

Pour résoudre rapidement les problèmes audio les plus courants, sélectionnez une option dans le menu Préconfigurations.

Fréquence Définit la fréquence racine du bourdonnement. Si vous ne connaissez pas la fréquence précise, faites glisser ce paramètre d’avant en
arrière tout en prévisualisant l’audio.

Pour régler visuellement le gain et la fréquence racine, faites-les glisser directement dans le graphique.
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Q Définit la largeur de la fréquence racine et des harmoniques au-dessus. Des valeurs élevées affectent une plage étroite de fréquences, tandis
que des valeurs faibles affectent une plage plus large.
Gain Détermine le niveau d’atténuation des bourdonnements.
Nombre d’harmoniques Détermine combien de fréquences harmoniques affecter.
Pente harmonique Modifie le rapport d’atténuation des fréquences harmoniques.
Bourdonnement en sortie uniquement Vous permet de prévisualiser le bourdonnement supprimé afin de déterminer s’il contient de l’audio
désirable.

Effet Réduction du souffle (éditeur de forme d’onde uniquement)
L’effet Réduction / restauration du bruit > Réduction du souffle réduit le souffle issu de sources telles que les cassettes audio, les disques vinyles
ou les microphones. Cet effet réduira considérablement l’amplitude d’une plage de fréquences s’il tombe sous un seuil d’amplitude appelé bruit de
fond. Les sons situés dans les plages de fréquences supérieures au seuil restent identiques. Si le son présente un niveau constant de souffle de
fond, celui-ci peut être complètement éliminé.

Pour réduire d’autres types de sons ayant une vaste plage de fréquences, essayez plutôt l’effet Réduction du bruit (consultez la section Effet
Réduction du bruit (éditeur de forme d’onde uniquement)).

Utilisation du graphe de l’effet Réduction du souffle pour réduire le bruit de fond

Capturer le niveau de bruit Estimation du bruit de fond sous forme de représentation graphique. L’effet Réduction souffle utilise cette estimation
afin de supprimer plus efficacement les souffles sans affecter les sons légitimes. Il s’agit de la caractéristique la plus puissante de l’effet Réduction
souffle.
Afin de créer un graphe qui représente plus précisément le bruit de fond, cliquez sur Obtenir bruit de fond après avoir sélectionné du son qui
contient uniquement du souffle. Vous pouvez également sélectionner une zone qui contient la plus petite quantité de son souhaitable et la plus
petite quantité d’informations de hautes fréquences (recherchez dans les premiers 75 % de l’affichage spectral une zone sans aucune activité).

Après avoir capturé le niveau de bruit, il peut s’avérer nécessaire d’abaisser les points de contrôle sur la gauche (représentant les fréquences les
plus basses) de manière à rendre le graphe le plus plat possible. Si de la musique est représentée à une fréquence quelconque, les points de
contrôle situés autour de cette fréquence sont plus élevés que la normale.

Graphe Représente le bruit de fond estimé pour chaque fréquence du son source, la fréquence étant représentée sur la règle horizontale (axe
des abscisses) et l’amplitude du bruit de fond sur la règle verticale (axe des ordonnées). Ces informations permettent de distinguer les souffles
issus de données audio souhaitables.
La valeur réelle utilisée pour réduire le souffle résulte d’une combinaison du graphe et du curseur Niveau de bruit, qui augmente ou diminue la
valeur estimée du bruit de fond afin d’obtenir un réglage plus précis.

Pour désactiver les info-bulles de la fréquence et de l’amplitude, cliquez sur le bouton  situé en haut à droite du graphe, puis désélectionnez
l’option Afficher l’info-bulle sur le graphique.

Echelle Détermine de quelle manière sont organisées les fréquences le long de l’axe des abscisses horizontal :

Pour un contrôle plus précis des fréquences basses, sélectionnez Logarithmique. Une échelle logarithmique ressemble
davantage à ce qu’entend un humain.

Pour utiliser une haute fréquence détaillée avec des intervalles égaux, sélectionnez Linéaire.

Canal Affiche le canal audio sélectionné dans le graphe.

Réinitialiser Réinitialise le bruit de fond estimé. Pour réinitialiser le niveau le plus ou le moins élevé, cliquez sur le bouton  en haut à
droite du graphique, puis sélectionnez une option du menu Réinitialiser le contrôle de courbe.

Pour obtenir une réduction du souffle rapide et universelle, il n’est pas toujours nécessaire d’avoir recours à un graphe du bruit de fond
complet. Il suffit bien souvent de réinitialiser le graphe à un niveau uniforme et de manipuler le curseur Niveau de bruit.

Niveau de bruit Permet de régler plus précisément le niveau de bruit jusqu’à obtenir la réduction du souffle appropriée et le degré de qualité
souhaité.
Réduire de Permet de définir le niveau de réduction du souffle pour les sons situés sous le bruit de fond. Des valeurs plus élevées (surtout
supérieures à 20 dB) permettent de réduire considérablement le souffle ; toutefois, le reste des sons peut alors présenter une distorsion. Avec des
valeurs plus basses, moins de bruit est supprimé et le signal audio d’origine reste relativement stable.
Souffle en sortie uniquement Permet de prévisualiser uniquement le souffle afin de déterminer si l’effet supprime du son souhaitable.
Avancé Cliquez sur le triangle afin d’afficher les options suivantes :



 

Vitesse d’atténuation spectrale  Lorsque le programme détecte du son situé au-delà du bruit de fond estimé, détermine la quantité de
son des fréquences environnantes attendue. Si vous définissez des valeurs faibles, peu de son est censé suivre et la réduction de souffle
découpe au plus près les fréquences conservées.
Les valeurs comprises entre 40 % et 75 % produisent les meilleurs résultats. Si la valeur est trop élevée (supérieure à 90 %), de longues
queues et réverbérations peu naturelles risquent de se faire entendre. Si la valeur est trop basse, des bruits semblables à des bulles
peuvent devenir audibles en bruit de fond et conférer un son artificiel à la musique.

Facteur de précision  Détermine l’exactitude temporelle de la réduction du souffle. Les valeurs sont généralement comprises entre 7
et 14. Des valeurs inférieures peuvent provoquer quelques millisecondes de souffle avant et après les portions les plus intenses du son.
Les valeurs supérieures fournissent généralement de meilleurs résultats, mais allongent les temps de traitement. Les valeurs supérieures
à 20 n’améliorent pas généralement la qualité.
Largeur de transition  Produit une transition lente de la réduction du souffle, plutôt qu’un changement abrupt. Les valeurs comprises
entre 5 et 10 permettent généralement d’obtenir de bons résultats. Si la valeur est trop élevée, une partie du souffle peut subsister après
traitement. Si la valeur est trop basse, des artefacts d’arrière-plan peuvent devenir audibles.
Taille de la TFR Détermine la taille de la TFR (transformation de Fourier rapide), qui détermine le compromis entre la précision de la
fréquence et la précision temporelle. En règle générale, les tailles comprises entre 2 048 et 8 192 sont les plus performantes.
Des tailles de TFR inférieures (2 048 et moins) fournissent un meilleur temps de réponse (moins de bruissements avant un coup de
timbale, par exemple), mais peuvent amoindrir la résolution de la fréquence, créant ainsi des sons creux ou étouffés.

Des tailles de TFR plus élevées (8 192 et plus) peuvent entraîner des bruissements, des échos ou la mise en évidence de bruits de fond,
mais elles produisent des résolutions de fréquence plus précises.

Points de contrôle  Définit le nombre de points ajoutés au graphique lorsque vous cliquez sur Capturer le niveau de bruit.
Voir aussi
A propos de l’affichage spectral

Commande des paramètres d’effets dans des graphiques

Application d’effets dans l’éditeur de multipiste

Utilisation des préconfigurations d’effets

  |  
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Effets de réverbération

Haut de la page

Haut de la page

Effet Réverbération par convolution
Effet Réverbération avancée
Effet Réverbération
Effet Réverbération studio
Effet Réverbération surround

Dans une pièce, le son rebondit sur les murs, le plafond et le sol avant de parvenir à vos oreilles. Tous les sons réfléchis atteignent vos oreilles
quasiment en même temps de telle sorte que vous ne les percevez pas comme des échos distincts mais comme une ambiance sonore créant une
impression d’espace. Ce son réfléchi est appelé réverbération ou réverb, en abrégé. Grâce à Adobe Audition, vous pouvez utiliser les effets de
réverbération afin de simuler une multitude d’environnements de pièces.

Pour utiliser la réverbération de manière optimale et flexible dans l’éditeur de multipiste, ajoutez des effets de réverbération aux bus et
définissez les niveaux de sortie de réverbération sur 100 % (avec effets). Acheminez ensuite des pistes vers ces bus et déterminez la
proportion de son pur et de son avec effet de réverbération à l’aide d’émissions.

Effet Réverbération par convolution
L’effet Réverbération > Réverbération par convolution reproduit des environnements acoustiques de pièces allant des vestiaires aux salles de
concert. Les réverbérations à convolution utilisent des fichiers d’impulsions pour simuler des espaces acoustiques. Les résultats sont
incroyablement réalistes et vivants.

Les sources de fichiers d’impulsion comprennent la séquence audio que vous avez enregistrée d’un espace ambiant ou les collections
d’impulsions disponibles en ligne. Pour optimiser les résultats, les fichiers d’impulsion doivent être décompressés, les fichiers de 16 ou 32 bits
correspondant au taux d’échantillonnage du fichier audio en cours. La durée d’impulsion ne doit pas dépasser 30 secondes. Pour la conception
sonore, essayez diverses données audio source afin de produire des effets uniques basés sur la convolution.

Remarque : parce que la réverbération par convolution nécessite un traitement intensif, vous risquez d’entendre des claquements ou des bruits
secs lors de son aperçu sur des systèmes lents. Ces artefacts disparaissent après application de l’effet.
Impulsion Spécifie un fichier qui simule un espace acoustique. Cliquez sur Charger pour ajouter un fichier d’impulsion personnalisé au
format WAV ou AIFF.
Mixer Contrôle le rapport entre le son d’origine et le son réverbéré.
Taille de la pièce Précise un pourcentage pour la pièce complète défini par le fichier d’impulsions Plus le pourcentage est grand, plus les
réverbérations sont longues.
Limiter BF Réduit les composants basses fréquences, à forte dominante de basses dans la réverbération, pour produire un son plus clair mieux
articulé.
Limiter HF Réduit les composants transitoires haute fréquence dans la réverbération, pour éviter la discordance et produire un son plus chaud,
plus riche.
Pré-retard Détermine combien de millisecondes nécessite la réverbération pour atteindre l’amplitude maximale. Pour produire le son le plus
naturel, spécifiez un pré-retard court compris entre 0 et 10 millisecondes. Pour produire des effets spéciaux intéressants, spécifiez un long pré-
retard de 50 millisecondes ou plus.
Largeur Contrôle l’étendue stéréo. Un réglage de 0 produit un signal de réverbération mono.
Gain Amplifie ou atténue l’amplitude après compression.

Effet Réverbération avancée
L’effet Réverbération > Réverbération avancée est à convolution, et permet d’éviter les sonneries, les bruits métalliques et d’autres artefacts
artificiels.

Cet effet propose plusieurs options uniques, comme Perception (simulation des irrégularités d’une pièce), Emplacement gauche/droit (décentrage
de la source) et Taille de la pièce et Dimension (simulation réaliste d’une pièce personnalisable. Pour simuler des murs et une résonance, vous
pouvez modifier l’absorption de fréquences de la réverbération à l’aide d’une égalisation paramétrique tribande dans la section Coloration.

Lors de la modification des paramètres de réverbération, cet effet crée un fichier d’impulsions temporaire qui simule l’environnement acoustique
défini. La taille de ce fichier peut atteindre plusieurs mégaoctets, ce qui nécessite un temps de traitement de quelques secondes. Par conséquent,
il peut s’avérer nécessaire d’attendre avant d’entendre la prévisualisation. Toutefois, les résultats sont très réalistes et facilement personnalisables.

Important : le traitement de cet effet prend un certain temps. Dans le cadre d’une utilisation multipiste en temps réel, effectuez le pré-rendu de
cet effet ou remplacez-le par l’effet Réverbération studio (Voir la section Pré-rendu des effets de piste pour améliorer les performances).

Paramètres de réverbération
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Temps d’atténuation Détermine le délai en millisecondes requis par la réverbération pour atténuer 60 dB. En fonction des paramètres de
coloration, certaines fréquences prennent parfois plus de temps pour s’atténuer à 60 dB, tandis que d’autres fréquences s’estompent beaucoup
plus rapidement. Si les valeurs sont élevées, les queues de réverbération sont plus longues, mais le traitement est plus lourd. La limite effective
est d’environ 6 000 millisecondes (queue de 6 secondes), mais la queue réellement générée est beaucoup plus longue afin que l’atténuation soit
intégrée au niveau de bruit de fond.
Temps de prédélai Détermine le délai en millisecondes requis par la réverbération pour atteindre son amplitude maximale. En règle générale, les
réverbérations sont rapidement générées, puis s’atténuent beaucoup plus lentement. Les temps de prédélai extrêmement longs (400 millisecondes
ou plus) génèrent des effets intéressants.
Diffusion Contrôle le rythme de génération de l’écho. Si vous choisissez une valeur de diffusion élevée (supérieure à 900 millisecondes), vous
obtenez une réverbération très coulée dans laquelle on ne distingue pas les différents échos. Si vous définissez une valeur plus basse, vous
distinguez mieux les échos puisque la densité initiale des échos est plus légère et s’intensifie au fur et à mesure de la vie de la queue de
réverbération.

Pour créer des effets de rebond d’écho, paramétrez une diffusion faible et une perception élevée. Avec des queues de réverbération longues,
l’utilisation de valeurs de diffusion faibles et de valeurs de perception assez faibles produit l’effet d’un stade de football, par exemple.

Perception Simule les irrégularités de l’environnement (objets, murs, pièces connexes, etc.). Une perception faible crée une réverbération qui
s’atténue progressivement sans frise. Une perception plus importante produit des échos plus distincts (provenant d’emplacements différents).

Si la réverbération est trop progressive, elle risque de ne pas sembler naturelle. Les valeurs de perception jusqu’à environ 40 simulent des
variantes usuelles de pièces.

Taille de la pièce Définit le volume de la pièce virtuelle, exprimé en mètres cubes. Plus la pièce est grande, plus la réverbération est longue.
Utilisez cette commande pour créer des pièces virtuelles à votre gré, qu’elles fassent quelques mètres carrés ou qu’elles soient gigantesques.
Dimension Indique le rapport entre la largeur (gauche-droite) et la profondeur (avant-arrière) de la pièce. Une hauteur sonore appropriée est
calculée et reportée en tant que Dimensions réelles de la pièce au bas de la boîte de dialogue. En règle générale, les pièces ayant un rapport
largeur-profondeur compris entre 0,25 et 4 offrent les meilleures réverbérations sonores.
Emplacement gauche/droit (audio stéréo uniquement) Vous permet de décentrer les premières réflexions. Sélectionnez Inclure direction dans
la section Niveau de sortie afin de placer le signal d’origine au même emplacement. Il est possible d’obtenir de très agréables effets avec des
chanteurs légèrement décentrés, de 5 à 10 % vers la gauche ou la droite.
Coupure passe-haut Empêche la perte de sons basse fréquence (100 Hz ou moins), tels que les basses ou les tambours. Ces sons peuvent se
déphaser si la pièce est petite et que vous mélangez les premières réflexions avec le signal original. Indiquez une fréquence supérieure à celle du
son que vous voulez conserver. Un réglage entre 80 Hz et 150 Hz s’avère habituellement judicieux. Si la valeur de coupure est trop élevée, vous
n’allez sans doute pas obtenir une image réaliste de la taille de la pièce.
Définir la réverbération en fonction de la taille de la pièce Détermine les délais d’atténuation et de prédélai en fonction de la taille de la pièce,
afin de produire une réverbération plus convaincante. Vous pouvez ensuite définir plus précisément ces délais.

Options de coloration
Pour ajuster visuellement les options de coloration, faites glisser le curseur directement dans le graphe.

Fréquence Détermine la fréquence angulaire des papillons grave et aigu ou la fréquence centrale de la bande du milieu. Par exemple, pour
« chauffer » la réverbération, réduisez la fréquence et le gain du papillon aigu.
Gain Amplifie ou atténue la réverbération dans différentes plages de fréquences.

Pour améliorer le son de manière subtile, amplifiez les fréquences de réverbération autour de la fréquence naturelle d’un élément sonore
principal. Pour la voix d’un chanteur, par exemple, amplifiez les fréquences de 200 Hz à 800 Hz afin d’améliorer la résonance dans cette plage.

Q Détermine la largeur de la bande du milieu. Des valeurs élevées affectent une plage étroite de fréquences, tandis que des valeurs faibles
affectent une plage plus large.

Pour obtenir une résonance bien distincte, utilisez une valeur de 10 ou supérieure. Pour amplifier ou couper une plage étendue de fréquences,
utilisez des valeurs inférieures (2 ou 3, par exemple).

Atténuation Détermine le délai en millisecondes requis par la réverbération pour s’atténuer avant l’application de la courbe de coloration. Les
valeurs jusqu’à 700 fonctionnent bien. Si vous souhaitez obtenir une réverbération plus colorée, définissez une valeur inférieure (entre 100 et 250).

Options de niveau de sortie
Pur Contrôle le niveau du signal d’origine inclus avec la réverbération. Utilisez un niveau inférieur afin de créer un son distant. Optez pour un
niveau élevé (proche de 100 %) tout en définissant un niveau faible de réverbération et de réflexion si vous souhaitez créer une impression de
proximité par rapport à la source.
Réverbération Contrôle le niveau de la couche dense du son réverbéré. L’équilibre entre les sons purs et les sons réverbérés modifie la
perception de la distance.
Premières réflexions Détermine le niveau des premiers échos à atteindre l’oreille, pour donner une idée de la taille générale de la pièce. Une
valeur trop élevée peut produire un son artificiel, alors qu’une valeur trop faible risque de supprimer les repères audibles pour la taille de la pièce.
Il est généralement conseillé de commencer avec un volume inférieur de moitié à celui du signal pur.
Inclure direction Déphase légèrement les canaux gauche et droit du signal original afin de faire correspondre l’emplacement des premières
réflexions (définies par l’emplacement gauche/droit sur l’onglet Premières réflexions).
Somme des entrées Combine les canaux d’une forme d’onde stéréo ou surround avant le début du traitement. Activez cette option pour
accélérer le traitement, mais désactivez-la pour obtenir une réverbération riche et pleine.

Effet Réverbération
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L’effet Réverbération > Réverbération simule les espaces acoustiques sur la base d’un traitement à convolution. Il peut reproduire des
environnements acoustiques ou ambiants tels qu’un vestiaire, une douche carrelée, une salle de concert ou un grand amphithéâtre. Les échos
peuvent être espacés de manière si ténue que la queue réverbérée d’un signal s’atténue graduellement au fil du temps, créant un son naturel et
chaud. Le Temps de prédélai peut également être utilisé pour simuler la taille de la pièce.

Par rapport à l’effet Réverbération, l’effet Réverbération avancée propose plus d’options et un meilleur rendu audio. Toutefois, il est recommandé
d’utiliser les options de base de l’effet Réverbération pour effectuer un ajustement rapide.

Important : le traitement de cet effet prend un certain temps. Dans le cadre d’une utilisation multipiste en temps réel, effectuez le pré-rendu de
cet effet ou remplacez-le par l’effet Réverbération studio (Voir la section Pré-rendu des effets de piste pour améliorer les performances).
Temps d’atténuation Détermine le délai en millisecondes requis pour que la réverbération s’atténue jusqu’à l’infini (environ -96 dB). Utilisez des
valeurs inférieures à 400 pour les petites salles, des valeurs comprises entre 400 et 800 pour les salles de taille moyenne et des valeurs
supérieurs à 800 pour les grandes salles, telles que des salles de concert. Saisissez, par exemple, 3 000 millisecondes pour créer des queues de
réverbération dans un amphithéâtre gigantesque.

Pour simuler des pièces ayant à la fois des échos et des réverbérations, utilisez d’abord l’effet Echo pour établir la taille de la pièce et ensuite
l’effet Réverbération pour rendre le son plus naturel. Un temps d’atténuation d’à peine 300 millisecondes permet de conférer plus d’espace à
un son pur.

Temps de prédélai Détermine le délai en millisecondes requis par la réverbération pour atteindre son amplitude maximale. Si le temps
d’atténuation est bref, le temps de prédélai doit également être court. En général, il est conseillé de définir une valeur environ 10 % aussi longue
que le temps d’atténuation. L’utilisation d’un temps de prédélai plus long avec un temps d’atténuation plus court permet toutefois d’obtenir des
effets intéressants.
Diffusion Simule l’absorption naturelle, en réduisant les hautes fréquences au fur et à mesure de l’atténuation de la réverbération. Des temps
d’absorption plus rapides simulent des pièces remplies de personnes, de meubles et de tapis (discothèques et cinémas, par exemple). Des délais
plus courts (plus de 1 000 millisecondes) simulent des pièces vides (auditoriums, par exemple), où dominent les réflexions de hautes fréquences.
Perception Modifie les caractéristiques des réflexions dans une pièce. Les valeurs inférieures créent une réverbération plus coulée dans laquelle
on ne distingue pas autant d’échos. Les valeurs élevées simulent de grandes pièces, avec une variation plus importante de l’amplitude de
réverbération, et donnent une impression d’espace en créant des réflexions bien distinctes au cours du temps.

Pour obtenir un effet de canyon réussi, paramétrez cette option à 100 et le temps d’atténuation à 2 000 millisecondes, voire plus.

Pur Définit le pourcentage de source audio à appliquer. La plupart du temps, un pourcentage de 90 % s’avère judicieux. Définissez un
pourcentage plus élevé pour ajouter un effet de grandeur subtile et un pourcentage plus faible pour obtenir un effet spécial.
Avec effets Définit le pourcentage de réverbération à appliquer. Pour ajouter un effet de grandeur subtile à une piste, définissez ce pourcentage
sur une valeur inférieure au pourcentage Pur. Augmentez ce pourcentage afin de simuler une distance plus éloignée de la source audio.
Somme des entrées Combine les canaux d’une forme d’onde stéréo ou surround avant le début du traitement. Activez cette option pour
accélérer le traitement, mais désactivez-la pour obtenir une réverbération riche et pleine.

Effet Réverbération studio
A l’instar des autres effets de réverbération, l’effet Réverbération > Réverbération studio simule des espaces acoustiques. Cependant, il est plus
rapide et exige moins de ressources du processeur que les autres effets de réverbération car il n’est pas basé sur la convolution. Dès lors, vous
pouvez apporter des modifications en temps réel de manière simple et rapide dans l’éditeur de multipiste, sans devoir effectuer un prérendu des
effets d’une piste.

Taille de la pièce Définit la taille de la pièce.
Atténuation Règle l’atténuation de la réverbération en millisecondes.
Premières réflexions Détermine le pourcentage d’échos qui atteignent les premiers l’oreille, pour donner une idée de la taille générale de la
pièce. Une valeur trop élevée peut produire un son artificiel, alors qu’une valeur trop faible risque de perdre les repères audio pour la taille de la
pièce. La moitié du volume du signal original constitue un bon point de départ.
Largeur stéréo Contrôle la diffusion sur les canaux stéréo. 0 % produit un signal de réverbération mono ; 100 % produit une séparation stéréo
maximale.
Coupure fréquence élevée Indique la fréquence la plus haute à laquelle la réverbération peut avoir lieu.
Coupure fréquence basse Indique la fréquence la plus basse à laquelle la réverbération peut avoir lieu.
Amortissement Définit l’importance de l’atténuation appliquée aux hautes fréquences du signal de réverbération au cours du temps. Si vous
définissez un pourcentage élevé, l’amortissement est plus important et produit un ton de réverbération plus chaud.
Diffusion Simule l’absorption du signal réverbéré à mesure qu’il est réfléchi par les surfaces, telles que les tapis ou les rideaux. Si vous attribuez
une valeur faible, vous obtenez plus d’échos et si vous optez pour une valeur plus élevée, la réverbération est plus lisse avec moins d’échos.
Pur Définit le pourcentage des données audio source auxquelles l’effet doit être appliqué.
Avec effets Définit le pourcentage de réverbération à appliquer.

Effet Réverbération surround
L’effet Réverbération > Réverbération surround est destiné principalement aux sources 5.1. Il peut toutefois être utilisé pour créer une ambiance
surround avec des sources mono ou stéréo. Dans l’éditeur de forme d’onde, sélectionnez Edition > Convertir le type d’échantillon afin de convertir
en 5.1 un fichier mono ou stéréo, puis appliquez l’effet Réverbération surround. Dans l’éditeur de multipiste, vous pouvez envoyer des pistes mono
ou stéréo vers un bus 5.1 ou les mastériser à l’aide de l’effet Réverbération surround.
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Entrée, Centre Détermine le pourcentage du canal central inclus dans le signal traité.
Entrée, FB (LFE) Détermine le pourcentage du canal LFE utilisé pour provoquer la réverbération des autres canaux (le signal LFE lui-même n’est
pas réverbéré).
Remarque : l’effet génère toujours 100 % des canaux surround gauche, droit et arrière.
Impulsion Spécifie un fichier qui simule un espace acoustique. Cliquez sur Charger pour ajouter un fichier d’impulsion personnalisé de 6 canaux
au format WAV ou AIFF.
Taille de la pièce Précise un pourcentage pour la pièce complète défini par le fichier d’impulsions Plus le pourcentage est grand, plus les
réverbérations sont longues.
Limiter BF Réduit les composants basses fréquences, à forte dominante de basses dans la réverbération, pour produire un son plus clair mieux
articulé.
Limiter HF Réduit les composants transitoires haute fréquence dans la réverbération, pour éviter la discordance et produire un son plus chaud,
plus riche.
Pré-retard Détermine combien de millisecondes nécessite la réverbération pour atteindre l’amplitude maximale. Pour produire le son le plus
naturel, spécifiez un pré-retard court compris entre 0 et 10 millisecondes. Pour produire des effets spéciaux intéressants, spécifiez un long pré-
retard de 50 millisecondes ou plus.
Largeur avant Contrôle la diffusion stéréo sur les trois canaux avant.
Un réglage de 0 produit un signal de réverbération mono.

Largeur surround Contrôle la diffusion stéréo sur les canaux surround arrière (Gs et Ds).
Niv. effets C Contrôle le niveau de réverbération ajouté au canal central. Ce canal contenant habituellement des dialogues, la réverbération doit
normalement être plus faible.
Bal. G/D Contrôle l’équilibre gauche-droit des haut-parleurs avant et arrière. Une valeur de 100 produit des réverbérations sur le haut-parleur de
gauche uniquement, une valeur de -100 sur celui de droite uniquement.
Bal. Av/Ar Contrôle l’équilibre avant-arrière des haut-parleurs gauche et droit. Une valeur de 100 produit des réverbérations sur le haut-parleur
avant uniquement, une valeur de -100 sur celui arrière uniquement.
Mix rés/ori Contrôle le rapport entre le son d’origine et le son réverbéré. Un paramètre de 100 génère uniquement de la réverbération.
Gain Amplifie ou atténue l’amplitude après compression.
Voir aussi
Application d’effets dans l’éditeur de multipiste

Utilisation des préconfigurations d’effets

Commande des paramètres d’effets dans des graphiques
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Effets d’imagerie stéréo

 

Haut de la page

Effet Extracteur de canal central

Certains effets permettent de modifier la position apparente, c’est-à-dire l’imagerie stéréo, des sons émis par les haut-parleurs.

Effet Extracteur de canal central
L’effet Imagerie stéréo > Extracteur de canal central conserve ou supprime les fréquences communes aux deux canaux gauche et droit, c’est-à-
dire les sons qui sont panoramisés au centre. Les voix ainsi que les instruments graves et solistes sont souvent enregistrés de cette manière. Par
conséquent, vous pouvez utiliser cet effet pour augmenter le volume des voix, des basses ou de la grosse caisse ou supprimer certains de ces
éléments pour obtenir un mélange karaoké.

Onglet Extraction Limite l’extraction aux données audio qui remplissent certains critères.

Extraire  Sélectionnez les données audio issues du canal central, gauche, droit ou surround, ou sélectionnez Personnalisé et précisez un
angle de phase, un pourcentage de panoramique et un délai pour les données audio à extraire ou à supprimer (l’option Surround extrait
les données audio qui sont parfaitement déphasées entre les canaux gauche et droit).
Plage de fréquences  Détermine la plage à extraire ou à supprimer. Il existe des plages prédéfinies : Voix masculine, Voix féminine,
Basses et Spectre entier. Sélectionnez Personnalisé pour définir une plage de fréquences.

Onglet Discrimination Comprend des paramètres qui permettent d’identifier le canal central.

Marge de répartiteur  Déplacez le curseur vers la gauche pour augmenter l’absorption audio et la rendre moins artificielle et vers la droite
pour séparer davantage le matériel du canal central du mixage.
Discrimination de phase  En règle générale, il est préférable d’utiliser des valeurs élevées pour extraire le canal central et des valeurs
faibles pour le supprimer. Les valeurs plus faibles autorisent une absorption plus importante et risquent de ne pas séparer efficacement les
voix du mixage. Cependant, elles sont plus efficaces pour capturer tous les signaux au centre. Dans l’ensemble, choisissez une valeur
comprise entre 2 et 7 pour obtenir un bon résultat.
Discrimination d’amplitude et Largeur de bande d’amplitude Additionne les canaux gauche et droit et crée un troisième canal
parfaitement déphasé qu’Audition utilise pour supprimer les fréquences similaires. Si l’amplitude est semblable à chaque fréquence, les
données audio en phase communes aux deux canaux sont également prises en considération. Si vous attribuez des valeurs inférieures
aux options Discrimination d’amplitude et Largeur de bande d’amplitude, vous coupez davantage de signaux du mixage mais vous risquez
également d’enlever les voix. Si vous attribuez des valeurs élevées, l’extraction dépend plus de la phase du matériel et moins de
l’amplitude du canal. Pour un fonctionnement idéal, paramétrez l’option Discrimination d’amplitude entre 0,5 et 10 et Largeur de bande
d’amplitude entre 1 et 20.
Vitesse d’atténuation spectrale  Conservez une valeur de 0 % pour un traitement plus rapide. Définissez-la entre 80 % et 98 % pour
lisser les distorsions en arrière-plan.

Niveaux des canaux central et latéral Précise la proportion du signal sélectionné à extraire ou à supprimer. Déplace les curseurs vers le haut
pour inclure le matériel supplémentaire.
Options avancées Cliquez sur le triangle afin d’accéder aux options suivantes :

Taille de la TFR  Détermine la taille de la TFR (transformation de Fourier rapide) ; des valeurs faibles améliorent la vitesse de traitement,
des valeurs élevées améliorent la qualité. En général, le paramétrage optimal se situe entre 4 096 et 8 192.
Incrustations  Définit le nombre de fenêtres TFR superposées. Les valeurs supérieures produisent des résultats plus lisses ou un effet de
type chœur, mais elles exigent plus de temps de traitement. Les valeurs inférieures produisent parfois des bruits en arrière–plan
ressemblant à des bulles qui pétillent. Sélectionnez une valeur entre 3 et 9 pour obtenir un bon résultat.
Largeur de la fenêtre  Définit le pourcentage de chaque fenêtre TFR. Choisissez une valeur entre 30 % et 100 % pour obtenir un bon
résultat.

Voir aussi
Application d’effets dans l’éditeur de multipiste

Utilisation des préconfigurations d’effets
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Special effects

Note:

To the top

Link 

Positive and Negative graphs

Reset 

Curve Smoothing

Time Smoothing

dB Range

Linear Scale

Post-filter DC Offset

To the top

Compressor

Filter

Type

Freq

Resonance

Distortion

Amplifier

Distortion effect
Guitar Suite effect
Mastering effect
Vocal Enhancer effect

Special effects require mono or stereo audio; they do not support 5.1 surround.

Distortion effect
Use the Special > Distortion effect to simulate blown car speakers, muffled microphones, or overdriven amplifiers.

Creates identical curves in the Positive and Negative graphs.

Specify separate distortion curves for positive and negative sample values. The horizontal ruler (x-axis) indicates
input level in decibels; the vertical ruler (y-axis) indicates output level. The default diagonal line depicts an undistorted signal, with a one-to-one
relationship between input and output values.
Click and drag to create and adjust points on the graphs. Drag points off a graph to remove them.

To copy one graph to another, click the arrow buttons between them.

Returns a graph to its default, undistorted state.

Creates curved transitions between control points, sometimes producing a more natural distortion than the default linear
transitions.

Determines how quickly distortion reacts to changes in input levels. Level measurements are based on low-frequency content,
creating softer, more musical distortion.

Changes the amplitude range of the graphs, limiting distortion to that range.

Changes the amplitude scales of the graphs from logarithmic decibels to normalized values.

Compensates for any sample offset introduced by distortion processing. To understand this concept, see Correct DC offset.
Such offsets can cause audible pops and clicks when edited.

Guitar Suite effect
The Special > Guitar Suite effect applies a series of processors that optimize and alter the sound of guitar tracks. The Compressor stage reduces
dynamic range, producing a tighter sound with greater impact. Filter, Distortion, and Box Modeler stages simulate common effects that guitarists
use to create expressive, artistic performances.

Apply the Guitar Suite to vocals, drums, or other audio to create textured effects.

Reduces dynamic range to maintain consistent amplitude and help guitar tracks stand out in a mix.

Simulates guitar filters ranging from resonators to talk boxes. Choose an option from this menu, and then set options below:

Determines which frequencies are filtered. Specify Lowpass to filter high frequencies, Highpass to filter low frequencies, or
Bandpass to filter frequencies above and below a center frequency.

Determines the cutoff frequency for Lowpass and Highpass filtering, or the center frequency for Bandpass filtering.

Feeds back frequencies near the cutoff frequency, adding crispness with low settings and whistling harmonics with high
settings.

Adds a sonic edge often heard in guitar solos. To change the distortion character, choose an option from the Type menu.

Simulates various amplifier and speaker combinations that guitarists use to create unique tones.
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Controls the ratio of original to processed audio.

Mastering effect
Mastering describes the complete process of optimizing audio files for a particular medium, such as radio, video, CD, or the web. In Adobe
Audition, you can quickly master audio with the Special > Mastering effect.

Before mastering audio, consider the requirements of the destination medium. If the destination is the web, for example, the file will likely be
played over computer speakers that poorly reproduce bass sounds. To compensate, you can boost bass frequencies during the equalization stage
of the mastering process.

Adjusts the overall tonal balance.

Shows frequency along the horizontal ruler (x-axis) and amplitude along the vertical ruler (y-axis), with the curve representing the
amplitude change at specific frequencies. Frequencies in the graph range from lowest to highest in a logarithmic fashion (evenly spaced by
octaves).

Drag control points in the graph to visually adjust the settings below.

Activate shelving filters at either end of the frequency spectrum.

Activates a peaking filter in the center of the frequency spectrum.

Indicates the center frequency of each frequency band.

Indicates the level of each frequency band.

Controls the width of the affected frequency band. Low Q values (up to 3) affect a larger range of frequencies and are best for overall
audio enhancement. High Q values (6–12) affect a very narrow band and are ideal for removing a particular, problematic frequency, like
60-Hz hum.

Adds ambience. Drag the Amount slider to change the ratio of original to reverberant sound.

Exaggerates high-frequency harmonics, adding crispness and clarity. Mode options include Retro for light distortion, Tape for bright tone,
and Tube for quick, dynamic response. Drag the Amount slider to adjust the level of processing.

Adjusts the stereo image (disabled for mono audio). Drag the Width slider to the left to narrow the image and increase central focus.
Drag the slider to the right to expand the image and enhance spatial placement of individual sounds.

Applies a limiter that reduces dynamic range, boosting perceived levels. A setting of 0% reflects original levels; 100%
applies maximum limiting.

Determines output levels after processing. For example, to compensate for EQ adjustments that reduce overall level, boost the
output gain.

Vocal Enhancer effect
The Special > Vocal Enhancer effect quickly improves the quality of voice-over recordings. The Male and Female modes automatically reduce
sibilance and plosives, as well as microphone handling noise such as low rumbles. Those modes also apply microphone modeling and
compression to give vocals a characteristic radio sound. The Music mode optimizes soundtracks so they better complement a voice-over.

Optimizes audio for a man’s voice.

Optimizes audio for a woman’s voice.

Applies compression and equalization to music or background audio.
Applying effects in the Waveform Editor

Techniques for restoring audio

Match volume across multiple files
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Chorus effect
Chorus/Flanger effect
Flanger effect
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Chorus effect
The Modulation > Chorus effect simulates several voices or instruments played at once by adding multiple short delays with a small amount of
feedback. The result is lush, rich sound. You can use Chorus to enhance a vocal track or add stereo spaciousness to mono audio.

Adobe Audition uses a direct-simulation method to achieve a chorus effect, making each voice sound distinct from the original by slightly varying
timing, intonation, and vibrato. The Feedback setting lets you add extra detail to the result.

To achieve the best results with mono files, convert them to stereo before applying the Chorus effect.

Represent the characteristics of each voice in the chorus.

Determines the number of simulated voices.
Note: As you add more voices, the sound becomes richer and richer —but processing time also increases.

Specifies the maximum amount of delay allowed. Chorusing introduces short delays (often in the 15-35 millisecond range)
that vary in duration over time. If the setting is very small, all the voices start merging into the original, and an unnatural flanging effect
might occur. If the setting is too high, a warbled effect might occur, like a tape being eaten by a cassette deck.

Determines how quickly the delay cycles from zero to the maximum delay setting. Because the delay varies over time, the
pitch of the sample increases or decreases over time, giving the effect of separate, slightly out of tune voices. For example, a rate of 2 Hz
would vary the delay from zero to the maximum and back twice per second (simulating a pitch vibrato at twice per second). If this setting is
too low, the individual voices don’t vary much in pitch. If it is set too high, the voices may vary so quickly that a warbled effect might occur.

Adds a percentage of processed voices back into the effect input. Feedback can give a waveform an extra echo or reverb
effect. A little feedback (less than 10%) can provide extra richness, depending on the delay and vibrato settings. Higher settings produce
more traditional feedback, a loud ringing which can get loud enough to clip the signal.

Gives an added delay to each voice, separating them in time by as much as 200 milliseconds (1/5th of a second). High values
cause the separate voices to start at different times—the higher the value, the farther apart the onset of each voice may be. In contrast,
low values cause all voices to be in unison. Depending on other settings, low values can also produce flanging effects, which may be
undesirable if your goal is a realistic chorus effect.

Determines the maximum variation in amplitude that occurs. For example, you can alter the amplitude of a chorused
voice so that it is 5 dB louder or quieter than the original. At extremely high settings, the sound may cut in and out, creating an
objectionable warble. At extremely low settings (less than 1 dB), the depth may be unnoticeable unless the Modulation Rate is set
extremely high. Natural vibratos occur around 2 dB to 5 dB.
Note that this setting is a maximum only; the vibrato volume might not always go as low as the setting indicates. This limitation is
intentional, as it creates a more natural sound.

Determines the maximum rate at which amplitude changes occur. With very low values, the resulting voice slowly gets
louder and quieter, like a singer that cannot keep his or her breath steady. With very high settings, the result can be jittery and unnatural.

Ensures the best quality results. Increasing the quality, however, increases the processing time for previewing and
applying the effect.

Determines where the individual voices are placed in the stereo field and how the original stereo signal is interpreted. These
options are active only when you work with stereo files:

Combines the original left and right channels. If deselected, the channels are kept separate to
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preserve the stereo image. Leave this option deselected if the stereo source audio was originally monophonic—it won’t have any effect
other than increasing processing time.

Adds separate delays to the left and right outputs of each voice. This delay can make each voice seem to come from
a different direction when you listen through headphones. For greater stereo separation, deselect this option for audio that will be played
through standard speakers .

Specifies where chorused voices are placed across the left and right stereo image. At lower settings, voices are closer to
the center of the stereo image. At a setting of 50%, voices are spaced evenly from left to right. At higher settings, voices move to the outer
edges. If you use an odd number of voices, one is always directly in the center.

Sets the ratio of original (Dry) signal to chorused (Wet) signal. Extremely high settings may cause clipping.

In the Multitrack Editor, you can vary the Wet level over time with automation lanes. (See Automating track settings.)This technique is handy for
emphasizing vocal or instrumental solos.

Chorus/Flanger effect
The Modulation > Chorus/Flanger effect combines two popular delay-based effects. The Chorus option simulates several voices or instruments
played at once by adding multiple short delays with a small amount of feedback. The result is lush, rich sound. Use this effect to enhance vocal
tracks or add stereo spaciousness to mono audio.

The Flanger option creates a psychedelic, phase-shifted sound by mixing a varying, short delay with the original signal. This effect was originally
created by sending an identical audio signal to two reel-to-reel tape recorders, and periodically pressing the flange of one reel to slow it down.

Simulates several voices or instruments playing at once.

Simulates the delayed, phase-shifted sound originally heard in psychedelic music.

Controls the rate at which the delay time cycles from zero to the maximum setting.

Specifies the maximum amount of delay.

Controls the ratio of original to processed audio.

Emphasizes transients, giving them a sharper, more distinct sound.

Flanger effect
Flanging is an audio effect caused by mixing a varying, short delay in roughly equal proportion to the original signal. It was originally achieved by
sending an identical audio signal to two reel-to-reel tape recorders, and then pressing the flange of one reel to slow it down. Combining the two
resulting recordings produced a phase-shifted, time-delay effect, characteristic of psychedelic music of the 1960s and 1970s. The Modulation >
Flanger effect lets you create a similar result by slightly delaying and phasing a signal at specific or random intervals.

Sets the point in milliseconds at which flanging starts behind the original signal. The flanging effect occurs by cycling over time
from an initial delay setting to a second (or final) delay setting.
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Final Delay Time

Stereo Phasing

Feedback

Modulation Rate

Mode

Inverted

Special Effects

Sinusoidal

Mix

To the top

Stages

Intensity

Depth

Mod Rate

Phase Diff

Upper Freq

Feedback

Mix

Output Gain

Sets the point in milliseconds at which flanging ends behind the original signal.

Sets the left and right delays at separate values, measured in degrees. For example, 180° sets the initial delay of the right
channel to occur at the same time as the final delay of the left channel. You can set this option to reverse the initial/final delay settings for the left
and right channels, creating a circular, psychedelic effect.

Determines the percentage of the flanged signal that is fed back into the flanger. With no feedback, the effect uses only the original
signal. With feedback added, the effect uses a percentage of the affected signal from before the current point of playback.

Determines how quickly the delay cycles from the initial to final delay times, measured either in cycles per second (Hz) or beats
per minute (beats). Small setting adjustments produce widely varying effects.

Provides three ways of flanging:

Inverts the delayed signal, cancelling out audio periodically instead of reinforcing the signal. If the Original - Expanded mix
settings are set at 50/50, the waves cancel out to silence whenever the delay is at zero.

Mixes the normal and inverted flanging effects. The delayed signal is added to the effect while the leading signal is
subtracted.

Makes the transition from initial delay to final delay and back follow a sine curve. Otherwise, the transition is linear, and the
delays from the initial setting to the final setting are at a constant rate. If Sinusoidal is selected, the signal is at the initial and final delays
more often than it is between delays.

Adjusts the mix of original (Dry) and flanged (Wet) signal. You need some of both signals to achieve the characteristic cancellation and
reinforcement that occurs during flanging. With Original at 100%, no flanging occurs at all. With Delayed at 100%, the result is a wavering sound,
like a bad tape player.

Phaser effect
Similar to flanging, phasing shifts the phase of an audio signal and recombines it with the original, creating psychedelic effects first popularized by
musicians of the 1960s. But unlike the Flanger effect, which uses variable delays, the Modulation > Phaser effect sweeps a series of phase-
shifting filters to and from an upper frequency. Phasing can dramatically alter the stereo image, creating unearthly sounds.

Specifies the number of phase-shifting filters. A higher setting produces denser phasing effects.

Determines the amount of phase-shifting applied to the signal.

Determines how far the filters travel below the upper frequency. Larger settings produce a wider tremolo effect; 100% sweeps from the
upper frequency to zero Hz.

Modulation rate controls how fast the filters travel to and from the upper frequency. Specify a value in Hz (cycles per second).

Determines the phase difference between stereo channels. Positive values start phase shifts in the left channel, negative values in the
right. The maximum values of +180 and -180 degrees produce a complete difference and are sonically identical.

Sets the upper-most frequency from which the filters sweep. To produce the most dramatic results, select a frequency near the
middle of the selected audio’s range.

Feeds a percentage of the phaser output back to the input, intensifying the effect. Negative values invert phase before feeding audio
back.

Controls the ratio of original to processed audio.

Adjusts the output level after processing.
Applying effects in the Waveform Editor
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Effet Générer des tonalités

Fréquences de balayage

Fréquence de base

Taux de modulation

Vitesse de modulation

Forme d’onde

Composants de fréquence

Volume

Durée

Débuter la phase

Différence de phase du 2e canal

Modifier la vitesse

Décalage DC

Avec audio sélectionné

Choisissez Effets > Générer des tonalités pour créer une forme d’onde simple à l’aide de plusieurs paramètres liés à la fréquence- et à
l’amplitude-. Les tonalités générées constituent de bons points de départ pour les effets sonores.

Applique une transition aux tonalités à partir des paramètres de l’onglet Début jusqu’à ceux de l’onglet Fin. (L’onde
reste constante.)

Indique la fréquence principale à utiliser pour générer les tonalités. 

Module la hauteur de la fréquence de base sur une plage définie par l’utilisateur-. Par exemple, un paramètre de 100 Hz
module la fréquence d’origine de 50 Hz en dessous jusqu’à 50 Hz au-dessus.

Indique combien de fois par seconde la fréquence est modulée, produisant un effet de vibrato mélodieux.

Choisissez une des options suivantes :
L’option Sinusoïdale et Inverser l'onde sinusoïdale produit la fréquence fondamentale. Un paramètre Type défini sur 1.00
produit des tonalités pures. Des paramètres moins élevés génèrent des ondes plus carrées, et plus élevés des ondes plus
triangulaires.
L’option Triangle/Dents de scie produit une véritable onde triangulaire avec des harmoniques impaires uniquement, si le
paramètre Type est défini sur 50 %. Les paramètres inférieurs et supérieurs à ce pourcentage produisent des formes d’onde
en dents de scie avec des harmoniques à la fois paires et impaires.
L’option Carré produit uniquement des harmoniques impaires. Une véritable onde carrée est créée si le paramètre Type est
défini sur 50 %. Des paramètres inférieurs et supérieurs font osciller la forme d’onde entre une crête plate (100 %) et un creux
plat (0 %). (Des valeurs extrêmes ne produisent qu’un clic audible.)

Permet d’ajouter jusqu’à cinq harmoniques à la fréquence fondamentale (Fréquence de base). En dessous des
curseurs, entrez une fréquence spécifique pour chaque harmonique ou indiquez un multiplicateur de la fréquence fondamentale. Ensuite, utilisez
les curseurs d’amplitude pour mixer proportionnellement les harmoniques. 

Définit la sortie globale de l’effet.

Indique la longueur de la tonalité générée dans le format actuellement spécifié pour l’échelle de temps. Avec le bouton droit de la souris,
cliquez sur les numéros afin de choisir un format heure séparé pour l’effet Générer des tonalités.

Pour accéder aux options suivantes, cliquez sur Options avancées :

Indique le point de départ du cycle de l’onde. Si cette valeur est définie sur 0°, l’onde commence au point de passage à zéro.
Si cette valeur est définie sur 90°, l’onde commence à une amplitude maximale (ce qui produit un clic audible).

Ajuste la phase relative des canaux stéréo. Avec une valeur nulle, les canaux sont entièrement phasés, avec
une valeur de 180, ils sont complètement déphasés.

Modifie dynamiquement la phase relative entre les deux canaux d’un fichier audio stéréo au fil du temps. Par exemple, si
vous entrez 1 Hz, vous obtenez une différence de phase cyclique de 360° pour chaque seconde.

Ajoute un décalage de courant direct qui déplace le centre de la forme d’onde vers le haut ou vers le bas selon le pourcentage
spécifié. Utilisez ce réglage pour étalonner le matériel audio ou simuler le décalage induit par le matériel.

Sélectionnez l’une des options suivantes :
Remplacer : permute le contenu audio existant par des tonalités générées.
Moduler : module ou multiplie l’audio existant selon les paramètres de tonalité actuels. Cette option est particulièrement utile
pour ajouter des effets spéciaux.
Démoduler: démodule l’audio existant selon les paramètres de tonalité actuels. Cette option permet de créer des effets
uniques ou de rétablir l’audio précédemment traité avec l’option Moduler à son état d’origine.

Chevauchement : mixe les tonalités générées avec l’audio existant.
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Effet Filtre coupe-bande
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Fréquence

Gain

Largeur de bande coupée

Ultra-silencieux

Fixer les atténuations à

L’effet Filtre et égaliseur > Filtre coupe-bande supprime jusqu’à six bandes de fréquence définies par l’utilisateur-. Utilisez cet effet pour supprimer
des bandes de fréquence très étroites, telles qu’un bourdonnement de 60 Hz, tout en laissant intactes les fréquences environnantes.

Pour supprimer les sons en "ess", utilisez le paramètre prédéfiniAtténuateur de sifflements (Déesseur). Ou utilisez les paramètres prédéfinis
DTMF afin de supprimer les tonalités standard pour les systèmes téléphoniques analogiques.

Spécifie la fréquence centrale pour chaque bande coupée.

Spécifie l’amplitude pour chaque bande coupée.

Détermine la plage de fréquences de toutes les bandes coupées. Les trois options vont de Étroite pour un filtre de
second ordre, qui supprime certaines fréquences adjacentes, à Extrêmement étroite pour un filtre de sixième ordre, qui est très spécifique. 

En règle générale, n’utilisez pas plus de 30 dB d’atténuation pour un paramètre Étroite, 60 dB pour Très étroite et 90 dB pour Extrêmement
étroite. Une atténuation plus intense peut supprimer une vaste plage de fréquences avoisinantes.

Supprime virtuellement le bruit et les artefacts, mais nécessite davantage de traitement. Cette option est audible uniquement
avec les casques et les systèmes de surveillance haut de gamme.

Détermine si les bandes coupées présentent des niveaux d’atténuation identiques ou individuels. 
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Effet Déphaseur graphique
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Graphique de changement de phase

Échelle de fréquence

Plage

Canal

Remarque :

Taille de la TFR

L’effet Imagerie stéréo > Déphaseur graphique permet de régler la phase d’une forme d’onde en ajoutant des points de contrôle sur un graphique. 

Avec le bouton droit de la souris, cliquez sur des points pour accéder à la boîte de dialogue Point d’édition et disposer d’un contrôle numérique
précis.

La règle horizontale (abscisses) mesure la fréquence, tandis que la règle verticale (ordonnées) affiche le
degré de phase à décaler ; zéro signifie qu’il n’y a aucun décalage de phase. Vous pouvez simuler un effet stéréo en créant un motif en zigzag qui
s’accentue à l’extrémité supérieure d’un canal.

Définit les valeurs de la règle horizontale (abscisses) sur une échelle linéaire ou logarithmique. Sélectionnez Logarithmique
pour un niveau de détail plus précis dans les basses fréquences. (L’échelle logarithmique reproduit mieux l’accentuation des fréquences pour
l’ouïe humaine.) Sélectionnez Linéaire pour un niveau de détail plus précis dans les hautes fréquences.

Définit les valeurs de la règle verticale (abscisses) sur une échelle de 360° ou 180°.

Spécifie le ou les canaux auxquels appliquer le décalage de phase.

Traitez un seul canal pour obtenir de meilleurs résultats. Si vous appliquez un décalage de phase identique à deux canaux stéréo, le
son du fichier résultant est exactement le même.

Spécifie la taille de la TFR (Transformation de Fourier rapide). Des tailles supérieures donnent des résultats plus précis, mais
exigent un temps de traitement plus long.
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Effet Correction manuelle de la hauteur de ton (éditeur de forme
d’onde uniquement)
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Canal de référence

Courbes splines

Résolution de courbe de hauteur de ton

L’effet Correction manuelle de la hauteur de ton vous permet de régler visuellement la hauteur de ton avec l’affichage de la hauteur de ton
spectrale. L’affichage de la hauteur de ton spectrale présente la hauteur de ton fondamentale sous la forme d’un trait bleu vif et les partiels dans
des teintes allant du jaune au rouge. La hauteur de ton corrigée s’affiche sous la forme d’un trait vert vif.

Vous pouvez surveiller visuellement la hauteur de ton à tout moment sans utiliser l’effet Correction manuelle de la hauteur de ton. Il vous suffit
de cliquer sur l’icône Afficher la hauteur de ton spectrale <<ICON>> dans la barre d’options. Pour personnaliser la résolution, la plage de
décibels et le quadrillage, réglez les paramètres d’affichage de hauteur de ton dans les préférences d’affichage spectral.

1. Sélectionnez Effets > Temps et hauteur de ton > Correction manuelle de la hauteur de ton.

2. Dans la fenêtre Correction manuelle de la hauteur de ton, définissez les options suivantes :

Choisissez un canal source dans lequel les changements de hauteur de ton sont les plus clairs. L’effet
analyse uniquement le canal sélectionné, mais applique la correction de hauteur de ton de manière égale à tous les canaux.

Créez des transitions plus douces lors de l’utilisation d’images clés d’enveloppe afin d’appliquer une
correction de hauteur de ton différente au fil du temps.

Définit la taille TFR (transformation de Fourier rapide) de chaque élément de
données traité par l’effet. En général, il est conseillé d’utiliser de petites valeurs pour corriger les fréquences élevées. En ce
qui concerne les voix, les valeurs 2 048 ou 4 096 procurent un son très naturel, tandis que la valeur 1 024 donne des effets
robotiques.

3. Effectuez l’une des opérations suivantes dans le panneau Editeur :

Pour appliquer une modification uniforme de la hauteur de ton, faites glisser le bouton Modifier la hauteur de ton
<<ICON>> dans l’affichage tête haute.
Pour modifier la hauteur de ton au fil du temps, ajoutez des images clés à la ligne d’enveloppe jaune au centre de
l’affichage de forme d’onde.

Pour effectuer un zoom avant sur certaines plages de hauteur de ton, cliquez avec le bouton droit de la souris et faites
glisser le pointeur de la règle verticale vers la droite de l’affichage de hauteur de ton spectrale. Pour réinitialiser le niveau
de zoom ou personnaliser l’échelle affichée, cliquez avec le bouton droit de la souris sur la règle et sélectionnez des
options dans le menu déroulant.

Modification de la hauteur de ton dans le panneau Editeur 
A. Le bouton Régler la hauteur de ton modifie uniformément la hauteur de ton B. Des images clés sur la ligne d’enveloppe modifient la hauteur de
ton au fil du temps 
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Filter and equalizer effects

To the top

Scale

Spline Curves

Reset 

Advanced options

FFT Size

Window

To the top

Gain sliders

Range

FFT Filter effect
Graphic Equalizer effect
Parametric Equalizer effect

FFT Filter effect
The graphic nature of the Filter And EQ > FFT Filter effect makes it easy to draw curves or notches that reject or boost specific frequencies. FFT
stands for Fast Fourier Transform, an algorithm that quickly analyzes frequency and amplitude.

This effect can produce broad high- or low-pass filters (to maintain high or low frequencies), narrow band-pass filters (to simulate the sound of a
telephone call), or notch filters (to eliminate small, precise frequency bands).

Determines how frequencies are arranged along the horizontal x-axis:

For finer control over low frequencies, select Logarithmic. A logarithmic scale more closely resembles how people hear sound.

For detailed, high-frequency work with evenly spaced intervals in frequency, select Linear.

Creates smoother, curved transitions between control points, rather than more abrupt, linear transitions. (See About spline curves
for graphs.)

Reverts the graph to the default state, removing filtering.

Click the triangle to access these settings:

Specifies the Fast Fourier Transform size, determining the tradeoff between frequency and time accuracy. For steep, precise
frequency filters, choose higher values. For reduced transient artifacts in percussive audio, choose lower values. Values between 1024 and
8192 work well for most material.

Determines the Fast Fourier transform shape, with each option resulting in a different frequency response curve.
These functions are listed in order from narrowest to widest. Narrower functions include fewer surrounding, or sidelobe, frequencies but
less precisely reflect center frequencies. Wider functions include more surrounding frequencies but more precisely reflect center
frequencies. The Hamming and Blackman options provide excellent overall results.

Graphic Equalizer effect

The Filter And EQ > Graphic Equalizer effect boosts or cuts specific frequency bands and provides a visual representation of the resulting EQ
curve. Unlike the Parametric Equalizer, the Graphic Equalizer uses preset frequency bands for quick and easy equalization.

You can space frequency bands at the following intervals:

One octave (10 bands)

One-half octave (20 bands)

One-third octave (30 bands)

Graphic equalizers with fewer bands provide quicker adjustment; more bands provide greater precision.

Sets the exact boost or attenuation (measured in decibels) for the chosen band.

Defines the range of the slider controls. Enter any value between 1.5 and 120 dB. (By comparison, standard hardware equalizers have a
range of about 12 to 30 dB.)
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Accuracy

Master Gain

Note:

To the top

Master Gain

Graph

Frequency

Gain

Q / Width

Band

Constant Q, Constant Width

Sets the accuracy level for equalization. Higher accuracy levels give better frequency response in the lower ranges, but they require
more processing time. If you equalize only higher frequencies, you can use lower accuracy levels.

If you equalize extremely low frequencies, set Accuracy to between 500 and 5000 points.

Compensates for an overall volume level that is too soft or too loud after the EQ settings are adjusted. The default value of 0 dB
represents no master gain adjustment.

The Graphic Equalizer is an FIR (Finite Impulse Response) filter. FIR filters better maintain phase accuracy but have slightly less frequency
accuracy than IIR (Infinite Impulse Response) filters like the Parametric Equalizer.

Parametric Equalizer effect
The Filter And EQ > Parametric Equalizer effect provides maximum control over tonal equalization. Unlike the Graphic Equalizer, which provides a
fixed number of frequencies and Q bandwidths, the Parametric Equalizer gives you total control over frequency, Q, and gain settings. For example,
you can simultaneously reduce a small range of frequencies centered around 1000 Hz, boost a broad low-frequency shelf centered around 80 Hz,
and insert a 60 Hz notch filter.

The Parametric Equalizer uses second-order IIR (Infinite Impulse Response) filters, which are very fast and provide very accurate frequency
resolution. For example, you can precisely boost a range of 40 to 45 Hz. FIR (Finite Impulse Response) filters like the Graphic Equalizer provide
slightly improved phase accuracy, however.

Compensates for an overall volume level that’s too loud or too soft after you adjust the EQ settings.

Shows frequency along the horizontal ruler (x-axis) and amplitude along the vertical ruler (y-axis). Frequencies in the graph range from
lowest to highest in a logarithmic fashion (evenly spaced by octaves).

Identifying band-pass and shelving filters in the Parametric Equalizer: 
A. High- and low-pass filters B. High and low shelving filters 

Sets the center frequency for bands 1-5, and the corner frequencies for the band-pass and shelving filters.

Use the low shelving filter to reduce low-end rumble, hum, or other unwanted low-frequency sounds. Use the high shelving filter to reduce hiss,
amplifier noise, and the like.

Sets the boost or attenuation for frequency bands, and the per-octave slope of the band-pass filters.

Controls the width of the affected frequency band. Low Q values affect a larger range of frequencies. Very high Q values (close to 100)
affect a very narrow band and are ideal for notch filters removing particular frequencies, like 60 Hz hum.

When a very narrow band is boosted, audio tends to ring or resonate at that frequency. Q values of 1-10 are best for general equalization.

Enables up to five intermediate bands, as well as high-pass, low-pass, and shelving filters, giving you very fine control over the equalization
curve. Click the band button to activate the corresponding settings above.

The low and high shelving filters provide slope buttons ( ,  ) that adjust the low and high shelves by 12 dB per octave, rather than the
default 6 dB per octave.

To visually adjust enabled bands in the graph, drag the related control points.

Describes a frequency band’s width as either a Q value (which is a ratio of width to center frequency) or an
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Ultra-Quiet

Range

absolute width value in Hz. Constant Q is the most common setting.

Virtually eliminates noise and artifacts, but requires more processing. This option is audible only on high-end headphones and
monitoring systems.

Sets the graph to a 30 dB range for more precise adjustments, or a 96 dB range for more extreme adjustments.
About process effects

Apply individual effects in the Waveform Editor

Applying effects in the Waveform Editor

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/en_US/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/fr-fr/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/fr-fr/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://help.adobe.com/en_US/audition/cs/using/WS58a04a822e3e5010548241038980c2c5-7f3e.html#WSD2E5EC8C-E2FE-4a48-AACC-FB4EF76E9F25
http://help.adobe.com/en_US/audition/cs/using/WS58a04a822e3e5010548241038980c2c5-7f3e.html#WS58a04a822e3e5010548241038980c2c5-7f3b
http://help.adobe.com/en_US/audition/cs/using/WS58a04a822e3e5010548241038980c2c5-7f3e.html


Effet Déphaseur de doppler (Editeur de forme d’onde uniquement)

 Les publications Twitter™ et Facebook ne sont pas couvertes par les dispositions de Creative Commons.Creative Commons.

Informations juridiques   |   Politique de confidentialité en ligne

Remarque :

Type de trajectoire

Régler le volume selon : distance ou direction

Niveau de qualité

L’effet Spécial > Déphaseur de doppler crée l’augmentation et la diminution de la hauteur tonale que l’on remarque lorsqu’un objet s’approche et
s’éloigne ensuite, comme une voiture de police qui déboule toutes sirènes hurlantes. Lorsque la voiture s’approche, le son qu’elle génère atteint
les oreilles comme une fréquence supérieure car chaque onde sonore est comprimée par la voiture qui avance. Le contraire se produit lorsque la
voiture s'éloigne : les ondes sont étendues, ce qui entraîne un son d'une hauteur plus faible.

Contrairement à la plupart des graphiques liés aux effets Adobe Audition, le graphique Déphaseur de doppler n’est pas interactif. Il
est dès lors impossible de le manipuler directement. Le graphique évolue en réalité à mesure que vous ajustez les paramètres de l'effet.

Définit la trajectoire que la source sonore semble prendre. Selon le type de trajectoire choisi, vous disposez de différentes
options. 

Options Ligne droite :

La Distance du point de départ définit le point de départ virtuel (en mètres) de l’effet.
La Vélocité définit la vitesse virtuelle (en mètres par seconde) à laquelle se déplace l’effet.
L’origine détermine la direction virtuelle (en degrés) d’où semble venir l’effet.
Le Passage à l’avant de indique à quelle distance (en mètres) semble passer l’effet devant l’auditeur.
Le Passage à droite de indique à quelle distance (en mètres) semble passer l’effet à droite de l’auditeur.

Options Circulaire :

Le Rayon définit les dimensions circulaires (en mètres) de l’effet.
La Vélocité définit la vitesse virtuelle (en mètres par seconde) à laquelle se déplace l’effet.
L’Angle de départ définit l’angle virtuel initial (en degrés) de l’effet.
Le Centre à l’avant de définit à quelle distance (en mètres) se trouve la source sonore devant l’auditeur.
Le Centre à droite de définit à quelle distance (en mètres) se trouve la source sonore à droite de l’auditeur.

Ajuste automatiquement le volume de l’effet d’après les valeurs définies.

Propose six niveaux de qualité de traitement. Les niveaux de qualité inférieurs demandent moins de temps de traitement,
tandis que les niveaux plus élevés produisent généralement de meilleurs résultats acoustiques. 
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Gamme

Clé

Attaque

Sensibilité

Canal de référence

Taille de la TFR

Etalonnage

Règle de correction

Effet Correction automatique de la hauteur de ton
L’effet Correction automatique de la hauteur de ton est disponible à la fois dans les éditeurs Forme d’onde et Multipiste. Dans le second cas, ses
paramètres peuvent être automatisés au fil du temps à l’aide d’images clés et de consoles d’étalonnage externes.

Sélectionnez Effets > Temps et hauteur de ton > Correction automatique de la hauteur de ton et définissez les options suivantes :

Indique le type de gamme qui convient le mieux pour les données : Majeur, Mineur ou Chromatique. Majeur et Mineur permettent des
corrections plus importantes lorsque l’audio source est décalée d’un intervalle supérieur à un demi-ton. L’option Chromatique est idéale si vous
souhaitez simplement effectuer une légère correction afin de « tirer » la hauteur d’un ton vers la note chromatique la plus proche. 

Définit la clé souhaitée du son corrigé. Cette option n’est disponible que si vous avez défini l’option Gamme sur Majeur ou Mineur (puisque la
gamme Chromatique comprend 12 tons et n’est pas propre à une clé). 

Détermine la rapidité avec laquelle Adobe Audition corrige la hauteur de ton vers le ton de la gamme. Il est préférable de choisir une
attaque rapide pour un son composé de courtes notes ; par exemple, un passage rythmé joué par une trompette. Toutefois, une attaque
extrêmement rapide peut également produire une qualité robotique. Une attaque lente génère une correction plus naturelle sur les notes
soutenues plus longues ; par exemple, dans le cas d’un extrait vocal où le chanteur tient la note en ajoutant un vibrato. Etant donné que le
matériel source peut évoluer au cours d’une interprétation musicale, vous pouvez obtenir des résultats plus naturels en corrigeant séparément des
phrases musicales courtes.

Définit le seuil au-delà duquel les notes ne sont pas corrigées. La sensibilité se mesure en centièmes et chaque demi-ton comprend
100 centièmes. Par exemple, une valeur Sensibilité de 50 centièmes signifie qu’une note doit se situer à 50 centièmes (la moitié d’un demi-ton) du
ton de la gamme cible pour pouvoir être corrigée automatiquement.

Choisissez un canal source dans lequel les changements de hauteur de ton sont les plus clairs. L’effet analyse uniquement
le canal sélectionné, mais applique la correction de hauteur de ton de manière égale à tous les canaux.

Définit la taille de la TFR (transformation de Fourier rapide) de chaque élément de données traité par l’effet. En général, il est
conseillé d’utiliser de petites valeurs pour corriger les fréquences élevées. En ce qui concerne les voix, les valeurs 2 048 ou 4 096 procurent un
son très naturel, tandis que la valeur 1 024 donne des effets robotiques.

Spécifie la norme d’accordement pour l’audio source. Dans la musique occidentale, la norme est A4 à 440 Hz. Cependant, il se peut
que le contenu audio source ait été enregistré à l’aide d’une norme différente. Vous pouvez donc spécifier des valeurs A4 comprises entre 410 et
470 Hz.

Lors de l’aperçu d’un élément audio, cette option affiche la quantité de correction des tons plats et élevés.
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Effet Correction manuelle de la hauteur de ton (éditeur de forme
d’onde uniquement)

 

Canal de référence

Courbes splines

Résolution de courbe de hauteur de ton

L’effet Correction manuelle de la hauteur de ton vous permet de régler visuellement la hauteur de ton avec l’affichage de la hauteur de ton
spectrale. L’affichage de la hauteur de ton spectrale présente la hauteur de ton fondamentale sous la forme d’un trait bleu vif et les partiels dans
des teintes allant du jaune au rouge. La hauteur de ton corrigée s’affiche sous la forme d’un trait vert vif.

Vous pouvez surveiller visuellement la hauteur de ton à tout moment sans utiliser l’effet Correction manuelle de la hauteur de ton. Il vous suffit
de cliquer sur l’icône Afficher la hauteur de ton spectrale <<ICON>> dans la barre d’options. Pour personnaliser la résolution, la plage de
décibels et le quadrillage, réglez les paramètres d’affichage de hauteur de ton dans les préférences d’affichage spectral.

1. Sélectionnez Effets > Temps et hauteur de ton > Correction manuelle de la hauteur de ton.

2. Dans la fenêtre Correction manuelle de la hauteur de ton, définissez les options suivantes :

Choisissez un canal source dans lequel les changements de hauteur de ton sont les plus clairs. L’effet
analyse uniquement le canal sélectionné, mais applique la correction de hauteur de ton de manière égale à tous les canaux.

Créez des transitions plus douces lors de l’utilisation d’images clés d’enveloppe afin d’appliquer une
correction de hauteur de ton différente au fil du temps.

Définit la taille TFR (transformation de Fourier rapide) de chaque élément de
données traité par l’effet. En général, il est conseillé d’utiliser de petites valeurs pour corriger les fréquences élevées. En ce
qui concerne les voix, les valeurs 2 048 ou 4 096 procurent un son très naturel, tandis que la valeur 1 024 donne des effets
robotiques.

3. Effectuez l’une des opérations suivantes dans le panneau Editeur :

Pour appliquer une modification uniforme de la hauteur de ton, faites glisser le bouton Modifier la hauteur de ton
<<ICON>> dans l’affichage tête haute.
Pour modifier la hauteur de ton au fil du temps, ajoutez des images clés à la ligne d’enveloppe jaune au centre de
l’affichage de forme d’onde.

Pour effectuer un zoom avant sur certaines plages de hauteur de ton, cliquez avec le bouton droit de la souris et faites
glisser le pointeur de la règle verticale vers la droite de l’affichage de hauteur de ton spectrale. Pour réinitialiser le niveau
de zoom ou personnaliser l’échelle affichée, cliquez avec le bouton droit de la souris sur la règle et sélectionnez des
options dans le menu déroulant.

Modification de la hauteur de ton dans le panneau Editeur 
A. Le bouton Régler la hauteur de ton modifie uniformément la hauteur de ton B. Des images clés sur la ligne d’enveloppe modifient la hauteur de
ton au fil du temps 
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Effets Temps et hauteur de ton
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Effet Expansion/compression et hauteur du son (éditeur de forme d’onde uniquement)

Effet Expansion/compression et hauteur du son (éditeur de forme d’onde uniquement)
L’effet Temps et hauteur de ton > Expansion et compression permet de modifier la hauteur tonale d’un signal audio et/ou le tempo. Vous pouvez
par exemple utiliser l’effet afin de transposer une chanson dans une clé plus élevée sans changer le tempo ou encore pour ralentir un passage
verbal sans modifier la hauteur de son.

Remarque : cet effet nécessite un traitement hors ligne. Lorsqu’il est activé, vous ne pouvez pas modifier la forme d’onde, ajuster les sélections
ni déplacer l’indicateur d’instant présent.

Algorithme Sélectionnez Rayon iZotope pour étendre/compresser le son tout en altérant la hauteur de son, ou Audition pour modifier les réglages
d’expansion/compression ou de hauteur du son au fil du temps. L’algorithme du rayon iZotope nécessite un temps de traitement plus long, mais
introduit moins d’artefacts.
Précision Des valeurs plus élevées permettent d’obtenir une meilleure qualité, mais le temps de traitement est plus long.
Nouvelle durée Indique la durée de l’audio après l’expansion temporelle. Vous pouvez ajuster directement la valeur Nouvelle durée ou
indirectement en modifiant le pourcentage d’expansion/compression.

Si vous étendez/compressez fréquemment les fichiers jusqu’à une certaine durée, cliquez sur l’icône Favoris  afin d’enregistrer ce paramètre
pour une utilisation ultérieure. Pour appliquer un favori à plusieurs fichiers, consultez la section Traitement de fichiers par lots.

Verrouiller les paramètres d’expansion sur la nouvelle durée Remplace les paramètres d’expansion/compression personnalisés ou
préconfigurés, plutôt que de les calculer d’après les réglages de durée.

Sélectionnez l’option ci-dessus pour créer rapidement des spots radio de 30 ou 60 secondes.

Redim. Réduit ou étend les données audio traitées par rapport aux données audio existantes. Par exemple, pour réduire les données audio de
moitié par rapport à leur durée actuelle, définissez une valeur d’expansion/compression de 50 %.
Transposition Transpose la tonalité des données audio vers les aigus ou vers les graves. Chaque demi-ton équivaut à une demi-étape sur un
clavier.
Expansion/compression finale ou Transposition finale (algorithme Audition) Modifie graduellement les valeurs initiales
d’expansion/compression ou de transposition, jusqu’à obtenir le paramètre final sur le dernier échantillon audio sélectionné.
Verrouiller l’expansion/compression et la transposition (algorithme iZotope) Etend/compresse les données audio afin de prendre en compte
les modifications de hauteur du son, ou réciproquement.
Verrouiller l’expansion/compression et la transposition initiales (algorithme Audition) Etend/compresse les données audio afin de prendre
en compte les modifications de hauteur du son, ou réciproquement. Les paramètres d’expansion/compression ou de transposition finale ne sont
pas affectés.
Paramètres avancés (algorithme Rayon iZotope) Cliquez sur le triangle afin d’accéder aux options suivantes :

Instrument ou voix solo  Traite plus rapidement une performance solo.
Conserver les caractéristiques de la voix parlée  Maintient le réalisme de la parole.
Décalage de formant  Détermine les modalités d’ajustement des formants aux décalages de la hauteur de ton. La valeur par défaut de
zéro règle les formants sur les décalages de hauteur de ton, ce qui contribue à maintenir le timbre et le réalisme du son. Les valeurs
supérieures à zéro produisent des timbres supérieurs (ce qui transforme une voix d’homme en une voix de femme par exemple). Les
valeurs inférieures à zéro produisent l’effet inverse.
Cohérence de hauteur du son  Préserve le timbre des instruments ou voix solo. Des valeurs plus élevées réduisent les artefacts de
phasage, mais la hauteur de son est plus modulée.

Paramètres avancés (algorithme Audition) Cliquez sur le triangle afin d’accéder aux options suivantes :

Fréquence de raccord  Détermine le volume de chaque portion de données audio lorsque vous préservez la hauteur du son ou le tempo
tout en étendant/compressant une forme d’onde. Plus la valeur est élevée, plus le placement des données audio étendues est précis dans
le temps. Toutefois, plus la fréquence est élevée, plus les artefacts deviennent audibles. Le son peut alors devenir ténu ou avoir une
qualité de type tunnel. Si le niveau de précision est élevé, les basses fréquences de raccord peuvent générer un bégaiement ou un écho.
Superposition  Détermine dans quelle proportion chaque bloc de données audio actuel se superpose aux précédents et aux suivants. Si
l’expansion/compression génère un effet de chœur, réduisez le pourcentage de superposition sans pour autant aller jusqu’à produire un
son haché. Vous pouvez définir la superposition jusqu’à 400 % mais il est conseillé de n’utiliser cette valeur que pour des accélérations
très importantes (200 %, voire plus).
Choisir les valeurs par défaut appropriées  Applique les valeurs par défaut adéquates pour la fréquence de raccord et la superposition.
Cette option est très utile pour préserver la hauteur tonale ou le tempo.
Voyelles constantes  Préserve le son des voyelles dans les voix étirées. Le traitement de cette option étant relativement long, essayez-la
d’abord sur une petite sélection avant de l’appliquer à des données plus importantes.
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Mixage de sessions multipistes
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Automatisation des mixages avec des enveloppes (CS6)

En haut

Remarque :

Automatisation des paramètres de clip
Automatisation des paramètres de piste
Réglage de l’automatisation avec les images clés

L’automatisation des mixages vous permet de modifier les paramètres de mixage au fil du temps. Vous pouvez, par exemple, augmenter
automatiquement le volume du lors d’un passage musical critique et le réduire ultérieurement dans un fondu de sortie graduel. Visionnez ce
didacticiel vidéo pour observer l’automatisation du mixage en action.

Les enveloppes d’automatisation fournissent une représentation visuelle des paramètres à des points spécifiques dans le temps. Vous pouvez les
modifier en faisant glisser les images clés sur les lignes d’enveloppe. Les enveloppes ne sont pas destructrices, c’est-à-dire qu’elles ne modifient
pas les fichiers audio. Ainsi, si vous ouvrez un fichier dans l’éditeur de forme d’onde, vous n’entendrez pas l’effet des enveloppes appliquées dans
l’éditeur de multipiste.

Enveloppes de clip et de piste dans le panneau Editeur 
A. Enveloppe de clip B. Enveloppe de piste

Automatisation des paramètres de clip
Les enveloppes de clip permettent d’automatiser les paramètres de volume, de panoramique et d’effets des clips.

Sur les pistes stéréo, les enveloppes de volume et de panoramique des clips s’affichent par défaut ; vous pouvez les identifier par couleur et
position initiale. Les enveloppes de volume sont des lignes jaunes apparaissant sur la moitié supérieure des clips. Quant aux enveloppes de
panoramique, il s’agit de lignes bleues placées au milieu. (Avec les enveloppes de panoramique, la partie supérieure d’un clip représente un
panoramique à l’extrême gauche et la partie inférieure un panoramique à l’extrême droite.)

sur les pistes mono et surround 5.1, les clips n’ont pas d’enveloppes de panoramique.

Deux enveloppes de clip 
A. Enveloppe de panoramique B. Enveloppe de volume

Affichage ou masquage des enveloppes de clip
Les enveloppes de clip sont visibles par défaut. Vous pouvez toutefois les masquer si elles vous gênent.

Dans le menu Affichage, sélectionnez l’une des options suivantes :
Afficher les enveloppes de volume du clip

Afficher les enveloppes panoramiques du clip

Afficher les enveloppes d’effets du clip

Affichage ou masquage des paramètres d’automatisation individuels

Affichage d’un paramètre pour un effet

Dans le coin supérieur droit d’un élément, cliquez sur le menu des paramètres, puis sélectionnez une option de mixage du
rack ou un paramètre d’effet. (Dans le menu, les paramètres visibles sont accompagnés d’une coche. Sélectionnez à nouveau
un paramètre pour le masquer.)

Après avoir modifié les images clés d’un paramètre, il s’affiche avec un astérisque (*) dans le menu.

L’option Marche/arrêt du rack vous permet d’activer ou de désactiver le rack d’effets d’un clip au fil du temps.

Désactivation de la modification des images clés

http://tv.adobe.com/watch/adobe-evangelists-jason-levine/multitrack-mixing-automation-in-adobe-audition-cs55-/
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Désactivé

Lire

Enregistrer

Circuit à verrouillage

Toucher

Désactivez la modification des images clés afin de ne pas créer ni déplacer des images clés par inadvertance.

Dans le menu Multipiste, désélectionnez l’option Activer la modification des images clés de l’élément.

Automatisation des paramètres de piste
Les enveloppes de piste vous permettent de modifier les paramètres de volume, de panoramique et d’effets au fil du temps. Adobe Audition
affiche les enveloppes de piste dans une piste d’automatisation située sous chaque piste. Chaque paramètre automatisé est associé à une
enveloppe, que vous pouvez modifier de la même manière que des enveloppes de clip.

Automatisation des paramètres de piste dans le panneau Editeur 
A. Piste d’automatisation B. Enveloppe de paramètre

Création d’enveloppes de piste
Grâce aux enveloppes de piste, vous pouvez modifier précisément les paramètres des pistes à des points spécifiques dans le temps.

Affichage des pistes d’automatisation dans le panneau Editeur

1. Dans le panneau Editeur, cliquez sur le triangle situé à gauche du menu Mode d’automatisation de piste pour la piste que
vous souhaitez automatiser. (Le menu est défini par défaut sur Lire.)

2. Dans le menu Afficher les enveloppes, sélectionnez un paramètre à automatiser.
3. Cliquez sur la ligne d’enveloppe et faites-la glisser pour ajouter et ajuster les images clés.

Enregistrement de l’automatisation de piste
Lors de la lecture d'une session, vous pouvez enregistrer les modifications apportées aux paramètres de volume, de panoramique et d'effet afin
d'obtenir un mixage qui évolue de manière dynamique au fil du temps. Adobe Audition convertit automatiquement les modifications apportées en
enveloppes de piste que vous pouvez modifier avec précision.

Grâce à un contrôleur externe tel que Mackie Control, vous pouvez modifier simultanément plusieurs paramètres. Reportez-vous à Prise en
charge de surface de contrôle.

1. Dans le panneau principal, positionnez le repère d’instant présent à l’endroit où vous souhaitez démarrer l’enregistrement de
l’automatisation.

2. Sélectionnez une option dans le menu Mode d'automatisation de piste.
3. Pour démarrer l’enregistrement de l’automatisation, lancez la lecture. Lors de la lecture du contenu audio, modifiez les

paramètres de piste ou d’effet dans les panneaux Editeur, Mélangeur ou Rack d’effets.
4. Pour arrêter l’enregistrement de l’automatisation, arrêtez la lecture.

Si les images clés enregistrées sont trop nombreuses ou irrégulières, reportez-vous à la rubrique Optimisation de l’automatisation enregistrée.

Options du mode d’automatisation de piste
Dans le panneau Editeur ou dans le mélangeur, vous pouvez sélectionner l’un des modes suivants pour chaque piste :

Ignore les enveloppes de piste lors de la lecture et du mixage, mais continue à afficher les enveloppes pour vous permettre d’ajouter
ou de modifier manuellement des images clés.

Applique des enveloppes de piste lors de la lecture et du mixage, mais n'enregistre pas les modifications apportées. (Vous pouvez
prévisualiser les modifications apportées, mais les paramètres enregistrés sont rétablis pour les images clés.)

Dès le début de la lecture, remplace les images clés existantes par les paramètres actuels. Continue d’enregistrer les nouveaux
paramètres jusqu’à l’arrêt de la lecture.

Lance l’enregistrement des images clés lors de la première modification d’un paramètre jusqu’à l’arrêt de la lecture.

Similaire à l’option Verrou, mais rétablit progressivement les valeurs des paramètres précédemment enregistrées lorsque vous avez fini
de les modifier. Utilisez l’option Au toucher pour écraser des sections d’automatisation données tout en laissant les autres intactes.

http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/fr-fr/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/fr-fr/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/fr-fr/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/fr-fr/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/fr-fr/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/


Unité de correspondance automatique

Amincissement linéaire du point de montage

Réduction de l’intervalle de temps minimum

En haut

Protection des paramètres lors de l'enregistrement de l'automatisation
Lors de l’enregistrement de l’automatisation, vous souhaiterez peut-être protéger certains paramètres contre d’éventuelles modifications
involontaires, alors que vous en modifiez d’autres.

1. Dans la partie gauche du panneau Editeur, accédez aux commandes d’une piste particulière.
2. Cliquez sur l’icône Afficher/Masquer les pistes d’automatisation [ICON].
3. Dans le menu Afficher les enveloppes, sélectionnez le paramètre.
4. Cliquez sur l’icône Protéger le paramètre [ICON].

Optimisation des images clés d’automatisation enregistrées
Pour empêcher que l’automatisation enregistrée ne crée des images clés en trop grand nombre ou irrégulières, optimisez les paramètres suivants
dans la section Multipiste de la boîte de dialogue Préférences.

Détermine la vitesse à laquelle les paramètres sont rétablis à leur valeur d’origine en mode Au toucher.
Vous pouvez définir des valeurs de 0,00 à 5,00 secondes, la valeur par défaut étant de 1,00 seconde.

Supprime toutes les images clés représentant des réglages de paramètres statiques non
modifiés.

Crée des images clés à des intervalles de temps supérieurs à la valeur spécifiée. Entrez un
intervalle compris entre 1 et 2 000 millisecondes dans la zone Temps minimum.

Réglage de l’automatisation avec les images clés
Les images clés sur les lignes d’enveloppe modifient graduellement les paramètres des clips et des pistes. Adobe Audition calcule
automatiquement, ou interpole, toutes les valeurs intermédiaires entre deux images clés en appliquant l’une de ces deux méthodes de transition :

Les transitions de type Conserver  créent un changement abrupt de valeur à chaque nouvelle image clé.

Les transitions de type Linéaire  créent un changement régulier et graduel entre les images clés.

Vous pouvez également appliquer des courbes splines à l’ensemble d’une enveloppe, en remplaçant le paramètre spécifique à l’image clé du
dessus afin de créer des transitions naturelles dont la vitesse varie près des images clés (Voir A propos des courbes splines des graphiques).

Transitions entre images clés 
A. Par paliers B. Linéaire (par défaut) C. Courbes splines

Ajout d’une image clé

Effectuez l’une des opérations suivantes :

Placez le pointeur sur une ligne d’enveloppe. Cliquez sur le signe plus  qui s’affiche.

Positionnez la tête de lecture à l’endroit où doit être modifié le paramètre de piste. Cliquez ensuite sur l’icône Ajouter une
image clé  dans les commandes de la piste.

Navigation entre les différentes images clés d’une piste

1. Dans le panneau Editeur, sélectionnez un paramètre dans le menu de sélection près du bas des commandes de piste.

2. Cliquez sur l’icône Image clé précédente  ou Image clé suivante .

Sélection de plusieurs images clés pour un paramètre

Cliquez avec le bouton droit sur une image clé, puis choisissez Supprimer toutes les images clés.

Maintenez enfoncée la touche Ctrl (Windows) ou Commande (Mac OS), puis cliquez sur des images clés spécifiques.

Maintenez la touche Maj enfoncée, puis cliquez pour sélectionner une série d’images clés.

Repositionnement des images clés ou de la ligne d’enveloppe

Faites glisser les images clés sélectionnées pour les repositionner (pour préserver la valeur du paramètre ou de la position
temporelle, faites glisser les images clés en maintenant la touche Maj enfoncée).

Pour repositionner un segment d’une enveloppe sans créer d’image clé, maintenez enfoncée la touche Ctrl (Windows) ou
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Commande (Mac OS), puis faites glisser le curseur.

Changement de transition entre deux images clés

Cliquez avec le bouton droit sur la première image clé, puis sélectionnez Conserver l’image clé pour modifier drastiquement les
valeurs ou désélectionnez-la pour effectuer une transition graduelle d’une valeur à une autre.

Application de courbes splines à une enveloppe entière

Cliquez avec le bouton droit de la souris sur une ligne d’enveloppe, puis sélectionnez Courbes splines.

Suppression d’images clés

Cliquez avec le bouton droit de la souris sur une ligne d’enveloppe, puis choisissez Supprimer les images clés sélectionnées
ou faites glisser une image clé individuelle en dehors d’un clip ou d’une piste.

Désactivation de la modification des images clés

Désactivez la modification des images clés afin de ne pas créer ni déplacer des images clés par inadvertance.

Dans le menu Multipiste, désélectionnez l’option Activer la modification des images clés de l’élément.

Modification de sessions multipistes dans le panneau Editeur et dans le mélangeur
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Automating mixes with envelopes (CS5.5)

Note:

To the top

Note:

Automating clip settings
Automating track settings
Adjust automation with keyframes

Some features in the Windows version of Adobe Audition 3.0 are not available in CS5.5. Examples include control surface support, CD
burning, MIDI, some file formats and effects, clip grouping and time stretching, and the metronome. For a complete list, see Adobe Audition 3.0
features replaced or not implemented in CS5.5.

By automating mixes, you can change mix settings over time. For example, you can automatically increase volume during a critical musical
passage and later reduce the volume in a gradual fade out. See this video tutorial to watch mix automation in action.

Automation envelopes visually indicate settings at specific points in time, and you can edit them by dragging keyframes on envelope lines.
Envelopes are nondestructive, so they don’t change audio files in any way. If you open a file in the Waveform Editor, for example, you don’t hear
the effect of any envelopes applied in the Multitrack Editor.

Clip and track envelopes in the Editor panel 
A. Clip envelope B. Track envelope 

Automating clip settings
With clip envelopes, you can automate clip volume, pan, and effect settings.

On stereo tracks, clip volume and pan envelopes appear by default; you can identify them by color and initial position. Volume envelopes are
yellow lines initially placed across the upper half of clips. Pan envelopes are blue lines initially placed in the center. (With pan envelopes, the top of
a clip represents full left, while the bottom represents full right.)

On mono and 5.1 surround tracks, clips lack pan envelopes.

Two clip envelopes 
A. Pan envelope B. Volume envelope 

Show or hide clip envelopes
Clip envelopes are visible by default, but if they interfere with editing or are visually distracting, you can hide them.

From the View menu, choose any of the following:
Show Clip Volume Envelopes 

Show Clip Pan Envelopes

Show Clip Effect Envelopes

Show or hide individual automation parameters

http://kb2.adobe.com/cps/895/cpsid_89588.html
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Showing a parameter for an effect

In the upper-right corner of a clip, click the parameter menu, and select a Rack mixing option or an effect parameter.

The Rack Power option lets you turn clip effects on and off over time.

Automating track settings
With track envelopes, you can change volume, pan, and effect settings over time. Adobe Audition displays track envelopes in an automation lane
below each track. Each automated parameter has its own envelope, which you edit just like clip envelopes.

Automating track settings in the Editor panel 
A. Automation lane B. Envelope for parameter 

Create track envelopes
Track envelopes let you precisely change track settings at specific points in time.

Showing automation lanes in Editor panel

1. In Editor panel, click the triangle to the left of the Read menu for the track you want to automate.
2. From the Show Envelopes menu, select a parameter to automate.
3. On the envelope line, click and drag to add and adjust keyframes.

Track Automation Mode options
In the Editor panel or Mixer, you can choose one of the following modes for each track:



Off

Read

To the top

Track Automation Mode menu

Ignores track envelopes during playback and mixdown, but continues to display envelopes so you can manually add or adjust edit points.

Applies track envelopes during playback and mixdown.

Adjust automation with keyframes
Keyframes on envelope lines change clip and track parameters over time. Adobe Audition automatically calculates, or interpolates, all the
intermediate values between keyframes using one of two transition methods:

Hold  transitions create an abrupt change in value at each new keyframe.

Linear  transitions create a gradual, even change between keyframes.

You can also apply spline curves to an entire envelope, overriding the keyframe-specific setting above to create natural-sounding transitions that
change in speed near keyframes. (See About spline curves for graphs.)

Transitions between keyframes 
A. Hold B. Linear (the default) C. Spline curves 

Add a keyframe

Do either of the following:

Position the pointer over an envelope line. When a plus sign  appears, click.

Position the current-time indicator where you’d like a track parameter to change. Then click the Add Keyframe icon  in the
track controls.

Navigate between track keyframes

1. In the Editor panel, choose a parameter from the Select menu near the bottom of the track controls.

2. Click the Previous Keyframe  or Next Keyframe  icon.

Select multiple keyframes for a parameter

Right-click any keyframe, and choose Select All Keyframes.

Hold down Ctrl (Windows) or Command (Mac OS), and click specific keyframes.

Hold down Shift, and click to select a series of keyframes.

Reposition keyframes or the envelope line

To reposition selected keyframes, drag them. (To maintain time position or parameter value, hold down Shift and drag.)

To reposition a segment of an envelope without creating a keyframe, hold down Ctrl (Windows) or Command (Mac OS), and
drag.

Change the transition between two keyframes

Right-click the first keyframe, and select Hold Keyframe to abruptly change values, or deselect it to gradually transition from
one value to the next.
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Apply spline curves to an entire envelope

Right-click an envelope line, and choose Spline Curves.

Delete keyframes

Right-click an envelope line, and choose Delete Selected Keyframes. Or, drag an individual keyframe off a clip or track.

Disable keyframe editing

To avoid inadvertently creating or moving keyframes, disable keyframe editing.

From the Multitrack menu, deselect Enable Clip Keyframe Editing.

Editing multitrack sessions in the Editor panel and Mixer
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Arranging and editing multitrack clips
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Select and move clips
Snap to clip endpoints
Copy a clip
Trimming and extending clips
Split clips
Set audio clip properties

When you insert an audio file in the Multitrack Editor, the file becomes a clip on the selected track. You can easily move clips to different tracks or
timeline positions. You can also edit clips nondestructively, trimming their start and end points, crossfading them with other clips, and more.

To arrange clips in the Editor panel, you use the Move  or Time Selection  tools.

Select and move clips
Do any of the following:

To select an individual clip, click it in the Editor panel.

To select all clips in selected tracks, choose Edit > Select > All Clips In Selected Track.

To select all clips in a session, choose Edit >Select > Select All.

To move selected clips, select the Move tool  in the toolbar, and then drag the clips. Or choose Clip > Nudge Right or
Nudge Left to move clips one pixel at a time. (If you zoom in to see individual samples, nudging moves clips one sample at
a time.)

To move clips with the Time Selection tool , right-click and drag (similar to the Hybrid tool technique in previous versions).
You can also drag the clip header with any tool.

Snap to clip endpoints
Snapping lets you quickly align clips with other clips. If snapping is enabled, both dragged clips and the current-time indicator snap to selected
items. While you drag a clip, a white line appears in the Editor panel when snapping points meet.

1. To enable snapping for selected items, click the Toggle Snapping icon  at the top of the Editor panel.
2. Choose Edit > Snapping > Snap To Clips.

For more information, see Snap to loop beats and Snap to markers, rulers, frames, and zero crossings.

Copy a clip
You can create two types of copied audio clips: reference copies that share source files and unique copies that have independent source files.
The type of copy you choose depends upon the amount of available disk space and the nature of destructive editing you plan to perform in the
Waveform Editor.

Reference copies consume no additional disk space, letting you simultaneously edit all instances by editing the original source file. (For example,
you can add the Flanger effect to a source file in the Waveform Editor and automatically apply the effect to all 30 referenced copies in a session.)

Unique copies have a separate audio file on disk, allowing for separate editing of each version in the Waveform Editor. (For example, you can add
destructive effects to the version in an introduction while leaving the version in a verse dry.)

To quickly copy a reference, press Ctrl + C (Windows) or Cmd + C (Mac OS). Alternatively, Alt-drag (Windows) or Option-drag (Mac OS) the
clip header.

1. Click the Move tool  in the toolbar. Then right-click and drag the clip.

To copy with the Time Selection tool , right-click and drag the clip header (similar to the Hybrid tool technique in previous
versions).

2. Release the mouse button, and choose one of the following from the pop-up menu:
Copy Here (to copy a reference)
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Copy Unique Here

Trimming and extending clips
You can trim or extend audio clips to suit the needs of a mix. Because the Multitrack Editor is nondestructive, clip edits are impermanent; you can
return to the original, unedited clip at any time. If you want to permanently edit an audio clip, however, you can quickly open the source file in the
Waveform Editor. (See Comparing the Waveform and Multitrack editors.)

Remove a selected range from clips

1. In the toolbar, click the Time Selection tool .
2. Drag across one or more clips to select them and a range.
3. Do one of the following:

To remove the range from clips and leave a gap in the timeline, choose Edit > Delete.

To remove the range and collapse the gap in the timeline, choose Edit > Ripple Delete, and select one of the following
options:

Selected Clips

Removes selected clips, shifting remaining clips on the same tracks.

Time Selection in Selected Clips

Removes the range from selected clips, splitting them if necessary.

Time Selection in All Tracks

Removes the range from all clips in the session.

Time Selection in Selected Track

Removes the range only from the currently highlighted track in the Editor panel.

Collapse a gap between clips on a track
Right-click the empty area between the clips, and choose Ripple Delete > Gap.

Trim or extend clips
1. If you want to repeat a clip, right-click it and select Loop. (See Looping clips.)

2. In the Editor panel, position the cursor over the left or right edge of the clip. The edge-dragging icon  appears.
3. Drag clip edges.

Shift the contents of a trimmed or looped clip
You can slip edit a trimmed or looped clip to shift its contents within clip edges.

Shift clip contents within clip edges

1. In the toolbar, click the Slip tool .
2. Drag across the clip.

Permanently edit a clip’s source file in the Waveform Editor
Double-click the clip header.

Split clips
Split audio clips to break them into separate clips that you can independently move or edit.

Split clips with the Razor tool
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Razor Selected Clips

Razor All Clips

To the top

Clip Color

Clip Gain

Lock in Time

Loop

Mute

1. In the toolbar, hold down the Razor tool , and choose one of the following from the pop-up menu:

Splits only clips you click.

Splits all clips at the time point you click.

Tip: To switch between these modes in the Editor panel, press Shift.

2. In the Editor panel, click where you want the split to occur.

Split all clips at the current-time indicator

1. Position the current-time indicator where one or more audio clips exist.

2. Choose Clip > Split.

Set audio clip properties
In the Properties panel, you can quickly change multiple settings for selected audio clips. Clip settings for gain and mute are independent from
similar track controls.

1. Select an audio clip, and choose Window > Properties.

You can access individual properties from the Clip menu.

2. Set the following options:

To change the clip name, type in the text box at the top of the panel.

Click the swatch to customize. A swatch with a red slash indicates that the clip is using the default color for the
current Appearance preset. (See Change interface colors, brightness, and performance.)

Compensates for a low or high volume clip that is difficult to mix.

Allows only up or down moves to other tracks, with a fixed timeline position. A lock icon  appears on the clip.

Enables clip looping. For more information, see Looping clips.

Silences the clip.

Select ranges in the Multitrack Editor
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Mode

Type

Durée, expansion et hauteur de ton

Réglages avancés

1. Sélectionnez Clip > Expansion > Activer l’expansion globale du clip.

2. Dans le panneau Editeur, faites glisser les triangles blancs dans le coin supérieur droit ou gauche des clips.

Sélectionnez plusieurs éléments pour les étirer de manière proportionnelle.

Pour personnaliser les paramètres d’expansion des clips sélectionnés, réglez les options Expansion suivantes dans le panneau Propriétés :

Sélectionnez l’une des options suivantes :
Désactivé désactive l’expansion, rétablissant ainsi la longueur d’origine du clip.
Temps réel permet d’entendre les résultats de l’expansion à mesure que vous faites glisser les clips. Ce mode est un excellent
choix lors de l’édition.
Rendu (haute qualité) requiert davantage de traitement, mais permet d’éviter les artefacts audibles. Choisissez ce mode si la
lecture ralentit ou que les performances diminuent en mode Temps réel.

Sélectionnez l’une des options suivantes :
Monophonique constitue la meilleure option pour les instruments de musique en solo ou les dialogues.
Polyphonique constitue la meilleure option pour de la musique avec plusieurs instruments ou des sons ambiants complexes.
Vit. variable modifie la hauteur de ton en plus de la durée, à l’instar du ralentissement ou de l’accélération de magnétophones
à bobines analogiques.

Pour appliquer rapidement le même mode à tous les clips, sélectionnez Clip > Expansion > Tous les clips étirés en temps réel ou Rendu de
tous les clips tirés.

Ces options fournissent des entrées numériques permettant d’opérer des réglages plus précis que ceux
autorisés par le déplacement de clips dans le panneau Editeur.

Définissez les options suivantes :
Sensibilité aux transitoires (disponible en mode Polyphonique) Définit la sensibilité à des transitoires, comme des sons de
batterie et des débuts de note, utilisées comme points d’ancrage pour l’expansion. Augmente si les transitoires semblent
artificielles.
Taille de la fenêtre Définit la taille, en millisecondes, de chaque bloc de données audio traitées. A régler uniquement si un écho
ou des artefacts se produisent.
Les paramètres Précision (disponibles en mode Rendu) déterminent le compromis entre qualité et vitesse de traitement.
L’option Conserver les formants (disponible lorsque Rendu et Monophonique sont sélectionnés) ajuste le timbre des
instruments et des voix, en conservant un effet réaliste au cours des transpositions.

Pour féminiser une voix masculine ou vice-versa, sélectionnez l’option Conserver les formants et changez la hauteur de ton au maximum.
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Compréhension des pistes vidéo, audio, de bus et principales
Choix entre des pistes mono, stéréo et 5.1
Ajout ou suppression de pistes
Attribution d’un nom à chaque piste et déplacement de pistes
Zoom vertical sur les pistes
Silence et solo sur des pistes
Application d’un même paramètre à toutes les pistes
Réglage du volume de sortie de la piste
Panoramique des pistes en stéréo
Duplication des pistes

Compréhension des pistes vidéo, audio, de bus et principales
Les sessions multipistes peuvent inclure quatre types de pistes :

Les pistes vidéo  contiennent un clip vidéo importé. Une session peut inclure une piste vidéo et un clip à la fois. Vous
pouvez en prévisualiser un aperçu dans le panneau Vidéo (Fenêtre > Vidéo).

Les pistes audio  regroupent les données audio importées ou les clips enregistrés durant la session actuelle. Ces pistes
offrent la plage de commandes la plus large possible, ce qui vous permet de spécifier les entrées et les sorties, d’appliquer les
effets et l’égalisation, d’acheminer les données audio vers les émissions et les bus, et d’automatiser les mixages.

Les pistes de bus  permettent de combiner les sorties de plusieurs pistes audio ou émissions et de les contrôler de manière
collective.

Grâce à la piste principale (« master »)  (la dernière dans chaque session), vous pouvez facilement combiner les sorties de
plusieurs pistes et bus et les régler à l’aide d’un seul équilibreur.

Pour plus d’informations, voir la section Acheminement de données audio vers des bus, des émissions et la piste principale.

Choix entre des pistes mono, stéréo et 5.1
Les sessions multipistes prennent en charge un nombre illimité de pistes audio mono, stéréo et 5.1 et de pistes de bus. Lors de l’ajout de pistes,
sélectionnez une configuration de canal basée sur la configuration de la piste principale :

Pour les pistes principales mono, ajoutez des pistes audio mono et des pistes de bus.

Pour les pistes principales stéréo, ajoutez des pistes audio stéréo et des pistes de bus, à l’exception des pistes audio avec des
sources mono (tel un microphone unique).

Pour les pistes principales 5.1, ajoutez des pistes audio stéréo et des pistes de bus 5.1 (pour préserver un transfert correct du
gain) Si vous utilisez des clips audio 5.1, toutefois, ajoutez des pistes audio 5.1 pour les contenir.
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Pour identifier les canaux de piste, relevez les mesures dans le panneau Editeur ou Mélangeur :
A.  Mono B.  Stéréo C.  5.1

Ajout ou suppression de pistes
Remarque : une session multipiste prend en charge une seule piste vidéo, qu’Adobe Audition insère toujours en haut du panneau Editeur.

 Dans le panneau Editeur ou dans le mélangeur, effectuez l’une des procédures suivantes :

Pour ajouter une piste, sélectionnez la piste qui doit la précéder, puis choisissez Multipiste > Piste > Ajouter une piste [type de
piste].

Pour supprimer une piste, sélectionnez-la, puis choisissez Multipiste > Piste > Supprimer la piste sélectionnée.

Pour plus d’informations, reportez-vous aux sections suivantes :

Insertion d’un fichier audio dans une session multipiste

Attribution d’un nom à chaque piste et déplacement de pistes
Vous pouvez nommer les pistes de sorte à pouvoir mieux les identifier ou les déplacer pour afficher simultanément des pistes associées.

Dans le panneau Editeur ou le mélangeur, saisissez un nom dans la zone de texte.

Zone de texte Nom du panneau Editeur

Placez le pointeur à gauche du nom de la piste, puis faites-le glisser soit vers le haut ou vers le bas dans le panneau Editeur,
soit vers la gauche ou la droite dans le mélangeur.

Déplacement d’une piste dans le panneau Editeur

Zoom vertical sur les pistes
Lorsque vous utilisez les options de zoom vertical en bas à droite du panneau Editeur, le zoom se produit simultanément sur toutes les pistes.
Lorsqu’une une session contient plusieurs pistes, il est préférable d’effectuer un zoom sur chaque piste séparément.

 Dans les commandes de piste, faites glisser le bord supérieur ou inférieur de la piste vers le haut ou vers le bas.
Pour effectuer un zoom rapidement sur toutes les pistes, faites rouler la molette de la souris sur les commandes de piste. Pour effectuer un
redimensionnement horizontal de toutes les commandes de piste, faites glisser le bord droit.

http://helpx.adobe.com/en/audition/using/creating-opening-files.html#insert_an_audio_file_into_a_multitrack_session
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Zoom vertical sur une piste

Pour d’autres techniques, voir la section Zoom audio dans le panneau Editeur.

Silence et solo sur des pistes
Vous pouvez isoler des pistes pour les entendre séparément du reste du mixage. De la même manière, vous pouvez assourdir des pistes pour ne
pas les entendre dans un mixage.

Pour assourdir une piste, cliquez sur le bouton Silence  correspondant dans le panneau Editeur ou dans le mélangeur.

Pour isoler une piste, cliquez sur le bouton Solo  correspondant dans le panneau Editeur ou dans le mélangeur. Pour
supprimer automatiquement les autres pistes du mode Solo, cliquez en appuyant sur la touche Ctrl (Windows) ou Commande
(Mac OS).

Pour supprimer par défaut les autres pistes du mode Solo, sélectionnez Piste solo : exclusif dans la section Multipiste de la
boîte de dialogue Préférences (quel que soit ce paramètre, lorsque vous isolez un bus, les pistes attribuées sont toujours
placées en mode Solo).

Application d’un même paramètre à toutes les pistes
Pour améliorer votre rendement, vous pouvez appliquer rapidement plusieurs paramètres à toute une session.

 Maintenez enfoncées les touches Ctrl + Maj (Windows) ou Commande + Maj (Mac OS). Sélectionnez ensuite les paramètres Entrée, Sortie,
Muet, Solo, Préparer pour l’enregistrement ou Surveiller l’entrée pour toute piste.
Pour plus d’informations, reportez-vous aux sections suivantes :

Réglage du volume de sortie de la piste
 Effectuez l’une des opérations suivantes :

Dans le panneau Editeur, faites glisser le bouton de volume . Maintenez la touche Maj enfoncée pour modifier le réglage
par grands incréments. Maintenez la touche Ctrl (Windows) ou Commande (Mac OS) enfoncée pour modifier le réglage par
tous petits incréments.

Dans le mélangeur, faites glisser l’équilibreur de la piste ou cliquez au-dessus ou au-dessous pour le déplacer jusqu’à la
graduation suivante. Pour atteindre un point spécifique, cliquez en appuyant sur la touche Alt (Windows) ou Option (Mac OS)
au-dessus ou au-dessous de l’équilibreur.

Pour remettre les boutons et réglages à zéro (gain d'unité), cliquez directement sur ceux-ci en appuyant sur la touche Alt (Windows) ou Option
(Mac OS).

Panoramique des pistes en stéréo

 Faites glisser le bouton de panoramique  dans le panneau Editeur ou le mélangeur.
Maintenez la touche Maj enfoncée pour modifier le réglage par grands incréments. Maintenez la touche Ctrl (Windows) ou Commande (Mac OS)
enfoncée pour modifier le réglage par tous petits incréments.

Par défaut, l’éditeur de multipiste effectue un panoramique à l’aide d’une méthode de puissance équivalente, qui préserve l’homogénéité de
l’intensité sonore perçue en amplifiant légèrement un canal par dessus l’autre. Pour modifier le niveau d’amplification ou pour basculer en
panoramique logarithmique (qui atténue simplement un canal), modifiez le mode panoramique dans les préférences de multipiste.

http://helpx.adobe.com/en/audition/using/viewing-zooming-navigating-audio.html#zoom_audio_in_the_editor_panel
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Pour copier parfaitement l’ensemble des clips, des effets, de l’égalisation et des enveloppes d’une piste, dupliquez celle-ci. La duplication de piste
constitue un point de départ intéressant pour effectuer de nouveaux ajustements et vous aider à comparer différents réglages de traitement et
d’automatisation.

1. Dans le panneau Editeur ou dans le mélangeur, sélectionnez une piste.
2. Sélectionnez Multipiste > Piste > Dupliquer la piste sélectionnée.

Voir aussi
Automatisation des paramètres de piste

Application d’effets dans l’éditeur de multipiste

  |  
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Ajustement du volume du clip multipiste
Fondu ou fondu croisé de clips multipistes
Création d’un clip audio unique à partir de plusieurs clips
Création d’un clip audio à partir d’une piste de bus ou principale

Pour le fondu des fichiers audio individuels, reportez-vous à la section Fondu et modification de l’amplitude de manière visuelle. Les sections
ci-dessous concernent les clips multipistes.

Ajustement du volume du clip multipiste
Si les volumes des clips multipistes varient beaucoup, vous pouvez les uniformiser afin de faciliter le mixage. L’éditeur de multipiste n’étant pas
destructeur, ce réglage est complètement réversible. Si vous préférez modifier définitivement le volume des fichiers source, consultez la section
Ajustement du volume dans plusieurs fichiers.

1. A l’aide de l’outil Déplacer  ou Sélection temporelle , cliquez en maintenant enfoncée la touche Ctrl (Windows) ou
Commande (Mac OS) afin de sélectionner plusieurs clips.

2. Sélectionnez Clip > Ajuster le volume du clip.

3. Dans le menu contextuel, sélectionnez l’une des options suivantes :

Intensité sonore Ajuste le volume selon une amplitude moyenne que vous précisez.

Intensité sonore perçue Ajuste le volume selon une amplitude perçue que vous précisez, en prenant en compte les
fréquences intermédiaires auxquelles l’oreille est la plus sensible. Cette option fonctionne bien, sauf si la perception des
fréquences varie de manière importante (par exemple, si les fréquences moyennes sont marquées dans un court passage
alors que tout le fichier est en fréquences basses).

Volume maximal Ajuste le volume selon une amplitude maximale que vous précisez, en normalisant les clips. Comme cette
option conserve la plage dynamique, son choix est judicieux pour les clips que vous envisagez de traiter ultérieurement ou
pour les données audio très dynamiques, telles que la musique classique.

Amplitude RMS totale Ajuste le volume selon une amplitude moyenne quadratique que vous précisez. Si, par exemple, la
majorité des deux fichiers est de -50 dBFS, la RMS totale en tient compte, même si l’un des fichiers contient davantage de
passages forts.

4. Entrez un volume cible.

Fondu ou fondu croisé de clips multipistes
Les commandes de fondu et de fondu croisé sur clip vous permettent de régler visuellement les courbes et leur durée. Les commandes de fondu
d’entrée ou de sortie s’affichent toujours dans les coins supérieurs gauche et droit des clips concernés. Les commandes de fondu croisé
n’apparaissent qu’en cas de superposition de clips.

Commandes sur clip
A.  Faites glisser les coins des commandes sur clip pour effectuer un fondu en entrée ou en sortie. B.  Superposez les clips pour réaliser un
fondu croisé.

http://helpx.adobe.com/en/audition/using/automating-common-tasks-cs6.html#match_volume_across_multiple_files
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Cible

Fondu de clip en entrée ou en sortie
 Dans le coin supérieur gauche ou droit du clip, faites glisser l’icône de fondu   vers l’intérieur pour déterminer la longueur du fondu puis vers

le haut ou le bas afin de régler la courbe de fondu.

Fondu croisé de clips superposés
Lorsque vous effectuez un fondu croisé de clips sur la même piste, vous les superposez afin de déterminer la taille de la région de transition (plus
la zone de superposition est grande plus longue est la transition).

1. Placez deux clips sur la même piste, puis déplacez-les afin qu’ils se chevauchent (Voir la section Sélection et déplacement de
clips.)

2. En haut de la zone de superposition, faites glisser l’icône de fondu de gauche  ou de droite  vers le haut ou le bas pour
régler les courbes de fondu.

Options de fondu
Pour accéder aux options de fondu suivantes, sélectionnez un clip, puis cliquez avec le bouton droit sur une icône de fondu dans le panneau
Editeur ou choisissez Clip > Fondu d’entrée ou Fondu de sortie.

Aucun fondu Supprime le fondu ou le fondu croisé.
Fondu d’entrée, Fondu de sortie ou Fondu croisé Vous permet de sélectionner le type de fondu si les clips se superposent.
Symétrique ou Asymétrique (fondus croisés uniquement) Détermine de quelle manière les courbes de fondu de gauche et de droite
interagissent lorsque vous les faites glisser vers le haut et le bas. L’option Symétrique ajuste les deux fondus de manière identique, tandis que
l’option Asymétrique vous permet de les ajuster indépendamment l’un de l’autre.
Linéaire ou Cosinus Applique un fondu linéaire uniforme ou un fondu en forme de S qui débute lentement puis rapidement change d’amplitude et
se termine lentement.

Pour permuter entre les modes Linéaire et Cosinus tout en faisant glisser les icônes de fondu, maintenez enfoncée la touche Ctrl (Windows) ou
Commande (Mac OS).

Fondus croisés automatiques activés Réalise un fondu croisé de clips superposés. Décochez cette option lorsque les fondus croisé
automatiques sont indésirables ou interfèrent avec d’autres tâches, telles que la réduction de clips.

Création d’un clip audio unique à partir de plusieurs clips
Vous pouvez combiner le contenu de plusieurs clips dans une même plage temporelle afin de créer un seul clip que vous pouvez rapidement
modifier dans l’éditeur de multipiste ou de forme d’onde.

Création d’un seul clip à partir de plusieurs clips dans l’éditeur de multipiste

1. Dans le panneau Editeur, effectuez l’une des opérations suivantes :

Sélectionnez une plage temporelle spécifique (voir la section Sélection de plages dans l’éditeur de multipiste).

Sélectionnez des clips spécifiques en cas de retransmission vers une nouvelle piste.

Ne sélectionnez rien pour mixer une session entière.

2. Pour combiner le contenu des clips originaux, effectuez ce qui suit :

Pour créer une piste et un clip dans l’éditeur de multipiste, sélectionnez Multipiste > Retransmettre à la nouvelle piste.

Pour créer un fichier dans l’éditeur de forme d’onde, sélectionnez Multipiste > Mixage dans un nouveau fichier.

http://helpx.adobe.com/en/audition/using/arranging-editing-multitrack-clips.html#select_and_move_clips
http://helpx.adobe.com/en/audition/using/arranging-editing-multitrack-clips.html#select_and_move_clips


 

Haut de la page

Pour mixer une session entière, voir la section Exportation de fichiers de mixage multipistes.

Création d’un clip audio à partir d’une piste de bus ou principale
Pour éditer le son à partir d’une piste de bus ou principale, vous devez créer un clip depuis la piste concernée.

1. Dans le panneau Editeur, sélectionnez une plage temporelle pour le nouveau clip (voir la section Sélection de plages dans
l’éditeur de multipiste).

2. Dans le montage, cliquez avec le bouton droit sur une piste de bus ou principale, sélectionnez Retransmettre [type de piste] à
la nouvelle piste.

Adobe Audition crée alors une piste contenant un clip qui reproduit le mixage de bus ou principal.

Voir aussi
Exportation de fichiers de mixage multipistes

  |  
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Accès aux boucles libres à partir de Resource Central
Accrochage du curseur aux temps des boucles
Activation d’un clip en boucle et modification de sa durée

Remarque : certaines fonctionnalités de la version Windows d’Adobe Audition 3.0 ne sont pas disponibles dans CS5.5, notamment le tempo des
boucles et le réglage des touches, l’extension temporelle du clip, le format MIDI, le métronome, la gravure sur CD et certains effets et formats de
fichier. Pour obtenir une liste complète, voir Fonctionnalités d’Adobe Audition 3.0 remplacées ou non implémentées dans CS5.5.
La plupart des styles musicaux ont recours à des boucles, des pistes rythmiques de base aux compositions entières. Dans Adobe Audition, vous
pouvez créer vos propres boucles ou en sélectionner parmi les milliers de boucles fournies gratuitement dans le panneau Resource Central.

Grâce aux boucles, vous pouvez créer des sessions multipistes avec une flexibilité extrême. En règle générale, une boucle contient uniquement
une ou deux mesures de musique (quatre à huit temps). Vous pouvez l’étendre et la répéter d’un simple glissement du curseur.

Identification des boucles dans l’affichage de piste
A.  Pas de boucle B.  Boucle simple C.  Boucle étendue (répétée)

Accès aux boucles libres à partir de Resource Central
Resource Central fournit une bibliothèque en ligne complète de boucles, d’effets sonores et de fonds musicaux, à laquelle vous pouvez accéder
directement dans Adobe Audition.

1. Sélectionnez Fenêtre > Resource Central.
2. Dans la partie supérieure du panneau Resource Central, cliquez sur Boucles, Effets sonores ou Fonds musicaux.
3. Dans le menu situé sous la zone de recherche, sélectionnez un genre.
4. Dans la liste de résultats, cliquez sur le bouton de lecture pour écouter un aperçu ou sur la flèche vers le bas pour télécharger

le fichier dans Audition (les coches dans la liste indiquent les éléments précédemment téléchargés).

Accrochage du curseur aux temps des boucles
Pour mieux synchroniser une session contenant des boucles, utilisez le format temporel Mesures et temps, et activez la fonction d’accrochage.
Ensuite, insérez des boucles pour créer une base rythmique que vous pouvez développer en enregistrant des clips audio. (Vous pouvez
également ajouter des clips audio existants, mais seuls leurs points de début ou de fin s’aligneront avec les temps des boucles.)

1. Sélectionnez Affichage > Affichage temporel > Mesures et temps. (Ce format de règle permet d’aligner plus facilement les
boucles avec les temps musicaux d’un point de vue visuel.)

2. Dans le sous-menu Edition > Accrochage, choisissez une des options suivantes :
Accrocher à la règle (Brut) S’accroche aux temps dans les mesures. Utilisez cette option si vous travaillez avec des fichiers
de boucle de 1/4 ou 1/2 mesure.

http://kb2.adobe.com/cps/895/cpsid_89588.html
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Accrocher aux clips S’accroche au début et à la fin des clips audio.

Accrocher aux boucles S’accroche au début et à la fin des boucles dans les clips.

Activation d’un clip en boucle et modification de sa durée
1. Dans l’éditeur de multipiste, cliquez avec le bouton droit sur un clip audio, puis sélectionnez Boucle dans le menu contextuel.

2. Placez le pointeur de la souris sur le bord gauche ou droit du clip ; l’icône de modification de la boucle  s’affiche.
3. Faites glisser la souris pour étendre ou réduire la boucle.

En fonction de la longueur de l’extension, la boucle peut se reproduire totalement ou partiellement. Vous pouvez par exemple
faire glisser une boucle d’une mesure pour l’allonger à 3 mesures et demie, en terminant sur un temps dans la boucle. A
mesure que vous traversez chaque mesure, une ligne blanche verticale apparaît dans le clip. Il s’agit de la ligne d’accrochage,
qui indique un alignement parfait sur les temps d’autres pistes.

Allongement d’une boucle

Voir aussi
Accrochage du curseur aux extrémités des clips

Modification du format d’affichage du temps

  |  
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Sessions multipistes
Modification de sessions multipistes dans le panneau Editeur et dans le mélangeur
Sélection de plages dans l’éditeur de multipiste
Personnalisation du décalage de départ et de l’affichage temporel pour les sessions multipistes

Sessions multipistes
Dans l’éditeur de forme d’onde, vous pouvez mixer ensemble plusieurs pistes audio afin de créer des pistes sonores superposées et d’élaborer
des compositions musicales. Vous pouvez enregistrer et mixer un nombre illimité de pistes, chacune pouvant contenir autant de clips que vous le
souhaitez. L’espace disque et la puissance du processeur constituent les seules limites. Lorsque le mixage vous satisfait, vous pouvez exporter un
fichier de mixage en vue de l’utiliser sur un CD, sur Internet, etc.

L’éditeur de multipiste est un environnement d’édition en temps réel qui vous garantit une flexibilité extrême. Vous pouvez ainsi modifier des
paramètres lors de la lecture pour en écouter immédiatement les résultats. Par exemple, lorsque vous écoutez une session, vous pouvez régler le
volume de chaque piste afin d’effectuer des transitions impeccables. Toutes les modifications que vous apportez sont temporaires, c’est-à-dire non
destructrices. Ainsi, si un mixage que vous venez de créer ne vous plaît plus dans une semaine ou dans un an, il vous suffit de remixer les
fichiers source d’origine et d’appliquer ou de supprimer des effets pour obtenir d’autres textures sonores.

Adobe Audition enregistre dans des fichiers de session (.sesx) les informations sur les fichiers source et les paramètres de mixage. Ces fichiers
sont relativement petits car ils contiennent uniquement le nom des chemins d’accès aux fichiers source et des références aux paramètres de
mixage (p. ex., paramètres de volume, de panoramique et d’effet). Pour gérer plus facilement les fichiers de session, enregistrez-les dans un
dossier unique avec les fichiers source auxquels ils font référence. Si vous devez déplacer la session vers un autre ordinateur par la suite, il vous
suffira de déplacer le dossier de la session.

Modification de sessions multipistes dans le panneau Editeur et dans le mélangeur
Dans l’éditeur de multipiste, le panneau Editeur intègre plusieurs éléments vous permettant de mixer et de modifier les sessions. À l’aide des
commandes de piste situées à gauche, vous pouvez régler les paramètres spécifiques d’une piste, comme le volume et le panoramique. Dans le
montage situé à droite, vous pouvez modifier les clips et les enveloppes d’automatisation de chaque piste.

Panneau Editeur dans l’éditeur de multipiste
A.  Commandes de piste B.  Navigateur de zoom C.  Barre de défilement vertical D.  Piste

Le mélangeur (Fenêtre > Mélangeur) fournit une autre vue d’une session et affiche simultanément bien d’autres pistes et commandes, sans les
clips. Cet outil est idéal pour le mixage de sessions contenant un nombre important de pistes.
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Commandes du mélangeur :
A.  Entrées B.  Effets C.  Émissions D.  Égalisation E.  Volume F.  Sorties

Sélection de plages dans l’éditeur de multipiste

Sélection simultanée d’une plage et de clips dans le panneau Editeur

1. Dans la barre d’outils, sélectionnez l’outil de sélection temporelle .
2. Dans le panneau Editeur, effectuez l’une des opérations suivantes :

Pour sélectionner uniquement une plage, cliquez dans une zone vide de l’affichage et déplacez l’outil vers la gauche ou la
droite.

Pour sélectionner une plage et des clips, cliquez sur le centre d’un clip et faites glisser un rectangle de sélection.

Personnalisation du décalage de départ et de l’affichage temporel pour les sessions
multipistes



 

1. Dans le panneau Editeur, cliquez sur une zone vide de la piste affichée afin de vous assurer qu’aucun clip n’est sélectionné.

2. Sélectionnez Fenêtre > Propriétés.

3. Dans le panneau Propriétés, définissez les options suivantes :

Heure de début Définit un décalage d’heure de début, afin de vous aider à faire correspondre les données audio dans
Adobe Audition au temps affiché dans les applications vidéo.

Avancé Pour personnaliser les paramètres Affichage du temps pour la session en cours, définissez les paramètres Format
temporel et Fréquence d’images personnalisée. Pour plus d’informations, consultez la section Modification du format
d’affichage du temps.

Voir aussi
Comparaison des éditeurs de forme d’onde et de multipiste

Création d’une session multipiste

Enregistrement de sessions multipistes

Organisation et modification des clips multipistes

Automatisation des mixages avec des enveloppes
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Affichage ou masquage de l’acheminement de pistes et de commandes d’égalisation
Affectation d’entrées et de sorties audio aux pistes
Acheminement de données audio vers des bus, des émissions et la piste principale
Paramétrage d’une émission
Egalisation des pistes

Affichage ou masquage de l’acheminement de pistes et de commandes d’égalisation
Bien que le large éventail de commandes d’égalisation puisse sembler déconcertant de prime abord, les commandes de chaque piste sont
identiques. Ainsi, lorsque vous en connaissez une, vous les connaissez toutes.

Affichage ou masquage de groupes de commandes de piste audio
A.  Panneau Editeur B.  Mélangeur

 Effectuez l’une des opérations suivantes :

À gauche du mélangeur, cliquez sur le triangle Afficher/Masquer correspondant à un ou plusieurs groupes de commandes.

Dans le coin supérieur gauche du panneau Editeur, cliquez sur le bouton Entrées/Sorties , Effets , Envoi  ou

Egaliseur .

Dans le panneau Editeur, faites glisser le bord droit ou inférieur des commandes de piste pour afficher davantage ou moins
d’informations.

Glissement du bord droit des commandes de piste pour afficher davantage ou moins d’informations

Pour plus d’informations, voir la section Zoom vertical sur les pistes.

Affectation d’entrées et de sorties audio aux pistes

 Dans la section Entrées/Sorties  du panneau Editeur ou du mélangeur, effectuez les opérations suivantes :

Dans la liste Entrée, sélectionnez une entrée matérielle.

Dans la liste Sortie, sélectionnez un bus, la piste principale ou une sortie matérielle.

La liste des ports matériels disponibles varie en fonction des paramètres définis dans les préférences Matériel audio (voir la section
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Configuration des entrées et sorties audio).

Pour plus d’informations, reportez-vous aux sections suivantes :

Inversion de la polarité d’une entrée
Si une paire d’entrées stéréo (microphones pour percussions, par exemple) est hors phase, le son sera plus mat et l’image stéréo plus étroite.
Pour résoudre ce problème, inversez la polarité de l’une des entrées.

 Dans la section Commandes d’entrée  du mélangeur, cliquez sur le bouton Inversion de polarité .
Pour comprendre la phase audio, voir la section Méthodes d’interaction des ondes sonores.

Acheminement de données audio vers des bus, des émissions et la piste principale
Les bus, les émissions et la piste principale vous permettent d’acheminer plusieurs sorties de piste vers un groupe de commandes. Grâce à ces
commandes combinées, vous pouvez organiser et mixer une session de manière efficace.

Pour enregistrer la sortie d’une piste audio, bus ou principale dans un fichier, voir la section Exportation de fichiers de mixage multipistes.

Exemple d’acheminement audio pour des pistes
A.  Voix B.  Bus de réverbération recevant les émissions vocales et de guitare C.  Guitare D.  Bus de percussions combinant les sorties de
percussions E.  Basse avec sortie directe vers le matériel F.  Piste principale G.  Sorties matérielles

Présentation des pistes bus
Avec les pistes bus, vous pouvez combiner les sorties de plusieurs pistes audio ou d’émissions et de les déterminer de manière collective. Par
exemple, pour régler le volume de plusieurs pistes de percussions à l’aide d’un seul équilibreur, acheminez la sortie de toutes les pistes vers un
bus. Pour optimiser les performances système, vous pouvez également appliquer un effet de réverbération à une piste bus, puis acheminer vers
ce bus la sortie des émissions de plusieurs pistes. (L’application du même effet de réverbération à plusieurs pistes séparément utilise davantage
de ressources du processeur.)

Même si elles ne possèdent pas d’entrée matérielle, les pistes bus intègrent toutes les autres fonctionnalités des pistes audio. Vous pouvez
appliquer des effets et des fonctions d’égalisation, ainsi qu’automatiser les modifications au fil du temps. Pour la plupart des mixages, vous
acheminez la sortie des bus vers des ports matériels ou vers la piste principale. Toutefois, si vous souhaitez combiner des bus, vous pouvez
diriger leur sortie vers d’autres bus.

http://helpx.adobe.com/en/audition/using/saving-exporting-files1.html#export_multitrack_mixdown_files


Exemple d’acheminement de bus :
A.  Bus de batterie B.  Bus de percussions à main C.  Bus de percussions combinées avec sortie vers la piste principale ou le matériel

Présentation des émissions
Grâce aux émissions, vous pouvez acheminer des données audio d’une piste vers plusieurs bus tout en bénéficiant d’une flexibilité exceptionnelle
en termes d’acheminement du signal. Chaque piste fournit jusqu’à 16 émissions que vous configurez de manière indépendante de la sortie de
piste. Par exemple, vous pouvez faire sortir une piste non traitée directement vers un port matériel, tout en acheminant l’émission 1 vers un bus
de réverbération et l’émission 2 vers un bus casque. (Grâce à un bus casque, un musicien peut entendre un mixage unique lors de
l’enregistrement. Par exemple, un batteur peut préférer une piste basse plus forte.)

Envoi de pistes vers plusieurs bus
A.  Émission 1 vers bus de délai B.  Émission 2 vers bus de réverbération C.  Piste principale qui combine les sorties voix, guitare, délai et
réverbération

Présentation de la piste principale
Une session contient toujours une piste principale (« master »). Par conséquent, vous pouvez facilement combiner les sorties de plusieurs pistes
et bus et les régler à l’aide d’un seul équilibreur. La piste principale propose moins d’options d’acheminement que les pistes audio et bus, car elle
est située tout au bout de la trajectoire du signal. La piste principale ne peut ni être directement reliée aux entrées audio ni acheminer les sorties
vers des émissions ou des bus. Elle envoie uniquement les sorties directement vers des ports matériels.
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La piste principale est toujours située à la fin de la trajectoire du signal.
A.  Panneau Editeur B.  Mélangeur

Paramétrage d’une émission
Lors de la configuration d’une émission, vous déterminez le volume et le panoramique stéréo en sortie vers un bus. En outre, vous appliquez un
effet pré-équilibreur ou post-équilibreur à l’émission. Les émissions pré-équilibreur ne sont pas affectées par le volume de piste, tandis que les
émissions post-équilibreur le sont. (Par exemple, si vous déterminez la sortie d’une émission pré-équilibreur vers un bus de réverbération, la
réverbération se poursuit après un fondu de données audio pures. Par contre, si vous déterminez la sortie d’une émission post-équilibreur, un
fondu parallèle entre la réverbération et les données audio pures est appliqué.)

Effet pré-équilibreur et post-équilibreur et acheminement d’émission pour chaque piste
A.  Entrée B.  Égalisation C.  Volume de piste D.  Silence de piste E.  Émission F.  Rack d’effets

1. Dans la section Envoi  du mélangeur, cliquez sur le bouton d’activation/désactivation des effets .

2. Cliquez sur le bouton Pré-équilibreur/Post-équilibreur pour placer l’émission avant  ou après  le volume de piste.

3. Définissez le volume  et le panoramique  de l’envoi.
4. Dans le menu contextuel Envoyer, sélectionnez un bus.

Pour plus d’informations, voir la section Insertion d’effets avant ou après les émissions et l’égalisation.

Egalisation des pistes
L’éditeur de multipiste fournit pour chaque piste un égaliseur paramétrique.

http://helpx.adobe.com/en/audition/using/applying-effects-multitrack-editor.html#insert_effects_before_or_after_sends_and_eq


 

 Dans la zone de l’égaliseur  du panneau Editeur ou Mélangeur, procédez de l’une des manières suivantes :

Double-cliquez sur le graphique afin d’accéder aux commandes détaillées dans la fenêtre Egaliseur de pistes (Voir la section
Effet Egaliseur paramétrique).

Cliquez sur le bouton marche/arrêt de l’égaliseur  pour comparer les données audio avec et sans égalisation.

Voir aussi
Utilisation des préconfigurations d’effets
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Vidéo et son surround

Il se peut qu’une partie du contenu lié depuis cette page apparaisse uniquement en anglais.
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Contrôle du son surround 5.1
Modification des fichiers surround 5.1
Panoramisation des pistes dans un mixage surround 5.1
Emissions panoramiques vers une piste de bus 5.1

Contrôle du son surround 5.1
Adobe Audition prend en charge le son surround 5.1 qui, outre un caisson de grave (canal LFE), requiert cinq enceintes acoustiques. Pour bien
contrôler le son surround 5.1, l’ordinateur doit être équipé d’une carte son dotée d’au moins six sorties, qui doivent être mappées aux canaux
appropriés dans Audition.

1. Sélectionnez Edition > Préférences > Mappage du canal audio (Windows) ou Audition > Préférences > Mappage du canal
audio (Mac OS).

2. Mappez chaque canal 5.1 à une sortie de la carte son :

G : haut-parleur avant gauche.

D : haut-parleur avant droit.

C : haut-parleur avant central.

FLE : caisson de grave.

Gs : haut-parleur surround gauche.

Ds : haut-parleur surround droit.

Pour plus de détails, voir la section Configuration des entrées et sorties audio.

Modification des fichiers surround 5.1
Dans l’éditeur de forme d’onde, vous pouvez modifier les fichiers surround 5.1 avec les mêmes outils que pour les fichiers mono et stéréo. Voir la
section Edition de fichiers audio.

Pour restreindre la modification d’un sous-ensemble de canaux 5.1, consultez la section Spécification des canaux à modifier.

Panoramisation des pistes dans un mixage surround 5.1
1. Ouvrez ou créez une session multipiste 5.1 (Voir la section Création d’une session multipiste).

2. Pour ouvrir le Panoramique de piste, procédez de l’une des manières suivantes :

Sélectionnez Fenêtre > Panoramique de piste. Sélectionnez ensuite une piste mono ou stéréo dans le panneau Editeur.

Dans le panneau Editeur ou Mélangeur, double-cliquez sur un tracé surround pour une piste mono ou stéréo.

Remarque : vous pouvez uniquement panoramiser les pistes mono et stéréo, et non les pistes 5.1. Pour ajuster le volume
relatif des canaux dans un fichier 5.1, ouvrez-le dans l’éditeur de forme d’onde.

Double-cliquez sur un tracé surround pour ouvrir le Panoramique de piste.

3. Dans le Panoramique de piste, procédez de l’une des manières suivantes :

http://helpx.adobe.com/en/audition/using/creating-opening-files.html#create_a_new_multitrack_session
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Pour activer ou désactiver les canaux, cliquez sur les boutons G, C, D, Gs et Ds, ou cliquez sur LFE uniquement pour
envoyer les données audio au caisson de graves uniquement.

Dans le grand tracé surround, faites glisser le curseur pour modifier la position du signal.

Ce faisant, la longueur des lignes blanches change pour les haut-parleurs, reflétant la puissance du signal dans chacun
d’eux. En arrière-plan, les zones vertes et pourpres reflètent le positionnement de l’image stéréo gauche et droite ; les
zones bleues indiquent où se superposent les images.

Sous le tracé surround, définissez les options suivantes :

Angle Indique d’où dans le champ surround semble provenir le son. Par exemple, -90° est directement à gauche, tandis
que 90° est directement à droite.

Diffusion stéréo Détermine la séparation entre les pistes audio stéréo : zéro et -180° produisent une séparation minimale,
-90° produit une séparation maximale.

Rayon Détermine l’étendue du champ surround du son. Par exemple, un rayon de 100 % produit un son concentré issu
de quelques haut-parleurs seulement, tandis qu’une valeur de 0 % produit un son non concentré issu de tous les haut-
parleurs.

Centre Pour les pistes panoramisées vers l’avant du champ surround, détermine le pourcentage du niveau du canal
central par rapport aux niveaux de gauche et de droite.

LFE Contrôle le niveau de signal envoyé au caisson des graves.

4. Pour panoramiser les pistes supplémentaires, il suffit de les sélectionner dans le panneau Editeur. Le Panoramique de piste
affiche automatiquement les paramètres uniques de chaque piste.

Pour panoramiser dynamiquement les pistes surround au fil du temps, consultez la section Automatisation des paramètres de piste.

Emissions panoramiques vers une piste de bus 5.1
1. Dans l’éditeur de multipiste, créez une piste de bus 5.1 (voir la section Ajout ou suppression de pistes).

2. Dans le menu Envoyer la sortie d’une piste audio, sélectionnez la piste de bus 5.1 (voir la section Paramétrage d’une
émission).

Dans la section Envoi  des panneaux Editeur et Mélangeur, un tracé surround s’affiche. Double-cliquez dessus pour
accéder au Panoramique de piste pour l’envoi.

Voir aussi

  |  
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Insertion d’un fichier vidéo dans une session multipiste
Accrocher à des trames d’un clip vidéo
Personnalisation du panneau Vidéo

Insertion d’un fichier vidéo dans une session multipiste
Dans l’éditeur de multipiste, vous pouvez insérer des fichiers vidéo afin de synchroniser avec précision une session avec une prévisualisation
vidéo. Lors de l’insertion d’un fichier vidéo, le clip vidéo correspondant s’affiche dans la partie supérieure de l’affichage de piste et le clip audio
correspondant apparaît dans la piste du dessous.

Vous pouvez déplacer un clip vidéo indépendamment du clip audio contenant la piste son d’origine. Pour que ces clips restent synchronisés, avant
de les déplacer, sélectionnez-les : cliquez en appuyant sur la touche Ctrl (Windows) ou Commande (Mac OS).

Remarque : une session ne peut contenir qu’un seul clip vidéo à la fois.

Clips vidéo et audio liés (sélectionnez les deux pour qu’ils restent synchronisés).

1. Dans l’éditeur de multipiste, placez l’indicateur d’instant présent au point d’insertion souhaité.
2. Sélectionnez Multipiste > Insérer un fichier, puis sélectionnez un fichier vidéo dans un format pris en charge (Voir la section

Formats de fichiers vidéo).
3. Une fois le mixage audio terminé pour la vidéo, exportez-le, puis importez-le dans votre application vidéo (Voir la section

Exportation de fichiers de mixage multipistes.)

Pour modifier rapidement les données audio d’un fichier vidéo, sélectionnez Fichier > Ouvrir. Cette technique s’avère utile pour une édition de
pistes son qui ne requiert pas de prévisualisation de la vidéo ou pour la réadaptation de pistes son pour des supports de données audio
uniquement, comme une radio ou un CD.

Accrocher à des trames d’un clip vidéo
Pour synchroniser une session multipiste avec des données vidéo, accrochez les clips audio et l’indicateur d’instant présent aux trames.

1. Choisissez Affichage > Affichage temporel et sélectionnez le format temporel SMPTE qui correspond à la fréquence d’images
du clip.

2. Choisissez Edition > Accrochage > Accrocher aux trames.

Personnalisation du panneau Vidéo
Dans le panneau Vidéo, vous pouvez prévisualiser des clips vidéo pendant la lecture d’une session multipiste afin de synchroniser de manière
précise une piste son avec des événements vidéo spécifiques tels que des changements de scènes, des séquences de titres ou des effets
spéciaux.

Pour afficher ou masquer le panneau Vidéo, sélectionnez Fenêtre > Vidéo.

http://helpx.adobe.com/fr/audition/using/supported-file-formats.html#video_file_formats
http://helpx.adobe.com/en/audition/using/saving-exporting-files1.html#export_multitrack_mixdown_files


 

Panneau Vidéo et clip associé dans le panneau Editeur

Pour personnaliser le panneau Vidéo, cliquez dessus avec le bouton droit, puis sélectionnez l’une des options suivantes :
Un pourcentage de zoom Permet d’effectuer un zoom avant ou arrière.
Ajuster Permet d’ajuster la prévisualisation à la taille du panneau.
Voir aussi
Formats de fichiers vidéo

Sélection et déplacement de clips

Accrochage du curseur aux extrémités des clips

Zoom audio dans le panneau Editeur
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Modification de clips audio d’Adobe Premiere Pro CS5.5 ou d’After Effects
Exportation d’un mixage multipiste vers Adobe Premiere Pro CS5.5
Liaison des sessions aux fichiers de mixage exportés

Adobe recommande Vous souhaitez partager un
didacticiel ?

Intégration
d’Adobe Premiere Pro et
d’Audition
Jason Levine
Partage des mixages complets entre les deux
applications pour plus de souplesse.

Flux de travail
After Effects – Audition
Chris Meyer
Amélioration rapide des animations vidéo avec de
puissants outils audio.

Modification de clips audio d’Adobe Premiere Pro CS5.5 ou d’After Effects
Dans Adobe Premiere Pro® CS5.5 ou After Effects®, vous pouvez rapidement ouvrir les clips sélectionnés dans l’éditeur de forme d’onde afin de
les restaurer ou de les améliorer. Lorsque vous enregistrez les modifications, les clips audio mis à jour s’affichent automatiquement dans les
projets vidéo.

Dans Adobe Premiere Pro, sélectionnez Edition > Modifier dans Adobe Audition > Clip.

Dans After Effects, sélectionnez Edition > Modifier dans Adobe Audition.

Pour plus d’informations, recherchez « Adobe Audition » dans l’aide d’Adobe Premiere Pro ou d’After Effects.

Exportation d’un mixage multipiste vers Adobe Premiere Pro CS5.5
Adobe Premiere Pro et Audition CS5.5 échangent directement les données audio entre les séquences et les sessions multipistes. Les marques de
séquence s’affichent dans Audition ; il est possible de préserver les pistes individuelles afin d’optimiser la souplesse de montage.

Les applications échangent des séquences et des sessions à l’aide d’un format XML partagé, exporté vers un dossier qui contient des fichiers
audio référencés.

Pour envoyer un seul fichier de mixage vers Adobe Premiere sans exporter les pistes individuelles, consultez la section Liaison des sessions
aux fichiers de mixage exportés.

Plusieurs clips d’Audition combinés comme des ressources dans Adobe Premiere

1. Sélectionnez Multipiste > Exporter vers Adobe Premiere Pro.

2. Précisez un nom et un emplacement pour le dossier de session exporté, puis définissez les options suivantes :

Taux d’échantillonnage Correspond par défaut au taux d’échantillonnage de la séquence d’origine. Sélectionnez un autre
taux pour rééchantillonner le fichier en fonction de différents supports de sortie (voir la section Compréhension du taux
d’échantillonnage).

Exporter chaque piste ou bus comme une ressource Convertit la durée totale du montage de chaque piste en un seul clip,
en combinant plusieurs clips si nécessaire. Sélectionnez cette option pour étendre et aligner les clips avec les points de début
et de fin de la séquence.
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Mixer la session dans Exporte la session dans un fichier mono, stéréo ou 5.1 unique.

Ouvrir dans Adobe Premiere Pro Ouvre automatiquement la séquence dans Adobe Premiere Pro. Désélectionnez cette
option si vous prévoyez de modifier la séquence par la suite ou de la transférer sur un autre ordinateur.

3. Cliquez sur Exporter.

4. Lorsque Premiere Pro ouvre le fichier XML exporté (soit automatiquement, soit via la commande Fichier > Importer), la boîte
de dialogue Copier les pistes Adobe Audition s'affiche.

Dans le menu Copier dans la séquence active, choisissez où la piste Audition exportée commence. Toute nouvelle piste est
ajoutée en dessous des pistes existantes.

Pour envoyer les données audio d’une séquence d’Adobe Premiere Pro vers Audition, consultez la rubrique Exportation de pistes de séquence
vers Adobe Audition dans l’aide d’Adobe Premiere Pro.

Liaison des sessions aux fichiers de mixage exportés
Pour créer des pistes son de vidéo à plusieurs couches que vous pouvez facilement mettre à jour, reliez des sessions multipistes à des fichiers de
mixage exportés. Si vous sélectionnez les fichiers exportés dans une application telle qu’Adobe Premiere Pro, vous pouvez les remixer ou les
modifier dans Adobe Audition. Au fur et à mesure de l’évolution d’un projet vidéo, il suffit de répéter ce processus pour créer une piste son finale
impeccable.

Si vous utilisez Adobe Premiere Pro CS5.5 et que vous souhaitez partager l’ensemble des mixages multipistes, plutôt que les fichiers de
mixage, consultez la section Exportation d’un mixage multipiste vers Adobe Premiere Pro CS5.5.

Incorporation des données de modification de l’original dans les fichiers de mixage exportés

1. Ouvrez une session multipiste.

2. Sélectionnez Edition > Préférences > Marques et métadonnées (Windows) ou Audition > Préférences > Marques et
métadonnées (Mac OS).

3. Sélectionnez Incorporer les données du lien Modifier l’original dans les mixages multipistes.

4. Lorsque vous exportez des mixages, sélectionnez Inclure des marques et d’autres métadonnées.

Modification d’un fichier de mixage au moyen d’une application vidéo

1. Dans l’application vidéo, sélectionnez le fichier de mixage exporté depuis Adobe Audition.

2. Choisissez Edition > Modifier l’original.

3. Sélectionnez l’une des options suivantes, puis cliquez sur OK :

Ouvrir la session multipiste Audition qui a créé le fichier

Ouvrir le fichier dans l’éditeur de forme d’onde Audition

4. Mixez à nouveau la session liée dans l’éditeur de multipiste ou modifiez le fichier de mixage de l’éditeur de forme d’onde.

5. Pour remplacer le fichier d’origine dans l’application vidéo, effectuez l’une des opérations suivantes :

Dans l’éditeur de multipiste, sélectionnez Fichier > Exporter > Mixage multipiste, puis spécifiez les mêmes nom et
emplacement que pour le fichier original.

Dans l’éditeur de forme d’onde, sélectionnez Fichier > Enregistrer.

Voir aussi
Effet Mastérisation

Comparaison des éditeurs de forme d’onde et de multipiste

Exportation de sessions au format d’échange Final Cut Pro ou OMF

  |  
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Il se peut qu’une partie du contenu lié depuis cette page apparaisse uniquement en anglais.
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Enregistrement et exportation de fichiers (CS6)

En haut

Type d’échantillonnage

Paramètres de format

Inclure des marques et d’autres métadonnées

Remarque :

En haut

En haut

Enregistrement des fichiers audio
Extraction de canaux audio vers des fichiers mono
Enregistrement de sessions multipistes
Exportation de sessions au format OMF ou au format d’échange Final Cut Pro
Exportation de modèles de session
Exportation d’archives de session
Exportation de fichiers de mixage multipistes
Paramètres du format audio
Fermeture des fichiers

Enregistrement des fichiers audio
Dans l’éditeur de forme d’onde, vous pouvez enregistrer des fichiers audio dans divers formats courants. Le format que vous choisissez dépend
de la façon dont vous pensez utiliser le fichier (Voir Paramètres du format audio.) N’oubliez pas que chaque format vous permet de stocker des
informations uniques pouvant être ignorées si vous enregistrez le fichier sous un autre format.

1. Dans l’éditeur de forme d’onde, effectuez l’une des opérations suivantes :
Choisissez Fichier > Enregistrer pour enregistrer les modifications apportées au fichier en cours d’utilisation.

Pour enregistrer les modifications sous un autre nom de fichier, choisissez Fichier > Enregistrer sous. Ou choisissez
Fichier > Exporter > Fichier afin de conserver le fichier actuellement ouvert.

Choisissez Fichier > Enregistrer la sélection sous pour enregistrer les données audio actuellement sélectionnées dans un
nouveau fichier.

Choisissez Fichier > Enregistrer tout pour enregistrer tous les fichiers ouverts dans leur format actuel.

Choisissez Fichier > Enregistrer tout l’audio en tant que Traitement par lots pour traiter tous les fichiers ouverts. (Pour plus
d’informations, reportez-vous à Traitement de fichiers par lots.

2. Définissez un nom de fichier et un emplacement, puis sélectionnez un format de fichier.
3. Définissez les options suivantes :

Indique le taux d’échantillonnage et la résolution. Cliquez sur Modifier pour ajuster ces options (voir
la section Conversion du taux d’échantillonnage d’un fichier).

Indique les modes de compression et de stockage des données ; pour les ajuster, cliquez sur Modifier
(Voir Paramètres du format audio.)

Inclut dans les fichiers enregistrés les informations et les marques audio
issues du panneau Métadonnées (VoirUtilisation des marqueurs et Affichage et modification de métadonnées XMP.)

certaines applications de gravure de CD n’interprètent pas correctement les informations non audio (comme les
marqueurs et les métadonnées) et peuvent générer un bruit déplaisant au début de chaque piste.

Extraction de canaux audio vers des fichiers mono
Si vous souhaitez éditer ou exporter les canaux individuels d’un fichier stéréo ou son surround, extrayez-les dans des fichiers au format mono.
Adobe Audition annexe le nom du canal à chaque nom de fichier extrait. Par exemple, un fichier source stéréo nommé Jazz.aif produit des fichiers
mono nommés Jazz_G et Jazz_D.

Dans l’éditeur de forme d’onde, sélectionnez Edition > Extraire les canaux vers des fichiers mono.

Audition ouvre automatiquement chaque fichier extrait dans le panneau Editeur.

Enregistrement de sessions multipistes

http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/fr-fr/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
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En haut

Type d’échantillonnage

Paramètres OMF

Média

Remarque :

Options de média

Durée de la poignée

Un fichier de session multipiste est un petit fichier non audio. Il contient uniquement des informations sur l’emplacement des fichiers audio
associés sur le disque dur, la durée de chaque fichier audio contenu dans la session, les enveloppes et les effets appliqués aux pistes, etc. Vous
pouvez rouvrir ultérieurement un fichier de session enregistré afin de modifier le mixage.

Si vous créez des mixages multipistes entièrement dans Adobe Audition, enregistrez les fichiers de session au format SESX natif. Cependant, si
vous envisagez de partager des compositions multipiste avec d’autres applications, reportez-vous à la section Exportation de sessions au format
d’échange Final Cut Pro ou OMF.

Vous pouvez sauvegarder des sessions avec un enregistrement de tous les fichiers ouverts, puis les rouvrir automatiquement avec les
sessions. Dans les préférences Multipiste, sélectionnez Référencer tous les fichiers audio et vidéo ouverts.

1. Dans l’éditeur de multipiste, effectuez l’une des opérations suivantes :
Sélectionnez Fichier > Enregistrer pour enregistrer les modifications apportées dans le fichier de session en cours
d’utilisation.

Pour enregistrer les modifications sous un autre nom de fichier, choisissez Fichier > Enregistrer sous. Ou choisissez
Fichier > Exporter > Session afin de conserver la session actuellement ouverte.

Pour enregistrer le fichier de session ainsi que tous les fichiers audio qu’il contient, sélectionnez Fichier > Tout enregistrer.

2. Définissez un nom de fichier et un emplacement.
3. Pour inclure les marques audio et les informations du panneau Métadonnées, sélectionnez Inclure des marques et d’autres

métadonnées.

Exportation de sessions au format d’échange Final Cut Pro ou OMF
Pour transférer des mixages complets vers d’autres applications de votre flux de production, exportez-les au format d’échange OMF ou
Final Cut Pro. A l’origine créé pour Avid Pro Tools, le format OMF est désormais un format d’échange multipiste commun à de nombreuses
applications de mixage audio. Le format d’échange Final Cut Pro repose sur des fichiers XML lisibles à l’œil, que vous pouvez modifier hors
connexion afin de réviser les références textuelles, les paramètres de mixage, etc.

Exportation au format OMF

1. Dans l’éditeur de multipiste, sélectionnez Fichier > Exporter > OMF.

2. Définissez un nom de fichier et un emplacement.

3. Définissez les options suivantes :

Cliquez sur Modifier pour accéder à la boîte de dialogue Convertir le type d’échantillons (voir la
section Conversion de types d’échantillons).

Cliquez sur Modifier pour accéder aux options suivantes :

Le réglage Encapsulé stocke les clips audio dans le fichier OMF lui-même pour une organisation plus rapide.
Le réglage Référence stocke les clips audio dans le même dossier que le fichier OMF, où vous pouvez les modifier
hors connexion si nécessaire.

les fichiers OMF encapsulés ne peuvent pas avoir une taille supérieure à 2 Go.

Détermine si les fichiers source du clip sont conformés à la durée du clip dans le panneau Editeur
ou correspondent au fichier d’origine dans son ensemble.

Pour les clips conformés, définit la durée temporelle à inclure au-delà des bords du clip. Le fait
d’ajouter des données audio supplémentaires vous octroie une plus grande souplesse pour les fondus et le montage.

La section Avertissements répertorie les éléments de la session qui seront exclus ou modifiés. Pour copier ces informations dans le Presse-
papiers, cliquez sur le bouton Copier les avertissements .

Exportation au format d’échange Final Cut Pro

1. Dans l’éditeur de multipiste, sélectionnez Fichier > Exporter > Format d’échange XML FCP.

2. Définissez un nom de fichier et un emplacement.

3. Pour inclure les marques audio et les informations du panneau Métadonnées, sélectionnez Inclure des marques et d’autres
métadonnées.
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En haut

En haut

En haut

Type d’échantillonnage

Paramètres de format

Inclure des marques et d’autres métadonnées

4. Pour associer fichiers sources et fichiers de session afin de faciliter le transfert vers d’autres systèmes, sélectionnez
Enregistrer des copies de fichiers associés. Pour modifier le format et le type d’échantillonnage des fichiers sources exportés,
cliquez sur Options.

Les éléments de session suivants sont exclus du fichier exporté :

Deuxième canal des clips stéréo (tous les clips et pistes deviennent mono)

Clips qui se chevauchent

Effets et égaliseur de piste

Enveloppes d’automatisation autres que le volume du clip et le panoramique de piste mono-stéréo

Routage des sorties, émissions, bus et piste principale

Exportation de modèles de session
Les modèles de session contiennent l’ensemble des propriétés et clips multipiste et vous aident à lancer rapidement des projets nécessitant des
paramètres et des tâches similaires. En voici des exemples : un thème d’introduction ou une ambiance de fond commun(e) à plusieurs
performances associées.

1. Choisissez Fichier > Exporter la session en tant que modèle. Définissez ensuite un nom de fichier et un emplacement.
2. Pour appliquer un modèle à une nouvelle session, sélectionnez Fichier > Nouveau > Session multipiste. Choisissez une

option dans le menu Modèle.

Exportation d’archives de session
Pour associer fichiers sources et fichiers de session afin de faciliter le transfert vers d’autres ordinateurs ou périphériques de stockage, exportez
les archives de session.

Suivez cette procédure pour modifier le taux d’échantillonnage et la résolution d’une session.

1. Sélectionnez Fichier > Exporter > Session.
2. Sélectionnez Enregistrer des copies de fichiers associés, puis cliquez sur Options.
3. Pour enregistrer des fichiers sources dans un autre format, sélectionnez Convertir les fichiers, puis définissez les options de la

manière souhaitée.
4. Pour exporter des fichiers source complets ou conformés, effectuez une sélection dans le menu Options de média.

La durée de la poignée indique le niveau audio supplémentaire à inclure au début et à la fin des clips conformés. Pour une plus grande
souplesse avec les réglages ultérieurs de raccord et de fondu, augmentez la durée de poignée de 10 secondes.

Exportation de fichiers de mixage multipistes
Après avoir mixé une session, vous pouvez exporter une partie ou l’ensemble de la session dans divers formats courants (voir la section Formats
de fichiers audio). Lors de l’exportation, le fichier résultant reflète les réglages du volume, du panoramique et des effets routés vers la piste
principale.

Pour mixer rapidement des clips audio dans une seule piste, utilisez la commande Multipiste > Retransmettre à la nouvelle piste (voir la section
Création d’un clip audio unique à partir de plusieurs clips).

1. Si vous souhaitez exporter une partie d’une session, sélectionnez la plage à exporter à l’aide de l’outil de sélection temporelle 

.
2. Sélectionnez la commande Fichier > Exporter > Mixage multipiste

(vous pouvez également sélectionner Multipiste > Mixage dans un nouveau fichier afin d’ouvrir le mixage dans l’éditeur de
forme d’onde et d’ignorer les étapes ci-dessous).

3. Définissez un nom de fichier et un emplacement, puis sélectionnez un format de fichier.
4. Définissez les options suivantes :

Indique le taux d’échantillonnage et la résolution. Cliquez sur Modifier pour ajuster ces options (voir
la section Conversion du taux d’échantillonnage d’un fichier).

Indique les modes de compression et de stockage des données ; pour les ajuster, cliquez sur Modifier
(Voir Paramètres du format audio.)

Inclut dans les fichiers enregistrés les informations et les marques audio
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Options de mixage final

En haut

Type d’échantillonnage (disponible uniquement pour les fichiers 32 bits)

Remarque :

Ordre des octets (disponible uniquement pour les fichiers 16 bits)

Compression

Mode canal

Vitesse de transfert

issues du panneau Métadonnées (VoirUtilisation des marqueurs et Affichage et modification de métadonnées XMP.)

Permet de mixer des pistes sous forme de fichiers distincts ou de générer simultanément des
mixages mono, stéréo et 5.1. Pour modifier ces paramètres et d’autres, cliquez sur Modifier.

Dans l’éditeur de forme d’onde, sélectionnez Edition > Modifier l’original afin d’ouvrir la session multipiste qui a créé un
fichier de mixage. Cette commande nécessite des métadonnées incorporées dans le fichier (consultez la section
Incorporation des données de modification de l’original dans les fichiers de mixage exportés).

Paramètres du format audio
Dans la plupart des cas, vous devez enregistrer les données audio non compressées au format AIFF ou WAV. Enregistrez au format mp3
compressé uniquement lorsque vous créez des fichiers à publier sur Internet ou destinés à des lecteurs portables.

Dans une boîte de dialogue Enregistrer sous ou Exporter, cliquez sur Modifier à droite des Paramètres de format afin
d’accéder aux options ci-dessous.

Pour afficher l’effet des modifications des paramètres, notez la Taille de fichier estimée au bas de la boîte de dialogue.

Paramètres du format AIFF (*aif, *.aiff, *.aifc)
AIFF est le format de fichier audio non compressé standard de Mac OS.

Définit la résolution audio. Les résolutions plus élevées fournissent
une plage plus dynamique et réduisent la distorsion. Cependant, elles augmentent la taille des fichiers et le temps de traitement. Pour déterminer
le paramètre adéquat pour les types de sorties courants, reportez-vous à la section Compréhension de la résolution.
Les paramètres Entier rognent les données audio qui s’étendent au-delà de la plage d’amplitudes pour une résolution donnée. Les paramètres
Virgule flottante nécessitent un espace de stockage légèrement supérieur, mais conservent une plage dynamique largement supérieure.
Sélectionnez Virgule flottante 32 bits pour traiter à plusieurs reprises le fichier et ignorer les données d’amplitude minimales.

pour ajouter des métadonnées Auteur à un fichier AIFF, utilisez le champ Dublin Core : Créateur de l’onglet XMP du panneau
Métadonnées (Voir Affichage et modification de métadonnées XMP.)

Définit la séquence numérique pour les octets des données. Sélectionnez
la méthode Little-Endian pour les systèmes dotés de processeurs Intel et la méthode Big-Endian pour les systèmes dotés de processeurs
PowerPC.

Paramètres du format audio Monkey (.ape)
Le format audio Monkey compresse les fichiers jusqu’à environ la moitié de leur taille d’origine, au moyen d’un algorithme sans perte assurant la
fidélité sonique.

Détermine le compromis entre vitesse de traitement et taille de fichier. (Un traitement rapide génère des fichiers plus volumineux,
et vice-versa).

Paramètres du format audio MP2
Le format MP2 (MPEG-1 Layer II) est un format de compression avec perte particulièrement usité dans la radiodiffusion.

Choisissez une des options suivantes :
Sélectionne automatiquement une option ci-dessous en fonction de la configuration actuelle du canal du fichier.

L’option Mono produit un fichier monocanal.
L’option Double mono produit un fichier de deux canaux dont l’audio est identique.

L’option Stéréo produit un fichier de deux canaux, en traitant les canaux séparément et en conservant l’imagerie stéréo.

L’option Stéréo combiné traite deux canaux ensemble. Ceci réduit la taille de fichier, mais souvent au détriment de l’imagerie
stéréo.

Règle le compromis entre la taille du fichier et la qualité audio. Des paramètres plus élevés augmentent la taille et la qualité ;
des paramètres moins élevés les réduisent.
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Type

Vitesse de transfert (pour les débits constants) ou Qualité (pour les débits variables)

Type d’échantillonnage (disponible uniquement pour les fichiers 32 bits)

Remarque :

Prise en charge du format + de 4 Go

Format

Codage

Ordre des octets

Qualité VBR (fichiers OGG uniquement)

En haut

Pour plus d’informations sur les options avancées, placez le pointeur de la souris au-dessus jusqu’à ce qu’une info-bulle s’affiche.

Paramètres du format MP3
MP3 est le format audio compressé standard utilisé dans la diffusion en ligne.

Sélectionnez Constant pour appliquer un débit homogène ou Variable pour modifier le débit d’après le contenu audio.

Règle le compromis entre la taille du fichier et la
qualité audio. Des paramètres plus élevés augmentent la taille et la qualité ; des paramètres moins élevés les réduisent.

Evitez de compresser un même fichier audio plusieurs fois au format mp3. Si vous ouvrez et réenregistrez un fichier mp3, celui-ci est
recompressé, de sorte que tous les artefacts issus du processus de compression deviennent plus prononcés.

Paramètres de format QuickTime (*.mov audio uniquement)
Vous ne pouvez pas régler les paramètres de format des fichiers QuickTime audio uniquement, qui sont toujours enregistrés sous forme de
données PCM (Pulse Code Modulation) non compressées.

Paramètres de format Wave PCM (.wav, .bwf)
Le format Wave PCM est le format audio non compressé standard sous Windows.

Vous pouvez inclure des métadonnées Broadcast Wave dans les fichiers PCM Windows (Voir Affichage et modification de métadonnées XMP.)

Définit la résolution audio. Les résolutions plus élevées fournissent
une plage plus dynamique et réduisent la distorsion. Cependant, elles augmentent la taille des fichiers et le temps de traitement. Pour déterminer
le paramètre adéquat pour les types de sorties courants, reportez-vous à la section Compréhension de la résolution.
Les paramètres Entier rognent les données audio qui s’étendent au-delà de la plage d’amplitudes pour une résolution donnée. Les paramètres
Virgule flottante nécessitent un espace de stockage légèrement supérieur, mais conservent une plage dynamique largement supérieure.

les options Virgule flottante 24.0 et 16.8 sont fournies afin d’assurer la compatibilité avec des versions précédentes d’Adobe Audition
(16.8 était le format interne utilisé par Audition 1.0 ; 24.0 était un paramètre facultatif de la même version).

Stocke les fichiers de plus de 4 Go au format RF64 (norme de l’Union européenne de radiodiffusion
actuelle) ou au format Plusieurs blocs de données, pris en charge par plusieurs anciennes versions d’Audition.
Remarque : pour une plus grande compatibilité avec diverses applications, sélectionnez le format RF64 pour les fichiers ayant une taille
supérieure à 4 Go.

Paramètres des formats libsndfile, FLAC et OGG
Les options suivantes sont communes à un large éventail de formats.

Seul le format FLAC est à la fois compressé (réduction de la taille de fichier) et sans perte (préservation de la qualité audio optimale).

Spécifie le format et l’extension du fichier.

Détermine le schéma de stockage des données pour le fichier.

Définit la séquence numérique pour les octets des données. L’option Ordre des octets par défaut applique automatiquement la
valeur par défaut correspondant au processeur du système. Il s’agit généralement de la meilleure option.

Détermine le compromis entre taille du fichier et qualité audio. (Des paramètres plus élevés génèrent
des fichiers plus volumineux, mais produisent une meilleure qualité.)

Fermeture des fichiers
Effectuez l’une des opérations suivantes :

Pour fermer le fichier actuel dans le panneau Editeur, sélectionnez Fichier > Fermer.

Pour fermer tous les fichiers audio, vidéo et de session ouverts, sélectionnez Fichier > Tout fermer.

Pour fermer les fichiers qui ne sont pas référencés par une session multipiste ouverte, sélectionnez Fichier > Fermer le
média inutilisé.

Pour fermer la session en cours et les clips audio associés dans l’éditeur de multipiste, sélectionnez Fichier > Fermer la
session et son média.

http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/fr-fr/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/fr-fr/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/fr-fr/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/fr-fr/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/fr-fr/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/fr-fr/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/fr-fr/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/
http://idiom-q-win-1/Output/Build/cq.pdf.book/chrizhan/XML/fr-fr/Products/Audition/CS5.5/Using/pdf/cq.pdf.book/html/


 Les publications Twitter™ et Facebook ne sont pas couvertes par les dispositions de Creative Commons.Creative Commons.

Informations juridiques   |   Politique de confidentialité en ligne

Exportation d’un mixage multipiste vers Adobe Premiere Pro 

Création d’un clip audio à partir d’une piste de bus ou principale
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Saving and exporting files (CS5.5)
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Save audio files
Extract audio channels to mono files
Save multitrack sessions
Export sessions to OMF or Final Cut Pro Interchange format
Export multitrack mixdown files
Audio format settings
Close files

Some features in the Windows version of Adobe Audition 3.0 are not available in CS5.5. Examples include some file formats and effects,
CD burning, MIDI, the metronome, clip grouping and time stretching, and control surface support. For a complete list, see Adobe Audition 3.0
features replaced or not implemented in CS5.5.

Save audio files
In the Waveform Editor, you can save audio files in a variety of common formats. The format you choose depends on how you plan to use the file.
(See Audio format settings.) Keep in mind that each format stores unique information that might be discarded if you save a file in a different format.

1. In the Waveform Editor, do one of the following:
To save changes in the current file, choose File > Save.

To save changes under a different filename, choose File > Save As. Or choose File > Export > File to keep the current file
open.

To save currently selected audio as a new file, choose File > Save Selection As.

To save all open files in their current formats, choose File > Save All.

Use the Save Selection As command to break up a long recording into smaller, more manageable files.

2. Specify a filename and location, and choose a file format.
3. Set the following options:

Indicates the sample rate and bit depth. To adjust these options, click Change. (See Convert the sample rate
of a file.)

Indicates data compression and storage modes; to adjust these, click Change. (See Audio format settings.)

Includes audio markers and information from the Metadata panel in saved files. (See
Working with markers and Viewing and editing XMP metadata.)

Some CD-burning applications misinterpret non-audio information such as markers and metadata, producing an
unpleasant burst of noise at the beginning of each track.

Extract audio channels to mono files
If you want to edit or output individual channels of a stereo or surround-sound file, extract them to mono files. Adobe Audition appends the channel
name to each extracted filename. For example, a stereo source file named Jazz.aif produces mono files named Jazz_L and Jazz_R.

In the Waveform Editor, choose Edit > Extract Channels To Mono Files.

Audition automatically opens each extracted file in the Editor panel.

Save multitrack sessions
A multitrack session file is a small, non-audio file. It merely stores information about locations of related audio files on your hard drive, the duration
of each audio file within the session, the envelopes and effects applied to various tracks, and so forth. You can reopen a saved session file later to
make further changes to the mix.

If you create multitrack mixes entirely in Adobe Audition, save session files in the native SESX format. If you plan to share multitrack compositions
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with other applications, however, see Export sessions to OMF or Final Cut Pro Interchange format.

1. In the Multitrack Editor, do one of the following:
To save changes to the current session file, choose File > Save

To save changes under a different filename, choose File > Save As. Or choose File > Export > Session to keep the
current session open.

To save the session file and all the audio files it contains, choose File > Save All .

2. Specify a filename and location.
3. To include audio markers and information from the Metadata panel, select Include Markers And Other Metadata.

Export sessions to OMF or Final Cut Pro Interchange format
To transfer complete mixes to other applications in your workflow, export to OMF or Final Cut Pro Interchange format. OMF was originally created
for Avid Pro Tools, but now is a common multitrack exchange format for many audio mixing applications. Final Cut Pro Interchange format is
based on human-readable XML files, which you can edit offline to revise text references, effect settings, and so on.

Export to OMF

1. In the Multitrack Editor, choose File > Export > OMF.

2. Specify a filename and location.

3. Set the following options:

Click Change to access the Convert Sample Type dialog box. (See Converting sample types.)

Click Change to access the following:

Encapsulated stores audio clips in the OMF file itself for easier organization. Referenced stores audio clips in
the same folder as the OMF file, letting you edit them offline if necessary.

Encapsulated OMF files are limited to 2 GB in size.

Determines whether clip source files are trimmed to clip length in the Editor panel or reflect the entire
original file.

For trimmed clips, specifies the time duration to include beyond clip edges. Including additional
audio provides more flexibility for fades and editing.

The Warnings section indicates elements of the session that will be excluded or changed. To copy this information to clipboard, click the Copy
Warnings button .

Export to Final Cut Pro Interchange format

1. In the Multitrack Editor, choose File > Export > FCP XML Interchange Format.

2. Specify a filename and location.

3. To include audio markers and information from the Metadata panel, select Include Markers And Other Metadata.

The following session elements are excluded from the exported file:

The second channel of stereo clips. (All clips and tracks become mono.)

Overlapping clips

Effects and track EQ.

Automation envelopes other than clip volume and mono-to-stereo track panning.

Output routing, sends, buses, and the Master track.

Export multitrack mixdown files
After you finish mixing a session, you can export all or part of it in a variety of common formats. (See Audio file formats.) When you export, the
resulting file reflects current volume, pan, and effects settings routed to the Master track.
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To quickly mix specific audio clips down to a single track, use the Multitrack  > Bounce To New Track command. (See Create a single audio
clip from multiple clips.)

1. If you want to export part of a session, use the Time Selection tool  to select the desired range.
2. Choose File > Export > Multitrack Mixdown.

(Alternatively, choose Multitrack > Mixdown To New File to open the mixdown in the Waveform Editor and skip the steps
below.)

3. Specify a filename and location, and choose a file format.
4. Set the following options:

Indicates the sample rate and bit depth. To adjust these options, click Change. (See Convert the sample rate
of a file.)

Indicates data compression and storage modes; to adjust these, click Change. (See Audio format settings.)

Includes audio markers and information from the Metadata panel in saved files. (See
Working with markers and Viewing and editing XMP metadata.)

In the Waveform Editor, choose Edit > Edit Original to open the multitrack session that created a mixdown file. This
command requires embedded metadata in the file. (See Embed edit-original data in exported mixdown files.)

Audio format settings
In most cases, you should save uncompressed audio to the AIFF or WAV formats. Save to the compressed mp3 format only when creating files for
the web or portable media players.

In a Save As or Export dialog box, click Change to the right of Format Settings to access the options below.

To see the effect of settings changes, note the Estimated File Size at the bottom of the dialog box.

AIFF format settings (*aif, *.aiff, *.aifc)
AIFF is the standard uncompressed audio file format on Mac OS.

Sets the audio bit depth. Higher bit depths provide more dynamic range and reduce distortion,
though they increase file size and processing time. To determine the proper setting for common output types, see Understanding bit depth.
Integer settings clip audio that extends beyond the amplitude range for a given bit depth. Floating Point settings require slightly more storage
space, but retain much greater dynamic range.
Choose 32-bit Floating Point if you want to repeatedly process the file and discard minimal amplitude data.

To add Author metadata to an AIFF file, use the Dublin Core: Creator field on the XMP tab of the Metadata panel. (See Viewing and editing
XMP metadata.)

Specifies the numerical sequence for bytes of data. Choose the Little-Endian method for systems
with Intel processors and the Big-Endian method for systems with PowerPC processors.

mp3 format settings
mp3 is the standard compressed audio format across platforms.

Choose Constant to apply a consistent bitrate or Variable to change the bitrate based on audio content.

Adjusts the tradeoff between file size and audio quality. Higher settings increase size
and quality; lower settings reduce size and quality.

Avoid compressing the same audio to mp3 more than once. Opening and resaving an mp3 file causes it to be recompressed, so any artifacts
from the compressing process become more pronounced.

QuickTime format settings (audio-only *.mov)
You cannot adjust format settings for audio-only QuickTime files, which are always saved as uncompressed PCM (Pulse Code Modulation) data.

Wave PCM format settings (.wav, .bwf)
Wave PCM is the standard uncompressed audio format on Windows.

You can include Broadcast Wave metadata in Windows PCM files. (See Viewing and editing XMP metadata.)
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Sets the audio bit depth. Higher bit depths provide more dynamic range and reduce distortion,
though they increase file size and processing time. To determine the proper setting for common output types, see Understanding bit depth.
Integer settings clip audio that extends beyond the amplitude range for a given bit depth. Floating Point settings require slightly more storage
space, but retain much greater dynamic range.

The nonstandard 16.8 and 24.0 Floating Point options are provided for compatibility with previous versions of Adobe Audition. (16.8 was the
internal format used by Audition 1.0. 24.0 was an optional setting from the same version.)

Stores files larger than 4GB using either RF64 format, which reflects the current European Broadcasting Union standard, or
the Multiple Data Chunks format supported by previous versions of Audition.
note: To ensure compatibility with a wide range of applications, choose the RF64 format for files greater than 4GB.

Close files
Do any of the following:

To close the current file in the Editor panel, choose File > Close.

To close all open audio, video, and session files, choose File > Close All.

To close files that aren’t referenced by an open multitrack session, choose File > Close Unused Media.

To close the current session and related audio clips in the Multitrack Editor, choose File > Close Session and Its Media.

Export a multitrack mix to Premiere Pro CS5.5

Create an audio clip from a bus or master track
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About the Metadata panel and XMP
Show or hide XMP metadata
Edit XMP metadata
Search XMP metadata

In Adobe Audition, the Metadata panel provides BWF, ID3, and RIFF tabs that let you quickly access this common audio metadata. The XMP tab
provides the same information, combined with a longer list of metadata common to Adobe video applications. (For example, the Display Title field
on the RIFF tab corresponds to the Title field in the Dublin Core section of the XMP tab.)

To preserve metadata when you save files, select Include Markers and Other Metadata in the Save or Export dialog box.

The BWF tab applies to Broadcast Wave files, which let you specify a time offset for playback, as well as standard descriptive metadata. To
include Broadcast Wave metadata in a file, you must save in WAV format; see Save audio files. To insert a Broadcast Wave file in the Multitrack
Editor, see Spot-insert a Broadcast Wave file into a session.

The ID3 and RIFF tabs apply to mp3 and radio industry metadata, respectively.

About the Metadata panel and XMP
To streamline your workflow and organize your files, use XMP metadata. Metadata is a set of descriptive information about a file. Video and audio
files automatically include basic metadata properties, such as date, duration, and file type. You can add details with properties such as location,
director, copyright, and much more.

With the Metadata panel, you can share this information about assets throughout Adobe video and audio applications. Unlike conventional clip
properties, which are limited to only one application’s Project or Files panel, metadata properties are embedded in source files, so the data
automatically appears in other applications. This sharing of metadata lets you quickly track and manage video assets as they move through your
production workflow.

Properties in the Metadata panel also appear in Adobe Bridge, providing additional details that help you quickly browse assets.

For a video about the Metadata panel, see the Adobe website.

Maxim Jago explains XMP metadata in a video from, “Premiere Pro CS5 for Avid Editors.”

About schemas and properties
A metadata schema is a collection of properties specific to a given workflow. The Dynamic Media schema, for example, includes properties like
Scene and Shot Location that are ideal for digital video projects. Exif schemas, by contrast, include properties tailored to digital photography, like
Exposure Time and Aperture Value. More general properties, like Date and Title, appear in the Dublin Core schema. To display different
properties, see Show or hide metadata.

For information about a specific schema and property, hover the pointer over it in the Metadata panel. For most items, a tool tip appears with
details.

About the XMP standard
Adobe applications store metadata using the Extensible Metadata Platform (XMP). XMP is built on XML, which facilitates the exchange of
metadata across a variety of applications and publishing workflows. Metadata in most other formats (such as Exif, GPS, and TIFF) automatically
transfers to XMP so you can more easily view and manage it.

In most cases, XMP metadata is stored directly in source files. If a particular file format doesn’t support XMP, however, metadata is stored in a
separate sidecar file.

Project assets without corresponding files don’t support XMP. Examples from Adobe Premiere Pro include Bars and Tone, Universal Counting
Leader, Color Matte, Titles, Black Video, and Transparent Video.

To customize the creation and exchange of metadata, use the XMP Software Development Kit. For more information about XMP, see
Extensible Metadata Platform.

Show or hide XMP metadata
To optimize the Metadata panel for your workflow, show or hide entire schemas or individual properties, displaying only those that you need.

1. From the options menu  for the Metadata panel, select Metadata Display.
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2. To show or hide schemas or properties, select or deselect them from the list.

Save, switch, or delete metadata sets
If you use multiple workflows, each requiring different sets of displayed metadata, you can save sets and switch between them.

1. From the options menu  for the Metadata panel, select Metadata Display.

2. Do any of the following:

To save a customized set of displayed metadata, click Save Settings. Then enter a name, and click OK.

To display a previously saved set of metadata, select it from the menu.

To delete a previously saved set of metadata, select it from the menu, and click Delete Settings.

Create schemas and properties
If you have a unique, customized workflow that the default metadata options don’t address, create your own schemas and properties.

1. From the options menu  for the Metadata panel, select Metadata Display.

2. Click New Schema, and enter a name.

3. In the list, click Add Property to the right of the schema name.

4. Enter a property name, and select one of the following for Type:

Displays whole numbers that you drag or click to change.

Displays fractional numbers that you drag or click to change.

Displays a text box (for properties similar to Location).

Displays a check box (for On or Off properties).

Edit XMP metadata
Similarly named properties are linked in the Metadata and Files panels. However, the Metadata panel provides more extensive properties.

1. In the Editor panel, open the desired file or session.

2. In the Metadata panel, edit text or adjust values as needed.

Search XMP metadata

1. In the Editor panel, open the file or session you want to search.

2. In the Metadata panel, click the XMP tab.

3. In the search box, enter the text you want to find.

The list of metadata collapses to reveal only properties that contain your search string.

4. To navigate through the search results, click the Previous and Next buttons   to the right of the search box, or press Tab.

5. To exit the search mode and return to the full list of metadata, click the close button  to the right of the search box.
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Find shortcuts
Customize shortcuts
Save or delete custom sets of shortcuts
Restore the default shortcuts

Adobe Audition provides a default set of keyboard shortcuts to help you speed up the editing process. In menus and tool tips, available keyboard
shortcuts appear to the right of command and button names. You can customize nearly all default shortcuts and add shortcuts for other functions.

Find shortcuts
Do any of the following:

For menu commands, look for shortcuts to the right of command names.

For tools or buttons, look for shortcuts to the right of tool tips. (To display tool tips, hold the pointer over a tool or button.)

For a complete list of all shortcuts, choose Edit > Keyboard Shortcuts.

Customize shortcuts
You can customize nearly all default keyboard shortcuts and add shortcuts for other commands.

1. Choose Edit > Keyboard Shortcuts.
2. In the Command column, select the command you want to customize.
3. If you want to replace or remove an existing shortcut, choose it from the Shortcuts For Command menu.
4. Do any of the following:

To create a shortcut, click inside the Press Shortcut box, and press the desired key combination. Then click Assign.

To remove a shortcut, click Remove.

If you enter a key combination that’s already in use, Audition displays an alert. Click Yes to transfer the shortcut to a different
command, or No to retain the existing assignment.

Assign shortcuts to the Workspace commands to quickly switch between custom panel layouts.

Save or delete custom sets of shortcuts
1. Choose Edit > Keyboard Shortcuts.
2. Do either of the following:

To save a custom set, click Save As, enter a name, and click OK.

To delete a custom set, choose it from the Set menu, and then click Delete.

Restore the default shortcuts
1. Choose Edit > Keyboard Shortcuts.
2. From the Set menu, choose Default Set.

http://creativecommons.org/licenses/by-nc-sa/3.0/
http://help.adobe.com/en_US/legalnotices/index.html
http://helpx.adobe.com/go/gffooter_online_privacy_policy


Default keyboard shortcuts

To the top

To the top

Keys for playing and zooming audio
Keys for editing audio files
Keys for mixing multitrack sessions

These partial lists include the shortcuts that Adobe Audition experts find most useful. For a complete list of shortcuts, choose Edit > Keyboard
Shortcuts.

Keys for playing and zooming audio

Keys for editing audio files
The following keyboard shortcuts apply only in the Waveform Editor.

Result Windows shortcut Mac OS shortcut

Repeat previous command (opening its
dialog box and clicking OK)

Shift+R Shift+R

Repeat previous command (opening its
dialog box but not clicking OK)

Ctrl+R Command+R

Open Convert Sample Type dialog box Shift+T Shift+T

Capture a noise reduction profile for the
Noise Reduction effect

Shift+P Shift+P

Result Windows shortcut Mac OS shortcut

Toggle between Waveform and Multitrack
Editor

8 8

Start and stop playback Spacebar Spacebar

Move current-time indicator to beginning
of timeline

Home Home

Move current-time indicator to end of
timeline

End End

Move current-time indicator to previous
marker, clip, or selection edge

Ctrl+left arrow Command+left arrow

Move current-time indicator to next
marker, clip, or selection edge

Ctrl+right arrow Command+right arrow

Toggle preference for Return CTI To Start
Position On Stop

Shift+X Shift+X

Zoom in horizontally = =

Zoom in vertically Alt+= Option+=

Zoom out horizontally - -

Zoom out vertically Alt+minus sign Option+minus sign

Add marker M or * (asterisk) M or * (asterisk)
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To the top

Activate left channel of a stereo file for
editing

Up arrow Up arrow

Activate right channel of a stereo file for
editing

Down arrow Down arrow

Make spectral display more logarithmic or
linear

Ctrl+Alt+up or down arrow Option+Command+up or down arrow

Make spectral display fully logarithmic or
linear

Ctrl+Alt+Page Up or Down Option+Command+Page Up or Down

Increase or decrease spectral resolution Shift+Ctrl+up or down arrow Shift+Command-up or down arrow

Keys for mixing multitrack sessions
The following keyboard shortcuts apply only in the Multitrack Editor.

Result Windows shortcut Mac OS shortcut

Select the same input or output for all
audio tracks

Ctrl+Shift-select Command+Shift-select

Activate or deactivate Mute, Solo, Arm For
Record, or Monitor Input in all tracks

Ctrl+Shift-click Command+Shift-click

Adjust knobs in large increments Shift-drag Shift-drag

Adjust knobs in small increments Ctrl-drag Command-drag

Nudge selected clip to the left Alt+comma Option+comma

Nudge selected clip to the right Alt+period Alt+period

Maintain keyframe time position or
parameter value

Shift-drag Shift-drag

Reposition envelope segment without
creating keyframe

Ctrl-drag Command-drag
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